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Contact Us
Online: NetAlly.com

Phone: (North America) 1-844-TRU-ALLY 
(1-844-878-2559)

NetAlly, LLC
2075 Research Parkway, Suite 190
Colorado Springs, CO 80920

For additional product resources, visit: 
https://www.netally.com/products/airmagnet-survey-pro/

For customer support, visit: 
NetAlly.com/Support

Register your product:
Registering your product with NetAlly  gives you access to valuable information on product updates, troubleshooting 
procedures, and other services. 

Register on the NetAlly Support Page.

Legal Notification
Use of this product requires acceptance of the Terms and Conditions available at 
https://NetAlly.com/terms-and-conditions or which accompanies the product at the time of shipment or, if applicable, the 
legal agreement executed by and between NetAlly and the purchaser of this product.

 Open-Source Software Acknowledgment: This product may incorporate open-source components. NetAlly will make 
available open-source code components of this product, if any, at Link-Live.com/OpenSource (requires login).

 NetAlly reserves the right, at its sole discretion, to make changes at any time in its technical information, specifications, 
service, and support programs.

© 2019-2022 NetAlly, LLC
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Introduction
AirMagnet     Survey PRO contains powerful, easy-to-use tools for planning, collecting,     and analyzing WLAN site radio 
frequency (RF) data crucial for successful    WLAN deployment.  Operating at the RF level,   AirMagnet Survey helps you quickly 
and easily conduct RF site surveys and determine   the optimal number and placement of WLAN infrastructure devices to 
provide   the best coverage and throughput in a cost-effective   way. You can understand the behavior of radio waves in a 
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Introduction

Product Overview
AirMagnet     Survey PRO contains powerful, easy-to-use tools for planning, collecting,     and analyzing WLAN site radio 
frequency (RF) data crucial for successful    WLAN deployment.  Operating at the RF level,   AirMagnet Survey helps you quickly 
and easily conduct RF site surveys and determine   the optimal number and placement of WLAN infrastructure devices to 
provide   the best coverage and throughput in a cost-effective   way. You can understand the behavior of radio waves in a 
facility before  you install any wireless network access points.

AirMagnet Planner   is a wireless network planning tool that accounts for building materials,   obstructions, access point con-
figurations, antenna patterns and a host   of other variables to provide a reliable predictive map of Wi-Fi signal   and 
performance. The solution offers superior predictive modeling to determine   ideal quantity, placement and configuration of 
APs for optimal security,   performance and compliance.

AirMagnet Planner includes   built-in automated tools to help you form a migration strategy from   existing legacy 802.11a/b/g/n 
networks to 802.11ac/ax technology.

AirMagnet Planner   can be purchased as a separate product or as a fully integrated feature   of AirMagnet Survey. When 
integrated with AirMagnet Survey, you have   a powerful solution that combines state-of-the-art predictive modeling   with real-
world performance data.

Copyright
© 2004-2022 NetAlly

This User Guide is furnished under license and may   be used or copied only in accordance with the terms specified in the 
license.   The content of this document is for information only and should not be   construed as a commitment on the part of 
NetAlly.

No part of this document may be reproduced, transmitted,   stored in a retrievable system, or translated into any language in 
any   form or by any means without the prior written consent of NetAlly. Further,   NetAlly reserves the right to modify the 
content of this document without   notice.

NETALLY SHALL NOT BE HELD LIABLE FOR ERRORS   OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES   RESULTING FROM THE USE OF THIS CONTENT.         

AirMagnet® and AirWISE® are registered trademarks,   and the AirMagnet logo is a trademark, of NetAlly, LLC. All the other   
product names mentioned herein are trademarks or registered trademarks   of their respective companies.

This product features   Autodesk RealDWG technology. See https://www.autodesk.com/developer-network/platform-tech-
nologies/realdwg

This product includes software developed by David Young. Copyright 2003,   2004. All rights reserved.

This product includes software developed by Atsushi Onoe. Copyright   2001. All rights reserved.

This product includes software developed by Sam Leffler, Errno Consulting.   Copyright 2002-2005. All rights reserved.

This product includes software developed by Bill Paul <wpaul@ctr.columbia.edu>.   Copyright 1997, 1998, 1999. All rights 
reserved.

This product includes software developed by the University of California,   Lawrence Berkeley Laboratory and its contributors.

This product includes software derived from the RSA Data Security, Inc.   MD4 Message-Digest Algorithm. © 1990-1992 RSA 
Data Security, Inc. All rights reserved.

This product includes software derived from iPerf Performance Test:

iPerf2 - Copyright 1999-2007, The Board of Trustees of the University   of Illinois. All rights reserved. 

iPerf3 - Copyright   2014-2020, The Regents of the University of California, through Lawrence   Berkeley National Laboratory. All 
rights reserved. 

Powered by NetAlly.

NetAlly
2075 Research Parkway, Suite 190
Colorado Springs, CO 80920 

Compiled in the United States of America.
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Introduction

Version: v10.6, Released 10/2022

AirMagnet Survey PRO vs.   Survey Express
AirMagnet Survey comes in two versions: PRO and Express. The table below   highlights the similarities and differences 
between the two. (A Survey Viewer license is available only for products under current AllyCare Support or maintenance 
contracts.)

  Product Features Survey PRO Survey Express

Site Survey scenarios Indoor site survey Yes Yes

Outdoor site survey Yes No

Coverage maps RF signal coverage Yes Yes

Data rate Yes Yes

Channel interference Yes Yes

802.11n/ac/ax (AP operating mode, Channel 
width, Max MCS)

Yes No

Packet loss/retry Yes Yes

Floor-based 
deployments

Single-floor data display and analysis Yes Yes

Multi-floor data display and analysis Yes No

802.11 deployments 802.11a/b/g/n/ac/ax 802.11a/b/g/n/ac/ax

Surveying capabilities Passive surveys Yes Yes

Active surveys Yes Yes

Active iPerf surveys Yes No

Data simulation Yes Yes

Active tools Yes Yes

200+ channel deployment Yes No

Reporting capabilities Survey Reports Multiple reports One Report*

Network design veri-
fication

Network design verification Yes No

VoWLAN deployment verification Yes No

RF spectrum analysis Spectrum XT integration Yes No

RF spectrum heatmaps Yes No

Cisco Prime NCS/WCS Survey Integration Yes No

Planner Integration Yes With purchase of 
AirMagnet Planner 
Module.

Network Planning AirMagnet Planner Yes With purchase of 
AirMagnet Planner 
Module.

* AirMagnet Survey Express has one default report: ‘Overall Coverage   Report by Channel’.

Additional Notes regarding AirMagnet Survey   PRO and AirMagnet Survey Express:

 l If you are installing AirMagnet Survey PRO, you should see the    words “Survey PRO” across the top of the sticker bearing 
the serial    number and serial key; if you are installing AirMagnet Survey Express,    you’ll see the word “Survey Express”.

 l AirMagnet Survey PRO offers more features than AirMagnet Survey    Express. If you are using AirMagnet Survey Express and 
wish to upgrade    to AirMagnet Survey PRO, contact your AirMagnet product reseller or    AirMagnet Technical Support.
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Introduction

 l An AirMagnet Spectrum XT Adapter is required to view spectrum    data on AirMagnet Survey PRO. Those who want to take 
advantage of    this feature must purchase AirMagnet Spectrum XT separately at their    own expense.

Key Features and Benefits
AirMagnet Survey offers the following key features and benefits (Note   that some of the features are available in Survey PRO 
only):

 l AirMapper™                  eliminates    the need for laptops, dongles, or tethered devices to conduct site    surveys. You can perform a 
survey with the AirMapper application on    your NetAlly AirCheck G3 or EtherScope nXG and analyze the data with    
AirMagnet Survey PRO. 

You have two options to transfer survey data from a NetAlly AirCheck G3 or EtherScope nXG:

Link-Live Download

 1. When saving an AirMapper survey, select Link-Live as the destination.

 2. Log into your Link-Live account.

 3. You can download AirMapper projects to your PC with AirMagnet     Survey PRO v10.0 (or later) using the Export for 
Survey PRO option     on Link-Live.

USB Transfer

 1. When saving the survey on the AirCheck G3 or EtherScope nXG,     select Local as the destination.

 2. Plug a USB thumb drive into one of the USB-A ports on your     handheld tester.

 3. Transfer the AirMapper (.amp) file that was saved to the USB     thumb drive.

 4. Remove the USB thumb drive from the handheld tester and plug     it into a PC with AirMagnet Survey PRO v10.0 (or 
later).

 5. Open the AirMagnet Survey PRO application.

 6. Go to File and select     the Open Project option.

 7. Browse to the location of the .amp file.

 8. Select the .amp file and click the Open     button.

 9. When prompted to save the new project, browse to preferred     destination, and then click on the OK     button.

After the import is complete, a new Survey Project (.svp) file is    created using the data collected by the AirMapper 
application. You    can then use all AirMagnet Survey functionality to analyze your AirMapper    survey data, including: 

 l Heatmaps

 l Signal Strength

 l Noise

 l SNR

 l Interference

 l Predictive PHY Data Rates

 l Max MCS

 l AP Operating Mode

 l Channel Width

 l Simulation Mode

 l MultiView

 l DiffView

 l AirWISE

 l Reports

 l Comment support: The Display View shows     comments made at survey points in the AirMapper survey.

 l Support for Active and Passive surveys for     AirCheck G3 and EtherScope nXG, as well as EtherScope nXG dual     surveys 
(simultaneous surveys conducted with both the 4x4 Dual-band     802.11ac Wave 2 wireless radio and the 1x1 Dual-band 
802.11ac).      
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Please be aware of the following while using this functionality:

 l You cannot import an AirMapper (.amp) file into an existing     Survey Project (.svp) project, a new project is always 
created.     However, you can import the     .svdx file from the new project into other projects.

 l A converted AirMapper project is named with the same name as the     .amp file.

 l The Adapter Name under Survey properties is AirMapper.

 l Open Space Office is the default Environment. You can change this default with the Project Properties screen. Signal     
Propagation Assessment matches the value used on the AirMapper     application.

 l The AP Default Power is set at 100.0 mW. You can change this value through the Project Properties screen. (This 
setting is only used by the Simulation tool.)

 l An AirMapper (.amp) project cannot be directly imported into     MultiView, but you can import it after converting it into a 
Survey Project (.svp).

 l GPS support allows    you to use any AirMagnet-supported GPS device for large-scale, outdoor    WLAN site surveys. The 
program can automatically calibrate GPS location    information (longitude and latitude) of any given point on the site    and 
place APs in their optimal locations. It can also automatically    collect site data as you are moving (walking or driving) 
along the survey    path. Available in AirMagnet Survey    PRO only.

 l Integration with AirMagnet Spectrum    XT, which comes with AirMagnet’s advanced spectrum sensing    hardware and 
analysis software, brings the AirMagnet Survey to a higher    level by offering wireless network professionals a powerful tool 
for    spectrum monitoring as the basis for network planning and deployment,    in-depth and localized troubleshooting, and 
network optimization.    Available in AirMagnet Survey PRO    only. Requires AirMagnet Spectrum XT application installed on 
same    machine including a valid license and AirMagnet Spectrum XT Adapter.

 l AirWISE Integration incorporates    AirMagnet’s AirWISE technology into the Survey product to help wireless    LAN planners 
and administrators make well-informed decisions regarding    the requirements for their WLAN deployment and main-
tenance using real    data collected from a site survey. It is geared towards helping identify    critical issues in WLAN per-
formance and providing straightforward    actionable solutions to the issues that are identified. For example,    one of the 
policies can help you determine WLAN readiness for "Cisco    Location-based Services." Available    in AirMagnet Survey PRO 
only.

 l Comprehensive survey data reports let    you turn your survey data and simulation results into various data    reports. The 
reports contain comprehensive information on channel    allocation and usage, WLAN SSID coverage and throughput, AP 
coverage,    RF interference and noise, etc. The reports can be exported in popular    file formats (Acrobat PDF, HTML, 
Microsoft Word (RTF), Microsoft Excel    97-2000 (XLS) and XML). The reports can be saved on your hard drive.    A translation 
feature enables report templates to be localized for    multiple languages. Available in    AirMagnet Survey PRO only.

 l Multi-floor site survey    and data analysis feature allows you to conduct RF surveys on a per-floor    basis. Each survey on an 
individual floor is treated as a separate    project. You can then view them individually or collectively to see    how they 
perform in terms of signal coverage across the floors. Available in AirMagnet Survey PRO only.

 l A powerful, comprehensive, and    easy-to-use WLAN deployment utility integrates functionalities    such as site survey, 
data analysis, channel and power simulation,    data merging and filtering, calculation, and network connectivity    
troubleshooting all in one package.

 l Three survey options—active, passive,    and active iPerf—allow you to gather complete site RF data,    including signal 
strength, channel allocation, noise level, signal-to-noise    ratio, coverage, media type, transmission speed, packet loss/retry    
rate, etc. In an active survey, AirMagnet Survey can associate with    a specific AP or SSID; in a passive survey, it can “pick 
up” any RF    data that exist in a WLAN environment, including data from neighboring    WLANs. Active iPerf Surveys allow the 
system to gather information    for PHY data rates for both uplink and downlink connections.

 l Two display options enable    you to view and analyze site RF data by channel or by SSID. You can    easily identify WLAN defi-
ciencies in terms of AP coverage, roaming    boundary, channel allocation/interference, noise impact, etc.

 l Support for Intel®    Centrino® Mobile Technologies allows customers to take    advantage of the advanced performance 
and security features offered    by the latest Intel® Centrino® mobile technology products.

 l Easy-to-use Simulation tool allows    you to conduct simulations on AP channel allocation, output power,    and SSID assign-
ment right from your desktop and get the results in    a matter of seconds. You can conduct various “tests” to find the best    
AP channel allocation with maximum signal strength and minimum co-channel    or adjacent channel interference; analyze 
the impact of AP repositioning    to select the optimal AP deployment location and provide the most    efficient signal 
coverage; analyze the impact of adding or reducing    the number of APs at a site to determine the optimal number of APs    
for desired signal coverage; and visually compare the results before    and after the simulations, etc.

 l Data filtering capability allows    you to zero in on specific APs for detailed analysis and to experiment    with different AP 
deployment scenarios.
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 l Data merging gives    you a holistic view of all factors affecting your wireless LAN deployment.    You can experiment and 
simulate with different AP deployment options    for maximum signal coverage and minimum interference.

 l Diagnostic tools let the    you analyze signal distribution patterns and conduct end-to-end connectivity    tests with DHCP 
and Ping tools at any time.

 l Built-in wireless calculator    allows you to calculate various parameters important to WLAN performance.    They include 
System Operating Margin, Free Space Loss, Fresnel Zone,    Downtilt Angle and Distance, and Downtilt Coverage. So you can 
make    informed decisions for your WLAN deployment and/or upgrade.

 l Graphical data display with color    spectrum and gradient makes it easy to understand and differentiate    RF data from 
various sources (that is, APs or SSIDs and channels).    This allows you to base your WLAN decisions on “facts” rather than    
“hypotheses”.

 l Support for all wireless LAN PHY    standards, that is, 802.11a/b/g/n/ac/ax.

 l Survey comparison view helps    visualize the differences between two surveys taken of the same    area. This can help see 
how a wireless    environment changed over time by comparing two surveys taken months    apart.

 l Passive survey speed data calculation generates    speed data for passive or simulated data, allowing you to view the    
predicted transmission rates for APs without having to conduct an    active survey for each device.

 l Profile management makes    storing configuration settings for any given site easy. You can    implement profiles for each 
site surveyed and quickly switch back    and forth between profiles, eliminating the need to manually adjust    configuration 
settings at each location.

 l Cisco Prime NCS/WCS are network management tools.    Integrated with AirMagnet Survey, it allows    you to import 
AirMagnet Survey and AirMagnet Planner    files into Cisco Prime NCS/WCS. It also lets you export a Cisco Prime    NCS/WCS 
project into AirMagnet Survey.

 l Survey Mobile app is a    mobile and easy to carry platform for conducting site surveys using    an Android phone or 
tablet. Because it integrates seamlessly    with AirMagnet Survey PRO, you can conduct the survey using Survey    Mobile, and 
then share the projects with other users of AirMagnet    Survey PRO. Simply email the project from your handheld device 
and    open the project (.svd file) in AirMagnet Survey PRO for deeper survey    analysis and reporting.
The Survey    Mobile app .apk file can be found in your installation directory.    To load the app onto your device, connect 
your Android device    to your PC and enable USB mass-storage mode. You can then drag and    drop the file onto your 
Android device. Then, using a file manager,    such as Astro or ES File Explorer, locate the file on your Android    device and 
install it.

 l Multi Floor Planner                  enables    you to view how signal propagation occurs between floors in a multi-floor    building. With 
Multi Floor Planner, you can create a new project for    one or more floors and you can also import individual AirMagnet 
Planner projects for one    or more floors as well. By creating a single building project in this    way, you can see predictive 
heatmap visualizations, for example, of    how APs on one floor may propagate signal strength coverage to other    floors. It 
includes support for 802.11a/b/g/n/ac/ax APs.

System Requirements

PCs—Laptop, Notebook, or Tablet
Operating System Requirements: 

PC System Requirements: 
 l Supported operating system:

 o Microsoft Windows 8.1 Pro/Enterprise 64-bit

Note:   64-bit operating systems are supported on Windows 8 and 8.1 for certain wireless   adapters. 

 o Microsoft   Windows 10 Pro/Enterprise 64-bit

 o Microsoft 11 Pro/Enterprise 64-bit

 l Intel® Core™ i5 2.00 GHz minimum, Intel® Core™ i7 or higher recommended

 l 4 GB memory minimum, 8 GB or higher recommended

 l 800 MB free hard disk space             
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 l Aircheck™ G3/EtherScope® nXG with AirMapper™ (recommended) or AirMagnet-supported wireless    network adapter(s). 
See Guideline for Use of Wi-Fi Adapters and https://www.netally.com/wp-content/uploads/APA_FL_21_V2.pdf

 l One available USB port for each external    adapter or NetAlly multi-adapter kit (see https://www.net-
ally.com/products/airmagnet-survey-pro/ (click on Models & Accessories).

 l (Optional for Survey PRO only) AirMagnet    Spectrum XT adapter and license (required for viewing spectrum data and 
heatmap)          

 l A site map in a format supported by AirMagnet Survey. See Supported    Image File Formats.

 l (Survey PRO only) Google Earth must    be installed to export the GPS data for outdoor surveys to Google    Earth .             

Apple® MacBook®   Pro:
 l Operating System:    MAC OS X v10.5 (Leopard™) running a supported Windows OS (see "PCs—Laptop, Notebook, or Tablet" 

on the previous page) using Boot Camp®

 l Intel® Core™ i5 2.00 GHz, Intel® Core™ i7 or higher recommended

 l 4 GB memory minimum, 8 GB or higher recommended

 l 800 MB free hard disk    space

 l USB port for external    adapter use

 l AirMagnet-supported wireless    network adapter(s). AirMagnet-supported wireless    network adapter(s). See Guideline for 
Use of Wi-Fi Adapters and https://www.netally.com/wp-content/uploads/APA_FL_21_V2.pdf

 l When    using multiple adapters, NetAlly recommends the use of its multi-adapter    kit. Otherwise, multiple slots/ports in the 
Macbook® Pro are required.                 

 l Optional AirMagnet    Spectrum XT adapter and license for integrated spectrum survey on    Survey PRO. Required for viewing 
spectrum data and heatmap.

 l A site map in a format    supported by AirMagnet Survey. See Supported    Image File Formats.

 l Google Earth must    be installed to export the GPS data for outdoor surveys to Google    Earth (Survey PRO only).

Guideline for Use of Wi-Fi Adapters
AirMagnet Survey/Planner requires that a Wi-Fi adapter be installed   on the same computer running the application to capture 
Wi-Fi data.

AirMagnet mobile products categorize Wi-Fi adapters into the following   types:

Preferred Adapters: These adapters   have been tested by NetAlly and are recommended for use with AirMagnet Survey PRO. 
Drivers have been customized for extended feature support. For   a complete, up-to-date listing of AirMagnet Preferred wireless 
adapters,   visit: https://www.netally.com/wp-content/uploads/APA_FL_21_V2.pdf

Other Adapters: These adapters   can be used with AirMagnet Survey PRO but have not been tested by NetAlly.   Drivers have 
not been customized, provide limited features, and could   provide inaccurate data. 

NOTE: When installing Intel® and USB adapters,   be sure to deselect (uncheck) the option to install the adapter’s client   utility 
in addition to the driver software.

Limitations of Other Network Adapters
Any 802.11 adapter supported by Windows other than the Preferred Adapters   falls into the other network adapters category. 
They can be used with   AirMagnet Survey PRO to perform a survey but have not been tested by AirMagnet.   These adapters’ 
drivers have not been customized, provide limited feature   support, and could provide inaccurate information. 

NOTE: NetAlly is not responsible for the quality of the test results   collected using these adapters. 

The following are noted limitations of   generic adapters in AirMagnet Survey.

 l No ability to scan specific channels: all channels are scanned.    There is no Scan or 802.11 tab under the File > Configure 
menu.

 l No noise or signal-to-noise ratio (SNR) measurements.
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 l Measured PHY data rates in the uplink and downlink directions are    not separated. Only a single PHY data rate for the con-
nection is reported.

 l No packet retries and loss measurements on active and iPerf surveys.

 l iPerf throughput performance may vary, depending on the model of    the generic adapter in use.

 l Limitations in the wireless channels that they scan: They may only    be able to scan channels that are approved for wireless 
use in a specific    country, and unable to scan channels assigned as Dynamic Frequency    Selection (DFS) channels.

 l Only one non-preferred adapter can be used when using multiple    adapters. See Using Multiple Adapters.

 l There is no roaming control for active and iPerf surveys.

 l Due to the inability to disable roaming on the adapter, active and iPerf surveys can only be conducted  the “by SSID” (not 
"by AP").

Wi-Fi Adapter Driver Packages
The supported driver packages for preferred adapters are located in   your My AirMagnet account under the Documents/Drivers 
section.

Supported GPS Devices
(Survey only)

When conducting a GPS outdoor survey, the GPS device must be compatible   with AirMagnet Survey PRO by satisfying the 
following requirements:

 l Must be NMEA compliant.

 l Must be capable of generating serial data which can be verified via Hyperterminal.

 l Must be recognized by the laptop as a COM port.

If your GPS device is not NMEA compliant, you may use a 3rd party   software solution that allows the GPS USB to be detected 
as a COM   port. You then need to verify that the data is converted to NMEA   format. Software solutions such as this have 
worked on many GPS models;   however, AirMagnet cannot ensure that it works with all GPS devices.

Supported Image File Formats
A digital site map of the facility or location needs to be in one of   the supported file formats. Having a site map allows you to 
accurately   mark AP locations and coverage areas. However, if no digital site map   is available, you may create one using a 
drawing software application.   You can also sketch a map by hand and then have it scanned and saved in   one of the 
supported image file formats.

File Format Description
.BMP The standard Bit-Mapped Graphics format used in the Windows     environment.
.DIB Device-Independent Bitmap, a variant of a bitmap (bmp) file.
.DWF DWF is an Autodesk Design Web Format file. This file format is highly compressed for efficient dis-

tribution. 
Note: Project exports are not supported with this file type.

.DWG DWG is the format for Autodesk's AutoCAD® drawing files in MS-DOS and     Windows. DWG is now being 
supported by certain non-AutoCAD systems     in the same manner that DXF is supported by non-AutoCAD 
systems.     See .DXF below. Versions up to AutoCAD 2023 are supported.

.DXF Data Exchange Format is a format for storing vector data in     ASCII or binary files used by AutoCAD and 
other CAD software for     data interchange.

.EMF (Enhanced MetaFile) and WMF (Windows MetaFile) are the major     display formats of the Windows 
operating environment and the native     graphics formats for MS Office applications.

.GIF Graphics Interchange Format is a variation of the bitmap image     format for pictures with up to 256 
distinct colors.

.JPG Short for .JPEG (Joint Photographics Experts Group); a file     format widely used for web images.

.PNG Portable Network Graphics is a bitmap image format that     uses lossless data compression.

.VSD Microsoft Visio 2010 image file.

.WMF Windows MetaFile. See .EMF above.
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.VDX Visio drawing.

Note: One image   file format is not favored over another. Consult   a reference on digital imaging to learn which format best fits 
your needs.

 l By default, a floor map is displayed in an 8.5”x 11” or 21.6 cm x 28   cm dimension.

 l Make sure that the map is legible and as accurate as possible.   A good map should be clear enough to view at a normal 
scale (1:1)   without zooming.

 l Try to keep your map image file in a reasonable size. Larger-sized images take longer to upload and if too large may   even 
cause the program to crash. If you have problems loading a large map image, consider using a graphics editor to divide 
the image into sections.

Survey Viewer License
The Survey Viewer license is available to customers who have AllyCare   Support.

The Survey Viewer license replaces the “Display-Only Mode” implemented   in previous releases of the software. You can 
download one Viewer license   from their MyAirMagnet page after registering the Survey product. You   can obtain two 
additional Viewer licenses by contacting Technical   Support. The Viewer license can then be installed and bound to another   
machine or wireless card, just as with a normal Survey installation.

Note: The Viewer   license is bound in the same manner as any license, and as such can only   be associated with one machine 
or wireless card.

The main restriction of the Viewer license is that installations in   Viewer mode cannot conduct surveys or use "Tools". Addi-
tionally,   the Viewer license is based on the master Survey license you purchased   and has the same limitations as the master 
license. For example, if you   own a Survey Express license, the associated Viewer license allows access   to the Display, 
Simulation, and Calculator screens.

Product Registration
By registering your purchased software, you are entitled to a free My AirMagnet account with the following benefits:

 l Download software updates to the software when available.

 l Access product documentation, like Release Notes and User Guides.

 l Download wireless adapter    drivers.

 l Access training videos.

To register your product, open the following URL:

https://airmagnet.netally.com/support/register_product/

Technical   Support

AllyCare Product Support
NetAlly's AllyCare is our comprehensive support and maintenance program   that offers expanded coverage for the products.

For more information, visit https://www.netally.com/support/.

Contact Us
Call toll-free in North America: 1-844-TRU-ALLY (1-844-878-2559)

Visit https://www.netally.com/contact-us/   for additional phone numbers. Scroll down and select your region to complete   a 
web form and have a NetAlly representative contact you.

Help and Sample Projects
Display help options from the Help   menu.
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Press the   F1 key to display context-sensitive help for the current view. Context-sensitive help (if available) is displayed. 

 l Contents... - Displays

 l Sample Projects - Select to display a menu of sample projects. You can use these projects to learn more about 
Survey PRO or modify them to suit your own project.

 l About AirMagnet Survey - Display version and update information.

 l Check Update - Checks for software updates.

Sharing Projects
You can share your Survey and AirMagnet Planner projects   with other users who have the associated products or viewer 
software   installed on their computers.  

Here is what to do to share a project:

 1. Locate the project folder. The folder was created when you created    your new project. The folder name is the “project 
name” you gave your    project.

 2. Zip the folder and send it to the recipient.

 3. The recipient needs to unzip the folder, launch the application    and select File > Open. Browse    to the folder. The correct 
project file is the only file available    to open.
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Preparing for Software Installation
NetAlly strongly recommended that you review this information before   starting product installation.

Checking Product Package Contents
Before you start, make sure that the following items are included in   the product package:

 l Compliance Guide

 l A software certificate with the serial number and serial key

 l If a support contract was purchased, a support contract with a    support serial number and serial key.

In case any items are missing or damaged, contact Technical Support immediately.

Verify System Requirements
Be sure to install the software on a computer that complies with the   system requirements. 

Before You Begin
Consider the following before installing, launching and using the software:

 l Be sure to have active Internet connection when launching the software    for the first time.

 l You must have administrative rights on the computer running the    product software.

 l Be aware certain firewall settings or anti-virus software may interfere    with the product software.

 l Network software that uses a wireless adapter may cause a conflict    with the product software.

Product Upgrades
If the computer running the software application has an active Internet   connection and a product upgrade is available, a noti-
fication dialog is   displayed during product launch when a newer version of the software is   available. Click Yes   to proceed to 
your MyAirMagnet account where you can access the software   upgrade download. The product upgrade is listed in 
Registered   Products > Downloads section under Software Download.

An active support contract is required to upgrade from an older version   to a newer version of the product. All existing 
customers wishing to install   a newer release of the product should verify the status of their product   support contract before 
starting the installation.

You can view the status of your support contract under the Registered   Products section of your MyAirMagnet   account.

You can also manually check for product updates by selecting Check Update from the Help   menu.

Software License
You must install a unique software license to successfully   run the software application. The program prompts you to install 
the license   when you launch the product the first time.

Obtaining a Software License
Your Software License Certificate includes a Serial Number (S/N) and   a Keycode (Serial Key). When the application is launched 
for the first   time, you must enter this information to proceed. This   Serial Number / Serial Key combination enables you to 
obtain a software   license compatible with the software version of your product and in accordance   with your support contract.

Once you enter the Serial Number and Serial Key, you are prompted   to obtain the license:

License Download:   If the machine is connected to the Internet, you may choose to obtain   the license by download. In this 
case, the system automatically downloads   the license and install it.

Browse to License: If   the license is accessible on your network (previously downloaded), you   may choose to browse to it. 
The name of the license file is “serial number.lic”
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For example: A4018-04280450.lic.

The license is copied to your AirMagnet product directory.

For example: C:\Program Files\AirMagnet Inc\AirMagnet Surveyor.

Binding the License to a MAC address
One software license per MAC address is permitted. The license can be   bound to a specific computer (laptop) or to a 
removable wireless adapter.   This provides flexibility in how the product may be used and shared.

During product installation, you are prompted to choose which option   to use. Depending on your choice, the application auto-
matically captures   the MAC address of the machine or adapter.

Note: If you choose   to bind the software license to a removable adapter, the adapter must   be active on the computer at the 
time you launch the application.

MAC Address Reset
Should you desire to reset the MAC address to a different computer or   adapter, you can request a MAC address reset by 
choosing “MAC Address   Reset” from your MyAirMagnet account.

Backing-up the License File
NetAlly strongly recommends that you register your product, download   the license file and save it in a safe location. Having a 
backup license   file makes it easy to reinstall the application anytime, if needed because   you can just browse to the file to 
install it.

Support Contract Activation
If you purchased an AllyCare support contract for your product, the   license file contains information that indicates whether 
support has been   pre-activated. If no pre-activation occurred, you are presented with a dialog to supply   a support contract 
Serial Number and Serial Key.

Installing Product Software
If you have a current support   contract, the download is the most current version of the product; otherwise   it is the version 
you are entitled to download.

 1. Install all available Windows updates.

 2. From the Registered Products page of your My AirMagnet account,    click the software download link, and run or save the 
file. (If you save the file, double-click the .exe file to run the    installer.)

 3. Use the Windows Control Panel to uninstall any previous version of AirMagnet Survey before installing the current version 
of Survey PRO or Planner.

NOTE: Do not use the Windows Repair function. This may result in unreliable performance in some versions of Windows. 

 4. Agree to the Software License Agreement to proceed with installation. 

 5. Set the installation destination folder. (Accept the Program Files    default or browse to a different location.)

 6. Click Finish to complete    the installation. 

 7. Select another option from the installer, or click Exit    to close the installer.

Uninstalling Product Software
 1. From the Windows > Settings menu (accessible from the left    side of the Start menu), select Apps.

 2. Click Apps. The list of    installed applications is displayed.

 3. Select the desired application. 
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 4. Select Uninstall.

 5. You are prompted to choose whether to keep your license file    and created/modified files after uninstalling the product:

 l Yes: The license file and    created/modified files are not deleted.

 l No: The license file and    created/modified files are deleted.

The following is a list of files affected by the selection chosen:

 l Antenna patterns - User-created antenna files

 l Wall/Area configuration - Areas and Walls - AreaList.txt and WallList.txt

 l Floor Material - FloorMaterials.xml

 l OUI to vendor mappings - LanCardVendors.txt

 l Custom Report Templates - No change to current behavior. The current    predefined template is replaced, and the 
customer-created one is    kept.

 l AP Groupings - Predefined Rules.csv

 l APAlias.map - APAlias.map

 l Profiles from File\Configure - User-created profiles

 l AirWISE Policies and Areas - For policies, user-created policies.    For Areas, saved to project folder, so no action on those 
files.

 l Phonebook - Phonebook.xml and profiles.xml

 l Speed table - SpeedMap.txt

If you choose to re-install the product software and if you preserved   the files, the installer merges the new files (for example, 
new antenna   patterns) but does not replace any files from the above groups if they   already exist on the target system.  This 
applies to all files in   all groups.    

Launching the Application for the First Time
Note: Do not attempt   to launch the application during a Microsoft Windows update. If this occurs,   the following error 
message may be displayed, "The application has   failed to start because its side-by-side configuration is incorrect."

When you launch the application for the first time, you must  validate your license and install it.

License Method
Choose which method to use for installing the software license:

 l Download the license: You    must be connected to the Internet and have an active Internet connection.    The license is 
downloaded from the NetAlly website.

 l Browse to a license: You    are prompted to browse to the file. The license must have been    previously downloaded from 
the NetAlly website.

Serial Number, Serial Key and MAC Address Binding
When launching the software for the first time, you be required to supply   a valid serial number and serial key. You also need 
to bind the license   to the MAC address of an internal or external network adapter.

- 22 -



Installation

License Activation Notes:

If the license file does not support the installed version of the product,   an error message displays, such as “Invalid License 
File” or “This serial   number is currently out of support” or “Invalid Product Code.”

If you receive an error when attempting to install   the software license, check for the following:

 l Your license does not support    a newer version of the product: Purchase a support contract    that entitles you to run the 
newer software.

 l Invalid Product Code: The    license file you chose is for a different product. Verify that the    license file name has the same 
serial number as the serial number    for your product.

If you believe the error message to be incorrect about the status of   your product or license, contact Technical Support.   Be 
ready to provide the serial number and serial key for the product in   question.

When Using USB Adapters
 l It    is best to always use the same USB port for the adapter. When    using any of the USB wireless adapters, you may 

need to re-create    wireless profiles after plugging the adapter into a different USB    port. (Profiles are stored based on the 
port, not the adapter itself.)

 l Important: When installing    new Intel® and USB adapters,    uncheck the option to install the adapter’s client utility in 
addition    to the driver software.

 l To run AirMagnet    Survey using a USB preferred adapter, you must install the adapter    using the installer found at 
https://airmagnet.netally.com/my_airmagnet/public/documents/#3rdpartydriver (login required).             
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AirMagnet Survey Main View
To open AirMagnet Survey: Open the Windows Start menu, and then select   AirMagnet Survey > Survey. The   application 
opens in Survey mode with a default blank Map view.

To open an existing project:   Click Open    or select Open Project from the File menu and navigate to the project   file. If 
you select an AirMapper   project file (.amp) you are asked to specify a new location for the   converted Survey project.

Note: When opening   an existing project, be sure the Windows "Regional and Language Options"   setting matches between the 
existing project and the computer on which   you open the project.

To start a new Survey or Multi Floor Planner project:   Click Project Wizard .

Additionally, some sample floor plans and sample projects are available   from the Help menu.

Note: If you choose   to open or start a new Multi Floor Planner project, make sure you use the Navigation   bar to change the 
view to Multi Floor Planner.

 

Navigation Bar
The Navigation bar lets you quickly open the functional views:

Note: The image   above shows the Navigation Bar for AirMagnet Survey PRO. (Some tools are disabled for AirMagnet Survey 
Express, which has fewer   features than AirMagnet Survey PRO. See the comparison chart below for more information.

Button Description
Multi Floor 
Planner

Simulate AP signal propagation for a building to determine optimal AP placement and configuration before 
deployment.

Survey Perform site surveys by collecting RF data on a WLAN site.        

Note: This     view is not available if the software is installed or operated     in Viewer mode.
Display View and analyze RF data collected during site surveys.
Simulation Conduct data simulation on signal coverage.
AirWISE Access advice about AP deployment based on the RF data collected     during site surveys.
Multi View Display and analyze RF data collected from sites with multiple     floors so that you can visualize the inter-

- 25 -



Quick Start Instructions

relationship among the     APs across the floors.
DiffView Open the project in multiple frames enabling you to compare     the results of two data files.
Reports Generate reports based on Planner and Survey project data.        

Note: This     function does not work until data are loaded.

Comparison of functions available in AirMagnet Survey PRO vs. AirMagnet   Survey Express.

View/Tools AirMagnet Survey PRO AirMagnet Survey Express
  Typical Viewer Typical Viewer
Survey yes no yes no
Display yes yes yes yes
Simulation yes yes yes yes
AirWISE yes yes no no
Multi View yes yes no no
Reports yes yes no* no
Tools yes no yes no
Calculator yes yes yes yes

*AirMagnet Survey Express has one report: ‘Overall Coverage   Report by Channel’.

Using Multiple Adapters
Note: Use of   multiple adapters is supported by AirMagnet Survey PRO only. AirMagnet   Survey Express can use only a single 
adapter at a time.

AirMagnet Survey supports up to two simultaneous adapters. If multiple supported wireless adapters are  connected at 
launch, you are prompted   to select the adapters to use for the survey process.

Note: In some cases,   you must have multiple adapters inserted to use the multi-adapter   functionality. See  https://www.net-
ally.com/wp-content/uploads/APA_FL_21_V2.pdf for more information about which adapters   are supported in multi-adapter 
mode. 

When operating in multi-adapter mode, Survey’s user interface adjusts   slightly on many screens to reflect the simultaneous 
use of multiple wireless   adapters.
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Each adapter has its own survey pane so that you can easily   track the devices and signal levels detected by each independent 
device.   You also get additional control over the adapters in Survey’s Scan configuration   (File > Configure > Scan), where   you 
can adjust each device manually to specify the channels to be scanned.

Note: When you select a survey type in either of the drop-down menus, the second   menu displays only the types supported 
with the first selection.

The table below shows the possible   surveys that you can conduct simultaneously using two adapters. 

  Passive Active VoFi iPerf
Passive X X X X
Active X X    
VoFi X      
iPerf X      

Note: Only one   adapter can be a non-preferred adapter when using multiple adapters. In   this case, the following options are 
available:
- A preferred adapter performing a Passive Survey and a non-preferred adapter   performing an Active Survey.
- A preferred adapter performing a Passive Survey and a non-preferred adapter   performing an iPerf Survey.

The illustration below shows the Survey Type drop-down menu for a Broadcom   802.11ac Network Adapter. 
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Conducting Indoor Site Surveys
AirMagnet Survey can be used for both pre- and post-installation WLAN   surveys to collect RF data on the site. The surveys can 
be performed without   having APs permanently installed in their locations. Also, there is no   need to adjust channels from the 
APs before a survey since AirMagnet Survey   allows you to do channel separation when analyzing the data in the Display   view, 
where you can change channel allocation once a suitable channel   combination is identified through channel simulation. This   
saves both time and resources that would otherwise be required for a conventional   site survey.

When opening a Survey project, make sure that the Survey project (.svp)   file is located on the laptop PC you use to conduct 
the site survey. Opening   projects remotely (that is, over a network connection) can create problems   when trying to save the 
data after conducting the survey if the network   connection is no longer available.

When performing a survey that may take a long time (for example, longer   than 10-15 minutes), NetAlly recommends that you 
break the survey up into   several smaller instances. This ensures that you do not lose all the   survey data should a problem 
arise with the computer. After the multiple   surveys have been completed, you can then merge the resulting data files   
together to create the same result as surveying the entire area at once.

This section discusses indoor site surveys, which typically are small-scale   surveys conducted inside an office complex or 
warehouse,   etc.

NOTE: With the correct adapter, you can detect and connect to APs operating in the 6 GHz band, but with this release you 
can configure APs only in the 2.4 and 5 GHz bands.

Conducting Indoor Site Surveys
AirMagnet Survey can be used for both pre- and post-installation WLAN   surveys to collect RF data on the site. The surveys can 
be performed without   having APs permanently installed in their locations. Also, there is no   need to adjust channels from the 
APs before a survey since AirMagnet Survey   allows you to do channel separation when analyzing the data in the Display   view, 
where you can change channel allocation once a suitable channel   combination is identified through channel simulation. This   
saves both time and resources that would otherwise be required for a conventional   site survey.

When opening a Survey project, make sure that the Survey project (.svp)   file is located on the laptop PC you use to conduct 
the site survey. Opening   projects remotely (that is, over a network connection) can create problems   when trying to save the 
data after conducting the survey if the network   connection is no longer available.

When performing a survey that may take a long time (for example, longer   than 10-15 minutes), NetAlly recommends that you 
break the survey up into   several smaller instances. This ensures that you do not lose all the   survey data should a problem 
arise with the computer. After the multiple   surveys have been completed, you can then merge the resulting data files   
together to create the same result as surveying the entire area at once.

This section discusses indoor site surveys, which typically are small-scale   surveys conducted inside an office complex or 
warehouse,   etc.

NOTE: With the correct adapter, you can detect and connect to APs operating in the 6 GHz band, but with this release you 
can configure APs only in the 2.4 and 5 GHz bands.

Choosing a Survey Mode
After you have created an AirMagnet Survey, choose the survey mode:

 1. In the Data Window, click the Survey    Type drop-down list.

 2. Select one of the following survey types:

 l Active Survey: (Default) The Wi-Fi card actively associates itself    with the selected AP or SSID to send and receive RF 
packets. 
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 o To perform the active    survey on an individual AP, select AP    from the drop-down list on the left and then choose a 
specific AP    from the drop-down list on the right. The Wi-Fi card associate only with that AP.

 o To perform a survey on an    entire network, select SSID    from the drop-down list on the left and then choose an SSID 
from the    drop-down list on the right. The Wi-Fi card associates with the AP that has the strongest RF signal    in the 
SSID group as you roam the site during the survey.

 o See Active   Survey Data Window for more information on the data window.

 l Passive Survey: The Wi-Fi card does not associate itself with    any particular AP or SSID. Instead, it simply listens to the RF 
data    moving through the site, detecting and recording all RF signals and    noises in the environment. 

 l Leave the SSID    field set to Any, or

 l Select a specific SSIDorAP from    the drop-down.

 l See Passive   Survey Data Window for more information on the data window.

 l Active iPerf Survey: This option enables AirMagnet Survey’s integration    with the open-source iPerf software. This works 
like a standard active    survey but with more initial configuration information to provide    additional transmission data. You 
can gather transmission data for    both uplink and downlink rates (as opposed to just the former). See Using    iPerf 
Integration for information on configuring and activating    iPerf integration.

Pre-Installation Site Surveys
A properly conducted predeployment survey can help ensure that the   ultimate network installation operates at peak 
efficiency, with a minimum   of extraneous or conflicting components. The process outlined below details   how to conduct a 
basic survey of the network environment before actually   installing any network components.

Note: The following   steps are intended to outline the basic required steps for a proper survey;   additional enhancements for 
improved results can be found later in this   documentation.

Pre-installation survey procedures consist of the following steps:

 1. Conduct a passive survey of the entire site to collect data regarding ambient traffic,    noise levels, frequency usage, floor-
to-ceiling height, height between each floor, and signal loss per foot between floors. (You can divide this survey step into 
several    shorter surveys, if necessary.) 

 2. Use AirMagnet Planner    to create a model of the new site, including anticipated layout, obstacles,    and so on.

Note: You must   have an AirMagnet Planner   license to model the network using AirMagnet Planner.   For steps on manually 
planning out the environment, see Manually Planning the Deployment. Note that a manually created plan can provide 
several advantages over   a Planner-assisted one, since it is based on real-world data. After creating   the manual plan, 
continue with these steps to complete the pre-installation   survey process.

 3. Use the Planner Advisor function to allow Planner to automatically    suggest optimal AP locations for the new site. See 
Generating a Multi Floor Planner Advisor Layout for more details.

 4. Use Survey’s Display view to analyze the Planner results (or the    results from the manual plan) to verify that the 
projections meet    the needs of the expected deployment.

 5. Set up the network as projected from the steps above.

Manually Planning the Deployment
Manually testing the new wireless site before deployment can take environmental   variables into account and therefore 
provides more detailed information.   The following survey is generally referred to as an AP-on-a-stick survey   because you use 
a single AP to determine the potential placement of several   APs.

To manually plan the wireless deployment:

 1. Go to the likely location where you may want to deploy an access    point (AP).

 2. Use a test AP to conduct as many active surveys as needed to ensure    that the AP’s intended coverage area is fully 
covered by the surveys.

Note: Since you   should save the survey data at the end of each survey, you may end up   having several active survey data files 
for the AP at one location.

 3. Move the AP to the other potential AP locations and conduct several    active surveys at each location in the same manner 
as described in    Step 2. Remember to save the survey data at the end of each survey.

 4. Conduct one passive survey using the same AP. 
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 5. Save the survey data.

 6. Switch AirMagnet Survey to the Display view. 

 7. Merge all the active and passive survey data files. For instructions    on how to merge data files, see Merging    Survey Data.

 8. Display the merged data by channel or by SSID. See Project    Window and Channel/SSID    List.

Note: For better   results, NetAlly recommends that you: 1) merge the active survey data files   collected at each location, 2) 
merge the merged active survey data   files from all locations, and 3) merge the passive survey data file with   the merged active 
survey data file (the active survey data from   all locations). This provides you with the most comprehensive RF data about   the 
AP and the site environment.

Post-Installation Site Surveys
Regular post-deployment surveys can help you ensure that you keep abreast   of changes in the wireless environment. Even 
when perfectly designed,   a pre-installation site plan cannot account for changes in the network’s   demands, unexpected 
interferers, along with a multitude of other dynamic   factors in a wireless coverage area. You must conduct “refresher” surveys   
at regular intervals to verify that the deployment continues   to meet enterprise requirements. 

Note: The following   steps are intended to outline the basic required steps for a proper survey;   additional enhancements for 
improved results can be found later in this   documentation.

Post-installation survey procedures contain the following steps:

 1. Conduct a passive survey of the entire deployed environment . (You can break this survey step  up into several shorter 
surveys, if necessary.) 

 2. Compare the results    to those generated during the planning stage of the predeployment    process described above.

 3. Make any required adjustments that were not accounted for in the    pre-installation portion to make the network meet 
user    and throughput requirements.

Note: This step is   necessary because some factors cannot be accounted for during   the planning process. For example, 
having people moving through the wireless   environment can cause interference that would not be there before install-
ation.

 4. Conduct an active survey to verify that there are no gaps    in the coverage area that were not discovered during the 
passive survey.    This process also allows you to verify that the real-world network    traffic (for example, PHY data rate, 
packet loss/retry, uplink/downlink    data) meets user requirements.

Note: Even though active surveys are more complex, they provide a   variety of additional benefits over passive surveys.   
See Choosing a Survey Mode   for more information.

 5. Repeat this procedure at least every three months to    keep up-to-date information about the wireless network on hand.

Tips for Improved Survey Accuracy
The following tips are intended as guidelines that can help enhance   the general survey procedures.

 l Focus on one frequency band at a time. Attempting a survey of more than band may  take less time, but it can cause gaps 
in the data.

 l Plan the survey path ahead of time to conduct the most complete    survey in minimal time. Planning and walking the path 
ahead of time    can help you identify obstacles, potential trouble spots, etc.

 l Be sure to survey from all areas of the network; do not assume    that coverage on one side of the APs is identical on the 
opposite.

 l Moving faster can result in insufficient data collected; however,    moving too slowly results in longer processing times due 
to an excess    of information.

 l Active surveys give a much more comprehensive perspective of “real-world”    performance, and as such are required for a 
complete survey process.

Conducting a Passive Survey
A passive survey offers a   quick and easy method to gather all available 802.11 information   in the wireless environment. You 
can view any traffic present,  whether it comes from a neighboring network or from ambient noise.   The steps below detail the 
basic process of conducting a passive survey.
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When you start a survey, the application begins collecting   data about the environment. Then you walk a systematic path 
through the areas for which you want to measure signal coverage. 

Note: The steps   below assume that the you have already created a survey project for the   desired site. NetAlly recommends 
that you create the Survey projects   ahead of time to make sure that the site map is accurate and of good resolution.

To conduct a passive survey:

 1. From in AirMagnet Survey, click       (Open Project) from the Toolbar.

 2. Locate and open the Survey project (.svp) file of interest. The    selected project file appears in the Project Window and the 
site map    displays in the Map Window.  

 3. If the project has more than one site map, select the map you want    to display in the Map Window.

 4. Click    (Media    Type) and select a media type (2.4 GHz, 5.0 GHz, or Both from the drop-down list.

 5. From the Data Window, click the Survey    Type drop-down list and select Passive.     

Note: For best   results, NetAlly recommends leaving the SSID field to Any while performing   a passive survey. This lets you 
collect comprehensive RF signal   data from the site environment.

 6. Click  (Start    Survey) and walk through a planned survey path that covers all areas you want to measure. clicking    as 
necessary to indicate each step in the survey. 
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 l Click a point when you start the survey and then each time. (By default,    AirMagnet Survey automatically spaces data 
points over time.)

 l Walk at a slow steady pace (slower than a normal walk) to gather    plenty of data.

 l Click on your position on the image map each time you change direction.

 l Click at identifiable landmarks (such as doorways) that indicate    your position on the image map.

 l Save your data from time-to-time as you travel along your survey path. 

 l An inactivity timer automatically pauses the survey   if you do not click in the system-specified time. You then receive a 
warning prompt and a count-  down timer before the survey is automatically paused.

Note: NetAlly recommends   that you walk at a slow steady pace (slower than a normal walk) to gather   as much data as 
possible.

 7. Click  (Stop Survey) once you have covered the survey area.

 8. Save the survey data when prompted.

For instructions on how to view and analyze   survey data, see .

Conducting an Active Survey
As explained previously, active surveys are more difficult to set up   and perform than passive surveys, but have the advantage 
of providing   real-world data for PHY Data Rate, packet loss/retry, and uplink/downlink   rates. Active surveys require some con-
figuration and initial setup before   collecting data, but they give the most accurate reflection of the network’s   performance for 
end-users.

To conduct an active survey:

 1. In AirMagnet Survey, click       (Open Project) on the Toolbar.

 2. Locate and open the Survey project (.svp) file you want. The    selected project file appears in the Project Window, and the 
site map    displays in the Map Window.  
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 3. If the project has more than one site map, select the map you want    to display in the Map Window (if it is not already 
opened).

 4. Click    (Media    Type) and select a media type from the drop-down list.

 5. From the Data Window, click    the Survey Type drop-down    list and select Active.  

 6. Use the first drop-down to select the frequency band (media type), either 2.4 GHz, 5.0 GHz, or Both.

 7. Use the first drop-down to select SSID    (to associate to a specific SSID) or AP    (to associate to a specific AP).

 8. Use the second drop-down to select the SSID    or AP to which the application    should associate.

 9. If the selected SSID or AP requires a specific authentication mechanism,    configure this information via the 802.11 tab 
from the File > Configure…    menu or Windows' Network and Internet Settings. See Configuring  802.11 Parameters for 
more information. If no authentication    is necessary, continue to Step 9.

 10. Click  (Start Survey)    and walk through the planned survey path, clicking as necessary to    indicate each step in the 
survey. 

 l Survey automatically spaces data points over time, so you only need to  click a point when you start the survey or 
when you change direction.

 l While conducting a survey, click   from time-to-time to save the data as you travel along your survey path. Otherwise, 
an inactivity timer automatically pauses the survey   if you don't click in the system-specified time. (You are prompted 
and a countdown timer appears before the automatic pause.)

Note: AirMagnet   recommends that you maintain a steady pace slower than a normal walk to gather as much data as 
possible.

 11. Click  (Stop    Survey) once enough data have been collected.

 12. Save the survey data when prompted.

For instructions on how to view and analyze   survey data, See Introduction to Data Analysis.
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Setting Roaming Properties

Use the  (Roaming   Option) button in the upper-right corner of the active survey   window to control the roaming capability 
of the wireless network adapter. You can define precisely when the adapter   roams, based on the properties that you 
configure in the Set Roaming Criteria   dialog box. See the figure below.

A list of adapters that support this feature may be found under the   "Supported Adapters" section of the AirMagnet website at: 
https://www.netally.com/wp-content/uploads/APA_FL_21_V2.pdf.   Locate the desired adapter, and then click FEATURE   
DETAILS. See the column labeled "Roaming Control for   Active Surveys."

Configure the Roaming Control (Signal) feature when using a USB wireless   network adapter to perform a site survey by SSID.

Note: To test roaming   during an active survey, set the Windows Wireless Profile to Automatically   Connect and the other 
profiles to Manually Connect. Otherwise, Windows   may activate the other profiles when the Roaming feature is enabled.

To set the roaming properties of a wireless   network adapter:

 1. From the Survey view, click . The    Set Roaming Criteria dialog    box appears.

 2. Select Trigger roaming to a new AP if signal on currently connect    AP drops below.

 3. Click the down arrows to select a value.

 4. Click OK.

The wireless network adapter starts roaming when any one of these values   is met. Configuring roaming based on signal 
strength causes your computer   to roam once it reaches a specific minimum signal strength.

Using iPerf Integration

AirMagnet Survey’s integration with the open-source iPerf software provides   you with a means of recording both upload and 
download transmit rates   during an active survey. Although this requires some additional configuration   when compared to 
active surveys, the ability to view both upload and download   speed information can be invaluable when analyzing the 
wireless network   environment.

During an iPerf survey, the laptop which is being used to conduct the   survey transmits custom iPerf data packets to a user-
configured iPerf   server. The server’s responses allow Survey to record the station’s download   speed from the current 
location.

To conduct an active iPerf survey, you must download and unzip   the iPerf server software on a separate device. AirMagnet's 
legacy iPerf   integration is designed to operate with iPerf Server version 1.7.0, 2.0.5,   and 2.0.9. You can locate iPerf software by 
means of internet search on   the term "epiphany". (See the For   iPerf3 section below for information about using Survey's new 
iPerf3   integration in v9.3.) 

Note: AirMagnet   recommends that you create an iPerf folder in the root directory to contain   the files (that is, C:\iPerf).

Starting the iPerf Server:

After the iPerf server software has been downloaded and extracted, you   must launch the application before starting an iPerf 
survey.

 1. Type ‘cmd’ in the Windows search field in the bottom Taskbar.

 2. Open the Windows command-line interface.
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 3. Navigate to the iPerf folder (e.g., C:\Iperf) using the CHDIR command    as needed.

 4. Type ‘iPerf -s’ and press    Enter. A message appears describing    the TCP port in use by the server.

Note: In the command   to start the iPerf server, the ‘-s’ parameter stands for ‘server’ and   the ‘-p 5001 part tells the server to 
listen on port 5001. By default,   AirMagnet Survey uses 5001 as the port for its transmissions during an   active iPerf survey. If 
the iPerf server port is changed, you must change   the port used by the Survey application as well.

To access iPerf configuration options, select   Active iPerf as the Survey type, and then select the Advanced   button to open 
the iPerf Config   dialog box. (See Choosing   a Survey Mode and Active Survey   Data Window.)

Note: Ensure that   the Client port set in the iPerf Config dialog is not blocked   by an AP/controller/firewall, etc. The default 
client port for the down   link is 9999.

Once the iPerf server status message appears, the system is actively   listening for iPerf transmission messages. The system is 
now ready for   conducting an active iPerf survey.

For iPerf 3

Beginning with Survey version 9.3, iPerf 3 is supported for performing an iPerf survey,   either via iPerf 3 server software 
installed on a PC or other machine,   or using NetAlly's Test Accessory.

 l To download and install iPerf 3 software, visit https://iperf.fr/.

 l Learn more about the Test Accessory from NetAlly.com/products/TestAccessory.    See the Test Accessory User Guide for 
instructions on adjusting the    Test Accessory's settings.

Note the following differences in functionality between iPerf 2 and iPerf 3:

 l While using iPerf 2, you    can run both upload and download throughput measurements    at the same time. While using iPerf 
3, you can run upload or download tests only. iPerf 3 does not support the option    to run both tests at the same time.                 

 l You have the option    to perform an iPerf 3 throughput survey against your own iPerf 3 server,    or you could use NetAlly’s 
Test Accessory (pocket sized iPerf server).    You cannot perform an iPerf 2 survey against the NetAlly    Test Accessory.                 

 l iPerf    3 surveys are only supported while using 802.11ac/ax adapters. You    still can use older Wi-Fi adapters while running 
an iPerf    2 survey.

 l For iPerf3 servers, the default port    number is 5201. iPerf3 clients use an ephemeral port.

Using an iPerf 3 Server

See the "iPerf user docs" page at https://iperf.fr/.

In the Active iPerf Survey Data   Window, select iPerf 3 in the   appropriate drop-down menu field.

Placing APs in the Survey
Active Survey for a specific AP:   When you Start an Active Survey for a specific AP (Click Start   Survey ), you are 
prompted   about whether you want to place the AP at its location on the floor plan.   If you choose Yes, an AP appears   on the 
floor plan, and you may drag it to its actual location.

Passive Survey: When you Start   a Passive Survey (Click Start Survey ), detected AP(s) are listed   in the Active Survey Data 
window. Before the first click, you can drag   a desired AP listing on to the floor plan to indicate its actual location.   You can do 
this one-at-a-time for as many APs as desired.

When you stop and save the survey, any APs on the floor plan get saved in the associated Survey Data Files (.svdx) that gets 
saved   in the project. This means that when you switch to Display view and open   a Data File, any APs saved in the data file are 
automatically placed   on the floor plan.

At this point, once a survey is stopped and saved, you can drag one   or more APs on to the floor plan, however; these new APs 
are in the   next survey (since the last survey was saved and closed) or, if you do   not conduct another survey, these APs are in 
the survey project but   not contained in a data file.

Deleting APs from the Survey Project

You can delete any APs from the survey project. From the Survey view,   right click the desired AP listing in the Project Window 
and select Delete. However, any data file created   (saved surveys) still contains the placed APs.
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Deleting APs from a Data File

If one or more APs were placed in the survey project and the survey   was saved, the APs appear in the data file in Display view 
(see Map Window). You can delete   a placed AP from the data file.

 1. Select the desired data file (.svdx) in Display view to show its    floor plan and heatmap in the Map window.

 2. In the Map window, right-click the desired AP and select Delete location information for this AP.    You are prompted to 
choose one of two options:   

 l Delete     from both the survey and project files: The AP location     is deleted from both this survey data file and also 
from this     opened survey project.

 l Delete     from survey file only: The AP location is deleted from     this survey data file only; it is kept in the survey 
project.

 

Merging Survey Data
As mentioned earlier, when performing a site survey on a large site,   you may want to break up the project into several small 
survey projects.   Each small project covers only a part of the site. You save the survey   data collected from each small area as a 
separate Survey (.svp) file.   When the whole survey project is completed, you end up having several   survey files, each covering 
a specific part of the site or network.  You   then have to merge the individual Survey files together to get a Survey   file 
containing data that cover the whole site. You then use this   consolidated (.svp) file to plan and enhance your wireless 
network.

NetAlly recommends the following steps when merging Survey data files:

 1. Merge all the active survey files collected at the same AP location.

 2. Merge the merged active files from all AP locations.

 3. Merge the merged active file from Step 2 with the passive survey    file(s).

Documenting Your Surveys and Analyses
You can document the results of your site surveys and data analysis   using AirMagnet Survey’s Copy   and Print functions.

Copying Your Data into Other Applications

You can copy your survey data and the results of your analysand (displayed   in the Map Window) into any software application 
that supports the copy-and-paste   function. The copied data contains whatever information displayed   in the Map Window, 
including the site map, AP locations, survey paths,   and the graph (if in Display screen). This is a great way to share your   
survey data.

To copy data to another application:

 1. Display the data you want to show on the site map.

 2. Click Edit > Copy Heatmap Image.
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 3. Open a file in a software application that supports copy-and-paste    and paste it into the document. The following figure 
shows survey    data copied and pasted into a Microsoft Outlook document.

 

Printing Your AirMagnet Survey Data

You can print your survey data using AirMagnet Survey’s printing capability.   The data you print can be raw data collected 
from site surveys or the   results of your data analysis, simulation, or filtering. This can be an   effective way to document your 
site surveys and WLAN infrastructure, as   well as an easy way to share your work.

To print your survey data:

 1. Display   the file in the Map Window.

 2. Click   File > Print Preview. A  Print Preview window appears. 
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 3. If   you are satisfied with what you see in the Preview window,   click Print. The Print dialog   box appears.

 4. Choose your desired print options, and then click OK.

Sharing a Survey Project
You can share an AirMagnet Survey project with other users who have   AirMagnet Survey or AirMagnet Viewer installed on their 
computer along   with a valid license. (For viewer restrictions, see Survey   Viewer License.)

To share your project with another user:

 1. Locate the survey project folder (the folder created when you    set up your new project). The folder name matches the 
project name you    gave your project. The default location is in the My Documents folder.

 2. Compress the folder using a compression application (for example,    ZIP) and send it to the recipient.

The recipient of the compressed file can do the following to open the   shared AirMagnet Survey project:

 1. Decompress the folder.

 2. Launch AirMagnet Survey.

 3. Select File > Open and    browse to the .svp file contained in the decompressed folder.

Creating a GPS-Aided Survey Project Using an Existing Site 
Map
This section explains the procedures for creating GPS-aided Survey projects.   GPS-aided site surveys usually cover large 
outdoor areas. Like creating   an indoor Survey project, creating an outdoor GPS-aided Survey project   also involves importing 
a site map which is done in the same way as you   do when creating an indoor Survey project.
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NOTE: With the correct adapter, you can detect and connect to APs operating in the 6 GHz band, but with this release you 
can configure APs only in the 2.4 and 5 GHz bands.

To create a new site map using Bing Maps or Google Maps:

 1. Open Bing Maps or Google Maps in a web browser, and enter a location    for your outdoor Survey, zooming in appro-
priately.

 2. Use a screenshot application (like Windows Snipping Tool) to create    a .png or .jpg of the area.

 3. Open AirMagnet Survey.

 4. Create a new GPS Survey project (see details below).

 5. To view GPS coordinates (for later entry into the New    Project Wizard dialog box GPS    Coordination):

 l In Bing Maps, right click at the     desired map location. 

 l In Google Maps, left click at the     desire map location. A pop-up displays the GPS coordinates of     the spot where you 
clicked.

To create an outdoor Survey project using an existing site map:

 1. Start AirMagnet Survey and click File >    New Project.... The New Project Wizard view appears.  

 2. Specify the name of the new project.

 3. Select GPS Project.

 4. Type the directory path or browse to the location where you want    to store the project file.

 5. Click Next.  

Note: The following       steps assume you want to import a site map (image file) from your local      computer.

 6. Click the Import Outdoor Street/Campus    Map (GPS) Image radio button. The "Select Type" drop-down    appears, which 
lets you browse for a map. 
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 7. To import a site map from the local computer, click Browse    and then open the desired image. 

 8. If you know the values of GPS coordinates, enter them now. (You    can also use the calibration tool  to calibrate    the 
data later. For more information about GPS calibration, see Performing    a GPS-Aided Site Survey.)

 9. Click Next. The New Project    Wizard view refreshes.  

 10. For Survey Environment,    check the outdoor option that best matches the environment to be surveyed.

 11. For Signal Propagation Assessment,    do nothing (normally), since AirMagnet Survey can automatically assign    the value 
according to the survey environment you have selected.
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Note: AirMagnet   Survey assigns the Signal Propagation Assessment value based on the estimate   of the distance RF 
signals could travel in each of those typical survey   environments as shown in the figure above. Normally, NetAlly 
recommends   that you accept the default value the program assigns. (You can set a value of your own, but note that the 
value you   specify affect the way the program interpolates survey data.

 12. For AP Default Power, do    nothing (normally).

Note: If you know   the value of AP power, enter it now. (It is used for   data simulation.)

 13. Click Next. The New Project    Wizard view refreshes.

 14. Enter a short description of the project in the space, and then    click Finish. The newly created    Survey project auto-
matically opens on the Display view with the site    map in the Map Window.

Creating a GPS-Aided Survey Project Using an Existing Site Map
This section explains the procedures for creating GPS-aided Survey projects.   GPS-aided site surveys usually cover large 
outdoor areas. Like creating   an indoor Survey project, creating an outdoor GPS-aided Survey project   also involves importing 
a site map which is done in the same way as you   do when creating an indoor Survey project.

NOTE: With the correct adapter, you can detect and connect to APs operating in the 6 GHz band, but with this release you 
can configure APs only in the 2.4 and 5 GHz bands.

To create a new site map using Bing Maps or Google Maps:

 1. Open Bing Maps or Google Maps in a web browser, and enter a location    for your outdoor Survey, zooming in appro-
priately.

 2. Use a screenshot application (like Windows Snipping Tool) to create    a .png or .jpg of the area.

 3. Open AirMagnet Survey.

 4. Create a new GPS Survey project (see details below).

 5. To view GPS coordinates (for later entry into the New    Project Wizard dialog box GPS    Coordination):

 l In Bing Maps, right click at the     desired map location. 

 l In Google Maps, left click at the     desire map location. A pop-up displays the GPS coordinates of     the spot where you 
clicked.

To create an outdoor Survey project using an existing site map:

 1. Start AirMagnet Survey and click File >    New Project.... The New Project Wizard view appears.  
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 2. Specify the name of the new project.

 3. Select GPS Project.

 4. Type the directory path or browse to the location where you want    to store the project file.

 5. Click Next.  

Note: The following       steps assume you want to import a site map (image file) from your local      computer.

 6. Click the Import Outdoor Street/Campus    Map (GPS) Image radio button. The "Select Type" drop-down    appears, which 
lets you browse for a map. 

 7. To import a site map from the local computer, click Browse    and then open the desired image. 

 8. If you know the values of GPS coordinates, enter them now. (You    can also use the calibration tool  to calibrate    the 
data later. For more information about GPS calibration, see Performing    a GPS-Aided Site Survey.)

 9. Click Next. The New Project    Wizard view refreshes.  
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 10. For Survey Environment,    check the outdoor option that best matches the environment to be surveyed.

 11. For Signal Propagation Assessment,    do nothing (normally), since AirMagnet Survey can automatically assign    the value 
according to the survey environment you have selected.

Note: AirMagnet   Survey assigns the Signal Propagation Assessment value based on the estimate   of the distance RF 
signals could travel in each of those typical survey   environments as shown in the figure above. Normally, NetAlly 
recommends   that you accept the default value the program assigns. (You can set a value of your own, but note that the 
value you   specify affect the way the program interpolates survey data.

 12. For AP Default Power, do    nothing (normally).

Note: If you know   the value of AP power, enter it now. (It is used for   data simulation.)

 13. Click Next. The New Project    Wizard view refreshes.

 14. Enter a short description of the project in the space, and then    click Finish. The newly created    Survey project auto-
matically opens on the Display view with the site    map in the Map Window.

Configuring GPS COM Port
After you create the GPS-aided Survey project, the next step is to configure   Survey’s GPS COM port to communicate with the 
GPS device to   which it is connected.

To configure Survey’s GPS COM port:

 1. From your desktop, open the Device    Manager. (You can search for it using the Windows search field    in the bottom 
Taskbar.) 

Note: Accessing   the Windows Device Manger procedure may differ somewhat depending on the   Windows operating 
system. See Windows   Help > Device Manager.
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 2. Click Ports (COM & LPT).

 3. Write down the COM port number listed after the device’s name.

 4. Close Device Manager.

 5. From AirMagnet Survey’s Survey or Display view, click File > Configure....    The Survey Configuration dialog box appears at 
the default Settings    tab.

 6. Check Enable GPS Port and    click Configure GPS.... The    GPS COM Configuration dialog box appears.
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 7. Under Connect to, select    the COM port identical to the one you found in Step 2.

 8. Under Flow Control, select    None, and click OK.

 9. Click OK to close the Survey Configuration dialog box.

Note:   A USB to Com port software may be needed when connecting a GPS device   via a USB port rather than a Com port. 
This software is often provided   by the GPS device manufacturer.

Verifying GPS Device Connection
To verify the connection to a GPS device:

 1. From the Navigation Bar, click Tools > GPS    Information. Survey’s Tools    dialog box appears.

Note: The view   should be populated with valid GPS information if Survey is successfully   connected to the GPS device. 
Otherwise, check the connection between Survey and the GPS device. No data can be collected if communication has 
failed.

 2. Close the Survey Configuration    dialog box.
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Performing a GPS-Aided Site Survey
After you establish the communication between AirMagnet Survey and the GPS device, you can start performing the GPS-
aided site survey.

Note: To find coordinates   without using GPS, you can open Bing or Google Maps in a web browser.   In Bing Maps, right click at 
the desired map location. In Google Maps,   left click at the desire map location. A pop-up window displays the   GPS 
coordinates of the spot where you clicked.

To calibrate the GPS Coordinates:

If you created the GPS survey project using a site map, you must first   calibrate the GPS as described in the following steps. 
Otherwise skip   to "Starting GPS Survey."

 1. Open a GPS-aided survey project that you have created.

 2. From the GPS map, determine the two locations where GPS coordinates    are to be taken.

Note: To ensure   the accuracy of your GPS survey, it is highly recommended that you select   two points with different GPS 
coordinates on the map. They should be in   the north and west directions and be set far apart from each other.

 3. From the Toolbar, select  (Calibrate GPS), and then click the first    spot on the GPS map. AirMagnet Survey starts to 
recalibrate the GPS    information.

 4. Click OK to close the view.

 5. Move to the second location and click the corresponding point    in the map. Survey recalibrates the GPS coordinates for 
this location.
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 6. Click OK to close the view.    A dialog box appears asking if you wish to start the survey.

 7. Click Yes or go to "Starting    the GPS Survey" to do so manually.

To Start the GPS Survey:

 1. From the Toolbar, click       (Start Survey) and start to    move along the survey path.

 2. Click       (Stop Survey) when enough    data have been collected.

 3. Save the project.

Note: You can repeat   the same procedures to conduct as many GPS surveys as needed. The figure   below shows a sample 
GPS survey view.
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Exporting GPS-Aided Site Survey Data to Google Earth
You can export your survey data collected during a GPS-aided site survey   to Google Earth so that you can view the data on a 
larger scale.

Note: You must   be working from the Display view to export data to Google Earth.

To export into Google Earth:

 1. Download and install Google Earth software (if not already done)    from https://earth.-
google.com/intl/earth/download/ge/agree.html.

 2. Open the GPS project in the Display    view, click File > Export to Google    Earth.

 3. The Google Earth view opens, displaying your survey data superimposed    over the map.
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Conducting VoFi Surveys
VoFi surveys can help you troubleshoot problems in a VoFi deployment by providing details about active calls such as WiMOS, 
roaming   frequency, and signal strength. A VoFi survey is a critical part   of planning any voice-over-WLAN deployment because 
you get a   comprehensive view of the wireless environment from the perspective of   a VoFi phone. A VoFi survey helps you 
identify any problems   or wireless hazards before the network is fully operational when such problems are much easier to fix.   
Taking time to properly survey and troubleshoot the predeployment environment   can greatly improve the resulting install-
ation.

VoFi surveys gather data from an active connection between a wireless   AP and a VoFi phone. Before starting the survey, you 
must establish a   call between two phones. (One must be a VoFi phone; the other may be VoFi   or wired phone, but it must 
remain stationary during the survey.) Once   Survey detects the call, you can start collecting the survey data. 

Notes: 

 l To verify   that an existing wireless deployment is VoFi-ready, follow the instructions   provided with the Verifying VoFi 
Network Compliance.

 l VoFi surveys   require that you carry an actively connected VoFi phone along with the   laptop during the survey process.  For 
best results, attach the phone   to the laptop in an upright position (to best mimic the position of the   phone during an 
actual call). Before starting a VoFi survey, you should   note down the MAC address of the phone being used, as the phone 
must be   selected from a list of active calls once the survey has started.

 l Not supported for the 6 GHz band.

To conduct a VoFi survey:

 1. Create a new survey project (click    here for instructions).

 2. Configure Survey's VoFi    phone book.

 3. In Survey's configuration window, click the Scan    tab and specify the channels on which the VoFi APs operate. This step    
helps the application quickly re-detect the phone during instances    of roaming.

 4. From the Survey view, click the Survey    Type drop-down list, and then select VoFi    Phone Survey.

 5. Start a call with the VoFi phone and click     (Start Survey).     The VoFi Call List dialog    box appears.

 6. Select the phone's MAC address from the call list.

 7. Click Begin Survey.

 8. Click regularly along the survey path to collect data, just as    you would when performing a standard data survey. A pop-up 
status window    appears whenever the phone roams.

 9. Once the survey is completed, click  (Stop    Survey). 

 10. Save the data.

Note: After completing   a VoFi survey, you can view the resulting picture of the wireless environment.    See Analyzing   VoFi 
Survey Data for additional details.

Conducting VoFi Surveys
VoFi surveys can help you troubleshoot problems in a VoFi deployment by providing details about active calls such as WiMOS, 
roaming   frequency, and signal strength. A VoFi survey is a critical part   of planning any voice-over-WLAN deployment because 
you get a   comprehensive view of the wireless environment from the perspective of   a VoFi phone. A VoFi survey helps you 
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identify any problems   or wireless hazards before the network is fully operational when such problems are much easier to fix.   
Taking time to properly survey and troubleshoot the predeployment environment   can greatly improve the resulting install-
ation.

VoFi surveys gather data from an active connection between a wireless   AP and a VoFi phone. Before starting the survey, you 
must establish a   call between two phones. (One must be a VoFi phone; the other may be VoFi   or wired phone, but it must 
remain stationary during the survey.) Once   Survey detects the call, you can start collecting the survey data. 

Notes: 

 l To verify   that an existing wireless deployment is VoFi-ready, follow the instructions   provided with the Verifying VoFi 
Network Compliance.

 l VoFi surveys   require that you carry an actively connected VoFi phone along with the   laptop during the survey process.  For 
best results, attach the phone   to the laptop in an upright position (to best mimic the position of the   phone during an 
actual call). Before starting a VoFi survey, you should   note down the MAC address of the phone being used, as the phone 
must be   selected from a list of active calls once the survey has started.

 l Not supported for the 6 GHz band.

To conduct a VoFi survey:

 1. Create a new survey project (click    here for instructions).

 2. Configure Survey's VoFi    phone book.

 3. In Survey's configuration window, click the Scan    tab and specify the channels on which the VoFi APs operate. This step    
helps the application quickly re-detect the phone during instances    of roaming.

 4. From the Survey view, click the Survey    Type drop-down list, and then select VoFi    Phone Survey.

 5. Start a call with the VoFi phone and click     (Start Survey).     The VoFi Call List dialog    box appears.

 6. Select the phone's MAC address from the call list.

 7. Click Begin Survey.

 8. Click regularly along the survey path to collect data, just as    you would when performing a standard data survey. A pop-up 
status window    appears whenever the phone roams.

 9. Once the survey is completed, click  (Stop    Survey). 

 10. Save the data.

Note: After completing   a VoFi survey, you can view the resulting picture of the wireless environment.    See Analyzing   VoFi 
Survey Data for additional details.

Configuring a VoFi Phone Book
Note: The VoFi   phone book must be configured before attempting to conduct a VoFi survey.

Due to the differences between individual VoFi phones, you must provide   some configuration information to ensure that 
Survey can properly   interpret the data received from VoFi surveys. This process consists of   you creating VoFi phone profiles in 
Survey’s phone book that correspond   to the types of phones in use (or expected to be in use) on the VoFi deployment.   The 
following sections provide you with a guide through this process.

To access the VoFi Phonebook:

 1. Navigate to the Survey or Display view.

 2. Click File > Phonebook….    The Phonebook window appears.
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Note: The phone   book configuration process consists of two steps: create   a VoFi phone profile and add   the VoFi phones 
to the Phonebook. Click the links for   more details.

Creating VoFi Phone Profiles
Phone profiles contain the required configuration information specific   to individual types of phones. Phones provided by 
different vendors (or   even different phone models from a single vendor) can have drastically   different configurations. If you 
do not create profiles in Survey   that correspond to the phone types in use, you may not get optimal   results from VoFi surveys.

To create a VoFi profile:

 1. From the Phonebook window, click Profiles….    The VoFi Profiles window appears.

 2. Click Add… to open the    Create Profile dialog box.

 3. Enter a name for the profile (NetAlly recommends that this name    match the vendor and model number of the phone).

 4. Fill in the remaining fields as required by the phone. See the    table below for additional details.

Field Description
Codec Type A codec refers to an algorithm or specialized computer program     that encodes or reduces the number 

of bytes consumed by large     files and programs. Files encoded with a specific codec require     the same 
codec for decoding.  See the VoFi phone’s user     manual to determine the codec it uses.

Voice Frame 
Duration

In contrast to most wireless transactions, VoFi data is normally     transmitted in steady fixed-size 
packets.  The voice frame     duration refers to the time (in milliseconds) that should be allocated     for 
each frame.  This value should be available from the     VoFi phone vendor’s website or documentation.

Jitter Buffer The jitter buffer refers to the amount of memory allocated     to buffering voice data to account for 
“jitter”, or packet delays,     in the VoFi exchange.  Since seemingly small amounts of delay     in a con-
versation can result in drastically reduced call quality,     the phones include a built-in buffer to help 
smooth out portions     of the call that experience unusually high jitter levels.  The     phone’s specified 
jitter buffer value should be provided in its     documentation or website.

 5. Click OK to save the new    profile.

 6. Repeat Steps 1 through 5 for each type of phone in use on the VoFi    deployment. 

 7. When finished, click OK    to close the VoFi Profiles window.
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Note: Entering   incorrect values for a VoFi phone profile can result in Survey being   unable to detect calls made from phones 
associated with the profile.

Once all necessary profiles are implemented, you can add phones to their corresponding profiles, as described here.

Adding Phones to VoFi Profiles
After creating a VoFi phone profile, you must enter the VoFi phones   in use in the deployment into Survey’s VoFi phone book 
and match each   device with the appropriate phone profile. This step ensures that VoFi   Survey is able to detect the call.

To add phones to the phone book:

 1. From the Phonebook window, click Add….    The New Phonebook Entry dialog box appears.

 2. Enter the phone’s MAC address in standard MAC notation (for example,    aa:bb:cc:dd:ee:ff, including colons).

Note: If you have   already conducted a passive survey of the wireless environment, the MAC   Address drop-down list may 
already contain the phone’s MAC address information.   In this case, use the drop-down to select the desired phone.

 3. Use the Profile Name drop-down list to select the desired profile    and click OK to save the changes.

 4. Repeat steps 1 through 3 for all phones necessary.

About Survey View
The Survey view is used for conducting WLAN site surveys that collect RF data in the airwave over the site. To open the Survey 

view from another view, simply click    on the Navigation Bar.

Note: The Survey   view is NOT available for AirMagnet Survey that is installed or operated   for display only.

To learn more about the interface options for the Survey View, see:

SURVEY VIEW: MENUS, BUTTONS, AND WINDOWS
Modifying Project Properties
File menu
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SURVEY VIEW: MENUS, BUTTONS, AND WINDOWS
Edit menu: This menu has only one option, Copy Heatmap Image (Ctrl+C). Selecting this option copies the heatmap 
displayed in the map window to the clipboard as a .png file.
View menu
Toolbar
Project window

 l Right-click Pop-up Menu
Data Window  

 l Media Type Button 

 l  Active Survey Data Window 

 l  Passive Survey Data Window
Map window

 l Heatmap Legend

Modifying Project Properties
You can use the Survey view to change the properties that you specified when you created a project. For example, the 
dimensions of the site may need correction, new infrastructure may have been installed, or a site map may appear   to be 
stretched.

To adjust project properties:

 1. Right-click the map window and select Project    Properties…. (Alternatively, click View > Project    Properties… from the 
menu bar.) The Project Properties window    appears.

 2. Make any adjustments required, as described in the following Project    Properties table.

 3. Click OK to save the changes.
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Field Description
Dimensions Alter the width and length of the map as desired. Note that     since the units of measurement are 

locked in during project creation,     the Units field is grayed out.
Environment This field allows you to change the environment type,     that is, from Open Space Office to Commercial.
Signal Propagation 
Assessment

Adjusts the signal propagation assessment. The default value     depends on the Environment selected 
when creating the project.

AP Default Power Adjusts the default power setting for APs placed on the project.
Description Click this button to enter a description for the project.
Margins Allows you to adjust the spacing padded around the site     map.
Mapping Adjusts the scale of the image; this setting can also be modified     by using the Measure Mode tool. See 

The     Toolbar for more details.
Project Path Directory location for the open project.

Survey File Menu Options
The table below shows the options of the File menu on the Survey view.

For keyboard shortcuts: Alt+F   activates the menu. The activation letter (if any) is underlined. Any   Ctrl+ option is noted as 
well.

Option Description
 New Project... Opens the New Project Wizard window so you can create a     new Survey project (same as 

Ctrl+N) .

 Open... Opens an existing Survey project (same as     (Ctrl+O).

 Save Saves changes made to the current project (same Ctrl+S).

Save Project As... Saves the current project under a different name.
Close Project Close the current Survey project file.

 Configure... Opens the Survey Configuration dialog box.

Phonebook Used for managing VoFi profiles. See Configuring     a VoFi Phone Book.
Print... Opens the Print dialog box (same as Ctrl+P).
Print Preview Displays a preview of what will be printed.
Print Setup... Opens the Print Setup dialog box where you can select paper     options.
Recent Projects Lists the most recently opened Survey project files.
Multi Floor Planner Launches Multi Floor Planner. See Multi Floor Planner Introduction.
Exit Exits AirMagnet Survey.

Survey View Menu Options
The figure below shows the View menu options on the Survey view.

For keyboard shortcuts: Alt+F   activates the menu. The activation letter (if any) is underlined. Any   Ctrl+ option is noted as 
well.

Option Description
 Zoom In Enlarges the view of the current floor plan  (same as Ctrl+Page up).

 Zoom Out Reduces the view of current floor plan  (same as Ctrl+Page Down).

 Zoom to Fit Fits the current floor map to the map window. 

 Zoom to Actual 

Size

Fits the current floor map to its actual print scale. 

Set Zoom... Opens the Set Zoom dialog box where you can specify the specific     ratio at which the view of the map 
can be increased.

Show CAD Layers... Opens a dialog to select CAD layers to view on the map. (Available for CAD-based floor plans only.)
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Toolbars and 
Docking Windows

Choose to show or hide the Legend and Status Bar (show is checked).     Reset Toolbar: Dragging the 
Toolbar handles undocks the Toolbar. Clicking     this option reset the Toolbar to its default setting.

Show Rulers Shows or hides rulers along the edge of the     map window.
Show Grids Shows or hides grids in the map window.
Invert Legend Colors Flips the legend color scheme vertically (same as F10).
Project Properties... Opens the Project Properties window where you can adjust the     physical properties of the floor map 

of the survey site.
AP/Path Name Font... Opens the Font window where you can modify the font properties     of APs and survey paths on the 

floor map.

Toolbar
The table below shows  toolbar icons for  the Survey view. The icons link to frequently   used tools, some of which are also 
found in the File   and View menus.

Icon Name Description
Project 
Wizard

Opens the New Project Wizard where you can create a new Survey     project. See  File     
menu.

Open Project Opens an existing Survey (.svp) file. See File     menu.

Save Saves changes made to the current project. (Ctrl+S)

Configuration Opens Survey Configuration window. See File     menu.

GPS or 
Manual Mode

Allows you to switch between GPS-aided survey or regular survey.        

Note: This     option is available only in Survey PRO with GPS-aided Survey projects.
Measure 
Mode

Re-calibrates site dimensions of a floor plan.

Start Survey Starts the survey.

Stop Survey Ends the current survey.

Pause Stops the survey momentarily until you click to resume data     collection.

Retract Functions as an “Undo” command, reversing the most recent data     point at each click 
of the button. Clicking this button repeatedly     keeps erasing the survey path 
backwards. To resume the survey,     click a new data point on the site map.    

Note: If     the survey retract button is grayed out (unavailable), it probably     means "Auto 
Position APs with signal greater than __ dBm"     is enabled. See How     to Locate an AP.

Refresh Updates the display with the latest data.

Zoom In Enlarges the view of the site map.

Zoom Out Reduces the view of the site map.

Zoom Fit Fits the site map to the Map Window.

Zoom Actual 
Size

Fits the current floor map to its actual print scale.

Survey Zoom Expands the Map Window to the entire window. To restore the default     view, click the 
button again.

Measure 
Mode

Turns on Measure Mode, which lets you measure the distance between any     two points 
on the site map. You can also choose to recalibrate the site dimensions based on the 
measurement.

Toggles 
Outline

Enables you to view an outline of where a heatmap transitions     from one legend value 
to the next value.
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Overlap Show or hide areas of coverage overlap for a selected AP in the Map Window. 

View Overall 
or Per 
Channel

Click to select between an overall view or a per-channel view of an AP.

Tools Opens the Signal and DHCP tools.

Calculators Click to open a dialog with various calculators. See Calculating WLAN Parameters 
Introduction for more information.

Survey Project Window
The Project Window displays all the components of the current Survey   project opened on the Survey view, as shown in the 
figure below.

A Data File items are as follows from the top:

 l Project file name.

 l Floor plan image file name used in the project.

 l Survey paths (surveys conducted) listed from first to last for    this project.

 l Any APs and/or STA (stations) placed on the floor plan.

 

Right-click Pop-up Menu

The Project Window on the Survey view and Display view also includes   a right-click menu. Some options are available in 
Survey view and others   in Display view. Unavailable options are grayed out.

Right-click a survey data file to view the right-click menu options.
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Menu Option Description
Close Close this data file
Delete Deletes the selected (right-clicked) item.
Rename Rename this data file
Data Merge... Allows you to merge two or more data files.    

Note: This     option is available on Display view only.
View Merged Source 
...

Shows the sources from which a merged data file was created.

View Survey prop-
erties ...

Opens a window that displays information about the file.

View Survey properties

From the Project Window, right-click a survey data file (.svdx), and   then select View Survey properties   from the pop-up 
menu. The Survey properties dialog opens, as illustrated   below. 

Note: This option   replaces "View Raw Data" in Survey version 8.8 and higher.

The Survey properties dialog provides information about the selected   survey data file.
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View Survey Database

The Survey properties includes an option to view in-depth, database   details included in the selected survey data file.

To view the database, you need a database viewer application such   as DB Browser for SQLite, downloadable  at: http://sql-
itebrowser.org/

Click View Survey Database.   You may be prompted by Windows to associate the database with the desired   database viewer 
application.

Right-Click to Show CAD Layers...

From the Project Window, right-click a CAD image file, and select Show CAD Layers... 

The Drawing Layers... dialog opens, as shown below. 

 

Data Window
The Data Window displays real-time RF data as they are captured while   a survey is in progress. Data start to appear in this 

window once you   click  (Start   Survey) on the Toolbar. The contents displayed in the Data Window   vary, depending on the 
survey mode (active   vs. passive) you select.

For information on active and passive surveys, See Active   Survey Data Window and Passive   Survey Data Window.

Media Type Button

NOTE: Because certain   non-preferred adapters automatically scan multiple bands, the Media Type button   does not display 
when such an adapter is being used.
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NetAlly   highly recommends that you select a media type before you start on a site   survey. This allows you to focus on APs 
using a specific type of   media during the survey.

The  (Media Type)   drop-down is located in the Data window of the Survey view. Click this   button to display a drop-
down menu of 802.11 media types that determine   the type of data to be collected and displayed by the wireless network 
card. It offers the following   options:

 l 2.4 GHz: Scans data from APs in the 2.4 GHz band only (generally, 802.11b/g/n/ax    media types).

 l 5.0 GHz: Scans data from APs in the 5.0 GHz band only (generally, 802.11a/n/ac/ax    media types).

 l 2.4/5.0 GHz: Scans data from both bands.

Active Survey Data Window

The figure below shows the Data Window when AirMagnet Survey is set   in active survey mode using an adapter that supports 
both the 2.4 GHz and 5 GHz bands. 

Option Description
Adapter The adapter used for the survey is noted at the top of the     window.
Survey Type Options are Active, Passive and Active iPerf.
Media Type Options are 2.4 GHz, 5.0 GHz, or Both.
SSID/AP Choose from the drop-down menu to select a specific AP or SSID during     the active survey. 
Roaming Allows you to set the roaming criteria for the survey. See Setting Roaming Properties.

BSSID The name and MAC address of the AP being associated with.
SSID The name of the network to which the associated AP belongs.
Speed The rate (in terms of Mbps) at which packets are transmitted.
Channel The radio channel the AP uses to send and receive RF signals,     including the primary and secondary 

channels, channel bandwidth     and the channel span.
Signal The signal strength for the received packets. The higher the     value, the stronger the signal.
Noise The level of background radio frequency energy in the bands being scanned (2.4 GHz, 5 GHz) band. 

The lower the value, the less the noise.
S/N The Signal/Noise ratio. Compares the Signal data to the amount     of ambient Noise.
Frame Size The size of the frame transmitted in terms of bytes.
Delay The time (in microseconds) between successive transmissions.
Bytes/s The number of bytes (of data) transmitted per second.
Frames/s The number of packets (of data) transmitted per second.
Lost The percentage and number of packets that were not transmitted     successfully from the AP.
Retry The percentage and number of packets that were not transmitted     successfully from the AP.
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Passive Survey Data Window

The figure below shows the Data Window during a survey when set in Passive   Survey mode using an adapter that supports 
both the 2.4 GHz and 5 GHz bands. 

Note: During a   passive survey, if an AP is detected with a Hidden SSID, the AP name shown   in the MAC Address column on the 
Survey page displays in red,   instead of the usual black to distinguish it from the broadcasting SSID APs.

Option Description
Adapter The adapter used for the survey is noted at the top of the     window.
Survey Type Options are Active, Passive and Active iPerf.
Media Type Options are 2.4 GHz, 5.0 GHz, or Both.
SSID/AP Detects devices by AP or SSID during the survey.     A drop-down lets you choose a specific     device 

to survey or choose ANY to capture data for     all detected devices (SSID or AP).
Channel Captures the RF channel each AP is using. The Channel column displays the primary and 

secondary     channels, channel bandwidth, and the channel span.
MAC Address The MAC addresses of each AP. It can display either "Best     Name" or MAC address. Right-click the 

window to change the     display type.
Signal Strength The signal strength of all received packets from the AP.

Noise Level The level of background RF energy in the 2.4 GHz or 5 GHz band.     The Lower the value, the less 
noise detected.

Signal/Noise Ratio The signal strength compared to the noise level. A higher S/N     ratio usually means better network 
performance, as there is less     noise impacting the signal.

SSID The name of the network to which an AP belongs.
Current AP Count The total number of APs currently detected.

Before beginning a passive survey, you may drag-and-drop APs from the   Data Window onto the Map Window floor plan. Once 
the survey begins, this   option is not available; however, after concluding the survey, this option   becomes available in the 
Display View. See Channel/SSID   List.

Map Window
The figure below shows the Map Window on the Survey view for a 2.4 GHz and 5 GHz survey, with a site   map displayed. 
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By default, a site map automatically opens in the Map Window when you   open a Survey project. As soon as a survey is 
started, information such   as AP locations, survey paths, data collection points, and so on. start   to appear on the map. Before 
starting a site survey, make sure that the project and site map match the survey location.

NOTE: You can toggle display of the site map by selecting or deselecting the checkbox in the Project Window. 

Legend

The right-hand side of the Display view shows the Legend which provides   a variety of ways for displaying and analyzing 
survey data using different   color schemes and patterns.

Note: The colors   gray and white may appear in a heatmap and not be indicated on the legend.   White may indicate no 
coverage. Gray may indicate that a coverage requirement   is not met.

 l At the top of the Legend is the Data   Type (including its unit of measure). It indicates   the type of data 
displayed. It is identical to what is selected from the Data   Type list menu on top the Map Window.

 l Drag up   from the bottom of the Legend or down from the top of the Legend to set the upper or lower limit 
of RF data (signal, noise,   interference, and so on) shown in the Map Window.

 l You can also adjust the color scheme. See Configuring   Legend Color Schemes.
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Introduction
Multi Floor Planner (MFP) allows you to simulate AP signal propagation for a building before deployment to determine 
optimal AP placement and configuration, plus view signal propagation that occurs between floors in a multi-floor building.  
With MFP, you   can: 

 l Create a building projects that consists    of multiple floors.

 l Create floor plans for each floor in the building. 

 l Determine the best location and configuration for APs on each floor.

 l View predictive heatmap visualizations of how APs on one floor may    affect signal strength coverage to other floors or 
create    channel interference.

NOTE: Wi-Fi 6E APs are not supported on the 6 GHz band for Multi Floor Planner. The media type naming in AP Properties 
uses the industry standard terms of Wi-Fi 4 (for 802.11n), Wi-Fi 5 (for 802.11ac), and Wi-Fi 6 (for 802.11ax, as supported on 
the 2.4 GHz and 5 GHz bands). 

 l See Before You Begin for advice on setting up projects.

 l See Starting the Multi Floor Planner Building Project to learn how to start the MFP project. 

 l See the Creating a Site Plan for instructions on adding walls, identifying coverage areas, placing APs, and more. 

 l See the Viewing Multi-floor Data for additional viewing tips and controls. 

 l See the Multi Floor Planner Reports for details on creating reports for finished site plans. 

 l See the Export to CAD for information on exporting site plan results to CAD format.

 l See the Menu and Toolbar Reference for information on using the interface.

Before You Begin
With Multi Floor Planner, you can load and modify existing AirMagnet Planner site plans and   you can also create and modify 
new AirMagnet Planner   site plans for the individual floors that make up a multi-floor building   project.

When you import existing AirMagnet Planner   site plans into a Multi Floor Planner building project, they   are added by 
reference (absolute directory path). Therefore, you may want to keep all the source project folders containing site plans in a   
common directory. Saved changes in Multi Floor Planner update the source files. To avoid modifying existing projects,   make a 
copy of original project folder to use for Multi Floor Planner.

Note: Multi Floor   Planner projects that include 802.11ac/ax are not backwards compatible   with previous software versions of 
Multi Floor Planner that do not include   802.11ac/ax.

Also, AirMagnet Planner   project site plans are named 1.spi, 2.spi, and so on. You may want to   determine the site plan name 
before beginning your multi-floor building   project. To do this, open the .spi file in Notepad. The site plan name   is the Name 
value (for example, Name=myproject). The site plan is located   in the folder created for the Planner project.
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New Multi Floor Planner Project

To create a new Multi Floor Planner project:

 1. If you are in the main Survey view, click the button. This opens Multi Floor Planner. 

 2. Select Files > New. This opens the New Building dialog: 

 3. Enter the basic information for the project:

Item Description
Building Name Type a building name or description.
Building Folder Enter the directory path for the project files or click the file selection 

icon to open a selection dialog.
Building Contact Type a name for company or person to contact with questions about 

the project.
Unit of Measurement Choose Feet or Meters.
Number of Floors Enter the total number of floors in the building.
Floor height Enter the floor-to-ceiling distance for each floor.
Inter-Floor Height Enter the amount of space between each floor that is not part of the 

floor-to-ceiling distance.
Inter-Floor dB per <unit> 
Loss

Choose a number for light, medium, or heavy loss of signal between 
floors.

Inter-Floor dB Loss (Calculated value) Estimated total signal loss between floors, based 
on the information you have entered.

 4. Click OK when you have filled out the basic information. This opens a blank building view in the main map area and 
blank floor views in the upper left side window. 

 5. Click a floor card to set up that floor.
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 6. Select the Open icon  to display the New Project for Plan dialog 

 

 7. Enter the basic information for the project:

Item Description
Project Name Type a project name.
Project Folder Enter the directory path for the project files.
Floor Plan Enter the directory path for the floor plan or click the file selection 

icon to open a selection dialog. (Floor plan must be in a supported 
image file format.

Width (X) Enter the width (X axis) dimension.
Length (Y) Enter the length (Y axis) dimension.
Propagation Enter the typical signal propagation distance for APs.
Environment Click on the drop-down menu to select an environment type for the 

project (residential, office, outdoor, etc.).
Description Type a brief description of the plan.

 8. Click OK. This displays the 2D view of the floor. 

 9. Click the View Thumbnail icon  and repeat this procedure to add floor plans and information for the remaining floors 
in your plan.

 10. When you are done adding floors, you can choose to do any of the following:

 l Draw attenuation, coverage, and exclusion areas

 l Align floors

 l Use the wall tool or automatic wall extraction (AWE) tool to create walls. (AWE is available only if you used a CAD 
(.dwg) format drawing for your floor plan.)

 

Starting the Multi Floor Planner Building Project
This topic describes how to create and edit a Multi Floor Planner Building   Project.

To create, export, import or edit a building project:

Click  on the navigation Bar or from the File   menu. The Multi Floor Planner window opens.

 1. Create a new project or open an existing project: 

 l Create a new building project:    Select New from the File menu    to create a multi-floor building. Configure the New    
Building options and click OK.

 l Open a project:    Select File > Open. Browse to the building project file.
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 l Import a project:    Select Import from the File    menu. Browse to the building project zip file. 

Note:    The building project must have been previously exported (File > Export)    to create the zip file.

 2. Edit building properties:    Click View > View    Building Properties.

Item Description
Building Name Type a building name or description.
Building Folder Enter the directory path for the project files.
Building Contact Type a name for company or person to contact with questions about the project.
Unit of Meas-
urement

Choose Feet or Meters. 

If you are not sure of the dimensions, you can enter approximate values here and then recalibrate 
the values more accurately   later. See Measuring   and Calibrating the Floor Plan Scale.

Number of Floors Enter the total number of floors in the building.
Floor height Enter the floor-to-ceiling distance for each floor.
Inter-Floor 
Height

Enter the amount of space between each floor that is not part of the floor-to-ceiling distance.

Inter-Floor dB per 
<unit> Loss

Choose a number for light, medium, or heavy loss of signal between floors.
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To add and manage floors in a building project:

Each floor (level) in the building includes a menu of options. To access   the menu, click the chevron in the top right corner of 
the level.

Item Description
Create Plan Creates a new floor plan project for this floor.

Select Plan Imports an AirMagnet Planner site plan to this floor.

Remove Plan Removes the floor site plan from this floor.
Add Floor Above Insert a new floor above this floor.
Add Floor Below Inserts a new floor below this floor.
Delete Floor Deletes this floor from the building and consecutively     re-number the floors.
Edit Floor Details Opens a dialog containing floor details.
Reset Alignment Resets the alignment of this floor to the default alignment.
View 2D Switches to 2D view.

To configure each level in the building project:

In the Building Tree, each level is listed beginning with Level 1 at   the bottom.  

Adding an existing planner site plan   to a level in the building project: On the desired level in the   building tree, click the 
chevron drop-down menu and select Select Plan and navigate to the   desired AirMagnet Planner   site plan. A valid site plan 
has a .spi file extension.

Creating a new project for a level   in the building: On the desired level in the building tree, click   the chevron drop-down 
menu and select Create   Plan.

Configure the new project options and click OK.
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Item Description
Project Name Give a name to this new floor plan project
Project Folder The default path where the project is created is in     the parent building project.
Floor Plan You must add a floor plan image. Browse to a floor plan image.     The image must be in one of the 

supported file formats. See Supported     Image File Formats.    

Note: The     Visio format is not supported in Multi Floor Planner.
Dimensions This refers to the scale (in feet or meters) of the entire     image area of the floor plan (including any 

white space margin     included in the image). If you are not sure of the dimensions,     you may or may 
not enter the approximate values here and then     recalibrate the values more accurately later in 2D 
view. See Measuring     and Calibrating the Floor Plan Scale.

Propagation Like a regular AirMagnet Planner project, the Propagation value     default is based on the estimate 
of the distance RF signals could     travel in a typical site environments. Normally, NetAlly recom-
mends     that you accept the default value the program assigns. However,     if you want to set a value 
of your own, you must be aware that     the value you enter affects the way the program interpolates     
site data.

Environment Select an option that resembles the real world site environment.
Description (Optional) Type a text description of the project here.

Each level in the building tree includes a summary of the information   for that level as described in the following table:

Item Description
Floor Name Specify a name for this floor.
Floor Height The distance from floor to the ceiling. This may be changed     by editing the Floor Details.
Interfloor height Based on the unit of measure, the distance between the floor     and the ceiling of next lower floor.
Interfloor dB Loss The amount of dBm attenuation resulting from interfloor obstruction     to the RF signal. You may 

set this value or choose a preset from     the drop-down menu.
Floor Contact Contact information if desired. Any descriptive text may be     added here.
Plan The plan file for this floor along with its directory location.
Floor plan The name of the floor plan image used for this floor along     with its directory location. The browse 

option enables you to     change the image if desired.
Dimensions The width and length of the floor plan. This is based on the     calibration scale. See "Project Con-

figuration" table.
Propagation See "Project Configuration" table.
Environment Select an option that resembles the real world site environment

Next Steps:

 l Creating a Site Plan
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Configure Plan (Sample Density)
Selecting Tools > Configure Plan opens the Sampling Density dialog. This dialog has a slider that lets you control the 
precision with which Multi Floor Planner (MFP) processes signal data. 

 l Setting a value toward the right (low) end of the bar means that processing signal data takes less time but is less com-
prehensive. 

 l Setting a value toward the left (high) end the bar means that signal data results have more detail but take more time to 
process.  

 l (Optional) Select the Use recommended sampling distance checkbox to have MFP automatically calculate a suggested 
value. MFP calculates this value based on the size and complexity of the site plan in use.   Larger maps have a larger 
recommended value to reduce processing   time.

 

Creating a Site Plan
Now that you have created a project and imported   your site map, you must draw up your planned office arrangement so   you 
can analyze your AP setup. AirMagnet Planner’s drawing tools   help you design your ideal office and then determine how 
many APs you need   to realize that goal.  Click on the links below to view descriptions   of each section.

 l Using the Wall Tool

 l Drawing Attenuation, Coverage, and Exclusion Areas

 l Adding APs to the Plan

 l Using the Right-Click    Menu

Drawing Attenuation, Coverage, and Exclusion Areas
The Multi Floor Planner Advisor can create better site plans if you mark areas that experience attenuation, areas that require 
coverage, or areas that should be excluded from coverage. 

After you have completed the wall layout, use the tools in the right sidebar to draw out the   internal layout components of 
your office (walls, cubicles, offices, and so on) as areas of attenuation, coverage, or exclusion. 

Note: Do not use the Wall Tool and the area marking tools for the same attenuation space. For example,   if you create a wall 
enclosing a small office, do not create an attenuation   area inside the office.

Drawing Attenuation Areas

To mark an area that can attenuate a Wi-Fi signal:

 1. Choose one of the attenuation area buttons from the side toolbar:

 l
 Create Rectangular    Attenuation Area

 l
 Create Arbitrary Attenuation Area

 l
 Create Arbitrary AP   Exclusion Area

- 71 -



Multi Floor Planner

 2. A drop-down list appears in the top right corner of the map    view when you select any of the attenuation tools. Each 
menu item is a type of boundary with a preset Attenuation   Index. Select an area type from the menu.

Note: The numbers   displayed with each area type are the built-in attenuation index for that type. This numbers are not 
the same as the dB drop value of a walls created with the wall tool. The attenuation   index refers to the effect of an larger 
area on wireless coverage, while dB   drop refers to an immediate decrease over a single spot. 

 3. Mark the attenuation area:

 l For rectangular areas, right-click the corner of the area you wish to designate. Then move the mouse    cursor to the 
opposite corner of the rectangular area. Right-click or double-click to complete the area.

 l For arbitrary areas, right-click once at the point you wish to start drawing . Then move the cursor to the next corner of 
the area and single-click. Then repeat for the next corner, and so on. When you have marked the last corner, right-
click or double-click to automatically connect the final point to the first point to complete the area.

 l For elliptical areas, click once at one side of the ellipse, and then drag the cursor to the other side of the area. Release 
the click when the ellipse is the correct size. 

 4. Repeat this process for any further attenuation areas you wish to draw.

Drawing Coverage or Exclusion Areas

The coverage and exclusion area tools work like the attenuation area tools, except that you do not have to choose an area 
type. For example, you may want to mark a cubicle or office area that is not a perfect   rectangle.

To draw an arbitrary region:

 1. Choose one of the coverage or exclusion area tools from the side toolbar:

 l
 Create Rectangular    Coverage Area 

 l
 Create Rectangular Exclusion Area

 l
 Create Arbitrary AP  Coverage Area

 l
 Create Arbitrary AP  Exclusion Area

 l
 Create Elliptical  Coverage Area

 l
 Create Elliptical  Exclusion Area

 2. Mark the coverage or exclusion area:

 l For rectangular areas, right-click the corner of the area you wish to designate. Then move the mouse    cursor to the 
opposite corner of the rectangular area. Right-click or double-click to complete the area.

 l For arbitrary areas, right-click once at the point you wish to start drawing . Then move the cursor to the next corner of 
the area and single-click. Then repeat for the next corner, and so on. When you have marked the last corner, right-
click or double-click to automatically connect the final point to the first point to complete the area.

 l For elliptical areas, click once at one side of the ellipse, and then drag the cursor to the other side of the area. Release 
the click when the ellipse is the correct size. 

 3. Repeat this process until you have marked all your desired areas.
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 4. When you are done drawing areas, you can choose to do any of the following:

 l Align floors

 l Use the wall tool or (if you used a CAD (.dwg) format drawing for your floor plan) the automatic wall extraction tool to 
create walls.

Attenuation Index

An area’s attenuation index refers to the rate of signal degradation experienced by RF traffic as it moves across an area. A 
larger value corresponds to a greater drop in signal strength. For example, an area enclosed by concrete walls has a sig-
nificantly higher index than a cubicle. 

NOTE: This value is not identical to a dB drop value (which is used for walls), nor is it a percentage.

dB Drop

The dB drop value of a wall is the drop in signal strength (measured in dB) when the signal passes through a wall. You can 
enter measure signal strength directly (using AirMagnet Survey, for example) on both sides of a wall and then calculate the 
difference between the two sides to get the wall’s dB drop value.

NOTE: This value is not identical to an attenuation index, which is used for areas, not walls.

Floor Alignment
By default, all levels in the building project are aligned vertically   to their center point. Each level may be re-aligned based on 
common walls,   elevators, stairwells, and so on. to create a more accurate representation   of the building.

 1. Click Align Floors  or    select Align Floors from the    Tools menu.

 2. From the Select Floor to align    drop-down above the top image, select the desired floor plan.

 3. From the Select Ref Floor    drop-down above the bottom image, select the floor plan to which the    plan above is aligned.

 4. On the floor plan at the top, click the first point of alignment.    A push pin icon appears. Click the second point of 
alignment.    A second push pin icon appears. The distance between the push pins indicates the    alignment edge.

 5. On the bottom floor plan, click the first point of alignment. An    alignment line appears between two push pins that 
indicates the alignment    edge to which the top plan is aligned. The push pin highlighted    in pink may be adjusted around 
the radius of the other push pin. If    desired, click-and-drag the highlighted push pinto move its position.

 6. Click Align. You may see    the multi-floor view on the right readjust to account for any change    in alignment. 

You may continue to align floors as desired with the following    exceptions: 

 l If you use a floor as a reference floor and then aligned it to another reference floor, any floors previously aligned    the 
first reference floor remain their current position. 

 l You cannot align a reference floor to another floor that is already aligned to the reference floor. For example, if floor    1 
is a reference floor and you then align floor 2 to floor    1, you can no longer align floor 1 to floor 2. 

Note: You can choose       to reset alignment to the default and start over by selecting Reset       Alignment from the Tools      
menu.

 7. To save any alignment changes, click OK.    To return to the Building Tree view without saving changes, click    Cancel.
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 8. When you are done aligning floors, you can choose to do any of the following:

 l Draw attenuation, coverage, and exclusion areas

 l Use the wall tool or (if you used a CAD (.dwg) format drawing for your floor plan) the automatic wall extraction tool to 
create walls.

Using the Wall Tool
You should first establish your office’s walls and doors. The following steps guide you through the process of outlining your 
building.

Note:   If you use a CAD (.dwg) format drawing for your site map, you can use the Automatic Wall Extraction tool to create 
walls.

 1. Select the Create Wall    tool from the toolbar.This displays a drop-down list of wall types in the top-right corner of    the 
map window. Each preset wall types has a preset dB drop level (the attenuation affect that the wall has on wireless 
signals).

Note:   In a Cisco Prime NCS/WCS Planner project, only Cisco NCS/WCS type walls   appear in the drop-down menu.

 2. Select the wall type that you wish    to place.
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 3. Click the place on the floor plan/map where one end of the wall starts.    Move your cursor to a corner or a point where the 
wall changes its    angle, and click again. You can click several times along a wall,    following bends and curves as needed. 
Right-click to conclude this portion    of the wall. This fills in the wall in the display. 

 l To keep walls straight and at 45 or 90 degree angles to each   other, hold down the Shift key   while drawing. This locks 
the path to 45 and 90 degree   angles, making drawing straight walls much easier.

 l If you click   the wrong spot while drawing your wall, press Ctrl+Z on the keyboard.   This function reverses the action 
caused by the last click and continues to reverse the previous action   as you press it repeatedly. To cancel drawing the 
wall, press Esc,   and the wall is erased. (The drawing tool then defaults to the cursor.)

 4. Repeat step 3 until all of your walls    are filled in. Select different wall types (windows, doors,    and so on) from the drop-
down as needed.

 5. When you are done creating walls floors, you can choose to do any of the following:

 l Draw attenuation, coverage, and exclusion areas

 l Align floors

Wall/Area Properties

If you right-click a wall or a drawn area, the Wall/Area Properties dialog box pops up. The Wall Properties box is almost 
identical to the Area Properties box.

The Wall Properties dialog allows you to modify the dB drop value of the wall, and the Area Properties dialog allows you to 
modify the Attenuation Index of the area. If you double-click the colored rectangle, you may also adjust the color of the 
object.

If you are modifying a wall and wish to apply the changes to the entire section of that wall, check the box; otherwise your 
changes apply only to the segment of wall you have clicked.

CAD Layers and Automatic Wall Extraction

If your project uses an AutoCAD floor plan, Multi Floor Planner lets you import wall data from CAD files. You can select   which 
layers contain walls, and automatically draw walls in Multi Floor Planner at   those locations.  

 1. Select the CAD Layers to use 

 2. Extract the Walls

 3. (Optional) Modify Walls and APs as needed

Select the CAD Layers

 1. If you are not already in Planner (that is, you created your    new project in Display) click the Multi Floor Planner    tab.

 2. Select Tools > Configure    CAD Floor Plan. A window similar to the following appears. This window    allows you to decide 
which CAD layers you want to display on your    map.
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 3. Click the Select    all layers check box and then click it again to    clear all check boxes. Then click the layers that you wish    to 
appear on your map.                 

Note: CAD drawings can have many layers.  Try   to limit your choices to layers that represent   actual walls or that 
otherwise help you work with your floor plan.

 4. Use the drop-down menu/check boxes as follows:

 l Layout: Some CAD files may          have multiple layouts in them. Use          the Layout dropdown box to select from available 
layouts in the         CAD file.

 l Select all Layers:         Selects/deselects all layers.

 l View black and          white: Some CAD files use colors on layers, but the colors could interfere with visibility of 
heatmaps. Select this option to set all layers to display in black and white by default.

 5. Click OK when   you have finished selecting layers.

Extract the Walls

 1. Select   Tools > Configure CAD Floor Plan. A window   similar to the following appears, displaying the layers that you   
selected.
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 2. Select the layers you want to extract by clicking the check boxes in the Layer column.

 3. Click   on the Wall Type in any row to open a drop-down menu to select a wall composition to use for that layer. (The 
default is Brick Wall. The available selections are Dry Wall, Concrete   Wall, Thick Wall, Metal Door, Heavy Door, Brick Wall, 
Light Door, Cinder   Wall, Plasterboard Wall, Thin Window, Glass Wall with Metal Frame, Window   Office.)

 4. Click db   Drop in any row to modify the db Drop value. This is the amount of attenuation that you expect from the wall 
type. 

 5. Select   or deselect the following check boxes. These options can help you avoid importing   artifacts from CAD files that 
aren’t true wall segments. 
NOTE: These   options are for vertical and horizontal lines (not diagonal).

 l Ignore     line segments less than: Many CAD drawings contain short line     elements that don't contribute to RF 
propagation, but constitute     a large amount of "visual noise". This option provides     you with a way of reducing this 
visual noise.

 l Combine     parallel segments if in: Many CAD drawings represent walls     with two parallel lines close to each other. If 
this option is     disabled, you might end up with twice as many walls, doubling     the attenuation.

 6. Click   Overwrite Existing Planner Walls.   A map similar to the following example appears, based on your selections. (Do 
not use if you are adding layers to an existing floor plan.)

NOTE: If you want to repeat this process to add additional layers, click Append   to Existing Plan. This prevents adding 
the same layers multiple times, which makes editing difficult. 

You can now click the Refresh  icon to generate a heatmap and use the floor plan to place APs.

Modify Walls and APs

(Optional) You can use various options to move, modify, or delete extracted   walls, just as you can with drawn walls.         

Select   any wall or area type and right-click. A pop-up menu appears allowing   you to Delete the wall segment   or change the 
Properties   of each segment. For   more information, see Using   the Right-Click Menu. 

You   can also manipulate wall selection as follows:
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 l Press     and hold the Ctrl key     while selecting a wall to add it to a list of selected walls.

 l Press     and hold the Ctrl key     and click the selected wall a second time to remove it from the     selected wall list.

 l To deselect a wall or group of walls, click anywhere on the floor plan where a wall is not selected.

 l Clicking any other type of Planner object (AP, attenuation area, etc.) deselects all walls.

 l If you have selected multiple walls and want to change your selection to a single wall, click without the Ctrl key     on a wall 
that you want to select. That wall becomes the only     selected object in the list.

 l With     a group of walls selected, you can Right-Click to Delete, Move (as a group) and     Change Properties. (Resizing does 
not work when more than one wall     is selected.)

 l If     all the walls in a group do not have the same attenuation or type,     the Wall Properties dialog entries for type and 
attenuation are     blank.

 l The Wall     Properties dialog sets all to the selected attenuation value. A warning notice     in the Wall Properties dialog is 
displayed if all walls are not     the same type or attenuation. In     this case, the type, "dB Drop" fields is empty.                 

 l To select objects in an area: choose the Select icon  and hold down     the Shift key to create a rubber-band effect on a 
mouse     move from the initial selection point to a point where the mouse     is released. Any     wall segment completely     inside 
the area is added to the selected wall list.     This technique applies only     to walls. (Any     other Planner items such as APs, 
attenuation areas, and so on are not be selected.)

Any walls selected before the rubber-band selection are not   reselected unless they are in the rubber-band area.     If some 
other object was previously selected, it is deselected.

See Also:

 l Using     the Wall Tool (designing your ideal office and determining how     many APs you need)

 l Drawing     Attenuation Areas (changing the decibel values of walls and other     objects)

 l Adding APs to the Plan

 l 802.11 AP Options

 l Using   the Right-Click Menu 

Generating a Multi Floor Planner Advisor Layout
After you have laid out the site floor plan (drawing walls, cubicles, etc.), Multi Floor Planner   Advisor can generate an optimal 
AP layout.

To generate an Advisor layout:

 1. Click the  (Advisor)    button in the toolbar. The Advisor    Criteria dialog appears.
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 2. Make any desired changes to the dialog information. 

Field Description
Media Type Specifies the Wi-Fi standard supported by      the Advisor-placed APs. (This selection may      change 

the available range of other settings below.)
Minimum Signal 
Strength Coverage

Defines the minimum strength required at any point in a      coverage area. The signal strength 
cannot drop below this      value in areas that require coverage.

Transmit Power 2.4 
GHz

Defines the transmit power for the 2.4 GHz APs placed by      Advisor.

Transmit Power 5 GHz Defines the transmit power for the 5 GHz APs placed by      Advisor.
Band Defines the frequency band to be used by Advisor’s placed APs.
Channels Opens the Channel      Allocation drop-down menu, which lets you specify    which channels 

Advisor can use when placing      APs. You must select a minimum of three channels      for each band 
in use.

Channel Width Specifies the channel width to      be used by Advisor-placed APs. The 802.11n media type 
supports      20 MHz and 40 MHz channel widths. 802.11ac and 802.11ax media      types also include 
80 MHz and 160 MHz channel widths.

Spatial Stream 
Number

Specifies the number of spatial streams to be used by Advisor-placed      APs. The setting is used 
by 802.11ac and 802.11ax media types      and ranges from 1 to 8.

Max MCS Specifies the Modulation Coding Scheme (MCS) index used by Advisor-placed APs. The MCS 
setting corresponds      to the maximum data transfer rate supported by the AP. The      802.11n 
media type settings range from 0 to 76. The 802.11ac      media type settings range from 0 to 9. 
The 802.11ax media      type settings range from 0 to 11.

Frame Size Specifies the maximum frame size      used by the Advisor-placed APs. The range is      3839 to 
4194303, depending on the media type. Larger frame      sizes minimize wireless overhead in the 
network by reducing      the number of frames required per transmission.

AP Height The height of the AP. This setting directly affects signal coverage. APs      placed higher than 
standard ceiling height do not cover as wide an area. 

Omni Antenna Gain Defines each AP’s antenna gain. (Advisor assumes omnidirectional antennas.)

 3. Click OK to start    the Advisor. Advisor then processes the site data, tests AP locations,    and then places APs on the plan. 

 4. Click  (Refresh)    to view the Advisor’s projected heatmap. The following graphic shows    one floor of a multi-floor plan:
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Adding APs to the Plan
After you have finished designing your office map, you can place APs   where you expect to have them. Alternatively, you can 
just place one arbitrarily   and then see what its coverage region is like so you can determine where   the next one should go. 
This allows you to determine the number and placement   of APs to give you the optimal coverage for your site.

NOTE: Wi-Fi 6E APs are not supported on the 6 GHz band for Multi Floor Planner. The media type naming in AP Properties 
uses the industry standard terms of Wi-Fi 4 (for 802.11n), Wi-Fi 5 (for 802.11ac), and Wi-Fi 6 (for 802.11ax, as supported on 
the 2.4 GHz and 5 GHz bands). 

To view or edit current APs:
 l In the Planner    view, right-click an AP located on the site map and select Properties to open the AP Properties dialog. You 

can then view or edit the AP properties.

 l Expand either the SSID    or Channel tree in the Data window, right-click on an AP, and   then select Properties. 

 l In the Display    view, right click an AP located on the site map, and then select AP    Properties. You can then view or edit 
the AP properties.

To place new APs:

 1. Click Create AP  on the    toolbar.

 2. Click the location you wish to place the AP. Place as many APs    as are needed in this same manner.

 3. To change back to the normal cursor, click the Select    tool or press the Esc key.

 4. Right-click one of the APs and select Properties….    The AP Properties dialog box    appears.

 5. Enter an AP Name for the    new AP.
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 6. You can save this particular set of configuration properties by    giving this configuration an AP Model    name and by saving 

the model .    This is handy to give several APs the same basic configuration    later on. You can also delete an existing 

model by selecting the model    and clicking delete .

 7. The next section of the dialog box has two tabs: 2.4 GHz and 5    GHz. Use the tabs to select the band for the AP.

Item Description
Channel Enter the channel the device operates on.
Enable Check this box to enable the current tab media type. If your     device operates solely on one 

media type, disable the tab that     is not applicable.
MAC Address Modify the default value as desired to identify virtual APs.
Full Mac Address Multi Floor Planner only. Auto populates the field in the event     APs on different floors have 

the same MAC address.
IP Address Enter an IP, if desired, to identify a virtual AP. (This option is not included if you access this 

dialog from Multi     Floor Planner.)
SSID Enter the SSID, if desired, to identify a virtual AP.
Transmit Power (mW) Enter a number that closely matches the true transmit     power setting of the AP.
Antenna Selects the type of antenna your     device uses. 

 l If your antenna appears in the drop-down list, select     it. This displays the antenna’s 
coverage field in the diagram     on the left. 

 l If your antenna doesn’t appear in the drop-down list, click Pattern to open Antenna     
Manager, which allows you to do more detailed searching or to create a custom antenna     
pattern. 

 l After selecting or creating an antenna pattern,     you can use the Rotation slider to change 
the antenna orientation. 

Media Type (Multi Floor Planner only) Use the drop-down menu to choose the protocol for the AP: Wi-Fi 
4 (802.11n), Wi-Fi 5 (802.11ac), or Wi-Fi 6 (802.11ax). 

Properties Click Properties to display additional properties based on the Media Type you selected. This 
opens the dialog for See Wi-Fi 4 (802.11n Properties, Wi-Fi 5 (802.11ac) Properties, or Wi-Fi 6 
(802.11ax) Properties. 

Location Enter the planned height (in feet) for the AP. The X and     Y fields represent your device’s 
location on the map. (Specify these     if your layout is in a grid format.)

Note Enter a text description for the AP (optional).

 8. Click OK. Your AP is now placed. Modify any others you placed    earlier following this same procedure.

 9. Click  (Refresh)    to see a heatmap view of the predictive Wi-Fi signal strength coverage.

 10. You may move the APs by selecting the cursor tool and dragging    them where you wish. After making any changes, click 
Refresh    to update the view. The AP icons   placed on the site map vary in color based on their media type:

 o  Wi-Fi 4 (802.11a/n)   APs are blue , Wi-Fi 5 (802.11b/g/n) are purple , and Wi-Fi 6 APs (802.11ax) are red . Each 
icon uses a 4, 5, or 6 indicate the type to indicate that use both   mediums appear with half of each color.

 o
Channels for the 6 GHz band include an "E" suffix: 

 l AirMagnet Planner maintains   a list of all APs currently in use on the site plan.  To access this   list, click View > Show AP 
List.    

 l If the   existing AP numbering has gaps that resulted from deleting APs during   your design efforts, Survey can re-sequence 
the numbering of all APs placed   on the map that fit the default numbering scheme (“AP-#”). Select the   “Re-Sequence AP 
Numbering” option in the View menu to re-sequence your   auto-numbered APs. 

 l More heatmap data types are available in the Display view. For more   information about Display view data types, see 
About   Display view.

Wi-Fi 4 (802.11n) Properties

With 802.11n support, you can place, simulate, and assess coverage using   the latest wireless standard.

 1. In Planner view, right-click an AP and select Properties.

 2. Click the desired band tab (2.4 GHz or 5 GHz).
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 3. Check 11n support and click    Properties.

See the table below for the selections that can be made in the   802.11n Properties dialog box.

Option Description
Max MCS The MCS (Modulation and Coding Scheme) is an integer value     that can range from 0 to 76, although 

current 802.11n devices     only support MCS values up to 31. The MCS selection corresponds     to the 
maximum data transfer rate supported by the AP.

Max Frame Size 802.11n devices support frame sizes up to 64 KB, as opposed     to the 4 KB maximum size supported by 
legacy devices. This process     minimizes wireless overhead in the network by reducing the number     of 
frames required per transmission.

Expected Op. Mode 802.11n devices have the capability of operating in what is     known as Greenfield mode, which means 
that the deployment consists     purely of 802.11n-capable devices. This is a setting that is configured     on 
the individual AP; an 802.11n AP that is set to Greenfield     mode is unable to service legacy 
(802.11a/b/g) clients. A Mixed mode means a network that includes device types older than 802.11n.   

Note: After     placing 802.11n APs on a Planner project, your selections for     each AP’s Expected 
Operating Mode are checked when the data is     processed (that is, when you check        ). If the system 
detects that you have placed a legacy device     in range of an AP that is set to Greenfield mode, the AP 
List     dialog box appears to notify you that the Expected     Operating Mode and actual operating mode 
do not match. To ensure optimal operation of 802.11n devices, you should not     mix pure Greenfield 
devices with legacy APs.

Protection Method (If you selected Mixed mode) Use the drop-down menu to select the type     of protection mechanism in 
use on the AP.

Channel 802.11n devices are capable of operating on 40 MHz channel     widths, as opposed to the 20 MHz 
channels used by most standard     legacy devices. To accommodate the 40 MHz width, you     can set the 
AP to transmit over two 20 MHz channels. In this case,     you can select the desired channel and then 
specify whether the     secondary channel used is above or below the channel selected.

Block ACK The 802.11n specification provides a new frame type called     a Block ACK frame, which allows an AP to 
acknowledge blocks of     multiple frames with a single ACK frame. In contrast, legacy devices     are 
required to send an ACK frame for every frame received, resulting     in significantly increased network 
overhead. With Block ACK capability,     802.11n devices reduce this traffic load, which can     improve 
overall network performance.

Short Guard Interval The Guard Interval refers to the period of time that passes     between data transmissions; a shorter 
interval generally helps     to prevent potential wireless hazards such as propagation delays,     echoes, or 
reflections. The 802.11n specification currently provides     two guard interval options: 400 ns and 800 
ns. This setting can     be specified using the AP’s management interface. By default,     most 802.11n 
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devices are set to 800 ns.

 

Wi-Fi 5 (802.11ac) Properties

802.11ac Data Types

Multi Floor Planner includes some heatmap generation Data Type options   for 802.11ac not available in Planner: Predictive 
PHY Data Rate Downlink;   802.11ac: Max MCS (AP Tx); and Channel Overlap. For explanations of these   heatmap options, see 
DiffView and Data Analysis.

802.11ac AP Configuration

Multi Floor Planner includes some AP configuration options for 802.11ac   not available in Planner. For 802.11ac AP, Select the 
5   GHz tab and choose 802.11ac   from the Media Type drop-down.

Item Description
Spatial Stream Number Predictive MIMO support for up to 3 spatial streams
Max MCS Predictive MCS support for index values 0-9.
Predictive PHY Data Rate Calculation value based on spatial stream and MCS selections.
Max Frame Size Frame size options are available for Aggregate MAC protocol     data unit (A-

MPDU)
Primary Channel Indicates the Primary Channel selected for this AP.
Channel Width Provides options for the selection of 20, 40, 80 and 160 channel     width
Sec. Channel Options to choose whether the secondary channel should be A     higher 

frequency (up) or lower frequency (down).
Channel Summarizes the selections made for the channel.
Block Ack Block Ack is checked by default to indicate it is enabled.     It cannot be 

modified.
Short Guard Interval Checked is enabled. Default is 400 ns.

 

Wi-Fi 6 (802.11ax) Properties

802.11ax Data Types

Multi Floor Planner includes some heatmap generation Data Type options   for 802.11ax not available in Planner: Predictive 
PHY Data Rate Downlink;   802.11ax: Max MCS (AP Tx); and Channel Overlap. For explanations of these   heatmap options, see . 

802.11ax AP Configuration

Multi Floor Planner includes some AP configuration options for 802.11ax   not available in Planner. For 802.11ax AP, Select the 
5   GHz tab and choose 802.11ax   from the Media Type drop-down.
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Item Description
Spatial Stream Number Predictive MIMO support for up to 8 spatial streams
Max MCS Predictive MCS support for index values 0-11.
Predictive PHY Data Rate Calculation value based on spatial stream and MCS selections.
Max Frame Size Frame size options are available for Aggregate MAC protocol     data unit (A-

MPDU)
Primary Channel Indicates the Primary Channel selected for this AP.
Channel Width Provides options for the selection of 20, 40, 80 and 160 channel     width.
Sec. Channel Options to choose whether the secondary channel should be A     higher 

frequency (up) or lower frequency (down).
Channel Summarizes the selections made for the channel.
Block Ack Block Ack is checked by default to indicate it is enabled.     It cannot be 

modified.

 

 

 

Using Antenna Manager with Multi Floor Planner
You can use the Antenna Manager (Tools > Antenna Manager) on Multi Floor Planner to select the type of antenna your 
wireless device   uses. It also contains an antenna pattern modification tool that   lets you match patterns that your antenna 
generates. 

 l Viewing Included    Antenna Properties for Multi Floor Planner

 l Creating a    Custom Antenna Pattern for Multi Floor Planner

Viewing Included Antenna Properties for Multi Floor Planner

In this topic:

 l "Locate and View Antenna Properties" below

 l "Create or Delete a User Defined Pattern" on page 87

 

Locate and View Antenna Properties

Generally, you can find your antenna in the list of presets included   with Multi Floor Planner. 
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 1. Click Tools > Antenna Manager… to open the Antenna    Manager.  

 2. Use the filter options and vendor selection list at the top left    of the window to narrow your antenna search.

 

Field Description
Band Click this field to display antenna patterns for 2.4 GHz, 5      GHz, or Both.
Plane Click to display to antenna patterns using      the Azimuth (top view),      Elevation (side view),      or All (the default).
Create Click to display to antenna patterns by preset Defined (patterns supplied      by Multi Floor Planner), User      

Defined (patterns you have created yourself), or All (the default). See Creating      a Custom Antenna Pattern for 
Multi Floor Planner.

Vendor 
Selection 
List

Use this list to sort the pattern display by vendor.     

 l Right-click + All Selected       Vendors -       Displays a pop-up menu to:

 l Check        All (default,        displays patterns for all predefined vendors) 

 l Uncheck        All (clears        all selections, displays nothing until you check a        vendor name or choose Check        
All).

 l To       display patterns from a specific vendor

 l With        all vendors selected, click on a vendor name (do not        select the check box). This displays the 
patterns        for that vendor on the right side of the screen.

 l You may only alter the options you use to view        this pattern in the “Tracker” box at the bottom right.        
The box contains three options:
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 3. To    view the properties for a pattern, double-click    it. This opens the antenna pattern dialog with an enlarged picture    of 
the pattern and properties. (A smaller diagram in the upper right    displays the best fit of a curve to the data points in the 
pattern.)    

Note: You cannot    modify the vendor-provided antenna patterns. However, you can use    the pattern to create your own 
antenna by following the steps in Creating a Custom    Antenna Pattern for Multi Floor Planner.

Field Description
Vendor The name assigned by the antenna      vendor.
Band Select 2.4 GHz, 5      GHz, or Both.
Plane Either Azimuth (horizontal plane/top view) or      Elevation (vertical plane/side view).
Ring 
Count

The number of concentric circles      (measured in + and - dB) displayed in the field diagram. 

0 dB Ring 
#

The number of dB rings from      the center to the 0 dB ring of the diagram.

dB 
Interval

The interval in dB between      each ring of the diagram.

0 Ring dB 
Gain

Shows the peak gain value provided in the antenna vendor's user documentation/data sheet or shows a 0 if the 
field pattern reaches or exceeds the peak gain at any point. 

In the following examples, the 0 dB ring is highlighted       in bold and shown by an arrow. In the example on the 
left,       the antenna pattern does not exceed the peak gain value,       so the 0 Ring dB Gain value is 3.00 as per the 
vendor's       documentation. In the example on the right, the antenna       pattern does exceed the peak gain, so the 0 
Ring dB Gain       value is 0.
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Show 
Handle

Displays straight      lines connecting the yellow points on the field, as well as      the red curved fit line.                     

Show      
Assist

Displays intermediate      blue points, which are connected by the best-fit (red) curved      line. 

Save      as 
New

Select this checkbox to      create a new pattern based on the properties for the current      antenna pattern. Then 
follow the steps in Creating      a Custom Antenna Pattern for Multi Floor Planner.

Create or Delete a User Defined Pattern

You can create new User Defined patterns based on preset Defined patterns   or by creating a pattern from a vendor's spe-
cifications. You can also   delete User Defined patterns. 

 l To create a new User Defined directly:

 1. Click on the New button.     This     opens the antenna pattern dialog.

 2. Follow the steps in Creating     a Custom Antenna Pattern for Multi Floor Planner.

 l To create a new User Defined pattern based on a preset Defined vendor    pattern:

 1. Locate a preset Defined pattern as described in Locate and View     Antenna Properties above.

 2. Select the pattern.
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 3. Follow the steps in Creating     a Custom Antenna Pattern for Multi Floor Planner.

 l To delete a User-Defined pattern:

 1. Locate a User Defined pattern     as described in Locate and View Antenna Properties above.

 2. Select the pattern.

 3. Click on the Delete     button. This deletes the pattern     from the list of User Defined patterns.

Note: You     cannot delete the preset Defined patterns. 

Creating a Custom Antenna Pattern for Multi Floor Planner

If your antenna is not listed in the presets, you can create a customized   antenna pattern based on the vendor's specifications 
or one of the predefined vendor patterns. This enables AirMagnet Planner   to accurately project the desired pattern.

To create a new antenna pattern:

 1. From the Antenna Manager, either click the New    button or use the procedure in Viewing    Included Antenna Properties for 
Multi Floor Planner to locate    and view antenna properties to locate and select a predefined vendor    pattern that most 
resembles the pattern you want to create. The Antenna    Pattern dialog appears.

TIP: It often    saves time to use an existing pattern that is similar to the one you    want to create. The new antenna pattern 
properties are based on the    pattern you select.

 

 3. For the Antenna Name, enter    a unique name for the new antenna pattern. This is the name displayed    on the list of User 
Defined antenna patterns.

 4. Configure the antenna properties    as described in the following table:

Field Description
Vendor Enter the name of your antenna’s vendor.
Band Select 2.4 GHz, 5      GHz,  or Both.
Plane Select either     Azimuth (horizontal plane/top view) or Elevation     (vertical plane/side view).
Ring Count Enter the number of concentric circles that you want displayed     in the field diagram (include the outer-most 

ring).
0 dB Ring # Using the antenna's pattern diagram, count the number of rings     from the center to the 0 dB ring and enter 

the value here.
dB Interval Using the product antenna diagram, determine the dB interval     between each ring and enter the value here. 

For example, if there     is a 5 dB interval between each ring, enter 5.
0 Ring dB Gain  l Shows the peak gain value provided in the antenna vendor's      user documentation/data sheet

 l Shows a 0 if the field pattern reaches or exceeds the peak      gain at any point.
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 l In the following examples, the 0 dB ring is highlighted      in bold and shown by an arrow. In the example on 
the left,      the antenna pattern does not exceed the peak gain value, so      the 0 Ring dB Gain value is 3.00 as 
per the vendor's documentation.      In the example on the right, the antenna pattern does exceed      the peak 
gain, so the 0 Ring dB Gain value is 0.

        

 

Show Handle If you choose to manually adjust     the antenna pattern in the next step, select this checkbox to     display 
straight lines connecting the yellow points on the field,     as well as the red "best fit" curved line. These yellow     
points appear only on the lines radiating outward from the center     of the circle. Use these points to make 
larger changes to the     field pattern.

Show Assist                     If you choose to manually adjust the antenna pattern in     the next step, select this checkbox to display only 
the blue points,     which are connected by the best-fit (red) curved line. These blue     points allow you to fine-
tune the field in-between the Handle     points. Use these points to make detailed changes to the field     pattern. 
(Selecting Show Handle     at the same time displays the final field view.)

 5. Adjust the antenna pattern drawing by dragging the Handle and Assist    points on the pattern diagram as needed. Handle 
points (yellow points)    allow for larger changes while the Assist points (blue points) let    you fine-tune the drawing. The 
following example shows the result    of dragging the yellow Handle point at the top upward and then using    the adjacent 
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Assist points to smooth out the result.

TIP: Obtain an   electronic image of the product antenna pattern diagram if possible. Size   the image to the same size as the 
diagram (antenna drawing) in the Antenna   Manager. Trace the outline of the product antenna pattern onto a transparency.   
Overlay the transparency on the Antenna Manager. Drag the handles to conform   to the trace image.

TIP: You may find   it easiest to uncheck the Show Assist box and then make large changes   to the field pattern using only the 
yellow Handle points. You can then   re-check Show Assist to fine-tune the pattern drawing.   

 6. Click OK to save the new    antenna pattern. The new antenna pattern appears as a User Defined    selection in the Antenna 
Manager.

Note: To use the   new antenna pattern, you must first place an AP on the floor plan. Double-click   the AP to open its 
properties. Click Pattern   in the AP Properties dialog.

To delete the new pattern, select it from the list of User   Defined patterns, and then click Delete.   (You cannot delete any of the 
preset patterns.)

Viewing Multi-floor Data
Once APs are included into your building project (either as part of   an imported site plan or by adding them in the 2D view), 
Multi Floor Planner can process the data to show a predictive, color-coded   visualization of the Wi-Fi environment.

To get started, click Refresh    . The Map view processes the project to show a color-coded heatmap display.   The color-
codes correspond to the legend at the far right.
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You can adjust various controls in the user interface to examine various   predictive scenarios (see Data   Filtering Examples).

Editing AirMagnet Planner Site Plans
If you imported a Planner site plan into a building project using the   Select Plan option, the site plan was imported into Multi 
Floor Planner   by reference. This means that if you modify the plan in Multi Floor Planner   and save the building project, the 
original plan is modified to reflect   the changes. It also means that if you open the original planner project   in AirMagnet 
Planner   and save any changes, when you re-open the Multi Floor Planner building   project, it reflects the changes.

Building Tree Controls
To select a single floor, click the floor in the building tree. To select   all floors, click the parent Building Name at the top of the 
tree.

Data Type Controls
The Data Type drop-down in the top right of the Map view enables different   ways data may be shown: Signal Strength, 
Channel Interference, Predictive   PHY Data Rate Downlink and Throughput.  For more information about   data analysis using 
these controls, see . 

Data Tree Controls
Use "Select APs From..." drop-down menu to control what AP   information to display. This works in conjunction with checked 
options   in the Channel and SSID tree.

 l All Floors: Using this    option includes the data from all APs on all floors.

 l Floor __: This option includes    only data from APs on the selected floor.

 l Bleedover: This option    includes only data from all floors except the selected floor.

The Data Tree on the bottom left lists the APs discovered on the   site plans for each floor. APs are listed by Channel in the 
Channel   tab view and by SSID in the SSID tab view.

A Channel listing indicates the Channel Number (for example, 36), Channel   Width (for example, 40 MHz) and Channel Span 
(for example, 36-40).

Clicking an AP in the list displays a visualization of its location   and floor height.
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If a Data Tree option is unchecked, the data is filtered out of the   color-coded Map view. Re-checking an option re-incor-
porates that data.

Data Tree Controls

Item Description
Check All / Uncheck All Use these controls to "fast check all" or "uncheck     all" associated channels and/or SSIDs listed 

in the Data     Tree.
Media Type Use the checkboxes to choose whether to view 2.4 GHz APs, 5.0     GHz APs or both
Channels Click this tab to list APs by their corresponding channel setting.
SSID Click this tab to list APs by their SSID
AP list Use the checkboxes to include or exclude an AP in making heatmap     calculations. The parent 

checkbox enables or removes all children.
Selected AP Count Total APs selected.

Legend Controls
The label at the top of the legend indicates the measurement type. The   colors in the legend correspond to the associated 
numbered increments   along the vertical axis.
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 l Click and drag down from top of the legend to filter out the top ranges   of data. 

 l Click and drag up from the bottom of the legend to filter out the   lower ranges of data.

 l Use the arrow button below the legend to reverse the measurement   direction of the legend.

 l See Configuring   Legend Color Schemes for more information about configuring the legend.

Overlap, Overall, Per Channel Controls

Overlap: Displays signal overlap or channel interference in the Map Window.

Overall: (Default) Displays overall site   RF signal coverage. 

Per Channel: Displays data by   channel, SSID, or AP.

For detailed information about using Overlap, Overall and Per Channel,   see .

3D View
3D View    is the default view and displays   a three dimensional view of a building project including all levels. With   the cursor 
over this view, drag the mouse to rotate the building on the   associated axis (see Menu Reference). Selecting a level from the   
Building Project tree focuses on the selected level in the 3D view   and dim the other levels.

Thumbnail View
Click Thumbnail view  to display thumbnail images   of all the floors in your project. Double-click a single floor to open   it in 
2D view.

2D View
Select a floor in the tree view and click 2D View   to display a two dimensional   view of that floor.
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Note: Right-click   an individual AP to display a menu of AP options. To view AP details,   select Properties from the menu.   You 
can also delete the AP from the floor plan by selecting Delete   from the menu. If you select Default   AP from the menu, this 
AP's properties become the default   for the AP tool. If checked, unchecking Default AP restores the default   setting.

Data Filtering Examples
The following data filtering scenarios provide some guidance for using   the various data filtering controls in Multi Floor 
Planner.

Signal Bleed-over throughout the Entire Building

To view how the signal strength of particular AP or set of APs may propagate   to other floors: 

 1. Select Signal Strength   from the Data Type drop-down. 

 2. Activate data filtering on all floors by   selecting the parent Building Name in the Building Tree and selecting   All Floors 
from the Data Tree drop-down. 

 3. Make sure all APs   are checked in Data Tree.   

Signal Bleed-over on a Single Floor

To view how the signal strength from other floors affects a selected floor:   

 1. Select Signal Strength from the   Data Type drop-down. 

 2. Activate data filtering on a single floor by selecting   the floor in the Building Tree. 

 3. From the Select   APs from drop-down, select Bleedover.   This option filters out the data from the APs on the selected 
floor while   including any bleed-over data from other floors. 
NOTE: This data may be easier to   view in 2D view.

Signal Propagation from the Selected Floor

To see how the signal strength from one floor   affects the entire building: 

 1. Open the 3D or Thumbnail view.

 2. Select Signal   Strength from the Data Type drop-down. 

 3. Activate data filtering   on all floors by selecting the parent Building Name in the Building Tree. 
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 4. From the Select APs from drop-down,   select a floor (for example, Floor 1). This option filters out the data   from the APs 
on all floors except the selected floor.

Signal Propagation by Channel or SSID

To see how the signal strength is propagated by   channel or SSID: 

 1. In 3D or Thumbnail view. 

 2. Select Signal Strength   from the Data Type drop-down. 

 3. Activate data filtering on all floors by   selecting the parent Building Name in the Building Tree. 

 4. Select All Floors from the Data Tree drop-down. 

 5. Click Per   CH (below the legend). 

 l To view by channel, click the Channel tab in   the Data Tree. 

 l To view by SSID, click the SSID tab in the Data Tree. 

You can drill down to show data from all channels, from individual   channels, or from individual APs by selecting the desired 
parent or child listing   in the Data Tree.

AP List 
You can quickly view a list of all APs currently placed on the site   plan by clicking View > Show AP List.   This option opens the 
AP List   window. 

 l To modify an AP’s properties, double-click it in the AP List to   bring up the AP Properties window.

 l The AP List   shows two entries for each AP: one for 802.11a and one for b/g. This allows   you to easily modify which media 
type is enabled on any given AP. 

Column Description
Group Change Useful for batch changing Power and Antenna settings. Select     the APs to batch change. Check 

Group Change. Make a change to     an item in the table. All selected APs of the same type are 
changed.

Select/Unselect All AP Use this option to select all or deselect all APs.
A lock icon or check in this field indicates that the AP is locked, and     therefore it cannot be 
modified by Planner Advisor.

AP Name The name of the AP.
Channel The Channel that the AP is set to.
Media The media type of the AP.
Enabled A check in this field indicates that the AP is enabled on the     plan.
Power The power setting for the AP (in milliWatts).
Antenna The antenna currently used by the AP.
Ch. Width The channel width in use by the AP.  
Config Op. Mode The Operating Mode specified in the AP’s properties: Greenfield: for 802.11n devices     only; 

Mixed: for deployments     using 802.11n and legacy devices together; Legacy,     for a pure legacy 
(e.g., no 802.11n devices) implementation. Multi     Floor Planner also includes Mixed     VHT that 
includes 802.11ac.
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Note: The AP List   automatically opens when you click  (Refresh) if you have 802.11n APs set to Greenfield mode in a 
deployment   in which legacy APs are still present. This is to notify you of   potential conflicts due to the Greenfield restriction; 
Greenfield deployments   cannot have legacy devices present because the older devices can cause   reduced data rates for the 
wireless network.

Multi Floor Planner Reports
To generate a report of the building project, click Refresh  on the sidebar, and then click the Report icon .   This 
replaces the map view with a report toolbar at the top of the area:

To run the basic Default Planner Report, click the green arrow icon . (If the icon is not enabled, click Refresh  on the 
sidebar, and then try again.)

 l
 Click the Add icon to create a new report template. You can select a template name, language, and the template on 

which the new template is based. 

 l  Click the Delete icon to delete the selected report template. (You cannot delete the Default Planner Report template.)

 l
 Click the report selection drop down menu to select 

from a menu of saved report templates. (The Default Planner Report template is always listed.)

 l  Click the Edit icon to edit the template. You can then use the Edit Report Template dialog to change the General 
Information (title, graphics, headers, etc.) and Report Template information (report category selections, description, 
executive summary, etc.).

 l
 Click the Language icon to select the report language from a drop-down menu (select English, 

Arabic, French, German, or Russian). This automatically localizes the report to the selected language when you run the 
report.

 l  Run the selected report. This creates (or re-runs) the report and displays it in the main viewing area. (If the icon is not 

enabled, click Refresh  on the sidebar, and then try again.)

The topics, floors and heatmaps contained in the report are related   to the following factors:

 l If the "building" is selected in the tree view, information    about all floors in the building are generated. If a specific level    is 
selected, only information regarding that level is generated.

 l Information is generated according to the way the filters are set    in the Data Tree (see Viewing    Multi-floor Data). For 
example, if "Bleedover" is selected,    only information regarding bleed over is generated.

 l Legend settings.

Note: If any of   the above settings are changed, you must regenerate the report to reflect   the changes. To re-generate, click 

.

For actions you can take with the completed report, see Viewing Multi-floor Reports.

Edit Report Template
To edit a report template, select the template, and then click . This displays the Edit Report Template dialog. 

 l After changing the template properties as needed, click Preview   Cover Sheet to view the report’s cover sheet. 

 l To close the dialog and save changes, click OK. 
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General Information Tab

Field Description
Survey Title Formal title for survey.
Prepared for Recipient of the report.
Prepared by Report preparer.
Location Geographic location or address.
Time of Planning Automatic date stamp (editable).
Cover Sheet Picture Path to a picture to display on the     cover sheet of the finished report. Recommended size is 

650w x     400h pixels. (Larger dimensions may cut off the image or display part of it on a new 
page.)

Corporate Logo A logo to be displayed in the     lower-right corner of the cover page. Recommended size is 164w     
x 164h pixels. (Larger dimensions may cut off the image or display part of it on a new page.)

Plan Description A brief paragraph describing the plan.
Report Page Header & 
Footer

Text for running headers and footers. Both align with the left side of the page. A default     page 
number is automatically included at the bottom right corner of each page.

Report Template Tab

This tab lets you choose predefined categories to include with the report and to customize the report material that 
introduces the report, goes in the table of contents, and the executive summary material that precedes each section. 

 l Category - the list of categories that you can include. The default template includes all categories. To remove a category 
from the template, uncheck (deselect) the selection box next  to  the item. See below for a summary of the available 
categories.

 l Content Description - Summary information for a category that appears in the table of contents. 

 l Executive Summary Description - Summary information for a category that appears at the beginning of the report 
section for that category.

 l Multi Floor tab - If report includes more than one floor, this information is precedes the report for all floors for a 
category.

 l Single Floor tab - If report includes more than one floor, this information precedes the report for a single floors for a 
category.
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Category Description
Report Description A general introduction for the report.

 l Select the Multi Floor tab to edit the description for the entire multi-floor report. 

 l Select the Single Floor tab to edit the description for each floor. 
Planner AP List and 
Location

Lists the APs that are physically placed on a floor and that contribute to the heatmap. 

Planner Signal Coverage Color-coded maps that show the expected Wi-Fi signal coverage (in dBm) at each point in the 
floor plan. This display offers a good summary of overall signal coverage.

Channel Interference The levels of wireless interference predicted for the environment.
PHY Data Rate Coverage A heat map of the physical data rate predicted by AirMagnet Planner at each point in the site. 

This rate is calculated based on the objects that you have placed in the site plan. 
Throughput A heat map of the overall throughput expected at each point in the site plan, based on the 

objects that you have placed in the site plan.
Channel Width A heat map of the channel widths present in the proposed wireless environment. Channel 

Width data can vary between five different options: 20 MHz (Legacy), 20 MHz (802.11 HT), 40 
MHz, 80 MHz, or 160 MHz.

Operating Mode A heat map of the operating modes present in the wireless environment. The Operating Mode 
data can vary between three different 802.11n options and one 802.11ac option: Legacy 
(802.11a/b/g), Mixed HT (802.11a/b/g/n), Greenfield (802.11n), Mixed VHT (802.11a/n/ac), and 
Mixed HE (802.11a/b/g/n/ac/ax)

802.11n Highest MCS Index The 802.11n Highest MCS Index provides a heat map of the MCS in use by APs detected at each 
point in the site plan. The MCS Index can range from 0 to 15, with higher numbers cor-
responding to higher data transfer rates.

802.11ac Highest MCS 
Index

The 802.11ac Highest MCS Index provides a heat map of the 802.11ac MCS in use by APs 
detected at each point in the site plan. The 802.11ac MCS Index can range from 0 to 9, with 
higher numbers corresponding to higher data transfer rates.

802.11ax Highest MCS 
Index

The 802.11ax Highest MCS Index provides a heat map of the 802.11ax MCS in use by APs 
detected at each point in the site plan. The 802.11ax MCS Index can range from 0 to 11, with 
higher numbers corresponding to higher data transfer rates.

802.11ac Channel Overlap The 802.11ac Channel Overlap heat map shows how 802.11ac performance is being impacted 
by APs with overlapped primary channels and interfering wide channel widths.

Viewing Multi-floor Reports
The Report Window displays the report based on the options you selected in the report template and the Channel/SSID Tree. 
The editing controls appear at the top of the Report Window: 

 

Icon Name Description
Export 
Report

Opens the Export dialog box which allows you to export      the current report to a 
specific destination in a selected format (rpt, pdf, csv, xls, xlsx, rtf, or xml).

Print 
Report

Opens a print dialog.

First Page Goes to the first page of the report.

Back Displays the previous page.

Forward Displays the next page.

Last Page Goes to the last page of the report.

Page 
Count

Shows the current page number and total pages in the report.     

To go to a specific page, highlight the current page number, type a new    page 
number, and then press Enter.
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Find Opens a text search dialog.

Zoom Opens a dialog that lets you increase or decrease the magnification.

Export to CAD
If you imported a CAD image (.dwg) for your project, this option enables   you to export the image along with any APs and wall 
data that was added   to the image. 

Note: To use this   feature, you must use a CAD image (DWG file format) for your AirMagnet Planner project. 

Note: If you chose   to show or hide individual layers of the CAD image, these changes are   reflected in your exported CAD file. 

To export to CAD:

 1. From the File menu, select    Export to CAD. This opens    the Export to CAD dialog.

 2. Using the Folder text box,    type the path to save your exported file. You may also use the Browse button to the right of 
the    text box to set the path.

 3. In the File Name text box,    use the auto-fill file name or revise the file name. The file extension    must be .dwg.

 4. Use the Export option check    boxes to set the AirMagnet Planner    data to include in the file. The options are AP, AP Names 
and Walls.

 5. Fill Mode specifies whether    you want the wall thickness filled or unfilled. Check Force    True to cause the walls to be 
filled.

 6. The Color option enables    you to set the color of AirMagnet Planner    data. Click Set to change    the default color.

 7. Click Export to save the    file.

 

Menu and Toolbar Reference
See also: "Using the Right-Click Menu" on page 103.

Toolbars
Item Description

 Open   Open a multi-floor building project.

 View 3D Displays the floor plans in a 3D view that simulates 
width,     length and floor height in three dimensional 
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space. Clicking a     floor in the building tree highlight s 
that particular floor.     Clicking the parent Building 
Name highlights all floors.

 View 2D Displays a flat length by width view of a floor plan 
selected     in the Building Tree. Click a floor in the 
Building Tree and then     click View 2D. Mouse over     the 
floor to view a pop-up of data details.

 View Thumbnails Displays a 2D view of all the floors. (Double-click on a 
thumbnail to enlarge the view of that floor.)

 Open Advisor Opens the Multi Floor Advisor, which helps you 
optimize the layout of APs on each floor.

 Align Floors Opens the Floor Alignment feature.

 Print Print the current view.

 Report Generate the Multi     Floor Planner Reports.
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Side Toolbar
The side of the map view contains a toolbar for changing the map and objects:

Item Description

 

Enlarge rectangular 
area

Select this icon, then click and drag to outline a rectangle on the map. Release the click to zoom to 
the rectangle.

 Selector Changes cursor to selection arrow.

 Zoom 

in/out 

Click the + icon to zoom in. Click the - icon to zoom out.

 View 

Thumbnails 

The left icon resizes the map to fit in the available window space. The right icon restores the map to 
its normal size.

 Add AP Adds an AP to the plan. 

 Measure Mode Turns on Measure Mode, which lets you measure the distance between any     two points on the site 
map. You can also choose to recalibrate the site dimensions based on the measurement.

 Create Wall Create walls and select types for the floor plan. See Using the Wall Tool.

 Create Rect-

angular 
Attenuation Area

Selects an area type (cubicle, office, etc.) and     draws a rectangular area (for use with Planner 
Advisor).

 Create 

Arbitrary
Attenuation Area

Lets you draw an arbitrary shape for an attenuation area  (used with Planner Advisor).

 Create Elliptical 

Attenuation Area

Selects an area type (cubicle, office, etc.) and     draws an elliptical area (for use with Planner Advisor).

 Create Rect-

angular Coverage 
Area

Draws a draw a rectangular area  (for use with Planner Advisor).

 Create Rect-

angular Excluded 
Area

Draws a rectangular excluded area (for use with Planner Advisor).

 Create 

Arbitrary Coverage 
Area

Draws an arbitrary coverage area (for use with Planner Advisor).

 Create 

Arbitrary Excluded 
Area

Draws an arbitrary excluded area (for use with Planner Advisor).

 Create Elliptical 

Coverage Area

Draws an elliptical coverage area (for use with Planner Advisor).

 Create Elliptical 

Excluded Area

Draws an elliptical excluded area (for use with Planner Advisor).
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 Clear All 

Objects

Removes all placed objects or     all objects of a certain type (APs, attenuation areas, walls,     etc.).

 Undo Undoes the previous action.

 Refresh Generate and refresh the heatmap

Map View Options
Item Description

    Camera 3D view panning controls. Click the camera icon to 
reset the     default view. Arrows control the associated 
panning direction.

Zoom and Rotate While in 3D view, Right-click and drag in the desired 
direction     to rotate the building in 3D space; left-click 
and drag up to     zoom in or drag down to zoom out. 

Right-click You can modify or remove objects in the planner map 
view by right-clicking to display a pop-up menu. See 
Using the Right-Click Menu.

Hover To display AP information for anyplace on the map 
view, simply hover the mouse over that area.

File Menu
Item Description
New Create a multi-floor building project. The file extension is     .bml
Open Open a multi-floor building project. The file extension is     .bml
Close Close the multi-floor building project. Includes an option     to Save any unsaved changes.
Save Save the currently opened multi-floor building project.
Export Export the building project as a .zip file. Use this option     to import the project on another machine 

running Multi Floor Planner.
Export to CAD If you used a CAD (.dwg) file for your site map, you can export the map back to CAD. If you imported a 

CAD image (.dwg) for your project's site map, this option lets   you to export your project to CAD along 
with any APs and walls data that was added   to the image. See Export to CAD.

Import Import a building project from a .zip file.  Choose the     .zip from File for Import.  Create the imported 
project in     Import Location.

Print Preview 
(Current View)

Open a print preview of the current view.

Recent Files List any previously opened files.
Exit Quit Multi Floor Planner.

View Menu
Item Description
View 3D See Map View options.
View 2D See Map View options
View Thumbnail See Map View options
View Building Prop-
erties

See Building Project

View Legend If the Legend tool is unavailable, this option restores     the Legend.
View AP List View a list of all APs currently placed on the site plan. See Viewing     a List of APs.
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Tools Menu
Item Description
Align Floors See Floor Alignment
Reset Alignment Reset the building levels to default center alignment.
Copy View Copy the current site map view to the clipboard.
Copy Current View Copies the current view. If you have a zoomed-in view, this choice captures the zoom 

area     only.
Configure See Configuration.
Configure Plan Enter a custom Sampling Density.
Configure Walls/Areas See Using the Wall Tool.
Configure CAD Floor Plan Available only if you created a floor plan using an AutoCAD file (.dwg format). You can 

select the CAD layers to include in the floor plan and extract walls. See Using 
Automatic Wall Extraction.

Antenna Manager See Using Antenna Manager with Multi Floor Planner.

Help Menu
Item Description
View Help Open Help documentation
Sample Project Open a sample Multi Floor Planner building project for Wi-Fi 5 or Wi-Fi 6.
About Multi Floor Planner View basic information about Multi Floor Planner such as version and build number.

Using the Right-Click Menu
You may modify or remove a placed object at any time by just right-clicking   on it and selecting a menu option. 

Note: The options listed in the menu depend on the object selected. For example, the Locked   AP and Default AP options 
only appear if you have right-clicked on   an AP.

Option Description
Properties... Opens either the AP Properties or Wall/Area Properties     dialog box, depending on the object 

selected.
Delete Deletes the selected object.
Locked AP Locks the selected AP. This ensures that the Advisor cannot     modify any of the AP’s properties.
Default AP Specifies the properties of the selected AP as Planner’s default     AP settings. Any APs placed after 

selecting this reflect the current     AP’s settings.
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About Display view
The Display view is designed for viewing, analyzing, and manipulating   data. Normally, you use this view only after you have 

saved a completed  survey   and/or site plan. To open the Display view, click  on the Navigation Bar.

The Display view appears by default when you open a project file (.svp). The view may show the site map only, without any 
data. To show   data over the site map, click the corresponding radio   button for one of the data files listed under   Survey Data 
in the Project Window.

NOTE: The Spectrum XT Window may appear if   you are running AirMagnet Survey PRO, provided that this feature is enabled.   
See Enabling   Spectrum Analyzer.

Displaying a Site Map
By default, the most recently opened site map is automatically selected   and displayed when you switch to the Display screen. 
If a project contains   more than one site map, you may need to select the one you want to display   if it is not already opened.

To select a site map:

Select the check box in front of the site map. The selected site map   appears in the Map Window.

To deselect a site map:

Do one of the following:

 l Uncheck the check box in front of the site map, or

 l Select another site map.

Displaying Survey Data
Each survey data file contains the RF data. By default, no survey data   is displayed in the Map Window when you switch to the 
Display screen. You need to select a survey   data file to display it.

To display a survey data file:

Click the radio button in front of the data file. The   data in the selected survey data file populates the Map Window once the   
file is loaded. The time it takes to open a data file depends on the size   of the file. Some survey data files may take sig-
nificantly longer to load   mainly because of the enormous amount of data contained in those files.
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Displaying a Survey Path
To have a better understanding of the survey data, AirMagnet   recommends that the survey path be shown on the site map 
when analyzing   survey data. This provides a physical context for the data.

To display a survey path: Select   the check box associated with the survey path. The selected survey path   appears in the 
Map Window.

To hide the survey path: Uncheck   the check box in front of the survey path.

Channel/SSID List
The Channel/SSID List allows you to view the list of channels or wireless   networks contained in a selected survey data file. 

You can make the selection   by clicking either the Channel   or SSID tab    at the bottom of the list.

When a data file is selected in the Project list, the Channel/SSID List   can be  expanded to show individual APs. The APs are 
organized by   Channel or SSID depending on the tab selection. The APs display an   associated 802.11a/b/g/n/ac/ax icon (for 

example, ).   802.11ac/ax APs include the primary channel, channel width, and channel   span.

This part of the Display view contains the following control options   for manipulating data display:

Select All: This option enables   you to select or deselect all the entries (that is, channels, SSIDs,   APs, etc.) in the Channel/SSID 
tree with a click of the button. By default,   all entries in the Channel/SSID tree are selected when a survey data file   is loaded, 
meaning that all the data contained in the file is shown   in the Map Window.

If you want to focus on data related to one or more specific channels,   SSIDs, or APs, you can uncheck this option to clear all 
the selections.   At this point you can manually select only those entries that concern   you the most. These filter selections are 
preserved when changing   heatmap Data Type options.

2.4 GHz: This option enables   you to display or hide signal information for the 2.4 GHz (11b/g/n/ax)   spectrum. This makes it 
easy to distinguish between 802.11b/g/n/ax data   and 802.11a/n/ac/ax on a map that contains both types.
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5 GHz: This option enables you   to display or hide signal information for the 5 GHz (11a/n/ac/ax) spectrum.   Enabling this 
option along with the 2.4 GHz option described above displays   all media types detected in an environment that uses both 
802.11a/b/g/n/ac/ax   devices.

Note: You may also   create a filtered survey data file which contains data only related to   selected APs. See Creating   Filtered 
Data Files.

Placing APs on the Floor Plan
While in Display view, you may expand the Channel/SSID list to view   APs contained in the survey data file. If desired, you can 
drag APs from   this list to their location on the floor plan. There are a few benefits   to doing this:

 l Showing the physical location of APs in reports

 l Modifying the AP power setting

 l Using features such    as Cisco Location-based services             

Note: Physical   APs with more than one radio may be listed in the Channel/SSID list multiple   times relative to the number of 
radios. If this is the case, you can place   APs on top of each other on the floor plan.

After placing the AP on the floor plan, you may modify a few of the   properties of an AP. To do this, right-click the AP and 
select AP   Properties. This opens the AP   Properties dialog. A few options are editable.

Alias Name: Type an   alias name to map a full MAC address to a user-friendly name. Alias Name   is included in the AP 
information line in the Channel/SSID list. Select   the drop-down menu next to Alias to apply the Alias name to the whole   
Project or only the currently opened survey.
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The format for items in ‘MyAccessPoints.txt’ is as follows:

MAC Address, alias

For example:

01:23:45:67:89:0A, My Favorite AP

Original and Simulated Power Setting:   You may also modify the power setting in milliWatts. Select Apply   power setting, 
and check the Center   on AP checkbox to apply the power setting around the AP.

Click OK to save the changes.

Note: For information   about adding APs to the survey project (Survey view) and about deleting   placed APs from the project 
and from individual data files, see Placing APs in the   Survey.

Comments
AirMapper site surveys performed with an AirCheck G3 or EtherScope nXG   support comments for survey points on a floor 
plan. You can view these   comments in the Display View.

Indicates     a single comment for a survey point.

Indicates multiple     comments for the same survey point. (This     may happen after you have merged two data files that 
have comments     at the same survey point.)

To view comments, mouse over the comment icon. A pop-up bubble displays   comment text. 

 l Right-click on a comment icon to display the comment dialog for    that icon. 

 o When more than one comment exists for the same location, all     of the comments show up in the same dialog. Each 
comment is timestamped     to make it easier to identify.

 o The dialog allows you to scroll up and down and to scroll through     comments.

 o If there are duplicate comments, only the most recent of the     duplicates is shown.

 l To hide or unhide comment icons, right-click on the floor plan.    Select Hide Comments Icons    to hide comments. If the 
Hide Comments Icons option is checked, it    indicates comments are hidden. To redisplay the comments, right-click    on the 
floor plan and uncheck Hide    Comments Icons. 

 l When you merge site survey files, all comments included on the    source files are included in the merged file.

 l When you filter a site survey file, all comments are copied from    the original file to the filtered file.

 l Except for reports, comments show up on all views for which an    Access Point location is supported.

 l Comments cannot be edited; they are read only.

Measuring and Calibrating the Floor Plan Scale
An easy-to-use measurement tool enables you to measure distances on   the floor plan relative to the floor plan scale.  It also 
enables   you to recalibrate the scale of the floor plan (in feet or meters).

When you create a new project and load a floor plan image, there is   an option to enter the dimensions of the floor plan image 
in feet or meters   (X and Y dimensions). Keep in mind that entering dimensions using this   method includes any white space 
outside the perimeter of the building   that may be included in the image. In most cases, it is probably more   accurate to 
recalibrate the scale. In fact, if you leave the dimensions   blank when creating a new project, you are prompted at the 
conclusion   of the project wizard to recalibrate the default scale.

To recalibrate the scale of the floor plan:

 1. From the Toolbar, click the Measurement    tool . A prompt is displayed    to choose whether to measure or recalibrate. 
To recalibrate, click    Yes.
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 2. Click two points on the floor plan where you know    the actual distance between the points. (In general, using a    longer 
distance tends to be more precise than a shorter distance.) This opens the Recalibration dialog.
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 3. Enter the correct value for the "Actual distance" you    measured, click Recalibrate,    and then click OK.

To measure a distance on the floor plan:

 1. From the Toolbar, click the measurement tool .    A prompt is displayed to choose whether to measure or recalibrate.    
To measure, click No.

 2. Click the measurement beginning point. As you move the mouse, the    distance is shown in feet or meters depending on 
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the unit of measure    selected for the project. Click an end point to complete the measurement.

Merging Survey Data
Merging survey data means combining different survey data files into   one file that includes all the data collected from the 
individual files.

Note: If two data   files contain placed APs having the same MAC address and any were moved,   you are prompted that the 
location of APs was changed between surveys.

To merge survey data files:

 1. Click File > Data Merge....    The Data File Merge window appears.  
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 2. If the project contains data files generated by both an AirMagnet    adapter and non-preferred adapter, you can only merge 
files of the    same type. In this case, under Data    Files Generated By, select the desired adapter. Only data files    created by 
that adapter type are listed.

 3. Check the files you want to merge.

 4. In Save this merge to,    type a name for the merged file.

 5. Click OK. The file-merge    progress bar appears at the bottom of the Map Window, showing the    progress of the merge 
operation. The newly merged file appears in    the Project Window under Survey Data once the merge is completed.

 6. To display the merged file, click the radio button in front of    it.

Note: After a merged   file is created, you can view the list of source files that were used   to create the merged file, by right-
clicking the file and selecting “View   Merged Source” from the pop-up menu.
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Creating Filtered Data Files
You may create one or more data sub-set(s) of a Survey Data file (a   filtered data file). The new filtered data file is added to list 
of survey   data files.

To create a filtered data file:

 1. Select the desired Survey Data File.

 2. From the Toolbar, click Filtering . The Data    Filtering window appears.  

 3. Check boxes by AP names to select the APs you want to include.

 4. Use the various controls to sort the AP listings:

 l Column headings sort by the column type.

 l All AP check box selects all listings.

 l 2.4 GHz check box selects only APs set to 2.4 GHz.

 l 5 GHz check box selects only APs set to 5 GHz.

 l 6 GHz check box selects only APs set to 6 GHz.

 l Filter the list by selecting an option from the Filter drop-down (SSID, AP Name, MAC) or    type the desired name into 
the text entry box. (Two wild cards are supported.    Use * for incomplete names (e.g. 00*) or ? to replace an unknown    
character, such as Cisco-123?. Matches are case sensitive.) Then click Filter.

 5. In Save the filtered to:    type a name for the filtered data file.

 6. Click OK. The newly created    filtered file appears in the Project    window under Survey Data.

Display View Menus and Windows
The Menu bar on the Display view also has three menu groups, each containing   various menu options for viewing, analyzing, 
and manipulating survey data.   The File and View   menus contain options that are specific to the Display view only. (The Help 
menu content is the same for all screens.) 
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DISPLAY VIEW: MENUS, BUTTONS, AND WINDOWS

File menu

Edit menu: This menu has only one option, Copy Heatmap Image (Ctrl+C). Selecting this option copies the heatmap 
displayed in the map window to the clipboard as a .png file.
View menu

Toolbar

Project window

 l Right-click Pop-up Menu

 l Data Type List Menu

Overview Window  

Map window

 l Heatmap Legend

 l Using Context-Sensitive Pop-up Menu

File Menu
The figure below shows the File menu on the Display view.

Menu Option Description
New Project… Opens the New Project Wizard where you can create a new project.
Open Project… Opens an existing  project (.svp) file.
Save Saves changes made to the current project.    

Note: This option is available only when changes are made to     an opened project file.
Save Project As… Allows you to save an existing project under a new file name.
Close Project Closes the current project.
Configure… Opens the Configuration dialog box which allows you to set     up project parameters.
Phonebook Configure a VoFi Phonebook.     See Configuring     a VoFi Phone Book.
Data Merge Opens a window containing all data files so that you can select     the files you want to merge.
Import Survey Path… Opens the Import Site     Survey Path File dialog box where you can import the survey data     file. Also 

see Import Path on the toolbar.
Import Survey Data… Opens the Import Site Survey Data File dialog box so that you     can import the data of an existing 

survey project.
Import Floor Image… Opens the Open Site Image dialog box so that you can import     a site map.
Export to Google Earth Enables you to export     a GPS survey for viewing in Google Earth.
Export AP Config… Opens the Export AP Config dialog box so that you can export     AP configuration data in the Excel 

format.
Cisco Prime NCS/WCS 
Export

If     a Cisco Prime NCS/WCS Planner or Survey project was imported and     modified, it may be 
exported using these options.

Print Prints the content of the Map Window.
Print Preview Opens the Preview Window so that you can preview what is to     be printed.
Print Setup Opens the Print Setup window where you can set your printing     preferences.
Work in Display Only 
Mode

Allows you to switch to Viewer mode (which has fewer view     options and no survey options).

Recent Projects Allows you to quickly open projects that have been viewed recently.
Multi Floor Planner Opens Multi Floor Planner
Exit Exit the software application

View Menu
The figure below shows the View menu on the Display view.

Option Description
 Zoom In Enlarges the view of the current floor map in the map window.     
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 Zoom Out Reduces the view of current floor map in the map window. 

 Zoom to Fit Fits the current floor map to the map window. 

 Zoom to Actual 

Size

Fits the current floor map to its actual print scale. 

Set Zoom... Opens the Set Zoom dialog box where you can specify the specific     ratio at which the view of the 
map can be increased.

Show CAD Layers... Allows you to select which layers of a CAD image to display     and, if the image has multiple layouts, 
which layout to display.     This feature is also available when you right-click on the image     in Display 
View. 

Toolbars and Docking 
Windows

Enables you to show (checked) or hide legend and/or status     bar. If the default toolbar settings are 
modified, click Reset Toolbar to reset the toolbar     to default setting.

Show Rulers Allows you to show or hide the rulers along the edge of the     map window.
Show Grids Allows you to show or hide grids in the map window.
Invert Legend Colors Flips the legend color scheme vertically.
Filter APs Opens the Data Filtering by AP dialog box which allows     you to create a filtered survey data file 

which contains data     only related to the selected APs. See Creating     Filtered Data Files.
Overlap Allows you to show or hide signal overlap or channel interference     in the Map Window. Make sure 

the Data Type selected is 1st AP.
Overall Displays overall site RF coverage. This option is active by     default.
Per Channel Displays data by channel.
Per SSID Displays data by SSID.
Lock AP Location Allows you to lock APs to their respective locations on the     site map. Note: This feature can help 

make your survey results     more accurate.
Project Properties... Opens the Project Properties window where you can adjust the     physical properties of the floor map 

of the survey site.
AP/Path Name Font... Opens the Font window where you can modify the font properties     of APs and survey paths on the 

floor map.
Measure Mode Turns on Measure Mode, which lets you measure the distance between any     two points on the site 

map. You can also choose to recalibrate the site dimensions based on the measurement.
Throughput Simulator Opens the Throughput Simulator. See About     Simulation view.

 Refresh Refresh the heatmap display to reflect any changes. 

Display View Toolbar
The Toolbar on the Display view contains frequently used tools for presenting   survey data. Some of these tools are identical 
to those on the File and   View menus of the Display view.

The following screen shot shows the toolbar undocked. The toolbar may   be undocked by dragging its handle located on the 
far left.

Icon Name Description
Project 
Wizard

Opens the New Project Wizard where you can create a new Survey     project. See File menu.

Open Project Opens an existing Survey (.svp) file. See File     menu.

Save Saves changes you have made in the current project.

Configuration Opens Survey Configuration window. See File     menu.
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Print Prints what is shown in the Map Window.

Site Image Opens the Import Site Image window so you can import a site     map.

Import Path Opens the Import Site Survey Path File dialog box where you     can import the survey path of a survey 
data file.  

Import 
Survey Data

Opens the Import Site Survey Data window so you can import     site survey data (.svd or .svdx) files.

Zoom In Enlarges the view of the site map.

Zoom Out Reduces the view of the site map.

Zoom Fit Fits the site map to the Map Window.

Actual Size Displays the site image in a size as it is printed.

Measure 
Mode

Starts the Measure Mode so that you can measure the distance     between any two points in the site 
map. See Measuring     Distance Between Locations.

Toggle 
Outline

Enables you to view an outline of where a heatmap transitions     from one legend value to the next 
value.

Create 
Comment

Allows you to place a comment field anywhere on the displayed     map. To do so, click the button and 
then click where the comment     should be inserted.

Refresh Generate and refresh the heatmap

Overlap Show or hide areas of coverage overlap for a selected AP in the Map Window. 

Filtering Filter AP data out of the Planner project.

Tools Opens the Signal and DHCP tools.

Calculator Opens the calculator tool.

The Display view Toolbar also includes a drop-down menu with the following   options:

View Overall: Displays overall   RF coverage in the Map Window. This option is active by default.

View Per Channel: Displays data   by channel. The Channel tab in the Channel/SSID list must be selected.

View Per SSID: Displays data   by SSID. The SSID tab in the Channel/SSID list must be selected.

 

Project Window
The figure below shows the Project Window on the Display view.
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As shown in the figure above, the Project Window displays files in a   Survey project in three folders:

 l Site Map: Shows all the    site maps (floor plans) for the Survey project. To select a site map,    put a check mark in the check 
box in front of the map file. The selected    map is displayed in the Map Window. By default, a site map is    automatically 
selected and displayed when a new project is created,    or when an existing project is opened.

 l Survey Data: Lists the    data files available in this project, each file representing an individual    survey. They contain data 
such as SSIDs, APs, signal strength, noise    level, signal/noise ratio, etc. captured during the survey. File types    are as 
follows:

Code Survey      Type
A Active survey
P Passive survey
An Survey Mobile app survey

Am AirMapper      active survey file from the 1x1 radio on the EtherScope      nXG

I iPerf      survey
Ma Merge      survey

Ms Merged      survey

S Simulation survey
VoFi survey

V Virtual      survey

 l Survey    Path(applies to Survey projects only, not    to Multi Floor Planner projects): Shows all the survey paths recorded 
during a    site survey. You can have as many survey paths in the folder as you    recorded, and display as many of them as 
necessary. To display a survey    path, put a check mark in the check box in front of the survey path    file.             

You can show or hide any file (that   is, site map, survey data, survey path) simply by checking or unchecking   the cor-
responding radio button. Unlike the Project Window on the Survey   view, the Project Window on the Display view has a Survey 
Data folder   instead of the AP folder.

By default, the most recently opened site map is automatically selected   and displayed when you switch to the Display view. If 
a project contains   more than one site map, you may need to select the one you want to display   if it is not already opened. 
Also, no survey data are displayed in the   Map Window when you switch to the Display view. You need to select a survey   data 
file to display it.

Data File Conversion

Beginning with Survey PRO/Planner version 8.8, the project data file   extension was changed from .svd to .svdx. A project 
containing data files   having the .svd extension may be opened in version 8.8 and higher; however,   if the data file is selected in 
Display view (for example), you are   prompted to convert the file from .svd to .svdx.  

During conversion, the old file is preserved and a new .svdx file is   created.

Survey PRO, Survey Express or Survey Planner version 8.7 or earlier   cannot open projects that have the .svdx extension.

To Convert your Survey Data Files to .svdx:

 1. In    the Display View, right click    on the project, and select Convert    Surveys to Current Version.
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 2. Click Yes    to confirm and start the conversion process.

A progress window shows the files being   converted. If you click Cancel   during file conversion, the process is canceled after 
the current file   completes and before the next file begins.

 

Right-click Pop-up Menu

The Project Window on the Survey view and Display view also includes   a right-click menu. Some options are available in 
Survey view and others   in Display view. Unavailable options are grayed out.

Right-click a survey data file to view the right-click menu options.

Menu Option Description
Close Close this data file
Delete Deletes the selected (right-clicked) item.
Rename Rename this data file
Data Merge... Allows you to merge two or more data files.    

Note: This     option is available on Display view only.
View Merged Source 
...

Shows the sources from which a merged data file was created.
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View Survey prop-
erties ...

Opens a window that displays information about the file.

View Survey properties

From the Project Window, right-click a survey data file (.svdx), and   then select View Survey properties   from the pop-up 
menu. The Survey properties dialog opens, as illustrated   below. 

Note: This option   replaces "View Raw Data" in Survey version 8.8 and higher.

The Survey properties dialog provides information about the selected   survey data file.

View Survey Database

The Survey properties includes an option to view in-depth, database   details included in the selected survey data file.

To view the database, you need a database viewer application such   as DB Browser for SQLite, downloadable  at: http://sql-
itebrowser.org/

Click View Survey Database.   You may be prompted by Windows to associate the database with the desired   database viewer 
application.

Right-Click to Show CAD Layers...

From the Project Window, right-click a CAD image file, and select Show CAD Layers... 

The Drawing Layers... dialog opens, as shown below. 
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Data Type List Menu

This option is available on the Display view only after data are loaded,   that is, after a data file is opened from the Project 
Window. It allows   you to select the type of data you want to display in the Map Window.   You can access the options by 
clicking the down arrow.

The data types presented here are related to the selection you make   from the Channel/SSID Tree. It affects the content 
displayed in the Map   Window and may also affect the options on the Color Legend and Analytical   Tools.

Overview Window
In the lower left-hand corner of the Display view is the Overview Window, which provides a bird’s-eye view of the entire site 
map regardless of the viewing option used in the Map Window. It enables you to try different viewing options in the Map 
Window without “losing the big picture.”  
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By default, the Overview Window is enclosed by a red box when a survey data file is opened, indicating that you are now 
focusing on the entire site (map). If you want to focus on a specific area of the site, you can click outside the red box to make 
it disappear and then click and drag a smaller box on the map. You can then drag this box to zoom in on any specific area on 
the map to get a close-up look at that section in the Map Window.

Map Window
The Map Window on the Display view allows you to view and analyze data   contained in the selected data file.

Data at any location on the site (XY coordinates) may be viewed in two   ways: Mouse hover and Measurement Details. In each 
case, the data displayed   depends on the Data Type selection in the drop-down at the top of the   Display view.

Mouse hover: If you hover the   mouse over a point on the heatmap, a summary of the current Data Type   selected is displayed 
in a balloon tip.

Measurement Details: You can   view the Measurement Details of any location on the heatmap by clicking   the desired XY 
coordinates on the heatmap. A dockable window  opens   to display the details data. A red push pin indicates the coordinates   
location selected. Click a column heading to sort data by column in ascending   or descending order.

From the dockable window, click Copy   to copy the data details to the clipboard.

You can also visualize and analyze the data using different color schemes   and analytical tools. See Introduction to Data 
Analysis for more information.
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Legend

The right-hand side of the Display view shows the Legend which provides   a variety of ways for displaying and analyzing 
survey data using different   color schemes and patterns.

Note: The colors   gray and white may appear in a heatmap and not be indicated on the legend.   White may indicate no 
coverage. Gray may indicate that a coverage requirement   is not met.

 l At the top of the Legend is the Data   Type (including its unit of measure). It indicates   the type of data 
displayed. It is identical to what is selected from the Data   Type list menu on top the Map Window.

 l Drag up   from the bottom of the Legend or down from the top of the Legend to set the upper or lower limit 
of RF data (signal, noise,   interference, and so on) shown in the Map Window.

 l You can also adjust the color scheme. See Configuring   Legend Color Schemes.

Using Context-Sensitive Pop-up Menu

A context-sensitive pop-up menu can be accessed by right-clicking the   Map Window. It is available on all major screens of the 
application. As   the name suggests, the content of the pop-up menu depends on the view   context.
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To access the context-sensitive pop-up menu:

 1. Right-click any part of the map view. The context-sensitive pop-up    menu appears.

Option Description
AP Properties Allows you to view the properties of the AP that you right-clicked.     This option is 

available only when you right click an AP in the     Map Window.
Project Properties Same as View Menu.
AP/Path Name Font Same as View Menu.
Show Rulers Same as View Menu.
Show Grids Same as View Menu.
Hide AP Icons Hides the AP icons so that they do   not display in reports.
Disable Measurement Tooltip and 
Details Window

Prevents tip screens from popping up when you     mouse over the Map Window.

Hide APs Below Legend 
Threshold

Hides APs outside  threshold range     set for the Legend. (You can adjust the range by 
clicking on either end of the Legend and then dragging toward the center.)

Smaller Survey Man Shrinks the icon of a person on the map. (Applies     only to a site survey.)
Show Arrows in Path Adds directional arrows to survey paths.     These arrows indicate the beginning to end 

course of     the path taken during the survey. (Not applicable to Multi Floor Planner.)
Show Heatmap Removes the heatmap from the view.
Delete location information for 
this AP

Removes the location information of the selected AP.

Set Zoom… Sets the zoom level. 
Copy Same as View Menu.
Copy Current View Copies the content in the current Map     Window for pasting into another application. 

(This may be useful for copying     a zeroed-in area for detailed analysis.)
Print Current View Prints the content view in the current Map Window to     another application. (Printing a 

zeroed-in     area may help with detailed analysis.)
Export to Google Earth Exports the data to Google Earth.
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Simulation View
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About Simulation View
The Simulation view allows you to perform channel,   SSID, and power simulation to see how the network would function in 
different   scenarios. You can explore various WLAN deployment plans without   having to have the hardware devices actually 

installed. You can open the   Simulation view by clicking  (Simulation)   on the Navigation Bar.

The map window on the Simulation view is divided into two parts: the top shows survey data before simulation, and the 
bottom shows survey data after simulation. This helps you easily visualize differences between the simulated and 
unsimulated data.

  

The Simulation view can be divided into the following sections:

 l Channel/SSID    List (Before_Simulation)

 l Channel/SSID List    (After-Simulation)

 l File Menu

 l View Menu

 l Toolbar

 l Legend (same    as the one on Display view)

File Menu
The Simulation view includes an additional option on the File menu: Save Simulation opens the Save Simulation dialog box 
where you can save the simulated data as a file.
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View Menu
The View menu on the Simulation view includes additional options:

Menu Option Description
Vertical View Compare Allows you to compare pre- and post-simulation data side by side.
Horizontal View Compare Allows you to compare pre- and post-simulation data horizontally.

Simulation Toolbar
The following table describes additional tool available in the Simulation   view.

Icon Name Description
Save Sim Same as File > Save Simulation.     Enables you to save the simulation project.

Vertical 
Compare

Same as View > Vertical View Compare.     Changes the Map view to vertical orientation.

Horizontal 
Compare

Same as View > Horizontal View Compare.     Changes the Map view to horizontal orientation.

Simulation Opens the Simulation window, which allows you to perform data     simulations.

Add Sim-
ulation AP

Opens the New AP Properties window where you can specify the     properties of the AP to be used in 
data simulation.

Help Opens AirMagnet Survey’s Help window.

Throughput 
Simulator

Opens the Throughput Simulator tool, which allows you to     view predicted throughput speeds and 
bandwidth consumption for     a custom-designed network. See Simulating     Network Throughput for 
more details.

Setting Up Data Simulation
Before conducting data simulation, you must place and "power"   APs on the site map in the Display   view at locations where 
actual APs are located:

 1. Create a survey project and conduct the survey. See Creating    an Indoor Survey Project.

 2. Navigate to Display view    and Refresh the view.

 3. Expand the Channel or SSID list and drag an AP to its physical    location on the site map. Continue to do this for all the APs 
in the    list. (This step primarily relates to APs under your management, although    you may place any or all APs in the list.)

 4. Right-click an AP you placed on the site map and select AP    Properties.

 5. Check Apply Power Setting    and set the Original Power milliWatts.    Use the setting that matches the setting for the AP. 
Click OK.

 6. Navigate to Simulation    view and place simulation APs on the site map. On the toolbar,    click Add Simulation AP. This    
opens the New AP Properties    dialog. Modify any default settings (MAC Address, SSID and Original    Power settings are 
required). When finished, click OK. This places the AP is placed on the site map. You may drag the AP to the desired   
location. 

 7. On the toolbar,    click Add Simulation AP. This    opens the New AP Properties    dialog. Modify any default settings (MAC 
Address, SSID and Original    Power settings are required). When finished, click OK. This places the AP is placed on the site 
map. You may drag the AP to the desired   location. 

- 126 -

Creating_an_Indoor_Survey_Project.htm


Simulation View

 8. Click Refresh to view   changes to the heatmap.

Before-Simulation Channel/SSID List
The Before Simulation Channel/SSID List appears on the   upper-left part of the Simulation view. It lists the APs contained 
in the   unsimulated data. You can view the APs either by channel or by SSID using   the corresponding tab at the bottom of the 
list.

After-Simulation Channel/SSID List
The After Simulation Channel/SSID List appears in the lower-left part of the Simulation view. It lists the APs contained in the 
simulated data. You can view the APs either by channel or by SSID using the corresponding tab at the bottom of the list.

Conducting Data Simulation
The Simulation view allows you to test a number of what-if hypotheses using data collected from actual site surveys. 
Therefore, you must perform site surveys to collect the real data you need. Also, you need to open the data file on the Display 
view first before you switch to the Simulation view. Otherwise, the Simulation view is not be available. You can conducting 
two types of simulations:

 l Simulating Data Configuration

 l Simulating Channel Allocation
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Simulating Data Configuration
To conduct data simulation:

 1. From the Display view, open a survey data file.

 2. From the Navigation Bar, click . The    Simulation dialog box appears.

NOTE: Wi-Fi 6E APs are not supported in Simulation mode.

 3. Highlight the AP of your choice, and do any or all of the following:

 l Click the CH field     and select a channel from the drop-down list.

 l Click the SSID field     and select an SSID.

 l Drag the scale to set a Noise     Simulation level.

 4. Click Refresh. The Loading    Date File view appears. The graph refreshes once the simulation process    is completed.

 5. Click Close.

NOTE: Make sure   that the APs are placed in their exact locations and that the correct   values of the original output power are 
used. APs placed on Survey‘s Display   view are 'display-only‘ by default. Therefore, you cannot   modify the AP power settings 
for APs placed on the Simulation screen unless   the APs are first changed to Power APs. Placing APs and enabling power   can 
be done on the Display view. See Channel/SSID   List.

Simulating Channel Allocation
Simulating channel allocation enables you to find out the optimal channel   assignment or distribution for the APs currently 
detected in the survey.   It helps you make well-informed decisions on the number of APs needed   on the network or at a 
certain part of the network: if multiple APs are   covering the same area on the same channel, the chances are that not all   of 
the APs may be necessary.

NOTE: You can choose   to simulate channel allocation on either the 2.4 or 5.0 GHz band by using   their respective tabs across 
the top of the dialog box.  

NOTE: Wi-Fi 6E APs are not supported in Simulation mode.
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To simulate channel allocation:

 1. From the Toolbar, click Simulation    (not to be confused with Throughput Simulation). This opens the Simulation dialog.

 2. Click the Channel Allocation    tab. The view refreshes.

NOTE: All APs    that are detected are identified by AP name, SSID, and (original)    channel.  Wi-Fi 6E APs are not supported in 
Simulation mode.

 3. Select the AP of your choice and click the down arrow to specify    its new channel, if desired.

 4. Check the Lock CH box to    lock the channel for the corresponding APs, if you want to ensure    that the simulation process 
doesn’t alter that AP’s setting.

Note: 802.11ac/ax    APs are automatically locked ("Lock CH" column is checked)    in Channel Allocation.

 5. Check the Disable Redundant APs,    if desired.

Note: This    allows the application to disable the APs it considers redundant.    The slider allows you to configure the signal 
strength required for    APs to be considered redundant. If all points meet the specified signal    requirement, any APs below 
that level are eliminated. Once the    simulation is completed, Survey automatically disables those APs    that it considers 
redundant.

 6. Use the slider to set a minimum signal coverage value.

 7. Click Allocate.

       

Note: You can    also add APs or relocate APs to certain areas on the site map and    then use the Simulation tool to see how 
the changes affects the    signal coverage in the target areas.
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Simulating Network Throughput
Survey’s Throughput Simulator allows you to set up theoretical network   implementations and view the expected levels of 
traffic that the specified   devices experience. You can create entire simulated networks from   scratch to test a planned imple-
mentation or use devices already   detected in the current survey file to see how new additions   to the environment affects the 
overall performance of the existing   infrastructure.

The Throughput Simulator is a utility for calculating network, node   and media throughput, utilization and overhead (as 
measured at the 802.11   Link Layer) under various network and node configurations. It allows you   to add and configure up to 
fifty 802.11a, 802.11b, 802.11g and/or 802.11n   nodes on a “virtual channel”. The Simulator’s engine applies additional   
network and node parameters based upon the type and settings of the nodes   present. The Simulator runs in a “perfect” 
environment, assuming that   all nodes can “hear” each other (negating the possibility of packet collisions   and frame retries) 
and that all nodes transmit as much (and as fast) as   they possibly can (based upon their individual and overall network 
parameters).   The result of such simulation provides a baseline measurement of the (somewhat   theoretical) maximum link-
layer throughput that can be achieved for a   particular configuration.

To use the WLAN Throughput Simulator:

 1. From the Simulation view, click    (Throughput Simulator). The Throughput Simulator window appears.     

 2. From the menu bar, click Add Device and select an option as described    in the table below.

Note: For all options, you must add an     AP before the Throughput Simulator allows you to create a     station. 

NOTE: Wi-Fi 6E APs are not supported in Simulation mode.

Note: To remove   a device from the Throughput Simulator, right-click the desired device,   and then select Delete Node.

Option Description
Add 802.11x Device… Drop-down that enables you to select one or more devices to     be added from the information 

contained in the current survey     data file.
802.11a Device… Opens the Device Configuration dialog box, which allows you     to select a type of device to be 

added and the device's physical     data rate.    
802.11b Device… Opens the Device Configuration dialog box, which allows you     to select a type of device to be 

added, as well as its physical     data rate.    
802.11g Device… Opens the Device Configuration dialog box, which allows you     to select a type of device to be 

added, as well as its physical     data rate.    
802.11n Device… Opens the Device Configuration dialog box, which allows you     to select a type of device to be 

added, as well as its MCS index.     A series of checkboxes also allow you to specify the devices 
various     configuration parameters, including Greenfield, channel width,     etc.    

 3. After you add the necessary devices, click each station’s    Associated AP column to select an AP to which it should 
associate.
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Note: You must   associate at least one station to each AP to simulate network   throughput. Also note that APs with 
associated stations cannot be removed.

 4. After all the necessary associations have been made, click Run to start the simulation.  For    descriptions of the throughput 
simulation data fields, see Analyzing Simulated    Throughput Data.

Analyzing Simulated Throughput Data
During network simulation, the Throughput Simulator window updates dynamically as new information is calculated. These 
data are displayed in three major portions of the view, as highlighted in the image below.  

NOTE: Wi-Fi 6E APs are not supported in Simulation mode.

Throughput Simulator Summary
The Throughput Summary portion of the Throughput Simulator displays   the simulated network throughput separated based 
on media type, allowing   you to see how much throughput is dedicated to each type of device.   These data are described in the 
table below:

Field Description
Network Combined aggregate throughput of all wireless media (which     may include 802.11a/b/g/n/x, depending 

on the frequency band selected.                 
Average Average node throughput (that is, the network throughput     divided by the number of nodes).
Avg 802.11a Average node throughput for all 802.11a devices. Note that     this column only appears when the 5 GHz 

band is selected.
Avg 802.11b Average node throughput for all 802.11b devices. Note that     this column only appears when the 2.4 

GHz band is selected.
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Avg 802.11g Average node throughput for all 802.11g devices. Note that     this column only appears when the 2.4 
GHz band is selected.

Avg 802.11n Average node throughput for all 802.11n devices.

Throughput Simulator Device Table
The Device Table portion of the Throughput Summary displays the status   of each device as the simulation proceeds. The data 
in this portion of   the window are described in the following table:

Column Description
Device The name of the device. For actual detected devices, this name     is provided by the survey data. For 

devices added manually, these     names are numbered generic entries (for example, AP_1, STA_2).
Associated AP The AP to which a station has been associated. (APs do not display any information in this field.)
Rate The rate at which the device transmits. This number     is specified when you add devices.
Tx Packets The number of simulated packets transmitted by the device.
Tx Data Bytes The number of simulated data bytes transmitted by the device.
Throughput The device’s throughput (in Mbps).
Status The current operating state of the nodes which can be any of     the following:    

 l TX Data

 l Tx ACK

 l Random Backoff

 l Virtual Carrier Sense

 l Rx ACK

 l CCA

Note: The     Status column of the Device Table is color-coded as described     by the color legend listed 
across the bottom of the Throughput     Simulator window.
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Multiview Map View
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MultiView Overview
MultiView is  similar to the Display   view but you can display and compare up to four different   surveys at  the same time. When 
multiple surveys are loaded, each pane in   the window acts individually. You can view different survey   data files in each 
pane. A blue box highlights the currently active pane, as shown below.

 l Begin by opening the projects that you want to include. You can then select various options to compare surveys, bands, 
channels, SSIDs, etc. between the projects. 

 l You can also open a single project in the MultiView View to compare different parts of the same project in each pane.

For more information, see

 l The Project Window , which information for all survey projects opened in the MultiView, including individual components 
in   each project.

 l The Channel/SSID Tree, which shows the APs and SSIDs detected in the current data file(s).

 l MultiView Menus and Options

Opening Multi-Floor Survey Projects
The MultiView view is used for analyzing whether APs on a certain floor   can provide RF signals strong enough to cover 
wireless stations on floors   above and/or below and how APs on adjacent floors could interfere with   one another in terms of 
channel allocation, service quality, network security,   etc. However, to analyze RF data across multiple floors in a   single 
building, you must collect data from each of the floors involved.   This means that you first of all need to create a Survey 
project for each   of the floors, perform the site surveys individually floor by floor, and   save the survey data for each floor 
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separately. Once data are collected,   you need to open the one of the Survey projects first on the Display view,   and then bring 
up the MultiView view to open (import) the other survey   projects. After all the projects are loaded on the MultiView view, you   
can use the tools on the view to analyze the data.

The following procedures show how to open and analyze survey data involving   multiple floors.

To analyze multi-floor survey data:

 1. From the Display view, click File > Open    Project.... The Open dialog box appears.

 2. Browse to a Survey project (.svp) file and click Open.    The project opens on the Display    view.

 3. Click the radio button in front of the Survey Data file. The data    loads.

 4. Click  on the Navigation    bar. The MultiView view opens    with the project displayed.

 5. To import additional floors, click File > Import    Multi-Project…. The Project Import window appears.

 7. Click the check box(es) corresponding to the subproject file(s)    you wish to import, and click Import. The selected project 
file(s)    appear on the Multi View view.

Note: A “main project”   is the survey project that you first open on the Display view. Any survey   project that is opened 
(imported) afterward on the MultiView view is   a “subproject”. AirMagnet Survey PRO allows you to display multi-floor   survey 
data for up to four floors on the MultiView view at the same time.    For better data representation, it is recommended that you 
merge   all the survey data for each floor to create a merged file and then compare   the merged files on the Multi View view.

The MultiView view can also help you compare several different surveys   in a single project, using the Single Project Multi View   
function.

Single Project in MultiView
When you import additional project in MultiView, you may also choose   to view a single project in the four different panes to 
compare different parts of the same project in each pane.

To view a single project in MultiView mode:
 1. Open the Project Import    view.

 2. Check the box for the file you wish to view (you may need to browse    to find the project to import).

 3. Check the “Single Project Multi    View” box at the bottom.

 4. Click Import. This displays the single project you loaded displayed in all four panes.
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 5. Click the radio buttons for the survey data you wish to load in    each individual pane. Select your desired view options.

Project Window
The Project Window on the MultiView view displays all the survey projects   that you have opened (imported), including the 
individual components in   each project.
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Note: AirMagnet   Survey displays multiple survey projects in the order they are opened,   with the one that is opened first 
placed on top of the list of projects   in the Project Window. For this reason, the main project should appear   on the top 
because it is supposed to be opened first.

Channel/SSID Tree
The Channel/SSID Tree on the MultiView view shows the APs and SSIDs detected in the current data file(s). The following 
figure illustrates how channels and SSIDs are organized under their respective projects. This makes it easy to view, check and 
uncheck APs and SSIDs as desired to see how changes are reflected in multiple surveys.
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The Toolbar includes Automatic Multi Select . This feature enables you to turn the automatic selection feature on or 
off. With it turned on, data about the APs selected in one Map Window automatically displays in the other Map Window(s) if 
its RF signals are also contained (collected) in the preset(s). This enables you to easily visualize and compare how RF signals 
propagate across the floors.

MultiView Menus and Options

File Menu
The File menu in MultiView includes the following options:

Import MultiView Project: Use   this option to import up to four projects for MultiView comparison.

Close Subproject: Enables you   to select a subproject file to close without closing the entire survey   project.

View Menu 
The View menu includes the following options:

Swap Left/Right Views: Toggles two images left and right.

Swap Top/Bottom Views: Toggles two images up and down.

MultiView Toolbar
The toolbar contains the commonly used tools for analyzing multi-floor   data. Most of these tools are identical to the options 
found in the File   or View menus of the view. Some additional tools for Multiview are described   in the following table:

Icon Name Description
Open Subproject Allows you to select and open a subproject of a multi-floor     survey project.

Four View Displays the site maps used in a multi-floor project in four     separate mini windows.

Swap Left/Right Toggles two images between left and right.
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Swap Top/Bot-
tom

Toggles two images between up and down.

Automatic Multi 
Select

Turn the automatic selection feature on or off. With it turned     on, data about the APs selected in 
one Map Window is automatically displayed in the other Map Window(s). See Channel/SSID     Tree.

Legend
The color legend on the Multi View view works in the same manner as the one found on the Display view.
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DiffView and Data Analysis
AirMagnet Survey’s DiffView and other powerful analytical features allow you to visually   analyze network performance and 
validate WLAN deployment using collected   data. This section explains how to use the various analytical tools on   the Display 
view and DiffView to analyze data you have collected.

In this chapter:

DiffView: Compare Surveys and    Site Plans 141

Evaluate Overall Site Signal Coverage 142

Identifying Coverage Cells by Individual APs 143

Determining the Number and Placement of APs 144

Determining Cell Overlap 145

Identifying Provisioned Bandwidth and Speed 145

Identifying Predictive Downlink Bandwidth and Speed 146

Identifying Adjacent or Co-Channel Interference 147

Viewing Current Channel Allocation 148

Identifying Channel Noise 148

Evaluating Site Security Status 149

Viewing 802.11n/ac/ax Operating Mode 149

View 802.11n/ac/ax MCS Index Data 150

Viewing 802.11n/ac/ax Channel Width 152

Identifying 802.11ac Channel Overlap 152

Using the Real-Time AP Locator 156
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DiffView: Compare Surveys and    Site Plans
Note: The dimensions   of projects (width and height) must be identical to use this feature.

Oftentimes you may wish to display multiple projects or data files (surveys   and/or site plans) side-by-side to view the 
differences   between them. This can be particularly useful in displaying changes made   to a network environment over time. 
For example, a newly-conducted site   survey or site plan can be compared with one taken months   earlier to identify any new 
sources of interference or devices that have   been added in the meantime.

If the data files you intend to compare are in different projects, you   must use the      (Import Survey Data) button to   
import the data file from the project.

Typically, you can compare the same data types; however, the Diff view   enables the comparison of some different data types. 
If the data type   is not available, the data type reverts to blank.

For example, as shown in the following screen shot, you may compare   802.11ac actual uplink throughput in an iPerf data file 
to PHY Data Uplink   Rate. In this case, you must choose iPerf Throughput Down in the bottom   left (source) and PHY Data 
Downlink Rate in the bottom right (destination).

To compare the results of two data files:

 1. Open the project that contains the two data files for comparison.    As noted above, if the data files are in different projects, 
open    one project and import the data file into it.

 2. From the Navigation bar, click     (Diffview) to open the project    in multiple frames.  

 3. From the Project Window, click the ‘+’ sign to expand the Survey    Data under Survey One, select to open the first data file.

 4. From the Project Window, click the ‘+’ sign to expand the Survey    Data under Survey Two, select to open the second data 
file. Now data    contained in the two files are displayed on the view.  

The top pane of the view now displays a heatmap that shows the difference   between the two surveys at any given location on 
the site (map). Areas   marked in red indicate that Survey One (bottom left pane) is stronger   and areas marked in green 
indicate that Survey Two (bottom right pane)   is stronger.

You may use the data type drop-down in each bottom pane to view data   by various data type options. In some cases you may 
be able to compare   different data types. If the application permits the comparison, the choices   are accepted, otherwise 
unselected panes show as blank in the   data type drop-down.

The blue border around a pane indicates it is the pane in focus.

See also:
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Viewing    Specific Signal Comparison Data

Viewing Specific Signal Comparison Data
You can compare the signal strength of any location on the heatmap in   the selected data files using the DiffView window. 

 1. Open    the project that contains the two data files for comparison. (If the data files are in different projects, open one 
project    and import the data file into it.)             

 2. From    the Navigation bar,    click Diffview  to open    the project in multiple frames, one for each project. 

 3. Select Signal    Strength for each of the bottom panes. These show data from two different    survey projects, and the top 
pane shows the differences between    the two.

 4. Place the cursor at a spot on the site map to get the measurement    details of that location.

Evaluate Overall Site Signal Coverage
To evaluate the overall RF signal coverage at the site:

 1. If your project includes more than one survey, you may choose to    merge the survey data files before performing data 
analysis.

 2. From the Project Window, select the desired data file.

 3. Click the SSID tab and    select the SSID from the SSID List.

 4. From the Data Type drop-down menu, select Signal    Strength.

 5. From the Toolbar drop-down, select View    Overall.

 6. Use the colors on the Legend to determine the signal strength at    different locations.

 7. Set the upper and/or lower limit of signal strength on the Legend.

 8. Move the cursor to different locations to view details of signal    strengths from the pop-up view.  
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Note: Areas of   different signal strengths are indicated by different shades of colors.   Areas that fall out of the signal strength 
range are gray (as shown above).

Identifying Coverage Cells by Individual APs
To identify the coverage cells by individual APs:

 1. If your project includes more than one survey, you may choose to    merge the survey data files before performing data 
analysis.

 2. From the Project Window, select the desired data file.

 3. Once the data are loaded, click the SSID    tab and highlight an SSID from the SSID    List.

 4. From the Data Type drop-down    menu, select Signal Strength.

 5. From the drop-down on the Toolbar, select View    per AP. Areas covered by different APs are shown in different    colors, as 
shown in the following examples.  
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Determining the Number and Placement of APs
To determine the optimal number and placement of APs:

 1. If your project includes more than one survey, you may choose to    merge the survey data files before performing data 
analysis.

 2. From the Project Window, select the desired data file.

 3. Once the file is loaded, click the SSID    tab and select an SSID.

 4. Uncheck the APs that are of no interest to you.

 5. From the Data Type drop-down    menu, select Signal Strength.

 6. From the drop-down on the Toolbar, select View    per AP. This displays the APs in the color as they appear in    the SSID 
List.

For Survey: 

For Planner: 

Note: The figures above shows two APs selected; the heatmap   reveals that these APs provide coverage for virtually the entire   
map.
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Determining Cell Overlap
To determine a cell overlap:

 1. If your project includes more than one survey, you can choose to    merge the survey data files before performing data 
analysis.

 2. From the Project Window, select the desired data file.

 3. From the Channel/SSID Tree, click the SSID    tab and highlight an SSID of interest.

 4. Make sure all APs under the SSID are checked.

 5. From the Data Type drop-down    menu, select Signal.

 6. From Toolbar, click  (Overlap).     

 

Note: The overlap   areas of the AP coverage cells are shown in red.

 

Identifying Provisioned Bandwidth and Speed
To identify the provisioned bandwidth and speed of an AP for an Active   or iPerf survey:

 1. From the Project Window, select a data file.

 2. From the Channel/SSID List, select the SSID    tab and highlight the SSID of interest.

 3. From the Data Type drop-down menu, select Measured PHY Data Rate    Up/Measured PHY Data Rate Down (iPerf 
Survey only). The Legend on    the right changes to a color bar consisting of different color blocks,    each representing a 
specific speed. 

 4. Hover the cursor over a spot on the site map to get a pop-up detailed data    from the tooltip.

 5. Click a location on the site map to get a detailed measurement display at the bottom of the screen.
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Note:When using an 802.11ac adapter, the   option changes to PHY Connection Rate.   Choosing this option displays the single 
PHY data rate for the connection   that is reported from the non-preferred adapter.

 

Identifying Predictive Downlink Bandwidth and Speed
To identify the provisioned bandwidth and speed of an AP:

 1. From the Project Window, select a data file.

 2. From the Channel/SSID List, select the SSID tab and highlight the    SSID of interest.

 3. From the Data Type    drop-down menu, select Predictive    PHY Data Rate Down and then Predictive    PHY Data Rate 
Down (AP). The Legend changes to a color bar    consisting of different color blocks, each representing a specific    speed. 
The heatmap shows the predicted PHY Data Rate. 

The   Measurement Details appear at the bottom of the screen, showing the details   of the measurements.

Note: If   there are multiple APs covering a given location, the PHY rate for the   AP with the strongest signal strength is 
shown. 

 4. Place the cursor at a spot on the site    map to get detailed data from the tooltip.

 5. Click a location on the site map. The    Measurement Details pane appears at the bottom of the screen, showing    the details 

- 146 -



DiffView and Data Analysis

of the measurements.

Identifying Adjacent or Co-Channel Interference
To identify adjacent channel or co-channel interference in Display   View or MultiView:

 1. If your project includes more than one survey, you may choose to    merge the survey data files before performing data 
analysis.

 2. From the Project Window, select the desired data file.

 3. From the Channel/SSID pane,    click the Channel tab and select the channels adjacent to each other,    such as Channels 1, 
2, 3, or 4, 5, 6, and so on.

 4. From the Data Type drop-down    menu, click Channel Interference.

 5. On the Legend bar, drag up from the bottom (weakest signal strength)    to set the minimum interference level to be 
shown. This ensures that    only areas that exceed a certain amount of interference are displayed.    
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NOTE: Some single APs may   use multiple SSIDs under different BSSIDs, which can create the appearance that there is much 
more interference than really exists. You can use AP grouping to assign these multiple SSIDs to the same AP. See AP Grouping 
for more information. 

Viewing Current Channel Allocation
To identify current channel allocation:

 1. If your project includes more than one survey, you may choose to    merge the survey data files before performing data 
analysis.

 2. From the Project Window, select the desired data file.

 3. From the Channel/SSID pane,    select the Channel tab, make sure all channels are selected (checked),    and highlight 
Channel at the top of the channel list.

 4. From the Data Type drop-down    menu, select Signal Strength.

 5. From the Toolbar drop-down, select View    Per Channel. Each of the channels that are selected are displayed    in different 
a color.

For Survey:

For Multi Floor Planner:

Note: The channels   in the Channel tab are color-coded; the colors in the Map Window indicate   the channels in use.

Identifying Channel Noise
To identify channel noise:

 1. If your project includes more than one survey, you can choose to    merge the survey data files before performing data 
analysis.

 2. From the Project Window, select the desired data file.

 3. From the Channel/SSID pane,    click the Channel tab.

 4. From the Data Type drop-down    menu, select Noise Level.    The Legend changes to a color bar consisting of different 
color blocks,    each representing a specific noise level. 
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 5. Place the cursor at a spot on the site map to get detailed data    from the tooltip.

 6. Click a location on the site map. The Measurement Details    pane appears at the bottom of the screen, showing the details 
of the    measurements.

Evaluating Site Security Status
This section helps you identify any unexpected or unidentified APs or   stations in the current wireless environment. The 
presence of such devices   could signify potential network attacks at worst and improperly configured   network devices at best.

To evaluate site security status:

 1. From the Project Window, select a passive survey data file.

 2. Wait until the data are loaded and displayed in the Map Window.

 3. From the Data Type drop-down    menu, select Signal Strength.

 4. From the Channel/SSID pane,    click the SSID tab, look for    any SSID marked "Unknown," and select it.  

 

Viewing 802.11n/ac/ax Operating Mode
To provide a better view of 802.11n/ac/ax information in the   wireless network, Survey’s Display view provides an 
802.11n/ac/ax   AP Operating Mode heatmap selection. When you view this data type, the   heatmap displays different colors for 
areas where APs are using Legacy,   Mixed, Mixed VHT, Mixed HE, or Greenfield operating modes.

To view the 802.11n/ac/ax operating mode heatmap:

 1. From Survey’s Display view, load a data file with 802.11n, 802.11ac,    and 802.11ax information.

 2. Use the Data Type drop-down to select AP    Operating Mode.  

 3. Hover the mouse over any segment of the new heatmap to view the    operating mode of the AP detected at that location.

 4. Click any spot on the heatmap to see the detailed measurements    for that spot at the bottom of the screen.
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The heatmap indicates the signal strength of the strongest AP detected   in the mode color. The table below describes the 
meaning of each color.

Color Mode Description
Blue Legacy Legacy mode represents areas where non-802.11n devices are     operating. Blue portions of the map are 

regions where a “legacy”     device (802.11a/b/g AP) is strongest.
Purple Mixed Mixed mode contains both 802.11n and legacy devices. Purple     portions of the heatmap indicate that an 

802.11n AP is running     in the mixed mode.
Orange Mixed VHT Mixed VHT (Very High Throughput) mode is for 802.11ac APs only.     The .11ac standard runs only in this 

mode. Orange portions of     the heatmap represent regions where the strongest .11ac AP is     running.
Cyan Mixed HE Mixed HE (High Efficiency) mode is for 802.11ax APs only.     The .11ax standard runs only in this mode. 

Cyan portions of the     heatmap represent regions where the strongest .11ax AP is running.
Green Greenfield Greenfield mode contains APs operating at High-Throughput (HT)     transfer rates. These rates can be 

sustained by 802.11n devices.     Green portions of the heatmap represent regions where the strongest     AP 
is running at HT transfer rate.

View 802.11n/ac/ax MCS Index Data
During an Active, Active iPerf   or Passive survey, AirMagnet Survey automatically records the Modulation   Coding Scheme (MCS) 
detected from 802.11n/ac/ax APs. This number can range   from 0 to 31 for 802.11n APs, 0 to 9 for 802.11ac APs, or 0 to 11 for   
802.11ax APs, with higher numbers corresponding to higher data transfer   rates.

You can view MCS information for both Tx (transmission rate) and Rx   (receive rate) for detected APs. These data indicate the 
MCS for the AP   with the strongest signal strength at a given point on the survey floor   plan.

To view MCS information:

 1. From the Display view, load a data file that contains 802.11n and/or    802.11ac APs.

 2. Select 802.11n, 802.11ac, or802.11ax:    Max MCS (AP Tx) or (AP    Rx) data type. The heatmap refreshes.  

 3. Hover the cursor over any point in the survey to view the tooltip of the exact    MCS index for the strongest 802.11n, 
802.11ac, or 802.11ax AP detected    for that spot. 

 4. Click any point in the heatmap to see the measurement details at    the bottom of the screen. (See the examples below.)
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Viewing 802.11n/ac/ax Channel Width
The Channel Width data type allows you to easily view the different   channel width used by 802.11n/ac/ax   devices in the 
network environment.

To view the channel width heatmap:

 1. From the Display view, load a data file that contains 802.11n,    802.11ac, and/or 802.11ax APs.

 2. Select the Channel Width data type. The view refreshes.

 3. Hover the mouse over any point in the heatmap to see the tooltip    for the channel width at that spot.  

 4. Click any point on the heatmap to see detailed measurements at    the bottom of the screen.

The heatmap displays the colors corresponding to the strongest AP's   channel width color at the given point.

The table below describes the color schemes for various channel widths.

Color Width
Blue 20 MHz (channel width used by 802.11a/b/g or 802.11n APs operating     at legacy speeds).
Purple 20 MHz-HT (used by 802.11n/ac/ax APs operating at HT speeds).
Green 40 MHz (used by 802.11n/ac/ax APs).    

Note: 802.11n communications using 40 MHz bands are also     conducted at HT speeds.
Orange 80 MHz (used by 802.11ac/ax APs operating at VHT/HE speeds).
Light Blue 160 MHz (used by 802.11ac/ax APs operating at VHT/HE speeds).

 

Identifying 802.11ac Channel Overlap
While wider 802.11ac channels are capable of transmitting   higher throughput rates, they are also more susceptible to RF 
issues such   as channel interference, utilization, etc. If an 802.11ac radio detects   an issue, it can attempt to retransmit at a 
smaller available channel   width in accordance to the 802.11ac specifications.

Example:

A 160 MHz channel can retry   as a 80 MHz wide channel.

A 80 MHz channel can retry   as a 40 MHz wide channel. 

A   40 MHz channel can retry as a 20 MHz wide channel. 
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An 802.11ac wide channel   uses a specific 20 MHz channel as the primary channel. This primary channel   contains the Wi-Fi 
beacon information, for example. The remaining   20 MHz channels used by an 802.11ac wide channel are referred to as 
secondary   channels.

If an 802.11ac radio retransmits at a smaller channel than originally   allocated, this affects overall throughput and 
performance. This reduction   in throughput and performance of an 802.11ac wide channel is what the   802.11ac Channel 
Overlap heatmap conveys.

To identify 802.11ac channel overlap:

 1. From the Display view, load a data file that contains 802.11ac    information.

 2. From the data type drop-down menu, select 802.11ac Channel Overlap.

 3. Hover the mouse over any point in the heatmap to see the tooltip    for the channel overlap information for that spot.  

 4. Click any spot in the heatmap to see detailed measurements at    the bottom of the screen.

Please note that for all of the following examples,   AP #1 and AP #2 have overlapping coverage.

Red areas indicate overlapped primary channels.   These are areas where overall performance is significantly lower   because 
two AP/Client connections cannot transmit simultaneously on the   overlapping channel.

For example:

 l AP #1 is set to transmit   an 802.11ac 80 MHz wide channel with the primary channel on channel 36   (36P + 40 + 44 
+ 48).

 l AP   #2 is set to transmit an 802.11ac 40 MHz wide channel with the primary   channel on channel 36 (36P + 40).

    or:                        

 l AP #1 is set to transmit   an 802.11ac 80 MHz wide channel with the primary channel on channel 36   (36P + 40 + 44 
+ 48).

 l AP   #2 is set to transmit a 20 MHz channel on channel 36.

Orange areas indicate overlapped secondary   channels that cause fallback to a 20 MHz channel. These are areas where   overall 
performance is much lower because two AP/Client connections   on overlapping 802.11ac wide channels must fallback to a 
slower 20 MHz   channel to transmit simultaneously.

For example:

 l AP #1 is set to transmit   an 802.11ac 80 MHz wide channel with the primary channel on channel 36   (36P + 40 + 44 
+ 48).

 l AP #2 is set to transmit   an 802.11ac 40 MHz wide channel with the primary channel on channel 40   (36 + 40P).

 l AP #1 reduces its transmitting   channel to a single 20 MHz channel on channel 36. AP #1 is unable to use   channels 
40, 44, and 48.
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 l AP   #2 reduces its transmitting channel to a single 20 MHz channel on channel   40. AP #2 is unable to use channel 
36.

Yellow areas indicate overlapped secondary channels that cause   fallback to a 40 MHz channel. These are areas where overall 
performance   is slightly lower because two   AP/Client connections on overlapping 802.11ac wide channels must fallback   to a 
slower 40 MHz channel to transmit simultaneously.

For example:

 l AP #1 is set to transmit   an 802.11ac 80 MHz wide channel with the primary channel on channel 36   (36P + 40 + 44 
+ 48).

 l AP #2 is set to transmit   an 802.11ac 80 MHz wide channel with the primary channel on channel 48   (36 + 40 + 44 + 
48P).

 l AP #1 reduces its transmitting   channel to a 40 MHz wide channel on channels 36P and 40. AP #1 is   unable to use 
channels 44 and 48.

 l AP   #2 reduces its transmitting channel to a 40 MHz wide channel on channels   44 and 48P. AP #2 is unable to use 
channels 36 and 40.

Green areas indicate no significant channel   overlap. Channel overlap does not impact overall performance in these areas. An 
802.11ac wide channel does not have a 20 MHz channel   that is overlapped by any 20 MHz channels from other APs. 

For example:

 l AP #1 is set to transmit   an 802.11ac 40 MHz wide channel with the primary channel on channel 36   (36P + 40).

 l AP   #2 is set to transmit an 802.11ac 40 MHz wide channel with the primary   channel on channel 48 (44 + 48P).

Background

In 802.11ac, a transmission initiator sends a Request to Send (RTS)   message set with a channel bandwidth to use for a trans-
mission; for example,   80 MHz. A transmission recipient sends a Clear to Send (CTS) message set   indicating how much channel 
width is available and not currently used.   This mechanism allows two APs with overlapping 80 MHz channels to transmit   sim-
ultaneously by falling back to an available 40 MHz or 20 MHz channel,   if the full 80 MHz channel is not available. An example 
of how this works   is shown in the following diagram:
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In each example, AP#1 and AP#2 have overlapping 80 MHz channels. The   primary 20 MHz and 40 MHz channels are indicated 
by "P". Each   example has a different level of potential performance impact due to the   difference in primary channel 
assignments.

Example 1 shows the situation   highlighted in red in the Channel Overlap heatmap. Each AP has the same   primary channel. 
Therefore, they cannot transmit simultaneously if any   of the 20 MHz sub-channels are in use.

Example 2 shows the situation   highlighted in orange in the Channel Overlap heatmap. Each AP has a different   20 MHz 
primary sub-channel, but the same 40 primary MHz sub-channel. Therefore,   to transmit simultaneously, each AP can fallback 
to its 20 MHz primary   sub-channel to transmit, but not to a 40 MHz sub-channel.

Example 3 shows the situation   highlighted in yellow in the Channel Overlap heatmap. Each AP has a different   20 MHz primary 
sub-channel and a different 40 MHz primary sub-channel.   Therefore, to transmit simultaneously, each AP can fallback to its 40   
MHz primary sub-channel to transmit.  

Tooltip Text Explanation

 

The heatmap tooltip text for Overlapped   Primary Channels is shown above. There are two APs with 80 MHz   channels that 
overlap completely on channels 149, 153, 157, and 161. The   primary channel of each AP is the same: 153. Therefore, these 
two APs   cannot transmit simultaneously.
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The heatmap tooltip text for Overlapped   Secondary Channels with Fallback to 20 MHz is shown above. There   are two APs 
with 80 MHz channels that overlap completely on channels 149,   153, 157, and 161. The primary channel of AP#1 is 149 and 
the primary   channel of AP#2 is 153. A 40 MHz channel fallback for each AP would be   on channels 149-153 which would 
overlap and prevent simultaneous transmission.   Therefore, these two APs must fallback to their non-overlapping 20 MHz   
primary channels – 149 and 153 – to transmit simultaneously.

 

The heatmap tooltip text for Overlapped   Secondary Channels with fallback to 40 MHz is shown above. There   are two APs 
with 80 MHz channels that overlap completely on channels 149,   153, 157, and 161. The primary channel of AP#1 is 149 and 
the primary   channel of AP#2 is 157. AP#1 can fallback to a 40 MHz channel on 149-151,   and AP#2 can fallback to a 40 MHz 
channel on 157-161, to transmit simultaneously.

Using the Real-Time AP Locator
Survey’s AP Locator feature   uses collected survey data to calculate approximate locations for detected   APs. Before starting to 
survey the desired location for a particular AP,   you must perform the following steps to configure the feature and fine-tune   
the scanning process. These steps ensure that the device is   located with both precision and speed.

Note: These steps   focus on conducting a GPS survey; this   information may vary slightly if you are conducting AP Location 
surveys   on non-GPS projects.

To locate an AP:

 1. During project creation, import the map of the site to be surveyed;    you must specify the type of environment in which the 
AP is located    (that is, Restricted Closed Office for a standard office building)    for the Survey Environment, as shown in the 
figure below.
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Note: If the site   is a small portion of a larger GPS map, the image should be cropped just   to cover the specific area to be 
surveyed.

 2. From the Settings tab of    Survey’s Configuration dialog box, check Auto    Position APs with signal greater than __ dBm 
and specify a    minimum signal level to be used (if desired).  Click OK    to save the changes.

Note: If "Auto   Position APs..." is enabled, the survey retract button are grayed   out (unavailable).

 3. Place the external antenna (outside) on the roof of the car. It    is recommended that an omnidirectional antenna be used 
for best results.

 4. Select the band (2.4 or 5 GHz) in which Survey should operate and    the channel on which the device is located, if known. 
See the figure    below.

Note: As shown   in the figure above, the scan interval should be set to 250 ms for best   results.

 5. From the Survey view, select the Passive    Survey option and use the drop-down list to select SSID    or AP, as needed. See 
the    figure below.

 6. If known, select the specific AP    or SSID to be located from    the drop-down list. See the figure below.

Note: If you   select ANY from the SSID list, the Survey view cannot calculate   AP placement until a specific AP is selected.  
This can be done during   the survey process by selecting the desired AP from the scrolling list   in the passive survey 
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window, as shown in the figure below. After   the selection has been made, the application tries to calculate   the device’s 
location. However, after the survey is completed, calculated   positions of any additional APs detected are shown on the 
Display   view.

 7. Start the survey and drive slowly (between 5-10 mph) around the    perimeter of the site.

Note: After some   data are collected, an icon ( ) representing the selected   AP appears on the site map in its 
calculated position.  This   icon moves about during the course of the survey as its location is   recalculated from new data.  
The AP icon is color-coded based on   Survey’s confidence in the current location; the colors progress   from red (lowest 
confidence) through yellow, green, and finally, black   (greatest confidence).  This confidence level is also displayed in   the 
Passive Survey frame in place of the Signal/Noise ratio.

 8. When the survey is completed, stop the survey and save the data.

 9. View the data on the Display    view to analyze the results of the survey.

Note: The Display view automatically places all APs detected   during the survey, even though only one AP is shown on the 
Survey view.

- 158 -



AirWISE View

AirWISE View
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About AirWISE View
AirWISE is a powerful and easy-to-use tool to review and change the design requirements for your wireless LAN. AirWISE uses 
these requirements to automatically analyze your site survey data for problems. The requirements include:

 l Signal Coverage

 l Multiple AP Signal Coverage

 l Channel Interference

 l Speed Coverage

 l Signal/Noise Ratio

 l Noise Level

 l User Capacity

To open the AirWISE view, click    on the Navigation Bar after you have opened a project. 

To get a detailed description each AirWISE technical requirement, see the "AirWISE Requirements Summary" below.

AirWISE Requirements Summary
The AirWISE Summary pane on the AirWISE view lists the default AirWISE   requirement policy included with AirMagnet Survey. 
As described in this   section, new policies may be created and the default requirements can   be customized to conform to your 
particular needs.
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The AirWISE Summary pane displays the following AirWISE information:

 l AirWISE Requirements: Lists    each AirWISE Requirement policy. The list contains the default AirWISE    requirements 
included with AirMagnet.

 l % of Good Area: Shows the    status of the survey data in terms of compliance with requirement's    configurable threshold 
value. For example, if the requirement threshold    value is set to -67 and all the data is -67 or greater for this requirement,    
the percentage of good area is 100%. N/A indicates that this    particular requirement is not applicable to the type of survey 
data    selected in the Display view.

 l Pass/Fail: A configurable    value that indicates whether the "% of good area" is in    an acceptable threshold. For example, if 
the Pass/Fail value is set    to 100% and the "% of good area" is 80%, the Pass/Fail column    reads "Fail." However, if the 
Pass/Fail value is set    to 80% and the "% of good area" is 80%, the Pass/Fail column    reads "Pass."

In addition, by selecting an AirWISE Requirements listing, you can view   the associated heatmap and policy explanation.

For more details on each AirWISE requirement, see:

 l 802.11n MCS Index

 l 802.11ac MCS Index

 l 802.11ax MCS Index

 l Cisco Location-based Services

 l Channel Interference

 l Channel Width

 l iPerf Throughput Up

 l iPerf Throughput Down

 l Measured PHY Up

 l Measured PHY Down

 l Multiple AP Signal Coverage

 l Noise Level

 l Operating Mode
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 l Predicted PHY Down

 l RSSI Neighboring Cell Coverage

 l RSSI Serving Cell Coverage

 l Signal Coverage

 l Signal Noise Ration Coverage

 l Throughput Downlink Coverage

 l User Capacity

 l VoFi Packet Retry

 l VoFi PHY Data Rate

 l VoFi Signal Coverage

 l VoFi WiMOS

802.11n MCS Index
 l Threshold: Minimum Tx MCS Index required

 l Default value: 15

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

This requirement allows you to view precisely which areas of the current   survey data file meet the requirements specified by 

the Minimum Tx MCS   Index required threshold.  Areas that meet the requirement are displayed   in light green ( ), whereas   
regions that do not reach the required MCS are displayed in a color assigned   by the color-codes on the legend.  Hover the 
mouse over any given   point to view a bubble help pop-up that displays detailed information   about the APs detected at that 
location.

Background

802.11n defines MCS (Modulation and Coding Scheme) which is an integer   value (0 through 76) which determines the 
modulation, coding rate, and   number of spatial streams for a transmission. The following PHY data rate   table illustrates the 
possible combinations of MCS, Channel Width, and   Short Guard Interval (SGI) which determines the PHY data rate, for MCS   0-
31.

MCS Index Spatial 
Streams

Modulation Type Coding Rate Data     Rate (Mbit/s)
20 MHz Channel 40 MHz Channel
Non-SGI SGI Non-SGI SGI

0 1 BPSK 1/2 6.50 7.20 13.50 15.00
1 1 QPSK 1/2 13.00 14.40 27.00 30.00
2 1 QPSK 3/4 19.50 21.70 40.50 45.00
3 1 16-QAM 1/2 26.00 28.90 54.00 60.00
4 1 16-QAM 3/4 39.00 43.30 81.00 90.00
5 1 64-QAM 2/3 52.00 57.80 108.00 120.00
6 1 64-QAM 3/4 58.50 65.00 121.50 135.00
7 1 64-QAM 5/6 65.00 72.20 135.00 150.00
8 2 BPSK 1/2 13.00 14.40 27.00 30.00
9 2 QPSK 1/2 26.00 28.90 54.00 60.00

10 2 QPSK 3/4 39.00 43.30 81.00 90.00
11 2 16-QAM 1/2 52.00 57.80 108.00 120.00
12 2 16-QAM 3/4 78.00 86.70 162.00 180.00
13 2 64-QAM 2/3 104.00 115.60 216.00 240.00
14 2 64-QAM 3/4 117.00 130.00 243.00 270.00
15 2 64-QAM 5/6 130.00 144.40 270.00 300.00
16 3 BPSK 1/2 19.50 21.70 40.50 45.00
17 3 QPSK 1/2 39.00 43.30 81.00 90.00
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18 3 QPSK 3/4 58.50 65.00 121.50 135.00
19 3 16-QAM 1/2 78.00 86.70 162.00 180.00
20 3 16-QAM 3/4 117.00 130.00 243.00 270.00
21 3 64-QAM 2/3 156.00 173.30 324.00 360.00
22 3 64-QAM 3/4 175.50 195.00 364.50 405.00
23 3 64-QAM 5/6 195.00 216.70 405.00 450.00
24 4 BPSK 1/2 26.00 28.80 54.00 60.00
25 4 QPSK 1/2 52.00 57.60 108.00 120.00
26 4 QPSK 3/4 78.00 86.80 162.00 180.00
27 4 16-QAM 1/2 104.00 115.60 216.00 240.00
28 4 16-QAM 3/4 156.00 173.20 324.00 360.00
29 4 64-QAM 2/3 208.00 231.20 432.00 480.00
30 4 64-QAM 3/4 234.00 260.00 486.00 540.00
31 4 64-QAM 5/6 260.00 288.80 540.00 600.00

An 802.11n STA is required to support MCS   0-7 in 20-MHz (non-SGI) mode; an 802.11n AP is required to support MCS   0-15 in 
20-MHz (non-SGI) mode; all other MCS values and modes are optional.

MCS   32 is defined as 40-MHz HT duplicate format (BPSK ½ on both halves of   the 40-MHz channel). MCS 33 through 76 define 
Unequal Modulation MCS values,   where the modulation type differs across spatial streams. For instance,   MCS 33 defines a 2 
spatial stream transmission with stream 1 modulated   with 16-QAM and stream 2 modulated with QPSK.

For other AirWISE requirements, see AirWISE Summary.

802.11ac MCS Index
 l Threshold: Minimum Tx MCS Index required

 l Default value: 9

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

This requirement allows you to view precisely which areas of the current   survey data file meet the requirements specified by 

the Minimum Tx MCS   Index required threshold.  Areas that meet the requirement are displayed   in light green ( ), whereas   
regions that do not reach the required MCS are displayed in a color assigned   by the color-codes on the legend.  Hover the 
mouse over any given   point to view a bubble help pop-up that displays detailed information   about the APs detected at that 
location.

Background

Selecting a modulation and coding set (MCS) is much simpler in 802.11ac   than it was in 802.11n. Rather than the 70-plus 
options offered by 802.11n,   the 802.11ac specification has only 10. The reason for the dramatic simplification   is that 802.11ac 
separates the spatial stream number from the MCS number,   and each spatial stream has the same MCS for 802.11ac radios. 
An MCS number   for 802.11ac is really about the modulation scheme of a spatial stream.   The first 8 (0-7) are mandatory, and 
most venders support all 10   MCS options in all products they bring to market. The following table   illustrates the possible com-
binations of MCS, Spatial Stream number, Short   Guard Interval, and Channel Widths.

Spatial 
Streams

802.11ac MCS 
Index

Guard 
Interval

20 MHz Channel 
PHY Data Rate

40 MHz Channel 
PHY Data Rate

80 MHz Channel 
PHY Data Rate

160 MHz Channel 
PHY Data Rate

1 0 LGI 6.5 13.5 29.3 58.5
1 0 SGI 7.2 15.0 32.5 65.0
1 1 LGI 13.0 27.0 58.5 117.0
1 1 SGI 14.4 30.0 65.0 130.0
1 2 LGI 19.5 40.5 87.8 175.5
1 2 SGI 21.7 45.0 97.5 195.0
1 3 LGI 26.0 54.0 117.0 234.0
1 3 SGI 28.9 60.0 130.0 260.0
1 4 LGI 39.0 81.0 175.5 351.0
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1 4 SGI 43.3 90.0 195.0 390.0
1 5 LGI 52.0 108.0 234.0 468.0
1 5 SGI 57.8 120.0 260.0 520.0
1 6 LGI 58.5 121.5 263.3 526.5
1 6 SGI 65.0 135.0 292.5 585.0
1 7 LGI 65.0 135.0 292.5 585.0
1 7 SGI 72.2 150.0 325.0 650.0
1 8 LGI 78.0 162.0 351.0 702.0
1 8 SGI 86.7 180.0 390.0 780.0
1 9 LGI not used 180.0 390.0 780.0
1 9 SGI not used 200.0 433.3 866.7
2 0 LGI 13.0 27.0 58.5 117.0
2 0 SGI 14.4 30.0 65.0 130.0
2 1 LGI 26.0 54.0 117.0 234.0
2 1 SGI 28.9 60.0 130.0 260.0
2 2 LGI 39.0 81.0 175.5 351.0
2 2 SGI 43.3 90.0 195.0 390.0
2 3 LGI 52.0 108.0 234.0 468.0
2 3 SGI 57.8 120.0 260.0 520.0
2 4 LGI 78.0 162.0 351.0 702.0
2 4 SGI 86.7 180.0 390.0 780.0
2 5 LGI 104.0 216.0 468.0 936.0
2 5 SGI 115.6 240.0 520.0 1040.0
2 6 LGI 117.0 243.0 526.5 1053.0
2 6 SGI 130.0 270.0 585.0 1170.0
2 7 LGI 130.0 270.0 585.0 1170.0
2 7 SGI 144.4 300.0 650.0 1300.0
2 8 LGI 156.0 324.0 702.0 1404.0
2 8 SGI 173.3 360.0 780.0 1560.0
2 9 LGI not used 360.0 780.0 1560.0
2 9 SGI not used 400.0 866.7 1733.3
3 0 LGI 19.5 40.5 87.8 175.5
3 0 SGI 21.7 45.0 97.5 195.0
3 1 LGI 39.0 81.0 175.5 351.0
3 1 SGI 43.3 90.0 195.0 390.0
3 2 LGI 58.5 121.5 263.3 526.5
3 2 SGI 65.0 135.0 292.5 585.0
3 3 LGI 78.0 162.0 351.0 702.0
3 3 SGI 86.7 180.0 390.0 780.0
3 4 LGI 117.0 243.0 526.5 1053.0
3 4 SGI 130.0 270.0 585.0 1170.0
3 5 LGI 156.0 324.0 702.0 1404.0
3 5 SGI 173.3 360.0 780.0 1560.0
3 6 LGI 175.5 364.5 not used 1579.5
3 6 SGI 195.0 405.0 not used 1755.0
3 7 LGI 195.0 405.0 877.5 1755.0
3 7 SGI 216.7 450.0 975.0 1950.0
3 8 LGI 234.0 486.0 1053.0 2106.0
3 8 SGI 260.0 540.0 1170.0 2340.0
3 9 LGI 260.0 540.0 1170.0 not used
3 9 SGI 385.2 600.0 1300.0 not used
4 0 LGI 26.0 54.0 117.0 234.0
4 0 SGI 28.9 60.0 130.0 260.0
4 1 LGI 52.0 108.0 234.0 468.0
4 1 SGI 57.8 120.0 260.0 520.0
4 2 LGI 78.0 162.0 351.0 702.0
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4 2 SGI 86.7 180.0 390.0 780.0
4 3 LGI 104.0 216.0 468.0 936.0
4 3 SGI 115.6 240.0 520.0 1040.0
4 4 LGI 156.0 324.0 702.0 1404.0
4 4 SGI 173.3 360.0 780.0 1560.0
4 5 LGI 208.0 432.0 936.0 1872.0
4 5 SGI 231.1 480.0 1040.0 2080.0
4 6 LGI 234.0 486.0 1053.0 2106.0
4 6 SGI 260.0 540.0 1170.0 2340.0
4 7 LGI 260.0 540.0 1170.0 2340.0
4 7 SGI 288.9 600.0 1300.0 2600.0
4 8 LGI 312.0 648.0 1404.0 2808.0
4 8 SGI 346.7 720.0 1560.0 3120.0
4 9 LGI not used 720.0 1560.0 3120.0
4 9 SGI not used 800.0 1733.3 3466.7
5 0 LGI 32.5 67.5 146.3 292.5
5 0 SGI 36.1 75.0 162.5 325.0
5 1 LGI 65.0 135.0 292.5 585.0
5 1 SGI 72.2 150.0 325.0 650.0
5 2 LGI 97.5 202.5 438.8 877.5
5 2 SGI 108.3 225.0 487.5 975.0
5 3 LGI 130.0 270.0 585.0 1170.0
5 3 SGI 144.4 300.0 650.0 1300.0
5 4 LGI 195.0 405.0 877.5 1755.0
5 4 SGI 216.7 450.0 975.0 1950.0
5 5 LGI 260.0 540.0 1170.0 2340.0
5 5 SGI 288.9 600.0 1300.0 2600.0
5 6 LGI 292.5 607.5 1316.3 2632.5
5 6 SGI 325.0 675.0 1462.5 2925.0
5 7 LGI 325.0 675.0 1462.5 2925.0
5 7 SGI 361.1 750.0 1625.0 3250.0
5 8 LGI 390.0 810.0 1755.0 3510.0
5 8 SGI 433.3 900.0 1950.0 3900.0
5 9 LGI not used 900.0 1950.0 3900.0
5 9 SGI not used 1000.0 2166.7 4333.3
6 0 LGI 39.0 81.0 175.5 351.0
6 0 SGI 43.3 90.0 195.0 390.0
6 1 LGI 78.0 162.0 351.0 702.0
6 1 SGI 86.7 180.0 390.0 780.0
6 2 LGI 117.0 243.0 526.5 1053.0
6 2 SGI 130.0 270.0 585.0 1170.0
6 3 LGI 156.0 324.0 702.0 1404.0
6 3 SGI 173.3 360.0 780.0 1560.0
6 4 LGI 234.0 486.0 1053.0 2106.0
6 4 SGI 260.0 540.0 1170.0 2340.0
6 5 LGI 312.0 648.0 1404.0 2808.0
6 5 SGI 346.7 720.0 1560.0 3120.0
6 6 LGI 351.0 729.0 1579.5 3159.0
6 6 SGI 390.0 810.0 1755.0 3510.0
6 7 LGI 390.0 810.0 1755.0 3510.0
6 7 SGI 433.3 900.0 1950.0 3900.0
6 8 LGI 468.0 972.0 2106.0 4212.0
6 8 SGI 520.0 1080.0 2340.0 4680.0
6 9 LGI 520.0 1080.0 not used 4680.0
6 9 SGI 674.1 1200.0 not used 5200.0
7 0 LGI 45.5 94.5 204.8 409.5
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7 0 SGI 50.6 105.0 227.5 455.0
7 1 LGI 91.0 189.0 409.5 819.0
7 1 SGI 101.1 210.0 455.0 910.0
7 2 LGI 136.5 283.5 614.3 1228.5
7 2 SGI 151.7 315.0 682.5 1365.0
7 3 LGI 182.0 378.0 819.0 1638.0
7 3 SGI 202.2 420.0 910.0 1820.0
7 4 LGI 273.0 567.0 1228.5 2457.0
7 4 SGI 303.3 630.0 1365.0 2730.0
7 5 LGI 364.0 756.0 1638.0 3276.0
7 5 SGI 404.4 840.0 1820.0 3640.0
7 6 LGI 409.5 850.5 not used 3685.5
7 6 SGI 455.0 945.0 not used 4095.0
7 7 LGI 455.0 945.0 2047.5 4095.0
7 7 SGI 505.6 1050.0 2275.0 4550.0
7 8 LGI 546.0 1134.0 2457.0 4914.0
7 8 SGI 606.7 1260.0 2730.0 5460.0
7 9 LGI not used 1260.0 2730.0 5460.0
7 9 SGI not used 1400.0 3033.3 6066.7
8 0 LGI 52.0 108.0 234.0 468.0
8 0 SGI 57.8 120.0 260.0 520.0
8 1 LGI 104.0 216.0 468.0 936.0
8 1 SGI 115.6 240.0 520.0 1040.0
8 2 LGI 156.0 324.0 702.0 1404.0
8 2 SGI 173.3 360.0 780.0 1560.0
8 3 LGI 208.0 432.0 936.0 1872.0
8 3 SGI 231.1 480.0 1040.0 2080.0
8 4 LGI 312.0 648.0 1404.0 2808.0
8 4 SGI 346.7 720.0 1560.0 3120.0
8 5 LGI 416.0 864.0 1872.0 3744.0
8 5 SGI 462.2 960.0 2080.0 4160.0
8 6 LGI 468.0 972.0 2106.0 4212.0
8 6 SGI 520.0 1080.0 2340.0 4680.0
8 7 LGI 520.0 1080.0 2340.0 4680.0
8 7 SGI 577.8 1200.0 2600.0 5200.0
8 8 LGI 624.0 1296.0 2808.0 5616.0
8 8 SGI 693.3 1440.0 3120.0 6240.0
8 9 LGI not used 1440.0 3120.0 6240.0
8 9 SGI not used 1600.0 3466.7 6933.3

 

802.11ax MCS Index
 l Threshold: Minimum Tx MCS Index required

 l Default value: 11

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

This requirement allows you to view precisely   which areas of the current survey data file meet the requirements specified   by 

the Minimum Tx MCS Index required threshold.  Areas that meet   the requirement are displayed in light green ( ), whereas   
regions that do not reach the required MCS are displayed in a color assigned   by the color-codes on the legend.  Hover the 
mouse over any given   point to view a bubble help pop-up that displays detailed information   about the APs detected at that 
location.
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Background

802.11ax has a similar modulation and coding set (MCS) as 802.11ac with   two additional modulations, 1024-QAM 3/4 and 
1024-QAM 5/6. However, 802.11ax   uses a fixed 0.8 µs Guard Interval for indoor environments. The following   table illustrates 
the possible combinations of MCS, Spatial Stream number,   and Channel Widths.

802.11ax MCS     
Index

Spatial     
Stream

20     MHz Channel PHY 
Data Rate

40     MHz Channel PHY 
Data Rate

80     MHz Channel PHY 
Data Rate

160     MHz Channel 
PHY Data Rate

0 1 8.6 17.2 36 72.1
1 1 17.2 34.4 72.1 144.1
2 1 25.8 51.6 108.1 216.2
3 1 34.4 68.8 144.1 288.2
4 1 51.6 103.2 216.2 432.4
5 1 68.8 137.6 288.2 576.5
6 1 77.4 154.9 324.3 648.5
7 1 86 172.1 360.3 720.6
8 1 103.2 206.5 432.4 864.7
9 1 114.7 229.4 480.4 960.8

10 1 129 258.1 540.4 1080.9
11 1 143.4 286.8 600.5 1201

0 2 17.2 34.4 72.1 144.1
1 2 34.4 68.8 144.1 288.2
2 2 51.6 103.2 216.2 432.4
3 2 68.8 137.6 288.2 576.5
4 2 103.2 206.5 432.4 864.7
5 2 137.6 275.3 576.5 1152.9
6 2 154.9 309.7 648.5 1297.1
7 2 172.1 344.1 720.6 1441.2
8 2 206.5 412.9 864.7 1729.4
9 2 229.4 458.8 960.8 1921.6

10 2 258.1 516.2 1080.9 2161.8
11 2 286.8 573.5 1201 2402

0 3 25.8 51.6 108.1 216.2
1 3 51.6 103.2 216.2 432.4
2 3 77.4 154.9 324.3 648.5
3 3 103.2 206.5 432.4 864.7
4 3 154.9 309.7 648.5 1297.1
5 3 206.5 412.9 864.7 1729.4
6 3 232.3 464.6 972.8 1945.6
7 3 258.1 516.2 1080.9 2161.8
8 3 309.7 619.4 1297.1 2594.1
9 3 344.1 688.2 1441.2 2882.4

10 3 387.1 774.3 1621.3 3242.6
11 3 430.1 860.3 1801.5 3602.9

0 4 34.4 68.8 144.1 288.2
1 4 68.8 137.6 288.2 576.5
2 4 103.2 206.5 432.4 864.7
3 4 137.6 275.3 576.5 1152.9
4 4 206.5 412.9 864.7 1729.4
5 4 275.3 550.6 1152.9 2305.9
6 4 309.7 619.4 1297.1 2594.1
7 4 344.1 688.2 1441.2 2882.4
8 4 412.9 825.9 1729.4 3458.8
9 4 458.8 917.6 1921.6 3843.1
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10 4 516.2 1032.4 2161.8 4323.5
11 4 573.5 1147.1 2402 4803.9

0 5 43 86 180.1 360.3
1 5 86 172.1 360.3 720.6
2 5 129 258.1 540.4 1080.9
3 5 172.1 344.1 720.6 1441.2
4 5 258.1 516.2 1080.9 2161.8
5 5 344.1 688.2 1441.2 2882.4
6 5 387.1 774.3 1621.3 3242.6
7 5 430.1 860.3 1801.5 3602.9
8 5 516.2 1032.4 2161.8 4323.5
9 5 573.5 1147.1 2402 4803.9

10 5 645.2 1290.4 2702.2 5404.4
11 5 716.9 1433.8 3002.5 6004.9

0 6 51.6 103.2 216.2 432.4
1 6 103.2 206.5 432.4 864.7
2 6 154.9 309.7 648.5 1297.1
3 6 206.5 412.9 864.7 1729.4
4 6 309.7 619.4 1297.1 2594.1
5 6 412.9 825.9 1729.4 3458.8
6 6 464.6 929.1 1945.6 3891.2
7 6 516.2 1032.4 2161.8 4323.5
8 6 619.4 1238.8 2594.1 5188.2
9 6 688.2 1376.5 2882.4 5764.7

10 6 774.3 1548.5 3242.6 6485.3
11 6 860.3 1720.6 3602.9 7205.9

0 7 60.2 120.4 252.2 504.4
1 7 120.4 240.9 504.4 1008.8
2 7 180.7 361.3 756.6 1513.2
3 7 240.9 481.8 1008.8 2017.6
4 7 361.3 722.6 1513.2 3026.5
5 7 481.8 963.5 2017.6 4035.3
6 7 542 1084 2269.9 4539.7
7 7 602.2 1204.4 2522.1 5044.1
8 7 722.6 1445.3 3026.5 6052.9
9 7 802.9 1605.9 3362.7 6725.5

10 7 903.3 1806.6 3783.1 7566.2
11 7 1003.7 2007.4 4203.4 8406.9

0 8 68.8 137.6 288.2 576.5
1 8 137.6 275.3 576.5 1152.9
2 8 206.5 412.9 864.7 1729.4
3 8 275.3 550.6 1152.9 2305.9
4 8 412.9 825.9 1729.4 3458.8
5 8 550.6 1101.2 2305.9 4611.8
6 8 619.4 1238.8 2594.1 5188.2
7 8 688.2 1376.5 2882.4 5764.7
8 8 825.9 1651.8 3458.8 6917.6
9 8 917.6 1835.3 3843.1 7686.3

10 8 1032.4 2064.7 4323.5 8647.1
11 8 1147.1 2294.1 4803.9 9607.8
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Channel Interference
 l Threshold: Min Signal to Interference, Min Signal of interferer

 l Default value: -75, -85

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for Channel Interference   are displayed in light green ( ).  Areas that do   
not meet the requirement are displayed according to the color code on   the slider bar on the right-hand side of the view. Let 
the mouse hover   over any point of the map to show additional details.

Important:   AirMagnet Survey measures interference from the point of view of a particular   AP. This means that AirMagnet 
shows a cumulative view of all the   various Wi-Fi sources that are interfering with that one AP. Therefore,   make sure that you 
deselect all APs that are not the focus of your investigation. (Use   the device tree on the left side of the screen). Note that 
signals from deselected devices are   still considered when determining interference to other APs.

Background

Interference represents a serious threat to the performance of a wireless   network. The most common source of interference is 
co-channel interference,   which is caused by wireless access points that are operating on the same   channel or on an 
overlapping channel.

Networks should be designed to avoid co-channel interference whenever   possible. It is important to note that there are 
technically 11 or more   channels in the 802.11b/g spectrum, that only 3 of those channels are   non-overlapping. For this 
reason, most networks are designed to use an   arrangement of Channel 1, Channel 6, and Channel 11 to minimize   inter-
ference.

Site Surveyors should also note that interference is cumulative in nature.   Several weak sources of interference can combine 
to create a large overall   interference for a specific AP. For this reason, AirMagnet Survey always   shows the total interference 
from the perspective of a single AP. When you select   an AP of interest, you can see the total distribution of interference   for 
that single device.

Channel Width

Threshold: Allowed or Not Allowed

Default values: 40, 80 and 160 MHz Allowed; 20 MHz and 20 MHz HT Not   Allowed

Pass/Fail default value: 100%

Requirement Explanation

This requirement lets you view the various channel widths detected   in the survey data file in use. For example, if the wireless 
network   being installed must support only 40 MHz channels,   set the Thresholds to "Allowed" for the 40 MHz and "Not   
allowed" for 20 MHz, 20 MHz HT,   80 MHz, and 160 MHz. After loading the desired survey data,   the AirWISE view would show 
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you whether the data meets the requirements.    The heatmap shows a light green ( ) color for   passing and red ( ) for 
failing.   This requirement is pass or fail based.

Background

Legacy 802.11 systems operate on channels that are 20 MHz wide (actually   the channels are 22 MHz wide even though they 
are generally referred to   as 20 MHz). 802.11n defines both 20-MHz and 40-MHz-wide channel operation.   When operating in 40-
MHz mode, the capacity of the channel is effectively   double that of legacy systems. One may liken this to “doubling the 
number   of lanes on a freeway so that twice as many cars may pass through”.

The fourteen 802.11 channels in the 2.4 GHz band (eleven usable channels   in the US) are spaced 5 MHz apart, with center 
frequencies from 2412 MHz   to 2477 MHz.  

RF channels do not have exact edges. The modulated portion of a (20-MHz)   802.11 RF signal “falls” into +/- 11 MHz of the 
center frequency (thus,   it is 22 MHz wide); there is however some “bleed over”, or unmodulated   RF energy that is present to 
about +/- 30 MHz of the center frequency   (at relatively much lower power levels). The spectrum mask defines how   much RF 
energy may be present outside the channel boundary of +/- 11 MHz.    

An 802.11 transmission thus “takes up” 5 channels (the center, two left   adjacent and two right adjacent channels). Depending 
on transmit power   and receiver sensitivity, a transmission may even cause interference on   several additional channels (up to 
5 away from the center).

For instance, a device transmitting on channel 6 would certainly cause   significant interference on channels 5 and 7; some 
interference on   channels 4 and 8; and might cause (usually negligible) interference   on channels 2, 3, 9, and 10. This is why, in 
FCC regulated domains,   there are effectively just 3 simultaneously usable 802.11 20-MHz channels   in the 2.4 GHz band. A 
typical North American 802.11 b/g deployment   places APs on channels 1, 6 and 11 to cope with “bleed over”. This channel   
deployment scheme allows APs in close proximity to each other to minimize   interference with each other.

Operating in 40-MHz mode in the 2.4 GHz band makes this problem worse. The 40-MHz spectrum mask (necessarily)   allows 
higher signal energy to be present on adjacent channels, as shown in the graph below.
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Thus, a 40-MHz 802.11 transmission in the 2.4 GHz band takes up 9 channels   (the center, four left adjacent and four right 
adjacent channels). Thus, the 40-MHz transmission in the 2.4 GHz band (where there are only 11 usable channels) could cause   
problems because a single transmission could use more than 80% of   the available spectrum in the band. Additionally, the 2.4 
GHz band is much more crowded than the 5 GHz band because stations operating in the 2.4 GHz band must also contend 
with Bluetooth   devices, microwave ovens, and other common sources of 2.4 GHz interference,   such as cordless phones. 
Coexistence mechanisms can help reduce but not eliminate the problem in this band.

Fortunately, 802.11n allows operating in both the 2.4- and 5 GHz bands,   and 802.11ac operates exclusively in the 5 GHz band. 
In most regulatory   domains, there are many more usable channels in the 5 GHz band and the   channels are spaced 20 MHz 
apart. This provides for much more “room” for   40-, 80- and 160-MHz wide channel operation. 

802.11n/ac/ax APs and STAs exchange information about what channel widths   are supported using HT or VHT Information 
Element and HT, VHT, or HE Capabilities   Element frame fields. APs operating a 40-MHz BSS must continuously monitor   the 
environment for legacy or non-40 MHz capable HT STAs in both the primary   and secondary channels.

Note:   The scenario below describes some possible causes behind a network that   is designed to implement 40 MHz operation but 
has other channel widths   in use detected during the survey.

Thresholds: 40 MHz Allowed, 20 MHz HT and 20 MHz Not Allowed

Symptom: 40 MHz channel width is allowed but you are detecting 20 MHz   HT or 20 MHz in use.

Possible diagnoses:
 l Interference detected in the secondary    channel by AP/STA: The APs (and/or STA) have determined that    there is too 

much interference in the secondary channel to effectively    use both the primary and secondary channels. You must then 
determine    which 802.11 devices may be causing this interference. Using    AirMagnet Spectrum Analyzer may also help to 
identify non-802.11 interference    in the secondary channel.
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 l Associated STAs do not support 40    MHz transmission: One or more Stations    which are associated to the AP do not 
support 40 MHz operation, which    causes 40 MHz AP/STAs to use protection protocols for 40 MHz transmissions.     Review 
the survey data to determine exactly which APs are operating    in 20 MHz mode. You can then examine the Stations around 
those APs    to determine which station is causing the network to fall back into    20 MHz channel usage.

 l 40 MHz Intolerant announced:    An AP or STA in this or a neighboring BSS has broadcast "40    MHz Intolerant". An AP broad-
casts this when it does not allow    40 MHz transmissions in neighboring BSSs.  A STA broadcasts this    to indicate to its asso-
ciated AP that the AP is required to restrict    the use of 40 MHz transmissions in its BSS. The AirMagnet Wi-Fi    Analyzer 
product can help to analyze the 40 MHz Intolerant announcements    via the coexistence section of the Efficiency Analysis 
Tool.

Cisco Location-based Services
 l Threshold: Number of placed APs required to provide coverage, AP signal   strength required to provide coverage

 l Default Value: 3, -75

 l Minimum APs: 3, Maximum APs: 16

 l Minimum signal strength: -85 dBm, Maximum signal strength: 0

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

If three APs or more, that are placed on the floor plan, create a "convex   hull" configuration (see diagram below) and meet the 
requirements   for location-based services coverage (readiness), the convex hull area displays as green. The non-compliant 
area (outside the hull)   displays as pink.

The creation of a convex hull requires at least three placed APs on   the floor plan to form the hull. In addition, any location 
point in   the hull must not have a signal strength weaker than the defined minimum   signal strength value (based on the 
placed APs).  Both of these requirements   must be met in order for the hull to be considered "ready" for   location-based 
services.

However, if signal strength drops below the minimum requirement and/or   AP count drops below the requirement inside the 
hull, these locations   are color-coded as indicated by the legend.

To view areas in terms of AP count, click the "Number of placed   APs required to provide coverage" row in the thresholds area, 
just   below this view. To see how close the actual AP signal is to your requirement,   click the "AP signal strength required to 
provide coverage"   row in the thresholds area. Let the mouse hover over any point of the   map to show additional details. For 
the purpose of this requirement, any   placed APs closer together than one meter are considered as one physical   AP.

The “% of Good Area” indicates the area of the floor plan that meets   the requirements. To determine the percentage of good 
area in the   convex hull you may use the “Arbitrary Region Tool” to outline the convex   hull and create a region.

Note: After conducting   a survey, you must place all the APs intended for Cisco Location-based   services on the floor plan. See 
Channel/SSID   List.

Legend explanation

Item Description
Green Both the number of APs and signal strength threshold criteria     are met.
Pink Area outside the convex hull.
Silver (gray) All the APs meet the signal strength threshold; however, the     number of APs requirement is 

not met.
With Signal Strength require-
ment selected.

Colors besides green or gray inside the hull indicate the strongest     signal strength in areas 
where the AP requirement and/or signal     strength threshold are not met.

With AP requirement selected. Colors (besides green) indicate areas where either the total     number of APs making up the 
hull falls below the requirement or     the number of APs providing the required signal 
strength coverage     falls below the requirement.

Background

Location-based services generally involve determining the geographical   location of assets or persons. Some applications of 
location-based services   include RFID tracking solutions; location monitoring of Voice-over-Wi-Fi   phones; and locating rogue 
access points.

- 172 -



AirWISE View

Proper placement of access points is an important consideration for   planning location-based services (such as a location-
aware Cisco Unified   Wireless Network).

This policy applies the "convex hull" technique for determining   compliance. The convex hull technique involves establishing a 
perimeter   of at least three placed APs in which one could imagine a rubber band   wrapped around the "outside" APs. As you 
move an AP, the perimeter   border (rubber band) adjusts accordingly.

The interior area encompassed by this band can be considered as possessing   high potential for good location accuracy. As 
tracked devices stray into   the area outside the convex hull, accuracy can beg into deteriorate.

Cisco recommendations

This section contains an excerpt from "Best Practices—Location-Aware   WLAN Design Considerations" Used by permission © 
Cisco, Inc. All   rights reserved.

For Cisco "Location-aware" deployments, Cisco recommends that   designs that make use of only clustered or straight-line 
access point   placement should be augmented or redesigned in favor of those that combine   center access-point placement 
with perimeter and corner placement.

If possible, mount antennas such that they have an unencumbered 360º   view of all areas around them, without being blocked 
at close range by   large objects. For example, if possible, avoid placing access point antennas   directly against large objects 
such as steel columns. One option is to   mount the access point along with its antennas to a ceiling location (provided   that 
this allows an acceptable mounting height). Another option is to   use short, low loss cable extension to allow separation 
between antennas   and such obstructions.

In general, for access points deployed indoors at antenna heights of   20 feet or less, the range of any point on the floor to at 
least three   detecting access points on that floor (one in each of at least three of   the four quadrants surrounding it) is 
maintained in approximately   70 feet in an indoor environment. This is a general recommendation that   is intended to assist 
designers in avoiding situations where excessive   inter-access point distance may be a contributing factor to location 
inaccuracy.

Corrective Actions

You have 3 basic options to insure location-based coverage readiness:

 l Increase the transmit power of existing APs

 l Reposition APs to meet requirements

 l Add additional APs
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Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of 
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and 
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the 
environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve 
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should   have a clear “line of site” to the areas they serve. Installing   APs on the ceiling or high 
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the 
environment and   configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.

iPerf Throughput Up
Threshold: Min iPerf throughput up

Default value: 24.0

Pass/Fail default value: 100%

Requirement Explanation

Areas of the map that meet the current requirement for Min iPerf throughput are displayed in light green ( ). Areas that do 
not meet the requirement are displayed according to the   color code on the slider bar on the right-hand side of the view. This   
scale is shown in terms of Mbps. Let the mouse hover over any point of   the heatmap to show additional details.

Background

Throughput provides a direct insight into how well the network supports a real-world end-user client. An Active iPerf Survey is 
required   to obtain throughput data. A low throughput rate directly translates   to lower performance for an end-user. Con-
sistently low throughput speeds   are indicative of either insufficient signal coverage, interference, noise,   or misconfigured 
wireless devices.

The throughput speeds supported by each of the 802.11 protocols are   listed below:

802.11 Standard Supported Speeds (in Mbps)
802.11b 1, 2, 5.5, 11
802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54
802.11a 6, 9, 12, 18, 24, 36, 48, 54
802.11n 1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50,     14.40, 15.00, 18.00, 19.50, 21.70, 24.00, 26.00, 

27.00, 28.90,     30.00, 36.00, 39.00, 40.50, 43.30, 45.00, 48.00, 52.00, 54.00, 57.80, 58.50, 60.00, 65.00, 72.20, 
78.00, 81.00, 86.70, 90.00,     104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 130.00, 135.00,     144.40, 150.00, 
156.00, 162.00, 173.30, 175.50, 180.00, 195.00,     208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 
260.00,     270.00, 288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00,     450.00, 480.00, 486.00, 540.00, 600.00

802.11ac 6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9,     29.3, 30.0, 32.5, 39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 
57.8, 58.5,     60.0, 65.0, 72.2, 78.0, 81.0, 86.7, 87.8, 90.0, 97.5, 104.0, 108.0,     115.6, 117.0, 120.0, 121.5, 130.0, 
135.0, 144.4, 150.0, 156.0,     162.0, 173.3, 175.5, 180.0, 195.0, 200.0, 216.0, 216.7, 234.0,     240.0, 243.0, 260.0, 
263.3, 270.0, 292.5, 300.0, 324.0, 325.0,     351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 433.3, 450.0,     468.0, 
486.0, 520.0, 526.5, 540.0, 585.0, 600.0, 650.0, 702.0,     780.0, 866.7, 877.5, 975.0, 1053.0, 1170.0, 1300.0

802.11ax 8.6,     17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2,     108.1, 114.7, 120.4, 129, 137.6, 143.4, 
144.1, 154.9, 172.1, 180.1,     180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 275.3,     286.8, 288.2, 309.7, 
324.3, 344.1, 360.3, 361.3, 387.1, 412.9,     430.1, 432.4, 458.8, 464.6, 480.4, 481.8, 504.4, 516.2, 540.4,     542, 
550.6, 573.5, 576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 688.2,     716.9, 720.6, 722.6, 756.6, 774.3, 802.9, 825.9, 
860.3, 864.7,     903.3, 917.6, 929.1, 960.8, 963.5, 972.8, 1003.7, 1008.8, 1032.4,     1080.9, 1084, 1101.2, 1147.1, 
1152.9, 1201, 1204.4, 1238.8, 1290.4,     1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9,     1621.3, 
1651.8, 1720.6, 1729.4, 1801.5, 1806.6, 1835.3, 1921.6,     1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 
2294.1, 2305.9,     2402, 2522.1, 2594.1, 2702.2, 2882.4, 3002.5, 3026.5, 3242.6,     3362.7, 3458.8, 3602.9, 3783.1, 
3843.1, 3891.2, 4035.3, 4203.4,     4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 5404.4, 5764.7,     6004.9, 
6052.9, 6485.3, 6725.5, 6917.6, 7205.9, 7566.2, 7686.3,     8406.9, 8647.1, 9607.8

End-user throughput speeds change automatically   from a higher throughput rate to a lower one in response to a deteri-
orating   connection quality. The best method for determining the real-world   throughput at a given location is to perform a 
VoFi Survey. During   a VoFi Survey, the surveyor “follows” the AP’s connection to the phone   and actively collects real 
throughput data.
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iPerf Throughput Down
Threshold: Min iPerf throughput down

Default value: 24.0

Pass/Fail default value: 100%

Requirement Explanation

Areas of the map that meet the current requirement for Min iPerf throughput   are displayed in light green ( ). Areas that do 
not   meet the requirement are displayed according to the color code on the   slider bar on the right-hand side of the view. This 
scale is shown in   terms of Mbps. Let the mouse hover over any point of the map to show additional   details.

Background

Throughput provides a direct insight into how well the network   supports a real-world end-user client. An Active iPerf Survey is 
required   to obtain throughput speed data. A low throughput rate directly   translates to lower performance for an end-user. 
Consistently low throughput   speeds are indicative of either insufficient signal coverage, interference,   noise, or mis-configured 
wireless devices.

The connection speeds supported by each of the 802.11 protocols are   listed below:

802.11 
Standard

Supported Speeds (in Mbps)

802.11b 1, 2, 5.5, 11
802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54
802.11a 6, 9, 12, 18, 24, 36, 48, 54
802.11n 1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50,     14.40, 15.00, 18.00, 19.50, 21.70, 24.00, 26.00, 

27.00, 28.90,     30.00, 36.00, 39.00, 40.50, 43.30, 45.00, 48.00, 52.00, 54.00,     57.80, 58.50, 60.00, 65.00, 72.20, 
78.00, 81.00, 86.70, 90.00,     104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 130.00, 135.00,     144.40, 150.00, 
156.00, 162.00, 173.30, 175.50, 180.00, 195.00,     208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 260.00,     
270.00, 288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00,     450.00, 480.00, 486.00, 540.00, 600.00

802.11ac 6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9,     29.3, 30.0, 32.5, 39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 
57.8, 58.5,     60.0, 65.0, 72.2, 78.0, 81.0, 86.7, 87.8, 90.0, 97.5, 104.0, 108.0,     115.6, 117.0, 120.0, 121.5, 130.0, 
135.0, 144.4, 150.0, 156.0,     162.0, 173.3, 175.5, 180.0, 195.0, 200.0, 216.0, 216.7, 234.0,     240.0, 243.0, 260.0, 
263.3, 270.0, 292.5, 300.0, 324.0, 325.0,     351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 433.3, 450.0,     468.0, 
486.0, 520.0, 526.5, 540.0, 585.0, 600.0, 650.0, 702.0,     780.0, 866.7, 877.5, 975.0, 1053.0, 1170.0, 1300.0

802.11ax 8.6,     17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2,     108.1, 114.7, 120.4, 129, 137.6, 143.4, 144.1, 
154.9, 172.1, 180.1,     180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 275.3,     286.8, 288.2, 309.7, 324.3, 
344.1, 360.3, 361.3, 387.1, 412.9,     430.1, 432.4, 458.8, 464.6, 480.4, 481.8, 504.4, 516.2, 540.4,     542, 550.6, 
573.5, 576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 688.2,     716.9, 720.6, 722.6, 756.6, 774.3, 802.9, 825.9, 860.3, 
864.7,     903.3, 917.6, 929.1, 960.8, 963.5, 972.8, 1003.7, 1008.8, 1032.4,     1080.9, 1084, 1101.2, 1147.1, 1152.9, 
1201, 1204.4, 1238.8, 1290.4,     1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9,     1621.3, 1651.8, 
1720.6, 1729.4, 1801.5, 1806.6, 1835.3, 1921.6,     1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 2294.1, 2305.9,     
2402, 2522.1, 2594.1, 2702.2, 2882.4, 3002.5, 3026.5, 3242.6,     3362.7, 3458.8, 3602.9, 3783.1, 3843.1, 3891.2, 
4035.3, 4203.4,     4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 5404.4, 5764.7,     6004.9, 6052.9, 6485.3, 6725.5, 
6917.6, 7205.9, 7566.2, 7686.3,     8406.9, 8647.1, 9607.8 

End-user connection speeds change automatically   from a higher throughput rate to a lower one in response to a deteri-
orating   connection quality.  The best method for determining the real-world   throughput rate at a given location is to perform 
a VoFi Survey.  During   a VoFi Survey, the surveyor “follows” the AP’s connection to the phone   and actively collects real 
throughput data.

Measured PHY Data Rate Downlink Coverage
 l Threshold: Min Downlink Data Rate Supported

 l Default value: 54.0

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.
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Requirement Explanation

Areas of the map that meet the current requirement for Min Downlink   Data Rate Supported are displayed in light green ( ).   
Areas that do not meet the requirement are displayed according to the   color code on the slider bar on the right-hand side of 
the view. This   scale is shown in terms of Mbps. Let the mouse hover over any point of   the map to show additional details.

Background

Connection data rate provides a direct insight into how well the network   supports a real-world end-user client. An Active iPerf 
Survey is required   to obtain connection speed data. A low connection PHY data rate   directly translates to lower throughput 
and performance for an end-user.   Consistently low connection speeds are indicative of either insufficient   signal coverage, 
interference, noise, or mis-configured wireless devices.

The connection speeds supported by each of the 802.11 protocols are   listed below:

802.11 Standard Supported Speeds (in Mbps)
802.11b 1, 2, 5.5, 11
802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54
802.11a 6, 9, 12, 18, 24, 36, 48, 54
802.11n 1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50,     14.40, 15.00, 18.00, 19.50, 21.70, 24.00, 26.00, 

27.00, 28.90,     30.00, 36.00, 39.00, 40.50, 43.30, 45.00, 48.00, 52.00, 54.00,     57.80, 58.50, 60.00, 65.00, 72.20, 
78.00, 81.00, 86.70, 90.00,     104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 130.00, 135.00,     144.40, 150.00, 
156.00, 162.00, 173.30, 175.50, 180.00, 195.00,     208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 
260.00,     270.00, 288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00,     450.00, 480.00, 486.00, 540.00, 
600.00

802.11ac 6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9,     29.3, 30.0, 32.5, 39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 
57.8, 58.5,     60.0, 65.0, 72.2, 78.0, 81.0, 86.7, 87.8, 90.0, 97.5, 104.0, 108.0,     115.6, 117.0, 120.0, 121.5, 130.0, 
135.0, 144.4, 150.0, 156.0,     162.0, 173.3, 175.5, 180.0, 195.0, 200.0, 216.0, 216.7, 234.0,     240.0, 243.0, 260.0, 
263.3, 270.0, 292.5, 300.0, 324.0, 325.0,     351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 433.3, 450.0,     468.0, 
486.0, 520.0, 526.5, 540.0, 585.0, 600.0, 650.0, 702.0,     780.0, 866.7, 877.5, 975.0, 1053.0, 1170.0, 1300.0

802.11ax 8.6,     17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2,     108.1, 114.7, 120.4, 129, 137.6, 143.4, 
144.1, 154.9, 172.1, 180.1,     180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 275.3,     286.8, 288.2, 309.7, 
324.3, 344.1, 360.3, 361.3, 387.1, 412.9,     430.1, 432.4, 458.8, 464.6, 480.4, 481.8, 504.4, 516.2, 540.4,     542, 
550.6, 573.5, 576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 688.2,     716.9, 720.6, 722.6, 756.6, 774.3, 802.9, 825.9, 
860.3, 864.7,     903.3, 917.6, 929.1, 960.8, 963.5, 972.8, 1003.7, 1008.8, 1032.4,     1080.9, 1084, 1101.2, 1147.1, 
1152.9, 1201, 1204.4, 1238.8, 1290.4,     1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9,     1621.3, 
1651.8, 1720.6, 1729.4, 1801.5, 1806.6, 1835.3, 1921.6,     1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 
2294.1, 2305.9,     2402, 2522.1, 2594.1, 2702.2, 2882.4, 3002.5, 3026.5, 3242.6,     3362.7, 3458.8, 3602.9, 3783.1, 
3843.1, 3891.2, 4035.3, 4203.4,     4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 5404.4, 5764.7,     6004.9, 
6052.9, 6485.3, 6725.5, 6917.6, 7205.9, 7566.2, 7686.3,     8406.9, 8647.1, 9607.8

End-user connection speeds change automatically from a higher connection   data rate to a lower one in response to a deteri-
orating connection quality.    The best method for determining the real-world connection data rate   at a given location is to 
perform a VoFi Survey.  During a VoFi Survey,   the surveyor “follows” the AP’s connection to the phone and actively collects   
real connection data such as connection data rate.

Measured PHY Data Rate Uplink Coverage
 l Threshold: Min Uplink Data Rate Supported

 l Default value: 5.5

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for Min Uplink Data   Rate Supported are displayed in light green ( ). 
Areas   that do not meet the requirement are displayed according to the color   code on the slider bar on the right-hand side of 
the view. This scale   is shown in terms of Mbps. Let the mouse hover over any point of the map   to show additional details.
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Background

Connection data rate provides a direct insight into how well the network supports a real-world end-user client. An Active 
Survey is required   to obtain connection speed data. A low connection PHY data rate   directly translates to lower throughput 
and performance for an end-user.   Consistently low connection speeds are indicative of either insufficient   signal coverage, 
interference, noise, or mis-configured wireless devices.

The connection speeds supported by each of the 802.11 protocols are   listed below:

802.11 
Standard

Supported Speeds (in Mbps)

802.11b 1, 2, 5.5, 11
802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54
802.11a 6, 9, 12, 18, 24, 36, 48, 54
802.11n 1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50,     14.40, 15.00, 18.00, 19.50, 21.70, 24.00, 26.00, 

27.00, 28.90,     30.00, 36.00, 39.00, 40.50, 43.30, 45.00, 48.00, 52.00, 54.00,     57.80, 58.50, 60.00, 65.00, 72.20, 
78.00, 81.00, 86.70, 90.00,     104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 130.00, 135.00,     144.40, 150.00, 
156.00, 162.00, 173.30, 175.50, 180.00, 195.00,     208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 260.00,     
270.00, 288.90, 300.00, 324.00, 360.00, 364.50, 405.00, 432.00,     450.00, 480.00, 486.00, 540.00, 600.00

802.11ac 6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9,     29.3, 30.0, 32.5, 39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 
57.8, 58.5,     60.0, 65.0, 72.2, 78.0, 81.0, 86.7, 87.8, 90.0, 97.5, 104.0, 108.0,     115.6, 117.0, 120.0, 121.5, 130.0, 
135.0, 144.4, 150.0, 156.0,     162.0, 173.3, 175.5, 180.0, 195.0, 200.0, 216.0, 216.7, 234.0,     240.0, 243.0, 260.0, 
263.3, 270.0, 292.5, 300.0, 324.0, 325.0,     351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 433.3, 450.0,     468.0, 
486.0, 520.0, 526.5, 540.0, 585.0, 600.0, 650.0, 702.0,     780.0, 866.7, 877.5, 975.0, 1053.0, 1170.0, 1300.0

802.11ax 8.6,     17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2,     108.1, 114.7, 120.4, 129, 137.6, 143.4, 144.1, 
154.9, 172.1, 180.1,     180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 275.3,     286.8, 288.2, 309.7, 324.3, 
344.1, 360.3, 361.3, 387.1, 412.9,     430.1, 432.4, 458.8, 464.6, 480.4, 481.8, 504.4, 516.2, 540.4,     542, 550.6, 573.5, 
576.5, 600.5, 602.2, 619.4, 645.2, 648.5, 688.2,     716.9, 720.6, 722.6, 756.6, 774.3, 802.9, 825.9, 860.3, 864.7,     
903.3, 917.6, 929.1, 960.8, 963.5, 972.8, 1003.7, 1008.8, 1032.4,     1080.9, 1084, 1101.2, 1147.1, 1152.9, 1201, 
1204.4, 1238.8, 1290.4,     1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9,     1621.3, 1651.8, 1720.6, 
1729.4, 1801.5, 1806.6, 1835.3, 1921.6,     1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 2294.1, 2305.9,     2402, 
2522.1, 2594.1, 2702.2, 2882.4, 3002.5, 3026.5, 3242.6,     3362.7, 3458.8, 3602.9, 3783.1, 3843.1, 3891.2, 4035.3, 
4203.4,     4323.5, 4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 5404.4, 5764.7,     6004.9, 6052.9, 6485.3, 6725.5, 6917.6, 
7205.9, 7566.2, 7686.3,     8406.9, 8647.1, 9607.8

End-user connection speeds change automatically   from a higher connection data rate to a lower one in response to a deteri-
orating   connection quality.  The best method for determining the real-world   connection data rate at a given location is to 
perform a VoFi Survey.    During a VoFi Survey, the surveyor “follows” the AP’s connection   to the phone and actively collects 
real connection data such as connection   data rate.

Multiple AP Signal Coverage
 l Threshold: Min No. of AP, Min Signal

 l Default value: 2, -67

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirements for AP coverage   are displayed in light green ( ). This requirement 
contains   two requirements. One requirement is based on the number of APs present   in the area, and the second is based on 
the minimum signal required of   the present APs. Both of these requirements must be met to be   considered compliant. Either 
of these requirements can be shown for non-compliant   areas of the map. To view problem areas in terms of AP count, click 
the   Minimum Number of APs row in the thresholds area, just below the main   view. To see how close the actual AP signal is to 
meeting your requirement,   click the Minimum Signal row in the thresholds area. Let the mouse hover   over any point of the 
map to show additional details.

Background

Wireless networks with stringent performance requirements should insure   that all areas are served by at least two access 
points on non-overlapping   channels. Each of these APs should meet the minimum signal requirement   for the network 
(typically between -67 dBm and -75 dBm). In the 2.4 GHz   band, only channels 1, 6, and 11 are considered non-overlapping.
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Corrective Actions

You have 3 basic options to insure location-based coverage readiness:

 l Increase the transmit power of existing APs

 l Reposition APs to meet requirements

 l Add additional APs

Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of 
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and 
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the 
environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve 
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should   have a clear “line of site” to the areas they serve. Installing   APs on the ceiling or high 
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the 
environment and   configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.

Noise Level
 l Threshold: Max Noise Level

 l Default value: -90

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for noise are displayed   in light green ( ). Areas that   do not meet the 
requirement are displayed using the color code on the   slider bar on the right-hand side of the view. Noise levels are displayed   
in dBm with areas of highest noise shown in red. Let the mouse hover over   any point of the map to show additional details.

Background

Any energy in the Wi-Fi spectrum that is not recognized as 802.11 traffic   is considered noise. High levels of environmental 
noise interfere   with 802.11 signals and lead to serious performance problems for the wireless   network.

Noise is a very common problem especially in the 2.4 GHz band that supports   802.11b, 802.11g, and 802.11n. The 2.4 GHz 
band is “unlicensed” and is   commonly used by a variety of technologies including Bluetooth, cordless   phones, frequency 
hopping devices, wireless cameras, and more. Other devices   such as microwave ovens can emit noise simply as a byproduct 
of their   normal operation.

Like signal, noise is measured in units of “dBm”, with a signal of 0   dBm being the strongest, and signals of -100 dBm and 
below being the lowest.   The maximum acceptable noise depends on the requirements of the network.   As a general rule, a 
wireless network should aim to keep noise levels   below -85 dBm for normal data traffic, and under -90 dBm for networks   that 
support voice.

Corrective Actions

High environmental noise can be addressed either by removing the source   of the noise, or avoiding it by moving 802.11 traffic 
to a less noisy   portion of the Wi-Fi spectrum. However, avoidance of noise may not always   be an option. To remove the 
source of noise, technical staff must identify   the noise source. This is most reliably done with a tool such as the AirMagnet   
Spectrum Analyzer, which can analyze the waveform of the noise to pin   down a unique source of the noise.

Operating Mode
 l Threshold: Allowed or Not Allowed

 l Default values: Greenfield, Mixed VHT, and Mixed HE Allowed; Mixed and   Legacy Not Allowed

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.
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Requirement Explanation

The requirement is triggered by any 802.11n, 802.11ac, or 802.11ax networks   that fall outside of the selected threshold 
settings. For example if the   Wireless network being surveyed is designed to provide "Very High   Throughput” (VHT), then the 
Threshold setting would be set to "Allowed"   for the VHT Operating Mode and Not Allowed for the remaining thresholds.   After 
completing the Survey by using the AirWise section one can determine   if the desired network environment is actually in 

place. The heatmap   shows a light green ( ) color   for passing and red ( ) for   failing.  This requirement is a pass or fail 
based threshold

Background

The PHY- and MAC-layer improvements introduced in the 802.11n amendment   and extended in the 802.11ac and 802.11ax 
amendment brings Wi-Fi network   performance to an unprecedented level in terms of range, throughput, and   stability. 
However, given the current state of the Wi-Fi network infrastructure   which is largely built upon the legacy 802.11a/b/g 
standards, the new   802.11n protocols may have the potential of interfering with or even hampering   the normal operation of 
legacy (802.11a/b/g) networks.

Like the present 802.11g networks that are backward-compatible to the   802.11b networks, 802.11n networks are backward-
compatible   with stations built on the legacy 802.11a/b/g standards. Thus, 802.11n wireless access points must inter-operate   
smoothly in a mixed WLAN environment so that they can support   both legacy 802.11a/b/g transmissions over 20-MHz 
channels and high-throughput   transmissions over 40-MHz channels.

To effectively address the backward compatibility and coexistence issue,   802.11n wireless access points must automatically 
choose the appropriate   operating mode as is dictated by the changing dynamics of the wireless   environment in which they 
are operating. According to the 802.11n draft   2.0, 802.11n access points must function in any of the following operating   
modes, depending on the real-time circumstances of the wireless network.

Greenfield

An 802.11n AP using HT (High Throughput) mode – also known as Greenfield   mode – assumes that there are no nearby legacy 
stations using the same   frequency band.  The highest performance of an 802.11n network is   achieved in this mode, with only 
802.11n stations in the network and no   legacy devices in reach. If legacy stations or networks are present,   802.11n devices 
must communicate using protection mechanisms, which may   reduce the efficiency of the 802.11n network.  HT mode is 
optional.

HT Mixed

The mandatory HT Mixed mode is the most common 802.11n AP operating   mode.  In this mode, HT enhancements can be 
used simultaneously with   HT Protection mechanisms that permit communication with legacy stations.    HT Mixed mode 
provides backwards compatibility, but 802.11n devices   pay significant throughput penalties as compared to Greenfield mode.

Legacy

An 802.11n AP using Non-HT (Non-High Throughput) mode - also known as   legacy mode - sends all frames in the old 
802.11a/b/g format so that legacy   stations can understand them.  That AP must use 20-MHz channels and   none of the new HT 
features.  All Wi-Fi-certified 802.11n products   on the market must support this mode to ensure backward compatibility,   but 
an 802.11n AP using Non-HT delivers no better performance than 802.11a/g.
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Likewise,   802.11ac is designed to be backwards compatible with 802.11a and 802.11n   stations in the 5 GHz band. The 
802.11ac standard defines only one operating   mode: Very High Throughput.         

VHT

802.11ac simplifies WLAN networks by introducing   one operating mode (VHT) that works for all 802.11 technologies in the   5 
GHz band. By definition, VHT is mixed in that it supports new 802.11ac   connections along with legacy 802.11a and 802.11n 
connections.  A   VHT frame is transmitted with a legacy preamble that is recognized by   802.11a and 802.11n radios, followed 
by a VHT preamble.

HE

Like 802.11n/ac, the 802.11ax frame begins with the preamble. in   the preamble are legacy (non-HE) training fields followed by 
the HE preamble.   The initial legacy segment includes L-STF, L-LTF and L-SIG, which legacy   devices can decode, to support 
backwards compatibility. Only 802.11ax   capable devices can decode the HE preamble portion.

The image below shows the PPDU formats' overall composition and a breakdown   of the field sections.
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Predictive PHY Data Rate Downlink Coverage
 l Threshold: Min Downlink Data Rate Supported

 l Default value: 54.0

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for Min Downlink   Data Rate Supported are displayed in light green ( ).   
Areas that do not meet the requirement are displayed according to the   color code on the slider bar on the right-hand side of 
the view. This   scale is shown in terms of Mbps. Let the mouse hover over any point of   the map to show additional details.

Background

Connection Rates provide a direct insight into how well the network supports a real-world end-user client. When doing a 
Passive survey   the ability to see the actual Data rate is not available. To   provide Data Rates while doing a Passive survey we 
use Signal Strength   to Data Rate mapping table. Take the detected signal strength and map   it to a known Data Rate. A 
low Data Rate connection directly   translates to lower throughput and performance for an end-user. Consistently   low 
connection Rates are indicative of insufficient signal coverage, interference,   noise, or mis-configured wireless devices.

The connection speeds supported by each of the 802.11 protocols are   listed below:

802.11 
Standard

Supported Speeds (in Mbps)

802.11b 1, 2, 5.5, 11
802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54
802.11a 6, 9, 12, 18, 24, 36, 48, 54
802.11n 1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50,     14.40, 15.00, 18.00, 19.50, 21.70, 24.00, 26.00, 27.00, 

28.90,     30.00, 36.00, 39.00, 40.50, 43.30, 45.00, 48.00, 52.00, 54.00,     57.80, 58.50, 60.00, 65.00, 72.20, 78.00, 81.00, 
86.70, 90.00,     104.00, 108.00, 115.60, 117.00, 120.00, 121.50, 130.00, 135.00,     144.40, 150.00, 156.00, 162.00, 
173.30, 175.50, 180.00, 195.00,     208.00, 216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 260.00,     270.00, 288.90, 
300.00, 324.00, 360.00, 364.50, 405.00, 432.00,     450.00, 480.00, 486.00, 540.00, 600.00

802.11ac 6.5, 7.2, 13.0, 13.5, 14.4, 15.0, 19.5, 21.7, 26.0, 27.0, 28.9,     29.3, 30.0, 32.5, 39.0, 40.5, 43.3, 45.0, 52.0, 54.0, 57.8, 
58.5,     60.0, 65.0, 72.2, 78.0, 81.0, 86.7, 87.8, 90.0, 97.5, 104.0, 108.0,     115.6, 117.0, 120.0, 121.5, 130.0, 135.0, 
144.4, 150.0, 156.0,     162.0, 173.3, 175.5, 180.0, 195.0, 200.0, 216.0, 216.7, 234.0,     240.0, 243.0, 260.0, 263.3, 270.0, 
292.5, 300.0, 324.0, 325.0,     351.0, 360.0, 364.5, 385.2, 390.0, 400.0, 405.0, 433.3, 450.0,     468.0, 486.0, 520.0, 526.5, 
540.0, 585.0, 600.0, 650.0, 702.0,     780.0, 866.7, 877.5, 975.0, 1053.0, 1170.0, 1300.0

802.11ax 8.6,     17.2, 25.8, 34.4, 36, 43, 51.6, 60.2, 68.8, 72.1, 77.4, 86, 103.2,     108.1, 114.7, 120.4, 129, 137.6, 143.4, 144.1, 
154.9, 172.1, 180.1,     180.7, 206.5, 216.2, 229.4, 232.3, 240.9, 252.2, 258.1, 275.3,     286.8, 288.2, 309.7, 324.3, 344.1, 
360.3, 361.3, 387.1, 412.9,     430.1, 432.4, 458.8, 464.6, 480.4, 481.8, 504.4, 516.2, 540.4,     542, 550.6, 573.5, 576.5, 
600.5, 602.2, 619.4, 645.2, 648.5, 688.2,     716.9, 720.6, 722.6, 756.6, 774.3, 802.9, 825.9, 860.3, 864.7,     903.3, 917.6, 
929.1, 960.8, 963.5, 972.8, 1003.7, 1008.8, 1032.4,     1080.9, 1084, 1101.2, 1147.1, 1152.9, 1201, 1204.4, 1238.8, 
1290.4,     1297.1, 1376.5, 1433.8, 1441.2, 1445.3, 1513.2, 1548.5, 1605.9,     1621.3, 1651.8, 1720.6, 1729.4, 1801.5, 
1806.6, 1835.3, 1921.6,     1945.6, 2007.4, 2017.6, 2064.7, 2161.8, 2269.9, 2294.1, 2305.9,     2402, 2522.1, 2594.1, 
2702.2, 2882.4, 3002.5, 3026.5, 3242.6,     3362.7, 3458.8, 3602.9, 3783.1, 3843.1, 3891.2, 4035.3, 4203.4,     4323.5, 
4539.7, 4611.8, 4803.9, 5044.1, 5188.2, 5404.4, 5764.7,     6004.9, 6052.9, 6485.3, 6725.5, 6917.6, 7205.9, 7566.2, 
7686.3,     8406.9, 8647.1, 9607.8

End-user connection speeds change automatically   from a higher connection data rate to a lower one in response to a deteri-
orating   connection quality.  The best method for determining the real-world   connection data rate at a given location is to 
perform a VoFi Survey.    During a VoFi Survey, the surveyor “follows” the AP’s connection   to the phone and actively collects 
real connection data such as connection   data rate.

RSSI Neighboring Cell Coverage
 l Threshold: Min Signal

 l Default value: -67

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.
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Requirement Explanation

Areas that meet the current RSSI neighboring cell coverage requirement   are shown in light green ( ). Areas that do not 
meet   the requirement are displayed using the color code on the slider bar on   the right-hand side of the view. The weakest 
signals are shown in red.   Let the mouse hover over any point of the map to show additional details.

RF Coverage Background

RF signals are the basis for Wi-Fi communication in the same way that   copper wire is the basis for traditional networks. Each 
wireless client   (such as an end-user) must receive adequate levels of RF signal from its   Access Point to insure a reliable and 
well-performing connection.

RF signals are measured in units of “dBm”, with a signal of 0 dBm being   the strongest, and signals of -100 dBm and below 
being the weakest. The   minimum acceptable signal depends on the requirements of the network   and how it is used. As a 
general rule, voice clients should maintain a   signal of at least -67 dBm.

Environmental factors significantly affect RF signals. Solid objects attenuate and reflect RF signals, which can cause RF “dead 
spots” in otherwise well-served areas. This means that your must carefully survey areas where wireless clients need network 
service. Pay special attention to the areas around and in the line of site of physical obstructions such as solid metal object 
(beams, pillars, structural elements), solid walls, elevator shafts, and any shielded rooms, such as an x-ray room.

Corrective Actions

You have 3 basic options to insure location-based coverage readiness:

 l Increase the transmit power of existing APs

 l Reposition APs to meet requirements

 l Add additional APs

Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of 
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and 
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the 
environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve 
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should   have a clear “line of site” to the areas they serve. Installing   APs on the ceiling or high 
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the 
environment and   configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.

RSSI Serving Cell Coverage
 l Threshold: Min Signal

 l Default value: -67

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas that meet the current RSSI serving cell coverage requirement are   shown in light green ( ). Areas   that do not meet the 
requirement are displayed using the color code on   the slider bar on the right-hand side of the view. The weakest signals   are 
shown in red. Let the mouse hover over any point of the map to show   additional details.

RF Coverage Background

RF signals are the basis for Wi-Fi communication in the same way that   copper wire is the basis for traditional networks. Each 
wireless client   (such as an end-user) must receive adequate levels of RF signal from its   Access Point to insure a reliable and 
well-performing connection.

RF signals are measured in units of “dBm”, with a signal of 0 dBm being   the strongest, and signals of -100 dBm and below 
being the weakest. The   minimum acceptable signal depends on the requirements of the network   and how it is used. As a 
general rule, voice clients should maintain a   signal of at least -67 dBm.
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Environmental factors significantly affect RF signals. Solid objects attenuate and reflect RF signals, which can cause RF “dead 
spots” in otherwise well-served areas. This means that your must carefully survey areas where wireless clients need network 
service. Pay special attention to the areas around and in the line of site of physical obstructions such as solid metal object 
(beams, pillars, structural elements), solid walls, elevator shafts, and any shielded rooms, such as an x-ray room.

Corrective Actions

You have 3 basic options to insure location-based coverage readiness:

 l Increase the transmit power of existing APs

 l Reposition APs to meet requirements

 l Add additional APs

Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of 
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and 
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the 
environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve 
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should   have a clear “line of site” to the areas they serve. Installing   APs on the ceiling or high 
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the 
environment and   configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.

Signal Coverage
 l Threshold: Min Signal

 l Default value: -67

 l Pass/Fail default value: 100%

 l To set the default value: AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas that meet the current RF coverage requirement are shown in light green ( ). Areas that do not meet the requirement 
are displayed using the color code on the slider bar on the right-hand side of the view. The weakest signals are shown in red. 
Let the mouse hover over any area of the map to show additional details.

RF Coverage Background

RF signals are the basis for Wi-Fi communication in the same way that copper wire is the basis for traditional networks. Each 
wireless client (such as an end-user) must receive adequate levels of RF signal from its Access Point to insure a reliable and 
well-performing connection.

RF signals are measured in units of “dBm”, with a signal of 0 dBm being the strongest, and signals of -100 dBm and below 
being the weakest. The minimum acceptable signal depend on the requirements of the network and how it is used. As a 
general rule, data clients should maintain a signal of at least -76 dBm. Voice clients require a stronger signal and should 
maintain a signal of at least -67 dBm.

Environmental factors significantly affect RF signals. Solid objects attenuate and reflect RF signals, which can cause RF “dead 
spots” in otherwise well-served areas. This means that your must carefully survey areas where wireless clients need network 
service. Pay special attention to the areas around and in the line of site of physical obstructions such as solid metal object 
(beams, pillars, structural elements), solid walls, elevator shafts, and any shielded rooms, such as an x-ray room.

Corrective Actions

You have 3 basic options to insure location-based coverage readiness:

 l Increase the transmit power of existing APs

 l Reposition APs to meet requirements

 l Add additional APs

Increasing the transmit power: Many APs transmit at their maximum power by default. Some APs support the use of 
external high-gain antennas, which can also boost the strength of signal. However, these antennas are strictly regulated and 
require extra care to stay in the legal boundaries. Furthermore, high-gain antennas may not add any overall signal to the 
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environment. They may instead compress the signal that is already available. This can cause a high-gain antenna to improve 
a signal in one location and but make it worse in another location.

Repositioning APs: Ideally, APs should   have a clear “line of site” to the areas they serve. Installing   APs on the ceiling or high 
on walls can helpful with avoiding physical obstructions.

Adding APs: If the measures described above do not alleviate the problem, you may have to install an additional AP in the 
environment and   configure the AP to use a Wi-Fi channel that does not overlap with APs already deployed.

Signal-to-Noise Ratio Coverage
 l Threshold: Min Signal-to-Noise Ratio

 l Default value: 25

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas that meet the current Signal-to-Noise (SNR) coverage requirement are shown in light green (  ). Areas that do not 
meet the requirement are displayed using the color code on the slider bar on the right-hand side of the view. The weakest 
SNR values are shown in red. Let the mouse hover over any area of the map to show additional details.

SNR Background

SNR is a key measurement of the quality of the wireless signal transmission. A good SNR value means that a higher 
modulation and coding scheme (MCS) can be used to increase the data rates over the wireless connection.

SNR is measured in units of “dB”, representing the difference in a signal level measurement in dBm and a noise level 
measurement in dBm. For example, a signal level of -40 dBm and a noise level of -65 dBm results in an SNR of 25 dB. The 
minimum acceptable SNR depends on the requirements of the network and how it is used. As a general rule, an SNR of 25 dB 
or more is desired for good data rates. To achieve the higher data rates available in 802.11n, and SNR of 27 is desired. To 
achieve the even higher rates available in 802.11ac, an SNR of 32 is desired. Keep in mind that data rates also depend on 
other factors such as channel width and the number of spatial streams.

SNR is affected by two factors: the signal level from the transmitting AP or client, and the background noise level including 
noise from interferers. Providing higher signal levels and/or lower noise levels improves the SNR. See the sections on Signal 
Coverage and Noise Level for more details on these.

Corrective Action

Insufficient SNR can be addressed in several ways.

 l Increase the transmit power of the AP

 l Add additional APs to provided additional coverage

 l Reposition APs to avoid obstructions

 l Select a different WLAN channel that has less noise and interference

 l Mitigate interference sources (remove or relocate them)

Throughput Downlink Coverage
 l Threshold: Min Downlink Throughput Supported

 l Default value: 5.5

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas of the map that meet the current requirement for Min Downlink   Throughput Rate Supported are displayed in light 

green (    ). Areas that do not meet the requirement are displayed according to the   color code on the slider bar on the right-
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hand side of the view. This   scale is shown in terms of Mbps. Let the mouse hover over any point of   the map to show 
additional details.

Tips

Design your Planner/Advisor project with knowledge of the type of   wireless traffic the network must support. For example, a   
Wi-Fi usage to supports a lot of video traffic might require a larger frame size. This changes   your throughput calculation. 
Larger frames have less overhead   while transferring data. If you intend to support VoFi traffic then you   would want to use a 
smaller frame size to emulate typical VoFi packets.   Smaller frames provide less throughput, mostly due to the increased   
overhead required to transfer data packets.

Throughput calculations can provide a direct insight into how well the network supports a real-world end-user client. When 
creating virtual   Survey’s with Planner/Advisor the Physical Data Rates are calculated from   an Signal Strength to Data Rate 
mapping table. Then, take this number   with the Selected (Frame Size) and calculate the Throughput rate the client   can 
expect to see.

User Capacity
 l Thresholds: Maximum Users Supported per AP, With Load Balancing

 l Default values: 15, True

 l Pass/Fail default 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Intelligent capacity planning  ensures that all network users have   access to an adequate amount of bandwidth and that 
wireless access points   are arranged in a way to logically share the client load.

To perform a capacity plan, you should first   establish the network bandwidth that each end user needs. Then, you can 
calculate   the maximum number of end-user clients that should associate with an access   point, based on the total throughput 
available from the AP. With these   two pieces of information, you can use AirMagnet Survey to map out a scientific   capacity 
plan using the following steps.

Identify key end-user client areas. Select the    (Rectangular Region Tool) from the Toolbar,   and then draw a box 
covering the area where end users need support.   Enter the number of users that need to be supported in this area,   and enter 
the length and width of the area. Repeat   this process until you have accounted for all network end users and all locations. 
The program automatically tells you whether the users are covered or not.

Using the "With Load Balancing" Threshold

Note: Load Balancing is a setting on certain APs.  Do not enable this setting unless you know   that the network operates with 
APs that support (and use) load balancing.

If the AirWISE requirement for "With Load Balancing" is set   to "True", the AirWISE display attempts to distribute the users   in 
the defined areas evenly among the APs that cover that area.  For   example, if there are three APs that all provide coverage to 
a given block   of cubes with six users in them, each AP gets two users assigned   to it.  If the "With Load Balancing" field is set 
to "False",   the user stations are assigned to whichever AP provides the strongest   signal in their respective areas.

Each end-user area is automatically broken into equal-sized cells that   represent the area for each user. Areas in green ( )   

meet the capacity requirements set in the application, while a red area   ( ) indicates a client that connects to an overloaded 

AP. An area in gray ( )   means that NO Service is available in that area. Let your mouse hover   over any area of the map to 
see the strongest AP at that location and   any other APs that are operating nearby. Use the simulation tool to simulate   the 
result of relocating the APs, adjusting AP power, and adding additional   APs to meet the capacity requirements. 

VoFi Packet Retry
 l Threshold: Maximum percentage of packet retry allowed

 l Default value: 10%

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.
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Requirement Explanation

The WLAN RF spectrum is open, dynamic, shared, and subject to noise,   interference, packet collisions, multipath, hidden 
node syndrome, etc. When   there are errors caused by any of the above issues, the transmitter of   the error frame would not 
receive an 802.11 control frame called an acknowledgment frame. When   there is no acknowledgment observed, the 
transmitter, assuming that the   receiver did not receive the frame successfully, would re-transmit the   unacknowledged frame 
with the Retry   bit in the frame set to one. This indicates a re-transmission. The   figure below illustrates the Retry   field in the 
802.11 frame header.

Background

The VoFi packet retry policy takes rates recorded from transactions   from the phone to the AP (uplink) as well as those from 
the AP to the   phone (downlink) into account when displaying these data. As shown   in the legend bar on the right-hand 
portion of the view, the data rate   is color-coded to display the combined status of the two transmission   directions:

 l
Areas of the map in which both uplink and downlink retry rates    are good are displayed in light green ( ).

 l Areas in which the uplink retry rate is good but the downlink retry    rate is not are displayed in yellow.

 l Areas in which the downlink retry rate is good but the uplink retry    rate is not are displayed in orange.

 l Areas in which both uplink and downlink retry rates are bad are    displayed in red.

Let the mouse hover over any point of the map to show additional details.

VoFi PHY Data Rate
 l Threshold: Minimum data rate required

 l Default value: 24.0

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

The VoFi PHY data rate policy takes rates recorded from transactions   from the phone to the AP (uplink) as well as those from 
the AP to the   phone (downlink) into account when displaying these data.  As shown   in the legend bar on the right-hand 
portion of the view, the data rate   is color-coded to display the combined status of the two transmission   directions:

 l
Areas of the map in which both uplink and downlink rates are good    are displayed in light green ( ).

 l Areas in which the uplink rate is good but the downlink rate is    not are displayed in yellow.

 l Areas in which the downlink rate is good but the uplink rate is    not are displayed in orange.

 l Areas in which both uplink and downlink rates are bad are displayed    in red.

Let the mouse hover over any point of the map to show additional details.

Background

Connection data rate provides a direct insight into how well the network supports a real-world end-user phone.  A VoFi 
Survey is required   to obtain connection speed data.  A low connection PHY data   rate directly translates to lower throughput 
and performance for an end-user   phone.  Consistently low connection data rates are indicative of   either, insufficient signal 
coverage, interference, noise, or mis-configured   wireless devices.

The connection speeds supported by each of the 802.11 protocols are   listed below:

802.11 Standard Supported Speeds (in Mbps)
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802.11b 1, 2, 5.5, 11
802.11g 1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, 54
802.11a 6, 9, 12, 18, 24, 36, 48, 54
802.11n 1.00, 2.00, 5.50, 6.00, 6.50, 7.20, 11.00, 12.00, 13.00, 13.50,     14.40, 15.00, 18.00, 19.50, 21.70, 

24.00, 26.00, 27.00, 28.90,     30.00, 36.00, 39.00, 40.50, 43.30, 45.00, 48.00, 52.00, 54.00,     57.80, 
58.50, 60.00, 65.00, 72.20, 78.00, 81.00, 86.70, 90.00,     104.00, 108.00, 115.60, 117.00, 120.00, 
121.50, 130.00, 135.00,     144.40, 150.00, 156.00, 162.00, 173.30, 175.50, 180.00, 195.00,     208.00, 
216.00, 216.70, 231.10, 234.00, 240.00, 243.00, 260.00,     270.00, 288.90, 300.00, 324.00, 360.00, 
364.50, 405.00, 432.00,     450.00, 480.00, 486.00, 540.00, 600.00

End-user connection speeds change automatically from a higher connection   data rate to a lower one in response to a deteri-
orating connection quality.    The best method for determining the real-world connection data rate   at a given location is to 
perform a VoFi Survey.  During a VoFi Survey,   the surveyor “follows” the AP’s connection to the phone and actively collects   
real connection data such as connection data rate.

VoFi Signal Coverage
 l Threshold: Minimum AP signal strength required

 l Default value: -67 dBm

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.

Requirement Explanation

Areas that meet the current RF coverage requirement are shown in light   green ( ). Areas that do not meet   the requirement 
are displayed using the color code on the slider bar on   the right-hand side of the view. The weakest signals are shown in red.   
Let the mouse hover over any point of the map to show additional details.

RF Coverage Background

RF signals are the basis for Wi-Fi communication in the same way that   copper wire is the basis for traditional networks. Each 
wireless client   (such as an end-user) must receive adequate levels of RF signal from its   Access Point to insure a reliable and 
well-performing connection.

RF signals are measured in units of “dBm”, with a signal of 0 dBm being   the strongest, and signals of -100 dBm and below 
being the weakest. The   minimum acceptable signal depends on the requirements of the network   and how it is used. As a 
general rule, data clients should maintain a   signal of at least -76 dBm. Voice clients require a stronger signal and   should 
maintain a signal of at least -67 dBm.

Environmental factors can significantly affect RF signals. Solid   objects attenuate and reflect RF signals, which can cause RF 
“dead   spots” in otherwise well-served areas. Therefore, you should pay special attention to the areas around, and in the   line 
of site of physical obstructions. Typical obstructions can include any   solid metal object, solid walls, elevator shafts, and any 
shielded room   such as an x-ray room.

VoFi-Specific Coverage Data

In contrast to the general Signal Coverage requirement, the VoFi Signal   Coverage represents the information gathered from 
the AP to which the   VoFi phone is associated during the survey process. This information does not represent all coverage 
detected on   the VoFi deployment. Other VoFi APs may be placed in the vicinity of the   survey path but not be displayed 
because the phone did not associate with them   during the survey.

WiMOS Coverage
 l Threshold: Minimum WiMOS coverage required

 l Default value: 4.0

 l Pass/Fail default value: 100%

 l For other AirWISE requirements, see AirWISE Summary.
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Requirement Explanation

Areas of the map that meet the current requirement for desired WiMOS   Score are displayed in light green ( ).   Areas that do 
not meet the requirement are displayed according to the   color code on the slider bar on the right-hand side of the view. The 
lowest   WiMOS scores are shown in red. Let the mouse hover over any point of the   map to show additional details.

Background

VoFi call quality can be indicated by several different parameters,   one of which is the Wireless Mean Opinion Score (WiMOS), a 
numerical measurement   similar to the MOS value assigned to calls performed on wired networks. WiMOS   scores are the most 
commonly used way by which respondents are asked to   rate the quality of a call (that is, how it sounds) on a 1 (bad) to 5   
(excellent) scale. Anything that is above 4 is considered excellent. However,   such rating is in and of itself very subjective due 
to the lack of an   objective and scientific methodology.

Lower WiMOS may lead to choppy audio, one-way conversations, and ultimately   even calls getting dropped entirely.

User Satisfaction WiMOS Score
Unacceptable 1.0 ~ 1.9
Mildly dissatisfied 2.0 ~ 2.9
Slightly dissatisfied 3.0 ~3.9
Completely satisfied 4.0 ~ 4.5

Channel/SSID List
The figure below shows the Channel/SSID List on the AirWISE view, which   allows you to group the APs contained in the survey 
data either by channel   or by SSID using the corresponding tab.

Also, if your survey includes simulated data (see About   Simulation view), you may choose whether to use original data or 
simulated   data by selecting Use Simulated   Data from the View menu (checked is enabled).

File Menu
The File menu on the AirWISE view includes some additional options:

Menu Option Description
New AirWISE Policy… Opens the New Requirement Policy dialog box. See Creating Custom Requirement Policies 

for more information.
Save AirWISE Policy Saves any changes made to the current AirWISE policy.    

Note: If     the current policy is one of the preconfigured policies packaged     with Survey, an 
error message is displayed prompting you     to save under a different name.

Save AirWISE Policy As… Opens the Save As dialog box which allows you to save a     current AirWISE Policy using a 
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different file name.
Import AirWISE Policy... Opens the Open dialog box, which allows you to open a previously     created AirWISE policy 

file into the current project.
Export AirWISE Policy... Opens the Save As dialog box, which allows you to save a     current AirWISE Policy using a 

different file name to a separate     location (for example, to a USB external drive). Two files 
are created: The .SAR file and .PCT file. Both files must be imported into another installation 
of AirMagnet Survey     PRO to share the policy.

Remove AirWISE Policy... Opens the Remove Policy dialog box. See Removing     AirWISE Policies for more information.
Load AirWISE Areas... Opens the Open dialog box, which allows you to open an     AirWISE Area (.saa) File. The file 

contains data regarding areas     drawn on the AirWISE view to define requirement regions.
Save AirWISE Areas Saves the current AirWISE areas.
Save AirWISE Areas As... Saves the current AirWISE areas under a new file name.

View Menu
The View menu of the AirWISE view includes the Use Simulated Data option. When your survey includes simulated data (see 
About   Simulation view), you can choose whether to use original data or simulated   data (checked indicates Use Simulated 
Data).

Toolbar
The following table provides description for additional Toolbar tools   available in the AirWISE view.

Icon Tool Name Description
Reset AirWISE 
Requirements

Changes all AirWISE settings back to their defaults. 

Load AirWISE 
Requirements

Same as File > Load AirWISE Requirements. 

Save AirWISE 
Requirements

Same as File > Save AirWISE Requirements.     

Rect Region Tool Allows you to mark and select a rectangular area on the site     map in 
the AirWISE window.

Arbitrary Region 
Tool

Allows you to mark and select an area of any shape.

Clear Last Region Allows you to remove the area selection mark you last made     on the 
site map.

Clear All Regions Allows you to remove all area selection marks you have made     on 
the site map in the AirWISE window.

Legend
 l The Legend on the AirWISE view shows the   level of compliance to AirWISE requirements 

according to the threshold   (signal value) you specify. 

 l Areas that meet the requirements are shown   in green. 

 l Areas that fail to meet the requirements are shown progressively in shades of yellow and red, 
reflecting the different levels of non-compliance. The more red the color, the worse the non-
compliance.

 l Use the  Refresh button on the toolbar to update the view after   you have adjusted the 
threshold value.
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AirWISE Content Window
When you select an AirWISE Requirements listing in the AirWISE Summary   pane, the AirWISE Content window displays a 
heatmap of the associated   requirement.

You can display additional information by clicking on the tabs in the bottom-left   corner:

 l Requirement: Opens    the AirWISE Requirements window, which summarizes all the AirWISE    requirements and the com-
pliance status of the WLAN site according    to the data contained in the survey project file.

 l AirWISE: Opens    the AirWISE Content window, which shows the site map contained in the    survey data collected. It allows 
you to customize certain parameters    to see how the changes would affect compliance with AirWISE Requirements.

 l Description: Opens    the Description window on the AirWISE view, which provides a detailed    explanation about the 
selected AirWISE requirement and offers advice    on how to comply with it.

Configuring Pass/Fail Threshold Values
Each requirement includes a Pass/Fail option, a configurable percentage value that indicates whether the "%   of good area" 
lies in an acceptable threshold. For example, if   the Pass/Fail value is set to 100% and the "% of good area"   is 80%, the 
Pass/Fail column reads "Fail." However, if the   Pass/Fail value is set to 80% and the "% of good area" is 80%,   the Pass/Fail 
column reads "Pass."

 1. Click the Edit Pass/Fail Threshold    icon .

 2. Use the On column to select (check) the alarm types you    want.

 3. Edit the value in the Minimum    % of coverage to pass column.

 4. Click Save.
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Testing AirWISE Requirements Compliance on Site Map
A change of threshold in signal coverage can significantly affect the   size of the area with good signal coverage as can be seen 
graphically   in the Content Window when you select the AirWISE tab. The AirWISE view   offers a variety of troubleshooting 
features. This section shows how to   visually test several what-if hypotheses you may have in relation to any   of the AirWISE 
Requirements on a site map in the AirWISE view.

Note: To analyze survey data on the AirWISE view, you must first load the selected   survey data on the Display view and then 
switch to the AirWISE view. The   following discussion assumes that you have already loaded the data on   the Display view.

To test AirWISE requirements on the site map:

 1. While you are on the AirWISE view, click Multiple AP Signal Coverage.    The AirWISE view refreshes.  
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Note:   The figure above shows a network’s compliance status to the Multiple AP   Signal Coverage requirement 
based on the survey data collected. A large   part of the site is in RED, which implies that the signal coverage there   is 
bad. You can try to rectify this situation either by increasing signal   strength of the existing APs or by removing one 
of the APs from the network.   Steps 2 through 3 below are just for illustration purposes.

 2. From the bottom of the Content Window, reduce the minimum signal    strength.

 3. Click  (Refresh).    The AirWISE view refreshes.  
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Note: As shown   above, the WLAN site is now 91.3% covered when the signal strength was   decreased to -77 dBm. Based on 
this result, you can probably use two APs   to cover the entire site with a minimum signal strength of -77 dBm.

Determining the Number of APs Needed in an Area
The AirWISE view not only enables you to easily determine the number   of APs needed to provide adequate signal coverage for 
an entire WLAN site,   but also allows you to quickly figure out on the view the optimal number   of APs that are needed to cover 
a certain area of the site using a certain   channel. As a result, you can save the resources that would otherwise   have to be 
used in numerous trial-and-error attempts to find the best   solution.

Note: To analyze survey data on the AirWISE view, you must first load the selected   survey data on the Display view and then 
switch to the AirWISE view. The   following section assumes that you have already loaded the data on the   Display view.

To determine the number of APs needed for an area of the network:

 1. While you are on the AirWISE view, click       (Rectangular Region Tool) on the    Toolbar.

 2. On the site map, click a starting point and mark an area of interest    by dragging a rectangular frame around it.  

 3. Click    (Refresh).    The AirWISE view refreshes.  
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 4. From the Channel/SSID pane, select the Channel    tab.

 5. Click the Select All check    box to deselect all entries in the Channel/SSID pane.

 6. Manually select the entries by checking the corresponding check    boxes.

Note: The figure   above shows that the marked area of the WLAN site is mostly not covered   by the other APs.

Getting AirWISE Advice
If you need information about any of the AirWISE Requirements in question   (shown on the view) or advice on what you need 
to do to comply   with a certain AirWISE requirement, click the Description   tab in the lower-left corner of the Content Window. 
You get detailed   information and advice related to the AirWISE Requirement.  
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Managing AirWISE Requirement Policies
AirWISE Requirement Policies allow you to maintain different requirement profiles, which you can then apply   to existing 
Survey projects. This helps you ensure compliance   with various corporate requirements over different projects (or even in   
different areas of a single project). You can also enforce two levels of wireless compliance, such as locations where both 
wireless voice (VoIP) and data infrastructures are in   place. Due to the potentially wide variations in requirements for voice   
traffic as opposed to standard data transmissions, these two implementations   require different minimum signal levels, AP 
placement, and PHY data   rate information.

The policy management portion of the view contains five main functions,   as shown in the image below. These functions are 
described in more detail   in the following sections.

Note: AirMagnet   Survey currently includes preconfigured policies for Cisco phone models   7920, 7921, and 7925, as well as 
Vocera badges. Note that the policies   included with Survey cannot be modified or removed.

 

Selecting an AirWISE Requirement Policy
The AirWISE policy selection drop-down list allows you to specify   the current profile in use. This list includes preconfigured   
policies as well as any user-defined profiles that have been created.   To select a new profile, click the drop-down and make 
the desired selection   from the list.

Note: Several policies   are included with AirMagnet Survey by default; these policies cannot be   modified or removed.
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Creating Custom Requirement Policies
Although Survey includes several preconfigured   policies designed for standard deployment types, you may also customize   
your own policies tailored to your wireless environment. This section   describes the basic steps for creating and modifying a 
custom policy.

To create a new AirWISE policy:

 1. From the Requirement Policy window, click (New policy).    The New Requirement Policy window appears.

 2. Enter the desired name for the new policy.

 3. Choose one of the options:

 l Create new policy (default):    Creates the policy using the default values for all requirements.

 l Copy from:    Creates the policy by copying the values of another policy. Selecting    Copy From displays a drop-down    menu 
to select the policy to be copied.

Click OK to continue after making   the desired selection. The new policy is selected on the AirWISE view.

After the new policy has been created, you can modify any of the thresholds   as needed. Use the same steps described in 
Adjusting   AirWISE Requirement Thresholds.

Note: To delete   a user-created policy, click with   the policy selected.

Working in Requirement Window
This section explains how to change a requirement threshold value to affect compliance to the related AirWISE Requirement.

Note: To analyze survey data on the AirWISE view, you must first load the selected   survey data on the Display view and then 
switch to the AirWISE view. The   following explanation assumes that you have already loaded the data on   the Display view.

 1. When AirWISE is opened, the default view shows a list of requirements    and associated configurable threshold values in 
the right-side table.    However, if a particular AirWISE policy is selected from the list    of AirWISE requirements in the left-
side table, you can click the Requirement tab    to display the table.
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 2. In the Threshold column, select a value to change    and overwrite it with the new value.  

 3. Click    (Refresh).    The change and its impact on the network’s compliance with the selected    AirWISE Requirement 
are reflected instantly in the AirWISE Summary    section of the view.  

 4. With the requirement selected, click the AirWISE tab    in the lower-left corner of the Content Window to view how the 
change    is reflected in the heatmap.
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Saving Changes to AirWISE Policies
After changes have been made to a custom policy, you must save the changes   to ensure that they aren’t discarded after the 

project is closed   or navigates away from the AirWISE view. This can be performed by simply   clicking  (Save policy).

However, if you have made changes to one of the preconfigured policies,   the changes must be saved under a different profile 

name. This operation   can be performed using (Save policy as…).

Note: If unsaved   changes exist when you attempts to navigate away from the AirWISE   view, a message asks if the changes 
should be saved.

Removing AirWISE Policies
Clicking  (Remove policy)   opens the Remove Policy dialog box, which allows you to manage the attributes   of the 
current project’s policies.
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As seen above, the Remove Policy window provides three major options   for the policies:

 l Remove: Deletes    the selected policy application.

 l Set Read Only:    Sets the selected policy to Read Only, which ensures that the policy    cannot be modified or removed.

 l Done: Closes the Remove    Policy window.

Verifying VoFi Network Compliance
With the implementation of preconfigured AirWISE profiles for various   different VoFi phone types, you can conduct a standard 
survey of their   wireless environment and assess the results to see if the deployment is   ready for a VoFi implementation. This 
step can help ensure that   the VoFi deployment is prepared with minimal impact on the existing wireless   activity.

To assess VoFi compliance:

 1. After conducting a standard passive or active survey on the area,    navigate to the AirWISE view.

 2. Use the Requirement Policy drop-down list to select the profile    for the phone models to be used in the VoFi imple-
mentation.

 3. View the AirWISE Requirements listed and assess which aspects of    the network do not meet the standards for a VoFi 
implementation. Note    that the Multiple AP Signal Coverage    requirement is of particular importance as redundancy is a 
critical    factor in a VoFi deployment.

Note: You can perform this procedure before deploying the VoFi installation (to verify   that the network is ready) or after (to 
verify that the wireless   infrastructure remains sufficient after VoFi activity is present).
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Reports View
AirMagnet Survey can automatically convert any survey data shown on the Display view into a variety of data reports, which 

can be viewed, printed, or distributed from the Reports view. You can access the Reports view by clicking  on the 
navigation bar.

Note: You must have an open data file in the Display view and also select an option from the Report List before you can view 
data reports. 

In this chapter:

Reports Introduction 201

File Menu 202

View Menu 202

Report Template List 202

Customizing a Report Template 203

General information Tab 204

Report Translation 205

Channel/SSID Tree 205

Report Window 206

Toolbar 207

Viewing Survey Data Reports 208

Printing Reports 208

Exporting Reports 208
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Reports Introduction
The Reports feature enables you to generate a report based on the data   file selected in the Display view.  

A variety of preconfigured   reports are available. The following options enable you to customize any   report:

 l Edit an existing report    by adding and/or removing sections.

 l Duplicate a report and    modify the duplicate.

 l Start with a blank report    and add desired sections.

 l Revise the text of any    heading and/or section content.

 l Localize a report    automatically to any of the following languages: English, German,    French, Arabic, Russian, and Japanese. 
You can also manually revise    the translated text.             

 l Customize the Title    Page graphics             

 l Customize    to show/hide cover page, table of contents, header, footer, page number,    and each section’s title and contexts.
             

You can access the Reports view by clicking Reports   on the navigation bar.

Double-click a report to generate it. The report displays   in the main view.
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File Menu
The Reports File menu includes options that can help you manage and distribute  survey data reports.

Option Description
Report con-
figuration...

Opens the General Information tab in the Report Template manager     where you can modify aspects of the 
report, including logo, footer,     and location.

ACL... Opens the ACL (Access Control List) window where you can add     APs to or delete them from the ACL table. 
This feature enables     you to categorize access points discovered during a survey into     two groups: those 
that you manage (ACL) and those that you do     not manage. Non-ACL access points include those from 
your neighboring     businesses and rogue access points.    

Click Add to display     a list of Access Points contained in the survey. Check the APs     you want to include in 
ACL, and then click OK.     If the ACL feature is used, the report sorts the APs into     these two groups.

Print... Print the current report.
Print Setup... Change print settings for the current     report.

View Menu
The View menu on the Reports view provides an additional option:

Landscape Orientation: Switch the report orientation from portrait to landscape. Once in Landscape orientation, the report 
may be changed back to Portrait orientation by deselecting Landscape Orientation.

Report Template List
The Report List displays the Report Templates. Each template is preconfigured   to generate a report containing topics relevant 
to the title of the report   (for example, Passive Survey Report). However, you may fully customize   any report to meet your 
needs.

Note: A report   is based on the selected data file in Display view. Therefore, the report   may only contain data included in that 
data file. For example, your report   cannot contain VoFi information if the associated data file does not contain   a VoFi survey.

in the Report List, the following actions are available:

Item Description
 
or

     right-click the 
Reports

 folder 

and then select New     Custom Report 
Template

Add a new, blank template or copy an existing template. Type     a name for the 
template. Choose none for a blank template     or choose a listing from the drop-
down to create a duplicate template.     Then click OK.
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or

     right-click and select 
Edit

Edit the selected template.

     
or

 right-click and select 
Delete

Delete the selected template. Once deleted, the template cannot     be restored 
unless the product is re-installed.

Right-click and select Rename Rename the selected template.
Right-click and select Export Opens a file window that lets you select a folder to export the selected template in 

ZIP format.
Import Right-click the Reports folder, select Import     Custom Report Template, and then 

browse to the desired ZIP file.     Click Open.

 

Customizing a Report Template
If you choose to Edit or Create a report template (see Report   List), the Create Custom Report Template   manager opens with 
the Report Template   tab displayed.

 l If you chose to Create    a new template, the left-side of the manager is empty. This enables    you to build the template by 
adding the desired section from the Available Categories section.

 l If you chose to Edit a    template, the left-side of the manager contains the preconfigured    sections associated with the 
template title. You may choose to remove    undesired sections from the Custom    Report Template area on the left and/or 
you may add sections    from the Available Categories    list.

 1. To subtract a section from the report, locate the desired section    by expanding the Custom Report Template    tree. Select 
the section. Click the right facing arrow to move the    section to Available Categories.

 2. To add a section to the report, locate the desired section by expanding    the Available Categories tree.    Select the section. 
Click the left facing arrow to move the section    to Custom Report Template.

 3. You may also modify any of the default description text associated    with section. Select the section in the Custom    Report 
Template tree. This displays the text (if any) in    the description area at the bottom. Modify the text.

 4. Click OK to save changes
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General information Tab
Click the General Information   tab to customize information such as the survey title, surveyor name,   survey location, custom 
report header and footer, and so on.

This tab also includes the Translation button that enables some additional   translation features. See Report   Translation.

After modifying the properties desired, you can preview a sample   of the report’s cover sheet in the right-hand portion of the 
window by   clicking Preview Cover Sheet. The table below describes the fields available   for customization.

Field Description
Survey Title The title of the survey. Note that this differs from the name     of the template in that the Survey 

Title is printed on the     cover page of the report itself.
Surveyor Name The name of the person who conducted the survey.
Location The location at which the survey was taken.
Company The company for which the survey was conducted.
Date The date of the survey.
Cover Sheet Picture The picture that is displayed on the cover sheet of the     finished report. Recommended size is 

650w x 400h pixels. This     image appears in the cover sheet of all reports. BMP, JPG,     PNG and 
GIF are supported. When browsing for an image, be sure     to select the correct image type 
desired from drop-down.

Corporate Logo If desired, you can specify a logo to be displayed in the     lower-right corner of the cover page. 
Recommended size is 164w     x 164h pixels. This image appears in the cover sheet of all     reports. 
BMP, JPG, PNG and GIF are supported. When browsing for     an image, be sure to select the 
correct image type desired from     drop-down.

Individual Distribution This option allows you to force the report to display     a limited number of APs in each heatmap 
display.  In this     manner, you can view fewer devices per page and get a better     idea of each 
AP's coverage area.  This mechanism can be enabled     for any or all of the heatmaps displayed 
in the report.

Translation Enables report text to be localized to the language of choice.     See Report Translation.
Report Page Header & 
Footer

If desired, you can enter text to appear in the header and     footer portions of the report. This is 
displayed in addition     to the default page number shown on all reports.
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Include     Cover Page, Data 
Filename, Table of Contents, 
Section Headers     and Text, 
Page Headers/Footers, and 
Page Number 

Check     the corresponding boxes to include/hide different parts of report.                 

 

Report Translation
in the Report Template manager,   there are some options available for enabling you to localize a report   to a desired 
language.

By default, the Windows setting for "Display Language" is   presented, so translation in this regard refers to editing text.

Note: Before modifying   a template, you may find it desirable to first duplicate a report template   and include the desired 
language in the file name, for example, Passive   Survey (German).

 l Default Report Language:    This drop-down, located on the Report Template tab, enables you to    view report text in the 
following languages: English, German, French,    Arabic, Russian, and Japanese. After selecting a language option from    the 
drop-down, click Restore Default    to apply the language to any sections in the Custom    Report Template area of the 
template manager.

 l Manually edit any text:    You may manually edit the text in any section by selecting the section    and then editing the text 
that appears in the text editor area (the    lower section of the template manager).

 l Manually edit any header text    (category headers): right-click a heading in the Custom    Report Template area of the 
template manager. Select Rename and type the desired text.

 l Incidental items on the report    pages: Additionally, there is some incidental text in the report    not included in the 
methods above. From the General    Information tab, click Translation.    Translate the items in the left column into the 
desired language using    the fields in the right column.

Once translation is completed, click OK   to save any changes and close the Report Template manager.

 

Channel/SSID Tree
This part of the Reports view allows you to tailor the content of the   report. In general, the reports can be displayed by 
channel or by SSID.   You can toggle between the two by clicking 
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.  The   image below shows all the APs on each available channel as well as the   SSID and 
maximum RF signal level of each AP.

As seen above, there are check boxes above the Channel/SSID Tree:

 l Select All: This    function enables you to select or deselect all entries on the Channel/SSID    Tree with a click of the button. 
By default, all the entries in the    Channels/SSID Tree are selected when the Reports view opens. It is    a good idea to use this 
button to deselect all the entries and then    manually select only the entries in which you are interested. In this    way you 
can customize your survey data reports using data about the    selected devices.

 l 2.4 GHz: This    checkbox selects only the channels in the 2.4 GHz band.

 l 5 GHz: This checkbox    selects only the channels in the 5 GHz band.

 l 6 GHz: This checkbox    selects only the channels in the 6 GHz band.

Report Window
The Report Window displays the report based on the options selected from the Report List and Channel/SSID Tree.  There are 
a number of   tools across the top of the Report Window. They are specifically designed   for viewing and sharing survey data 
reports, as described below.
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Icon Name Description
Export Brings up the Export dialog box which allows you to export     the current report to a 

specific destination in a selected format.

To First 
Page

Allows you to move to the beginning of the current report.

Back Allows you to return to the previous page of the report.

Page 
Count

Shows the total number of pages contained in the current report     and the page you are 
viewing.    

Note: You can directly navigate to a specific page in the report     by highlighting the 
current page number and then entering the     page number of interest and pressing the 
Enter key on your keyboard.

Forward Allows you to move to the following page of the report.

To Last 
Page

Allows you to move to the end of the current report.

Toolbar
The toolbar contains the commonly used tools for viewing and printing   reports. Most of these tools are identical to the 
options found in the   File   or View   menus of the view.
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Icon Name Description

Zoom In Enlarges the size of the current report on the view.

Zoom Out Reduces the size of the current report on the view.

Zoom to Fit Fits the current report to the size of the Report Window.

Actual Size Resets the current report to actual printing size.

Refresh 
Report

Refreshes the data in the current report.

Report 
Information

Opens the Report Configuration view, where you can specify     or modify information that appears on the 
reports to be generated.

ACL Opens the ACL window, where you can add or delete APs from     the ACL table.

Landscape Allows you to switch the orientation of the report on the view     between portrait (default) and landscape.

Print Allows you to print the current report.

Viewing Survey Data Reports
The following are the general procedures for viewing a data report:

 1. While in the Display view, open a survey data file.

 2. From the Navigation bar, click .    The Reports view appears.

 3. From the Report List, select a report.

 4. From the Channel/SSID Tree, click the Channel or SSID tab.

 5. Use the controls on the view to adjust your viewing options.

The heatmap colors displayed in reports are somewhat dependent on monitor   display settings. 

Printing Reports
To print a survey data report:

 1. From the Report List Window,    double-click to open a report.

 2. Click  (Print    Report). The Print view appears.

 3. Make the selections and/or entries as shown on the view, and click    OK.

Exporting Reports
You can export reports in more than a dozen electronic file formats   and to a number of destinations. This makes it possible to 
share and back   up your survey data with ease.

To export a survey data report:

 1. Customize the report, if necessary, using the Channel/SSID Tree.

 2. Double-click the desired report from the Report    List Window.

 3. Click     (Export Report). The Export    view appears.
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 4. Click the Format down arrow    and select a file format from the drop-down list.

 5. Click the Destination down    arrow and select a destination for the file to be exported.

 6. Click OK. The Export Options    dialog box appears.

 7. Select one of the export options and click OK.

Note: Depending   on the option you select in Step 5, the report can be exported to a disk   drive or sent out as an email 
attachment. You can then open and view the   report in the format you have selected, provided that you have the application   
that supports it (file format).
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Configuration Options
Your site survey results are affected by AirMagnet Survey’s settings.   Careful configuration of AirMagnet's parameters can help 
you achieve   what you intend to accomplish. This chapter explains how to configure   the various settings on AirMagnet Survey.

In this chapter:

Configuration Dialog 211

Configuring Program Settings 211

Specifying Interference Settings 213

Calibrating Wireless Network Adapter Speed 214

Configuring AP Grouping 214

Configuring Legend Color Settings 218

Configuring 802.11 Parameters 219

Configuring Channel Scan 219

Configuring a Survey profile 221
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Configuration Dialog
The Configuration dialog includes several tabs, each dedicated to a   specific aspect of the program's settings.

To access the Configuration dialog, do either of the following:
 l From the Main Menu, select File > Configure....

 l
From the Toolbar, click       (Configuration).

By default, the Settings tab is selected when the dialog box opens.

Configuring Program Settings
This option defines the way AirMagnet Survey   collects and processes data. You can also optimize certain attributes   on the 
wireless network adapter to maximize its performance with   the application.

To configure settings:

 1. From the Main Menu, select File > Configure....

 2. Make sure the Settings    tab is selected.

Parameter Description

Ignore APs whose max dis-
covered signal strength is less 
than

Specify a threshold value for AP signal strength.    

Note: APs     with signal strengths below this value are ignored.     The value of signal 
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strength ranges from 0 (strongest) to -100     (weakest).

Hide ignored Access Point Hides APs with     maximum signal strengths that fall below the threshold (Channel/SSID 
Tree in the Display view).

Auto logging data period Enter a value in seconds.     This option sets how frequently the application automatically     
logs data points during a site survey. (Default value is once every three seconds.)

Beep when logging data Enables an audio beep each time Survey logs data.    This beep can serve as an indicator 
that Survey is working properly. 

Note: The frequency     of the beeping depends on the data sampling interval specified     
above.

Auto sampling through path Automatically marks data sampling points on the site     map, shown by blue dots along 
the survey path.        

Note: The     data sampling interval is determined by the value you specified     in the Auto 
logging data period. See above.

Sampling on click only Samples data only when you click on the site map.    

Note: When     conducting a Click to Sample survey, make sure     that the application has 
adequate time to complete a full     scan cycle before clicking to record a sample and 
moving on. Moving     and clicking significantly faster than the scan pattern can result     in 
decreased heatmap accuracy. Check the progress bar at the bottom of the survey screen 
to see the progression through the configured scan     pattern. Wait until the bar indicates 
that a full scan cycle has completed     before you click to record data. Once the meter 
reaches     100%, a new scan is started and the meter resets to 0. (This     progress bar 
appears only when you use adapters that support     user-defined scan patterns.)

Use maximum heatmap drawing 
resolution

Displays smoother looking heatmaps     for floor plans with dimensions less than 400 feet 
(122 meters).                 

Auto position APs with signal 
strength greater than

Automatically places the APs that meet your specification     in their optimal locations on 
the site map. (You may     also need to set a signal strength value in the space below. )

Display MAC address only Displays all APs by MAC address     alone without including a vendor ID or custom     name.

Prompt for refresh after AP 
location change

Tells AirMagnet Survey to prompt you to refresh the     view each time you reposition an 
AP.

Enable Survey Range Indicator Enables automatic marking of the survey data sampling range     (radius) as you click on 
the site map.

Enable GPS port Enables the Configure... button, which opens the GPS settings. See Creating a GPS-
Aided Survey Project Using an Existing Site Map.

Hide APs below legend threshold 
in Bubble Window

When selected, excludes APs placed on the floor plan are not displayed in     the Bubble 
window listing.

Configure GPS Opens the dialog to configure GPS integration for conducting     a GPS survey. See     Con-
figuring     GPS COM Port.

Channel Interference Opens the Interference dialog where you can configure the minimum     values of AP 
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signals that the program takes into account when     calculating signal interference.

Spectrum Integration Opens the Spectrum Integration dialog box where     you can choose to show or hide the 
Spectrum Integration window,     which displays below the Map Window on the Survey     and 
Display screens. See AirMagnet     Spectrum Analyzer introduction.

PHY Data Rate Map Generates speed data for passive surveys. See Calibrating     Wireless Network Adapter 
Speed.

 3. Click OK.

Specifying Interference Settings
Definitions of signal interference and noise are rather subjective.   They may vary from person to person, depending on an indi-
vidual’s perception   and level of tolerance. For instance, -67 dBm or -87 dBm may be considered   as interference by some 
people, but may also be considered acceptable   by others.

The Ch Interference Setting… button allows you to specify the minimum   value that the program should consider as inter-
ference when calculating   these parameters. Once specified, the program does not consider any signal from an adjacent AP as 
interference if it   falls below this value.

To specify interference settings:

 1. From the Main Menu, select File > Configure....

 2. From the Settings tab,    click Ch Interference Setting....     The Interference dialog    box appears.

 2. Specify the desired values for interference and noise, and click    OK.

Note: The first   field specifies a setting for “Interfered APs”, or those that are experiencing   interference from other sources. 
The second refers to “Interfering APs’,   or those that are causing interference to others.
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Calibrating Wireless Network Adapter Speed
The PHY Data Rate Map button   in the Settings dialog opens the PHY   Data Rate Map table, which lets you specify speed 
transmission   information for the wireless network adapter in use. This information helps with speed data calculations for 
passive or virtual surveys.

The values displayed in the speed mapping table relate to the minimum   signal strength required to transmit data at a given 
speed. For example,   the default value for transmitting at 6 Mbps for 802.11g traffic is -86 dBm.

Note: The default   values provided in the table are based on Receive/Radio sensitivity values   for most wireless network 
adapters. You should only modify any values   that do not match those of the wireless network adapter in use. See the 
adapter’s technical specifications from the vendor’s website.

To adjust speed settings on a wireless network adapter:

 1. Click File > Configure…

 2. From the Settings tab,    click PHY Data Rate Map. The    PHY Data Rate Map table appears.

Note: As shown   above, the table has three tabs, each for a different media type (802.11a,   802.11b/g, and 802.11n).  The 
Vocera B2000 Badge Speed Map option   is intended only for surveying a Vocera deployment. When this option is   enabled, 
the speed map values are hidden.

 3. Click the tab that matches the media type in use.

 4. To modify a value, highlight the value and enter the new value.

Note: The value   you enter must lie between the values above and below the entry.

 5. Click OK to save the changes.

 6. (Optional) To restore the default values, click Restore to Default.

Configuring AP Grouping
This dialog allows you to set up specific names for single devices that   use multiple SSIDs under different BSSIDs. The 
grouping helps identify   instances where separate BSSIDs show up and appear to be several different   devices when they 
actually belong to a single device.

To open the AP grouping dialog, click the Configuration icon , and then click the AP Grouping tab. You can also right-
click on a channel or AP in the Channel Tree View and then select the AP Grouping option

A few predefined rules are available. You may also create custom (New)   rules.

You can enable and use AP grouping as follows:
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 l Choose to use “Any” (any vendor) for the 2.4 GHz, 5 GHz, or 6 GHz frequency band. This    groups all MAC addresses where 
the last octet is 0-16, for example,    xx.xx.xx.xx.xx.x0

 l Choose to use Ubiquity 2.4 or 5 GHz: Octet: First (1), consecutive    mac address 16, starting bytes: 0

 l Choose to use Ruckus 2.4 or 5 GHz. This groups all MAC addresses    where the last octet is 0-16, for example, 
xx.xx.xx.xx.xx.x0

 l Create "New" AP Grouping Rules as described below.

Note: An enabled   (checked) user defined rule (New) takes precedence over an "ANY"   rule.

Note: AP Grouping information is saved as a comma-separated (.csv) file: 
<drive letter>:\Program Files (x86)\AirMagnet Inc\AirMagnet Surveyor\AP-Grouping.csv

To add 6 GHz AP grouping rules, you must either manually edit AP-Grouping.csv or delete that file and let Survey 
PRO regenerate it when you create new rules. 

AP Grouping Limitations
AP Grouping is subject to the following limitations:

 l Automatic rules are not editable and do not show up in the "Group    Rule Name" list and cannot be deleted or edited.

 l No special name is displayed if "Display Best Name"    is selected in the filter view, for example, Name is the same    as if its 
MAC address is selected unless there is a known AP name.

 l The existing OUI to create grouping rules is not modified.

 l AP grouping does not attempt to group dual radio APs into a single    device.

To configure AP grouping using predefined settings:

 1. From the Survey Configuration    dialog box, select the AP Grouping    tab.  
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 2. Check Enable auto grouping.

 3. Check the desired listings in the Group    Rule Name table.

 4. Click OK.

Disable AP Grouping by unchecking Enable   AP Grouping.

Viewing AP Grouping Rules
To view the details of the default settings.

 1. Select an AP Group rule.

 2. Click Detail. A dialog    box appears showing all the attributes of that auto grouping rule.
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The table below briefly describes each of these fields.

Parameter Description
Vendor ID Specifies the name of the device vendor that the rule applies     to.
Band Specifies the device's frequency band.
MAC address order Indicates whether address is in ascending or descending order
MAC address hexdigit starting 
from

Indicates the hex digit used to start the grouping.

Number of contiguous MAC 
address

Indicates the number of consecutive addresses you wish to classify     in the group.

Creating New AP Grouping Rules
The AP Grouping tab’s preconfigured auto group rules automatically   incorporate a range of vendor IDs for devices from 
various manufacturers.   These numbers are assigned to vendors by the IEEE, and as newer cards   are released, new IDs are 
granted.

The IEEE OUI file is located in the c:\AirMagnet\Surveyor\OUI folder. You   can download the latest IEEE file from here: 
http://standards.ieee.org/develop/regauth/oui/oui.txt.   Open the web page and from the browser File   menu, select Save As. 
Save as   a .txt format.

Additionally, vendor names can be modified to abbreviate them or otherwise   make them more meaningful as desired. For 
example, you may rename "Hewlett-Packard"   to "HP". To make a change, open "oui_alias.txt" located   here: C:\Program Files 
(x86)\AirMagnet Inc\AirMagnet Surveyor\OUI.   

Note: the vendor   names drop-down in AP Grouping are either the first word in the   name or the first 16 characters (if the first 
name is longer than 16 characters).

 1. From the Survey Configuration    dialog box, select the AP Grouping    tab.

 2. UnderAP Group Rules,    click New.

 3. From the Vendor ID drop-down,    select the desired vendor.

 4. Configure the grouping options as desired.

 5. Click OK.

 6. The newly added vendor ID can now be enabled as a AP Group Rule.

You can delete an AP Grouping rule you created. To do this, check the   desired rule and click Delete.   You cannot delete a 
predefined rule.

Current User Configured OUI(s)

 1. From the Survey Configuration    dialog box, select the AP Grouping    tab.

 2. Under Current User    Configured, click New.

 3. Type the Vendor ID.

 4. Type the Vendor Name.
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 5. Click OK.

 6. Select apply OUI change.

The newly added vendor ID can now be used to create an AP Group Rule.

Note: If you use   the same vendor name for each new vendor ID, a grouping rule using that   vendor name applies to all 
IDs associated with that vendor   name.

Alternatively, the ID may be created manually:

 1. Navigate to AirMagnet Survey’s installation directory (typically    C:\Program Files (x86)\AirMagnet Inc\AirMagnet Surveyor).

 2. Open LanCardVendors.txt.

 3. Follow the instructions for creating a new entry.

 4. Save and close the text file.

The new entry is implemented when AirMagnet Survey is launched.

Configuring Legend Color Settings
This feature allows you to set and change the color settings on the   Legend, which also affects the color scheme displayed in 
the Map Window   on the view.

To configure Legend color schemes:

 1. From the Main Menu, select File > Configure....

 2. Click the Color tab.

 2. Make the selections as described in the table below.

Parameter Description
Color Scheme Use the radio buttons to select a color scheme.    

Note: Each     radio button represents a color scheme, which affects the overall     color scheme of the 
Legend. Your selection is automatically     used by color legend after you click OK.

Outline Color Change any of the color values (Red, Green, Blue) by     highlighting it and then typing new color values 
or by clicking     Select Color... and then choosing     a color from the Color box.    

Note: This     option affects the color of the borderline around areas (that     is, cells) covered by different 
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APs.
Automatic contrast 
adjustment

Automatically adjusts the color     contrast as you drag the color box up or down the Legend.

Granular color bar 
selection

Changes the color shade one grade     at a time as you drag the color box up or down the Legend.

AP icon size Use the radio buttons to set the AP icon size.

 3. Click OK when finished.

Configuring 802.11 Parameters
To perform Active and Active iPerf surveys, the adapter needs   to associate with the desired AP or SSID.  This often requires 
establishing   the authentication method and security password for the AP or SSID. You can set up these requirements outside 
of AirMagnet   Survey using Windows Wireless settings, you can use AirMagnet Survey's 802.11 configuration.

To configure 802.11 parameters:

 1. From the Main Menu, select File > Configure....

 2. Click the 802.11 tab.

 2. Click New to create a new    profile. Provide a Name for    the AP or SSID and click OK.

 3. With the SSID or AP name selected in the Wireless    Networks drop-down, click Edit.

 4. Make the desired entries and/or selections in the Connections    tab and Security tab as you    normally would for a new 
Windows Wireless connection.

 5. Click OK.

Note: The options available depend on the adapter and OS being used with AirMagnet Survey. See the Supported Adapters 
section of the AirMagnet Survey web site at: https://www.netally.com/wp-content/uploads/APA_FL_21_V2.pdf   

Configuring Channel Scan
Configuring channel scan settings allows you to specify the channels   you want the wireless network adapter to scan and to 
set the frequency   at which the scanning occurs.

Note: In order   for AirMagnet Survey to record data from the channels of interest, make   sure that you have the scan feature 
enabled for those channels using this   view. A common reason that no data are recorded for a specific channel   is that the scan 
feature on that channel is not enabled at all.

To configure Scan parameters:

 1. From the Main Menu, select File > Configure....

 2. Click the Scan tab.  
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Note: When running   in multi-adapter mode, a drop-down menu appears at the top of the   window to select the desired 
device.

 2. Use the controls to enable the channel or channels to be scanned    (checked channels are scanned).

 l Use the check boxes to enable (or disable) individual channels    to be scanned.

 l Click Enable All to enable    all channels so that all channels are scanned.

 l Click Clear All to disable    all the channels so that no channel is scanned.

 3. Set the scan intervals:

 l Click the Period (ms) field,    and select a scan frequency for the individual channels from the drop-down    list.

 l Click Scan Time down arrow to select a time period, and then click    Set All to apply the time period to all channels.

 l Click Reset to restore the scan settings to the default, which    is 250 ms.

 4. Click OK.

Note: When an 802.11n   card is in use, the Scan tab allows you to specify scanning on lower and   upper portions of selected 
channels.  This is due to the use of 40   MHz channel settings; by default, AirMagnet Survey automatically configures   these 
channels.  However, you can specify these channels manually   by unchecking Enable automatic configuration of 40 MHz 
channels and checking   the individual upper and lower channels desired.
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Configuring a Survey profile
The Profile tab allows you to store settings made in Survey’s configuration   and reapply them for future surveys. You can save 
these settings to   an AirMagnet Profile (.apf) file and then upload the file onto another computer   using AirMagnet Survey. This 
feature can help you with repeated site surveys. Profiles can be created for individual   sites, making it easy to re-configure the 
scan settings as the site requires.

To configure a Survey profile:

 1. From the Main Menu, select File > Configure.

 2. Click the Profile tab. 

    

 3. Click New. The New Profile    dialog appears.  

 4. Enter a unique name for the profile. (This creates the profile’s    filename, for example, “Profilename.apf”).

 5. Leave the Create New Profile    radio button selected.

Note: The Copy   From button allows you to duplicate the settings configured in an   existing profile and apply them to the 
new profile.

 6. Click OK. The new profile    appears in the profile list window.

 7. Enter any comments about the new profile in the Comments field    below the Profile List (optional).

 8. Click OK.

Note: The new profile   automatically becomes the active profile. Any changes made in Survey’s   configuration are stored 
in the active profile.
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About Signal Adjustment
You can choose a wide variety of 802.11 wireless network adapters. However, there is a possibility   that manufacturing 
differences between the vendors can result in different signal readings.  

To reduce this problem, NetAlly has a list of “preferred” Wi-Fi adapters, which you can view here: https://www.net-
ally.com/wp-content/uploads/APA_FL_21_V2.pdf

NOTE: Signal adjustment on channels in the 6 GHz band are not supported.

Using Signal Adjustment Options
AirMagnet Survey comes with a Signal Adjustment dialog box to make wireless   network adapter adjustment fast and easy. 
You can bring up the dialog   box by clicking File > Configure… > 802.11 > Adjust   Signal….

Once you have brought up the Signal Adjustment dialog box,   click the down arrow in the upper-left corner and select one of 
the following   options:

 l No    Adjustment

 l Pre-Defined    Adjustment (This is the entry below No    Adjustment, for example., AirMagnet 802.11 a/b/g/n Wireless    PC 
card.)

 l Custom    Adjustment

No Adjustment
No Adjustment means no adjustment offsets are applied by AirMagnet to   the wireless network adapter. This option should be 
used when you   prefer to use the adapter manufacturer’s raw RF signal strength readings.

To use a wireless network adapter’s default settings without adjustment,   perform the following steps:

 1. From the upper-left corner of the Signal Adjustment dialog box,    click the down arrow and select No    Adjustment from the 
list menu. (See the figure below.)

Note: When you   have selected No Adjustment option, all other controls in the Signal   Adjustment dialog box are grayed 
out (unavailable).  

 2. Click the OK button to    implement the selection.

Pre-Defined Adjustment
If the wireless network adapter you are using is on the pre-adjusted   list, then the AirMagnet application automatically 
recognizes the adapter   and displays the predefined adjustment option. You can then select and use   the AirMagnet-adjusted 
values or make changes   to the predefined settings. (This is customizing a pre-adjusted wireless network adapter, discussed 
below.)

NOTE: All tests for defining the adjusted values for the wireless adapter   were performed using adjusted spectrum analyzers in 
a professionally shielded   isolation chamber to ensure the best possible accuracy. The adjustment   first uses the spectrum 
analyzer to measure the down-link (from AP to   station) radio signal strength from the Access Point at various attenuation   
points, with an attenuator placed in between the two. The attenuation   is achieved by tuning down the radio signal power the 
attenuator receives   from the AP.  For example, if the attenuator receives the signal   strength of -20 dBm from the AP, it is 
tuned down to -30 dBm. As a   result, the AP signal strength is -30 dBm when received by the spectrum   analyzers. The meas-
urements are carried out at on all channels applicable   to the 802.11 protocol used on the wireless network adapter being 
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adjusted.   Once the benchmark values are established using the spectrum analyzer,   we then perform the same measurement 
procedures with an 802.11 wireless   network adapter (for example, AirMagnet 802.11 a/b/g/n Wireless PC Card)   and adjust the 
values in reference to the benchmark values.

For example, at Attenuation Point A, the spectrum   analyzer displays a radio signal power value of -20 dBm, and the adapter   
being adjusted displays -30 dBm. AirMagnet adds 10 dBm to bring it   to line up with the benchmark values. The predefined 
offsets are relative   to the spectrum analyzer. In other words, the predefined adjustment   patterns make the target Wi-Fi 
adapter report signal strength   readings similar to those reported by professional-grade spectrum analyzers.   For the same 
wireless network adapter, this same procedure is repeated   on every applicable channel/frequency to derive the predefined 
adjustment   values. All adjustment data involving those pre-adjusted wireless   network adapters are included in the 
application.

To use predefined adjustment, do the following:

 1. Click the down arrow and locate your wireless network adapter in the predefined adjustment entries.

 2. Select the adapter (for example, AirMagnet 802.11 a/b/g/n/ USB Adapter Card    as shown in the figure above) if the name 
of your wireless network    adapter appears.

 3. Click OK.

Note: You can make any change to   a pre-adjusted wireless network adapter by making custom adjustments on the basis of   a 
predefined adjustment. Custom adjustments do no   change any of the signal values that depend on the pre-adjustment   
settings. See the next section.

To change predefined adjustments, do the following:

 1. Repeat Steps 1 through 2 in the previous paragraph.

 2. From the upper-right corner, click the down arrow and select a    channel of interest.

 3. Use the sliders to turn up or down the RF signal strength as desired.

 4. When the “Create a custom signal    adjustment based on current settings?” message appears, click    Yes.

 5. Continue to adjust the signal strengths with the sliders.

 6. Enter a value in the noise    floor adjustment box.

 7. Click OK to implement the    change.

Note: Custom signal   adjustment on a pre-adjusted wireless network adapter must be done channel   by channel because the 
changes apply to a single channel only. 

Custom Adjustment
Custom adjustment lets you create your own adjustment   table for your wireless network adapters. This process uses Signal 
Adjustment dialog   box.

Custom adjustment patterns can equalize the signal strength   readings between any combination of Wi-Fi adapters. Begin by 
measuring   (similar to the process defined in pre-adjustment section) two different   radios with zero offsets at varying 
distances, comparing the received   signal strengths at each distance, then calculating the differences between   Wi-Fi adapters 
and using the differences to set the offset of one radio   in an effort to match the signal strength reading of the other Wi-Fi 
adapter.

This feature allows you to adjust the RF signal strength and noise floor   of the wireless network card in 5 dBm increments. 
This way you can normalize   different Wi-Fi adapters to exhibit similar signal level readings. Without   using this feature, the 
signal level readings may vary significantly between   Wi-Fi adapters from different vendors, or even between different models   
from the same vendor.
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The horizontal numbers (-5 to -100) represent the signal strength levels   received by a Wi-Fi adapter. At each signal strength 
level, an offset   can be set (from -30 dB to +30 dB) by adjusting the sliders up or down.

To custom-adjust a wireless network adapter’s RF signal power, do the   following:

 1. From the drop-down list menu, select Custom    Adjustment (The name of your wireless network adapter should    be 
appended here, if it has not been pre-adjusted). See the figure    below.

 2. From the upper-right corner, click the down arrow and select a    channel of interest.

Note: Normally,   signal adjustment is performed on a per-channel basis unless you want   to apply the same adjustment to 
all channels. In this case, you should   select All Channels from the channel   list menu.

 3. Use the sliders to adjust the RF signal strengths.

 4. If you wish, highlight the number for the Noise floor adjustment    box and type a new value over it.

 5. Click OK when completed.
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Analyzing VoFi Survey Data
Since it is far easier to troubleshoot and repair issues with a VoFi   wireless deployment before supporting active users with it, 
NetAlly strongly   recommends that you conduct and analyze a VoFi survey before attempting   to activate it in a real-world 
scenario. This process can be drastically   different from deploying a standard data network simply because what would   
amount to a small issue for a wireless data installation (slight drop   in signal strength, small wireless dead zone, and so on) 
can be a much   greater problem when the deployment is intended to support voice traffic.   A disconnect that lasts for two 
seconds would go largely unnoticed in   a standard wireless deployment, but the same disconnect during a VoFi   call can result 
in dropped calls and overall diminished call quality.

The process of analyzing data collected from a VoFi survey is generally   similar to that of a standard survey, but VoFi surveys 
contain additional   data (such as roaming information) to help identify problem zones in the   VoFi deployment coverage.

NOTE: VoFi surveys are not supported for the 6 GHz band.

 l VoFi Data Types

 l Roaming Analysis

 l Troubleshooting    Poor Call Quality

VoFi Data Types
The Data Type List   Menu for VoFi-specific surveys contains selections that are unique   to voice deployments, as shown below.

Each selection provides information for troubleshooting   and maintaining VoFi deployments.

 l VoFi Signal Strength: shows    the signal strength detected at each point along the survey path.    Note that this selection 
provides data on transmissions from the AP    to the phone.

 l Roaming Zone: displays    the regions in which phones are most likely to roam. When this map    is loaded, potential roaming 
zones are displayed in red.

 l Capacity: Number    of Station(s) shows the number of stations detected on the    AP during the survey. Note that “stations” 
can see other VoFi    phones in addition to other wireless clients (such as notebooks or    wireless-enabled desktops). Number    
of Active Call(s) shows the number of active calls detected    during the survey. This value includes the call monitored 
during the    VoFi survey process.

 l Channel Utilization—displays    the overall utilization on the current channel. Note that this value    accounts for standard 
wireless traffic in addition to VoFi traffic    on the channel.

The AP -> Phone and Phone -> AP options each provide   three additional display types. These selections provide data 
detected   from transmissions between the AP and the VoFi phone.

 l WiMOS Score—much like the    MOS score widely used to monitor the quality of wired communications,    the WiMOS score 
provides a value to display the call quality at each    point during the survey process. This value can range from 1 (poor)    to 
4.5 (excellent).

 l PHY Data Rate—displays    the data transfer rate detected during the survey. This value is measured    in Mbps.

 l Packet Retry Rate—shows    the percentage of packet retries over the course of the survey path.    Excessive packet retries 
can indicate wireless hazards (such as interferers)    in the surveyed environment. Note that this percentage is calculated    as 
a percentage of retry packets transmitted over the past second.
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Roaming Analysis
VoFi phones roam in even the best of VoFi   deployments, so a roaming analysis is critical to ensuring   that users can enjoy unin-
terrupted service during these roaming periods.   AirMagnet Survey PRO allows you to review roaming information captured   
during the VoFi survey process, including each instance in which the phone   roamed, its location, and the time it took to re-
associate to the new   AP. These data can subsequently be used to determine potential hazards   or holes in the VoFi wireless 
deployment.

Note: Roaming events   are displayed in real-time during the VoFi survey process. See Conducting VoFi   Surveys for more 
details.

Survey’s VoFi Roaming Events tab provides a summary of all captured   instances of roaming as well as the pertinent data 
associated with each   event.

Each instance in which the VoFi phone roamed during the survey process   is included in this tab and has a checkbox allowing 
you to view the   roam location on the map. By default, all roaming events are automatically   checked when a VoFi data file is 
loaded. The roaming instances are displayed   on the site map with icons that demonstrate where the roaming started   and 
stopped, as shown below.
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The  (Roaming Start) icon allows you to identify   the location at which the phone enters and exits the roaming state. You   
can hover the mouse over these instances to view additional data regarding   the roam.

The bubble help pop-up allows you to attempt to determine the reason   that the phone roamed at this point on the map. The 
information is displayed   for each AP involved in the roam (for example, the original AP and the   one to which the phone 
roamed), as summarized in the table below.

Column Description
AP Displays the name for both APs in the roaming transaction.     The original AP is listed first, followed by the new 

AP (for example,     the one to which the phone roamed).
Signal The signal strength detected from each AP at the roaming point.     In most cases, the phone attempts to roam 

from an AP with     lower signal strength to one with a stronger signal.
Channel The channel on which each AP is operating.
WiMOS The WiMOS value for the call before and after the roam. A higher     score indicates improved call quality.
Utilization The percentage of available bandwidth on the channel used at the time of the roam.
Station(s) Total number of stations associated to each AP. This value includes other phones, which are recognized as 

stations.
Call(s) The number of active VoFi calls being supported by each AP.
Results Displays whether the roaming attempt was successful or failed.     Failed attempts result in the call being lost.
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Roaming 
Time

The amount of time that passed while the phone was attempting     to roam.

 

Troubleshooting Poor Call Quality
VoFi call quality can suffer due to various   different factors in the wireless environment. This section is designed   to help you 

identify the root cause of a problem detected during the VoFi   survey process. The MultiView    feature 
allows you to view up to four different data types for a VoFi   survey data file at any given time. This can be extremely useful   
when attempting to identify and troubleshoot a region in which the WiMOS   value unexpectedly drops on the map. The steps 
below illustrate the   recommended method for diagnosing the root cause behind a low WiMOS.

See the MultiView View topic, starting   with Map Window for instructions   on using MultiView.

To troubleshoot a region with low WiMOS:

 1. After identifying the problem area on the    map, import the same project containing the VoFi data file into the MultiView    
window four times (See MultiView File    Menu). 

 2. Select the same VoFi data file for each view pane.             

 3. Make sure the Automatic Multi-Select    option is off (See MultiView    Toolbar).             

 4. Use the Data Type drop-down list to load the following heatmaps    into the four panes:

 l Signal Strength (from AP -> Phone)

 l PHY Data Rate (from AP -> Phone)

 l Packet Retry Rate (from AP -> Phone)

 l Channel Utilization

 3. Assess the signal coverage at the region with a low WiMOS using    the Signal Strength map. If the signal strength is low (for 
example,    -67 dBm or lower), the signal coverage provided by the deployment is    insufficient to support a VoFi imple-
mentation.  See Insufficient Signal.

 4. If the signal level is sufficient, look at the PHY Data Rate at    that area. If it is lower than 24 Biopsy, the conversation is not    
being transmitted at a high enough data rate for high quality conversation    levels. See Insufficient    Signal.

 5. In the case where the speed is adequate for the conversation, the    problem may lie in the Packet Retry Rate 
map. Excessive retries    can mean that transmissions from the AP to the phone are not always    going through, which can 
result in a call    being lost. See High Retry    Rate.

 6. Finally, if the other three maps have been verified to be problem-free,    the overall utilization of the channel may simply be 
too high. Any    802.11 deployment is inherently limited in the number of transactions    that can be supported sim-
ultaneously, and as utilization climbs, traffic    may be transmitted at slower speeds to give the infrastructure    more time to 
process exchanges. If you find that    too much of the network is being used at a given time, you may need to upgrade the 
infrastructure with additional APs to support the volume    of traffic detected. See Low    PHY Data Rate.

Insufficient Signal
Ensuring adequate signal coverage is a significant challenge for standard   data network implementations; however, Voice-
enabled deployments present   unique challenges, not the least of which is the fact that a VoFi implementation   requires a 
much higher signal level to ensure adequate call quality.    If you are finding that your signal coverage is insufficient for   either 
type of implementation, this can generally be caused by several   different factors:

 l  Insufficient infrastructure:    This factor is easiest to diagnose but may not be easiest to remedy. If a deployment does not 
have    enough APs to ensure adequate signal coverage throughout the entire    region, transmissions suffer.  This is par-
ticularly noticeable    for VoFi deployments, because voice traffic requires a strong signal to ensure that voice-quality trans-
mission speeds are maintained.
 Although it may seem that adding more APs to the deployment should    be the obvious answer to this problem, this is not 
always the case.     In some situations, this may be the best solution; however,    due to the nature of the wireless spectrum, 
APs that are placed too    closely to each other (both in physical proximity as well as in adjacent    channels on the same 
band) can create interference for each other,    causing additional problems.  In some cases, you may find it    more helpful to 
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rearrange the placement of the existing APs by sacrificing    coverage in areas that do not require VoFi signal strengths (e.g.,    
break rooms, lobbies, and so on) to maintain adequate signal    in the most heavily-used areas.

 l Interferers: Network    interference can come from two major sources: 802.11 and non-802.11    devices.  802.11 devices 
include all existing wireless devices    currently active on the network, including APs, stations, VoFi phones,    and so on.  Non-
802.11 sources can include a wide variety of    common items, including cordless phones, Bluetooth devices, microwave    
ovens, or even fluorescent lighting.
 In cases where 802.11 devices are creating interference, this is most    often due to APs on the same network operating on 
the same (or adjacent)    channels.  Standard wireless practice recommends that APs placed    in close proximity be con-
figured to use channels that are at least    five apart (common practice for the 2.4 GHz band is to use channels    1-6-11, 
although standards may vary depending on country/region).     Non-802.11 interference can be reduced by ensuring that any    
APs be placed far from potential interferers, particularly microwaves    or wireless cameras.  For advanced analysis, you can 
identify    all sources of interference in the environment by using AirMagnet    Spectrum XT, which can be purchased sep-
arately and integrated    with the Survey software.

 l Obstacles: Large    or dense physical objects in the middle of a wireless deployment can    reduce signal coverage in their 
immediate vicinity, creating "holes"    in the network's coverage.  These are most commonly pillars or    thick walls, but can 
also be bodies of water, rooms full of equipment,    etc.
 Since moving obstacles in the wireless environment is often unfeasible,    the best solution for this issue is often similar to 
that for insufficient    infrastructure; namely, to either add or rearrange APs in the    deployment.

Low PHY Data Rate
The rates at which packets are transmitted through the wireless network   can drastically affect the quality of service for users, 
most particularly   during VoFi conversations.  This can be caused by a number of different   factors, two of which are detailed 
below:

 l Mixed-mode devices: Wireless    deployments that are designed to operate at high speeds (such as those    provided by 
802.11g or 802.11n devices) can have those speeds dramatically    reduced when slower devices (such as those that operate 
on 802.11b-only)    are introduced into the environment.  Such "legacy"    devices can cause traffic from all sources to be 
transmitted at lower    rates due to the simple fact that they cannot operate at the higher    rates.
 In these cases, eliminating the legacy devices is the easiest solution.     This can often be done simply by upgrading or 
replacing the    older components, ensuring that the replacements can meet the higher    speeds required for the deployment.

 l Interferers: Network    interference can come from two major sources: 802.11 and non-802.11    devices.  802.11 devices 
include all existing wireless devices    currently active on the network, including APs, stations, VoFi phones,    etc.  Non-802.11 
sources can include a wide variety of common    items, including cordless phones, Bluetooth devices, microwave ovens,    or 
even fluorescent lighting.
 In cases where 802.11 devices are creating interference, this is most    often due to APs on the same network operating on 
the same (or adjacent)    channels.  Standard wireless practice recommends that APs placed    in close proximity be con-
figured to use channels that are at least    five apart (common practice for the 2.4 GHz band is to use channels    1-6-11, 
although standards may vary depending on country/region).     Non-802.11 interference can be reduced by ensuring that any    
APs be placed far from potential interferers, particularly microwaves    or wireless cameras.  For advanced analysis, you can 
identify    all sources of interference in the environment by using AirMagnet    Spectrum XT, which can    be purchased sep-
arately and integrated with the Survey software.

 l Insufficient    signal coverage

High Retry Rate
Installations that experience high levels of packet retry attempts indicate   that packets are being lost during transmission.  
This can create   problems for standard data networks (due to slower transmission rates),   but can drastically impair the quality 
of voice transactions conducted   on the same deployment.  Dropped packets can cause jitter or gaps   in a conversation, 
quickly rendering a VoFi connection unintelligible.    High percentages of retries can be caused by:

 l Interferers:    Network interference can come from two major sources: 802.11 and non-802.11    devices.  802.11 devices 
include all existing wireless devices    currently active on the network, including APs, stations, VoFi phones,    and so on.  Non-
802.11 sources can include a wide variety of    common items, including cordless phones, Bluetooth devices, microwave    
ovens, or even fluorescent lighting.
 In cases where 802.11 devices are creating interference, this is most    often due to APs on the same network operating on 
the same (or adjacent)    channels.  Standard wireless practice recommends that APs placed    in close proximity be con-
figured to use channels that are at least    five apart (common practice for the 2.4 GHz band is to use channels    1-6-11, 
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although standards may vary depending on country/region).     Non-802.11 interference can be reduced by ensuring that any    
APs be placed far from potential interferers, particularly microwaves    or wireless cameras.  For advanced analysis, you can 
identify    all sources of interference in the environment by using AirMagnet    Spectrum XT, which can    be purchased sep-
arately and integrated with the Survey software.

 l Excessive Devices:    Deployments that are attempting to support more devices than they    have the infrastructure for can 
result in transmission collisions,    or ultimately, traffic being ignored in favor of devices with a better    signal.
 Deployments that are using large numbers of devices basically have    two options: expand the infrastructure (that is, add 
APs) or reduce    the total number of stations requiring service.
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Introduction to WLAN Tools
This section describes the four diagnostic tools AirMagnet Survey provides for evaluating and troubleshooting a WLAN. Access 
these tools from the Tools window.

 l Signal Distribution

 l DHCP

 l Ping

 l GPS Information

Signal Distribution
The Signal Distribution tool is designed to enable WLAN professionals   to detect RF signal problems (for example, signal 
multipath) by visually   analyzing RF signal distribution patterns. The sample image below shows   healthy signal distribution as 
indicated by the yellow dashed lines clustering   in a single range. In case of multipath, the yellow dashed lines would   be 
scattered all over the chart.

To access the Signal Distribution tool:

 1. From the Toolbar, click     (Tools). The Tools window    appears. By default, the Signal Dist.    tab (Signal Distribution)    
is automatically selected when the Tools    window opens.

 2. Click the down arrow in the upper-left corner of the window to    select AP or STA.

 3. Click the down arrow in the upper-right corner, and select the    AP or STA to be analyzed.

 4. Click Logging Option. The    Signal Distribution Option    window appears.
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 5. Make the desired selections and click OK.

 6. From the lower-right corner of the Tools window, select either    or both of the following:

 l Signal

 l Noise

 7. Click Go. The signal distribution    pattern of the selected AP or STA is plotted on the chart.

Using the DHCP Tool
WLAN connectivity problems can arise from 802.11 data link layer malfunction   or IP network layer misconfiguration. To 
troubleshoot and pinpoint   the cause of the problems, the interaction between the two network layers   must be investigated. 
AirMagnet Survey’s embedded DHCP tool emulates a   WLAN client acquiring IP-level connectivity beginning from the initial   
802.11 client association procedure.

To access the DHCP tool:

 1. From the Tools window,    click the DHCP tab. The Tools window refreshes.

 2. From the top left corner of the Tools    window, click the down arrow to select AP    or SSID.

 3. From the top right corner of the Tools    window, click the down arrow and select the AP    or SSID from the drop-down    list.

 4. Click Start. AirMagnet    Survey starts associating with the selected AP or SSID and perform    the tests.

Note: During the   association, AirMagnet Survey uses the 802.11 configuration parameters   for the AP or SSID, which can be 
accessed using File > Configure… > 802.11.   The associated AP or SSID is shown on the view. An error message   pops up on 
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the view if an unintended AP is associated or the intended   association fails. This serves as a confirmation that a data link 
layer   problem exists.

 5. Verify the DHCP acquisition of the IP address for the client service,    default gateway, and DNS server.

 6. Click Renew to initiate    the DHCP request once the association with the intended AP has been    confirmed. The following 
IP-level configuration parameters are    filled in on the view if DHCP request/reply is successful:

 l Device IP address

 l Subnet mask

 l Default gateway

 l DNS server

If it turns out that these parameters are NOT the ones you expected   or if you received a DHCP failure message, the chances 
are that there   is an error in the WEP key configuration. If the problem persists after   you have verified the correct WEP key, 
there might be a problem with the   DHCP server.

Using the Ping Tool
You can add a Ping test to DHCP   test to verify end-to-end connectivity. It is used after all the IP configuration   parameters are 
collected and confirmed using DHCP.

To add a Ping test:

 1. From the Tools window,    click the DHCP tab.

 2. Check the Ping option.

 2. Configure the following options:

 l AP/SSID

 l # Pings

 l Timeout

 l Delay

 l Length

 3. Enter the end node’s domain name, for example, www.yahoo.com.

 4. Click Go. Real-time Ping    responses appears on the view.

Note: If the Ping   test shows time-out, it means that the Ping connectivity with the local   LAN has failed. In this case, you 
should check the health of the default   gateway and the physical connection between the associated AP and the   wired LAN. 
Enter a host name on your corporate network such as your internal   Web server, for example, www.in-
ternal.My/computer.com, and click Go.

Verifying GPS Information
This tool is used to verify if your AirMagnet Survey is receiving GPS   signals. To use AirMagnet Survey to conduct large-scale, 
outdoor,   GPS-aided site surveys, your Survey must be able to communicate with the   GPS device it is connected with. When 
using GPS software in conjunction   with AirMagnet Survey, the GPS software must receive GPS position data   before the survey 
is started.

Note: This feature   is available only in Survey PRO and only when the GPS port is enabled.

To verify GPS Information:

From the Tools dialog box, click   GPS Information. The Tools dialog   box refreshes.   Survey PRO connects to the GPS device 
and displays a dialog   box. For more information, see Creating a GPS-Aided Survey Project Using an Existing Site Map.
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Calculating WLAN Parameters Introduction
This section explains the calculation of some parameters critical to   wireless network deployment, such as milliwatt and dBm 
Conversion, System   Operating Margin, Free Space Loss, Fresnel Zone, Downtilt Angle, and Downtilt   Coverage.

All the calculations are performed in the Calculator tool, which can   be accessed by clicking  (Calculator)   on the Toolbar.

 l Converting Between    milliWatt and dBm

 l System Operating Margin

 l Free Space Loss

 l Fresnel Zone Clearance

 l Downtilt Angle

 l Downtilt Coverage

Converting Between milliWatt and dBm
The Milliwatts and dBm Conversion tab of the calculator provides two   conversion operations: from dBm to milliWatt and from 
milliWatt to dBm.   dBm is used to express an absolute value of power relative to a milliWatt.    

To convert milliWatts to dBm:

 1. From the Calculator window,    select the Milliwatts and dBm Conversion    tab (if it not selected). By default, this tab is 
selected when the    Calculator is launched.

 2. Under milliWatts to dBm,    enter a value in milliWatts (from 0 to 1000).

 3. Click Calculate. The system    converts the value to dBm.

To convert dBm to milliWatts:
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 1. Under dBm to milliWatts,    enter a value in dBm (from -100 to 100).

 2. Click Calculate. The system    converts the value to milliWatts.

System Operating Margin
System Operating Margin (SOM) is the difference between the signal a   radio actually receives versus that the signal needed 
for good data   recovery (ice, Receiver Sensitivity). SOM measures in dB the signal loss   a system can sustain before it degrades 
to the error rate specified at   the Receiver Sensitivity threshold. SOM accounts for  all gains and losses in the components 
(such as transmitter power,   type of antenna, distance, etc.) that make up a wireless network   system. The goal is to make sure 
that the system has sufficient power to send radio   signals to their destination.

Normally, a minimum 20-dB SOM is recommended. However, factors (inadequate Fresnel clearance, desensitization, 
etc.) require many   network designs to use a 30 dB (or greater) SOM. SOM   calculation assumes an interference-free open 
space.

To calculate System Operating Margin:

 1. Click the System Operating Margin    tab. The Calculator window refreshes.

 2. Make the following entries:

 l Frequency

 l Power

 l Distance

 l Tx Cable Loss

 l Tx Antenna Gain

 l Rx Cable Loss

 l Rx Antenna Gain

 l Rx Sensitivity

 3. Click Calculate. The following    values are calculated:
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 l Free Space Loss

 l Rx Signal Level

 l System Operating Margin

Free Space Loss
Free space loss refers to signal attenuation that occurs assuming that all   absorbing, diffracting, obstructing, refracting, 
scattering, and reflecting   influences are removed and have no effect   on RF signal propagation. Free space loss is mainly 
caused by beam divergence (signal energy spreading) over larger areas at increased distances   from the source.  

To calculate the free space loss:

 1. From the Calculator window,    select the Free Space Loss    tab. The Calculator window refreshes.

 2. Make the following entries:

 l Frequency

 l Distance

 3. Click Calculate.
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Fresnel Zone Clearance
The line-of-sight condition between the transmitter and the receiver   is crucial in high-frequency radio communication. The 
Fresnel zone is   an elliptical-shaped area between two antennas where no obstacles may   exist so that radio signals can be 
transmitted. The zone defines the optimum   clearance and lets you determine the best antenna height between the AP and 
the client stations without any obstacles.  

To calculate Fresnel Zone:

 1. From the Calculator window, select the Fresnel    Zone tab. The Calculator window refreshes.

 2. Make the following entries:

 l Distance

 l Frequency

 3. Click Calculate. The following    values are automatically calculated:

 l Fresnel Zone Radius

 l 60% Fresnel Zone Radius
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Downtilt Angle
Antenna downtilt affects radio signals traveling between the transmitter   and the receiver. As a rule of thumb, the higher the 
transmitter antenna   and the shorter the distance, the more tilt is required. For instance,   for a 30-meter high transmitting 
antenna, a 0.35-degree antenna tilt is   required to reach a 12-meter high receiving antenna at a distance   of 3,000 meters.  

To calculate the Downtilt Angle:

 1. From the Calculator window, select the Downtilt    Angle tab. The Calculator window refreshes.

 2. Make the following entries:

 l Base Antenna Height

 l Remote Antenna Height

 l Distance

 l Angle

 3. Click Calculate.
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Downtilt Coverage
Downtilt Coverage defines the area into which the antenna of an AP can   beam.  

To calculate the Downtilt Coverage:

 1. From the Calculator window, select the Downtilt    Coverage tab. The Calculator window refreshes.

 2. Make the following entries:

 l Antenna Height

 l Downtilt Angle

 l Vertical Beam width

 3. Click Calculate.
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Introduction to Spectrum XT Integration
This section describes AirMagnet Survey’s ability to integrate with   supported spectrum analyzers. This integration brings 
AirMagnet Survey   to a new level by allowing you to view RF traffic across the entire wireless   spectrum. Spectrum Analyzers 
display potential sources of wireless interference   detected during a survey. This can help you identify and eliminate   RF 
hazards in the wireless environment as soon as they are detected.

Notes: 

 l This feature   is available only on AirMagnet Survey PRO. AirMagnet Survey supports integration   with AirMagnet Spectrum 
XT, AirMagnet Spectrum Analyzer, and Cisco Spectrum   Expert.

 l  To use this   feature, you must have AirMagnet Survey PRO, a supported spectrum analyzer   installed, and the associated 
spectrum analyzer adapter enabled on your   laptop. 

 l Not supported for the 6 GHz band.

 

Enabling Spectrum Analyzer
To enable a spectrum analyzer:

 1. From the Survey view, click File > Configure…. The Survey Configuration view    appears.

 2. Click . The    Spectrum Analyzer dialog box appears.

 3. Check Enable Spectrum Integration    and select one of the Max Hold Reset    options.   

Option Description
Never Reset If selected, the Max Hold value never resets.
Manually 
Reset

If selected, the Max Hold value resets each time      you click on the site map as you move along the survey 
path.

Automatically 
Reset

If selected, the Max Hold value automatically resets      each time or at each point data are collected or 
logged.

 4. Click OK to finish.  You    must restart the application for the new settings to take effect.

Collecting Spectrum Data
The integrated Spectrum Analyzer Window appears below the Map Window on the Survey view, provided that a supported 
spectrum analyzer adapter is installed (inserted) and that this option is enabled in AirMagnet Survey.  A close-up look at the 
Spectrum Analyzer Window is provided below.
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The Spectrum Analyzer Window displays the FFT (Fast Fourier Transform) plot which contains three types of data represented 
by the line charts in distinctive colors. The table below briefly describes each of these data. If you wish to have more 
information on AirMagnet Spectrum XT, see the AirMagnet Spectrum XT User Guide or the Help file in the stand-alone 
AirMagnet Spectrum XT software application.

Color Data 
Type

Description

Yellow Max 
Hold

The maximum power value detected at any time since the plot was initiated. Max Hold means that the plot 
holds onto the maximum power value up to the present.

Red Max The maximum power value detected during the most recent measurement interval.
Green Average The average power value detected during the most recent measurement interval.

Viewing Spectrum Data
With spectrum analyzer integration, you can see the integrated spectrum   analyzer Window on the Display view if they have 
this featured enabled.   You can also display and analyze spectrum data by mousing over any data   point along the survey path.

Note: When you   mouse over a point on a survey path, you not only see a tip view showing   the 802.11 data collected at that 
spot but also a pushpin that is related   to what you see in the Spectrum Analyzer Window below. In other words,   the 
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Spectrum Analyzer Window reflects the spectrum data collected at the   spot indicated by the pushpin. With spectrum data on 
the view, a tip view   pops up if you mouse over any spot on the FFT plot in the Spectrum   Analyzer Window. This tip view 
shows more spectrum data about that spot.

Spectrum integration allows you to identify non-802.11 devices that   cause interference with the wireless deployment 
(henceforth known as “interferers”).   Click here for more details.

You can also use Spectrum XT to display a spectrum heatmap   to help locate major sites of spectrum traffic.

Spectrum Heatmap Display
To provide a more comprehensive and user-accessible means of   viewing spectrum data, Survey implements a spectrum 
heatmap option when   spectrum analyzer integration is enabled. This allows you to view   all RF traffic in the entire spectrum, 
including both Wi-Fi (APs, stations,   and so on) and non-Wi-Fi (Bluetooth devices, microwaves, and so on) sources. The   
spectrum heatmap displays the average spectrum level for each channel   at any given point on the map. The color-coded 
display makes it easy   to determine areas of unusual spectrum traffic, allowing you to quickly   troubleshoot problem spots.

To view the spectrum heatmap:

 1. From the Display page, load the spectrum data file.

 2. Click the data type drop-down list in the map window and select    Spectrum. The heatmap refreshes,    displaying spectrum 
data.
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You can narrow the displayed spectrum to a specific channel, allowing   you to identify unusual traffic at the particular 
frequency of interest. Depending   on the card used when conducting the survey, this can include both 802.11a   and 802.11b/g 
channels.

Note: The heatmap   displays an overview of spectrum information. You can still mouse over   a point on the survey path to 
view specific spectrum data for that exact   location.

The spectrum heatmap can be particularly useful when you want to determine   the optimal channel for a new AP. By viewing 
the heatmap on the desired   channel, you can see whether there is excessive spectrum traffic at that   location. If the spectrum 
traffic level is high, you must change   the environment to eliminate interferers or select a new location.

Spectrum Interferers
Interferers can be viewed in a list and as detected in the deployment   by using the interferer heatmap provided on the Display 
view. The interferer   power heatmap shows the power levels for any such devices detected during   the survey process and also 
provides a list of the devices found. This   can be useful for identifying potential interference sources that may   not be picked 
up by a standard 802.11 survey.
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After gathering interferer data, you can view the interferers detected   listed in the Categories tree towards the left of the view.

Bold categories indicate that devices that match that particular category   were detected during the survey. (For example, in 
the first figure above the   system detected interference from Bluetooth devices, cordless phones,   and both continuous and 
fixed-frequency devices over the course of the   survey.) You can identify the location of the devices by selecting the   desired 
type; the heatmap refreshes to highlight only the location(s)   in which that device was detected.

All interferers detected across the entire survey path are displayed   in the bottom pane of the window, below the spectrum 
graphs. This table   provides various data regarding the detected interferers, including the   Type, Name, a brief description, and 
its center frequency (if known).
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Generating Spectrum Analyzer Reports
AirMagnet Survey not only enables you to collect and analyze the enormous   amount of spectrum data in the airwave over 
your WLAN site, but also allows   you to convert these valuable data into reports, making it convenient   to share, archive, and 
further analyze the data.

However, to generate and view spectrum analyzer reports, you   must make sure that first of all spectrum data are being 
collected during   the site survey. To do so, you have to make sure that the following requirements   are met at the time of the 
survey:

 1. You have AirMagnet Survey PRO installed on your laptop;

 2. You have the associated spectrum analyzer adapter inserted in your    system;

 3. You have the Spectrum Integration feature enabled on AirMagnet    Survey, which can be done by selecting File > 
Configure… > Spectrum    Integration > Enable Spectrum Integration.

If these three requirements are met, you should be able to see the Spectrum   Analyzer Window with spectrum data in it at the 
bottom of the Survey view   when you are doing the survey.

Once spectrum data are collected, the next step is to open the data   file on the Display view and mark the spectrum data 
collection points   on the survey path. This is important because even though spectrum   data are collected, no Spectrum 
Analyzer report shows up on the Reports   view until the spectrum data collection points are marked on the survey path.   
Otherwise, you get an error message when you try to   open the Spectrum Analyzer Report on the Reports view. To see how to 
mark   spectrum data collection points along the survey path on the Display view,   click here.

Once you have marked all the spectrum data collection points on the   Display view, AirMagnet Survey automatically generates 
the Spectrum   Analyzer Report, which can be viewed from the Reports view just as with   any of the other reports.  For instruc-
tions, click here.

Marking Spectrum Data Collection Points
To mark spectrum data collection points:

 1. From the Display view, click to open the data file that contains    the spectrum data.

 2. Right-click inside the Map Window. A right-click pop-up menu appears.
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 3. From the right-click menu, select Mark    Spectrum Data Mode.

Note: A check mark   appears in front of Mark Spectrum Data Mode when this feature is activated.

 4. In the Map Window, click to select the spectrum data collection    points along the survey path.
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Note: Pin icons   appear where you click. Pins are automatically numbered in the order they   appear. As you click, spectrum 
data also appears in the Spectrum   Analyzer Window. Be sure to click along the survey path. Otherwise, no icon appears and 
no spectrum data point is marked.

Viewing AirMagnet RF Spectrum Reports
To view the RF Spectrum Report:

 1. Click  on the Navigation    bar to switch to the Reports view

 2. From the Report List Window, select RF    Spectrum Report.

 3. Navigate through the report using the tools on the view.

Note: Normally,   the number of pages contained in a report depends on the amount of data   in the data file selected. However, 
in the case of the RF Spectrum Report,   the length of the report is determined by the number of data collection   points (you 
have marked), which in turn determine the amount of data contained   in the report.
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GENERAL TERMS AND CONDITIONS

(v31-Jan-21)

These General Terms and Conditions ("General T&Cs") are   by and between the Channel Company and/or the End-User, which 
has purchased   and/or licensed the Products, as set forth in the applicable Order (hereinafter   Channel Partner and End-User 
may collectively be referred to as the “Company”),   and provided the terms, conditions, rights and restrictions for which   
NetAlly, LLC and any of its subsidiaries and affiliates (collectively   or individually referred to as "NetAlly") is willing to sell   
devices ("Hardware"), license NetAlly’s proprietary software,   as well as any firmware residing on such Hardware, ("Software")   
(hereinafter Hardware and Software may be collectively referred to as   the "Product(s)"), and provide Services to Company. 
NetAlly’s   provisioning of Products, and/or Services to Company is expressly contingent   upon Company’s acceptance of these 
General T&Cs, “AS IS”. 

Receipt without return of any Products from NetAlly by Company shall   be deemed as acceptance of this Order and shall also 
constitutes Company's   confirmation that the Products descriptions, quantities, term, and prices   set forth in the Order 
accurately represent Company's intended purchase.   All additional and conflicting terms and conditions presented with or   in 
any communication, including but not limited to those set forth in   any P.O., except with respect to price, quantity, and 
location are hereby   rejected, and shall be deemed null and void. 

1. Definitions: 

“AllyCare Services” means the optionally purchased Maintenance Services,   which an End-User may purchase hereunder which 
can be reviewed at https://www.netally.com/allycare-enabled/. 

“AUP” means the Acceptable Use Policy published by NetAlly governing   the permitted uses of any Services provided 
hereunder, for which NetAlly   may update from time-to-time and can be reviewed at https://www.netally.com/legal/.   

“Channel Company” means a valid legal entity, in good standing, which   has entered into a commercial agreement with 
NetAlly, allowing for the   licensing or re-licensing of Software or distribution, sale, or resale   of Products and Service. 

“Company Data” means information that Channel Company uploads or uses   in conjunction with Channel Company’s use of 
the Products. 

“Data” mean collectively the Company Data and the EndUser Date. 

“Data Protection Act” means the Health Information Portability and Accountability   Act (HIPAA) (29 U.S. Code § 1181, et seq.), 
Gramm Leach Bliley Act (GLBA)   (15 U.S Code § 1681), General Data Protection Regulation (GDPR) (EU 2016/679),   and other 
applicable regulations which seek to protect the processing   and storage of personal information. 

"Documentation" means any installation guides, reference guides,   operation manuals and release notes provided with the 
Product in printed,   electronic, or online form. 

“End-User” means an individual and/or a valid legal entity that is using   the Products and/or receiving the Services. 

“End-User Data” means information that End-User uploads or uses in conjunction   with End-User’s use of the Products. 

“Evaluation Product” means software that contains a license key, which   disables the Software after thirty (30) calendar days, 
or other term as   agreed to by the parties. 

“Maintenance Services” &/or “Maintenance” means the support services   for the Products, including but not limited to the 
AllyCare Services,   provide by NetAlly to Company. 

“Order" means the combination of Company’s P.O., a Quote issued   by NetAlly or a NetAlly Company, and these General T&Cs. 

“P.O.” means a purchaser order or document, in tangible or intangible   form (e.g. .rtf, .pdf, formats, etc.), issued by Company 
indicating Company’s   acceptance of the Quote and these General T&Cs, without regards to   any conflicting terms and 
conditions presented therein, except with respect   to price, quantity, and location of Products or Services. 

“Personal Data” means any information relating to an identified or identifiable   natural person (hereafter a “Data Subject”); an 
identifiable person is   one who can be identified, directly or indirectly, in particular by reference   to an identification number or 
to one or more factors specific to his   physical, physiological, mental, economic, cultural or social identity.   

“Portal” shall mean URL(s) hosted by NetAlly used to communicate, provided   Maintenance Services, Software updates and 
upgrades to the Company. 

“Quote" means the document under which NetAlly offers for sale   and licenses its Products, Maintenance, and other services. 

“Services” means the AllyCare Services, Maintenance Services as well   as any other services offered by NetAlly to Company 
from time to time.   

2. Shipment & Delivery Terms: NetAlly ships all Products hereunder   FOB Origin. Unless otherwise agreed to by the parties, all 
shipments will   be made using the carrier designated by Company. If Company does not designate   a carrier, NetAlly reserves 
the right to choose a carrier at Company's   expense. For Software available for electronic download, delivery will   be deemed 
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to have occurred once NetAlly has made the Software available   for download by Company or Company’s designate agent or 
representative.   Unless otherwise stated conspicuously on the face of the applicable Order,   NetAlly reserves the right to fulfill 
Orders via multiple shipments. For   all Products shipped internationally, Company will be the importer of   record. Company 
agrees that it will not remove any NetAlly General T&Cs   or other agreement from the NetAlly Product(s), and/or associated 
packaging.   

3. License Grant & Restrictions: Subject to payment of the applicable   license fee and the terms set forth in an applicable 
Order, NetAlly grants   Company a limited, non-exclusive, non-transferable, revocable license   to use the Software and the Docu-
mentation for Company’s own internal business   purposes. 

(a) Evaluation License. NetAlly hereby grants Company a temporary, non-exclusive,   non-transferable, revocable license to use 
the Evaluation Product set   forth in the applicable NetAlly Evaluation Request Form solely for internal   testing, evaluation, or 
demonstration purposes. If Company chooses not   to purchase a license for the Evaluation Product, the Evaluation Product   
must be removed from Company’s system(s) and all permitted copies of such   Evaluation Product immediately destroyed. A 
Return Materials Authorization   number (“RMA #”) for any Hardware Evaluation Product must be obtained   before return of 
such Product. 

(b) Pre-Released Products. If the Product Company has received with   this license is not yet commercially available 
("PreReleased Product"),   then NetAlly grants Company a temporary, nonexclusive, non-transferable,   revocable license to use 
the Pre-Released Product and the associated Documentation,   if any, as provided to Company by NetAlly solely for internal 
evaluation   purposes. NetAlly may terminate Company’s right to use the Pre-Released   Product at any time at NetAlly’s 
discretion. Company’s use of the Pre-Released   Product is limited to thirty (30) days unless otherwise agreed to in writing   by 
NetAlly. Company acknowledges and agrees that (i) NetAlly has not promised   or guaranteed to Company that the 
PreReleased Product will be announced   or made available to anyone in the future; (ii) NetAlly has no express   or implied 
obligation to Company to announce or introduce the Pre-Released   Product; (iii) NetAlly may not introduce a product similar 
to or compatible   with the Pre-Released Product; and (iv) any use of the Pre-Released Product   or any product associated with 
the Pre-Released Product is entirely at   Company’s own risk. During the term of these General T&Cs, if requested   by NetAlly, 
Company will provide feedback to NetAlly regarding use of   the PreReleased Product. Company will not disclose any features 
or functions   of any Pre-Released Product until NetAlly makes the Pre-Released Product   publicly available. 

(c) License Restrictions. Except as required by law, Company will not,   and will not cause or permit others to, derive the source 
code of the   Software, or reverse engineer, disassemble, or decompile the Products.   Company may not (i) create derivative 
works of the Software, (ii) lend,   rent, lease, assign, sublicense, and/or make available through timesharing   or service bureau 
the Software, or (iii) transfer the Software or provide   third party access to the Software. 

(d) Third-party Technology. The Products may contain embedded third-party   technology (“Third-party Materials”). Such 
Third-party Materials are licensed   for use solely with the Product. Third-party Materials are provided subject   to the applicable 
third-party terms of use (“TOU”). Company agrees to   abide by the TOU and/or to obtain any additional licenses that may be   
required to use the Third-party Materials. 

(e) Ownership. NetAlly and its third-party licensors retain all right,   title, and interest in and to the Products, Third party 
Technology. Company   retains all right, title and interest in and to the Data. 

4. Acceptable Use: Company specifically agrees to limit the use of the   Products and/or Services to those specifically granted 
in these General   T&Cs. Without limiting the foregoing, Company specifically agrees   *not* to (i) attempt to reverse engineer, 
decompile, disassemble, or attempt   to derive the source code of the Software or any portion thereof; (ii)   modify, port, 
translate, localize or create derivative works of the Software;   (iii) remove any of NetAlly’s, or its vendors, copyright notices 
and proprietary   legends; (iv) use the Products to (a) infringe on the intellectual property   rights of any third party or any rights 
of publicity or privacy; (b) violate   any law, statute, ordinance, or regulation (including but not limited   to the laws and 
regulations governing export/import control, unfair competition,   antidiscrimination and/or false advertising); or (c) propagate 
any virus,   worms, Trojan horses or other programming routine intended to damage any   system or data; (v) file copyright or 
patent applications that include   the Product or any portion thereof; and/or (vi) use of the Portal, Products   and/or Services on 
violation of the AUP. 

5. Company & Personal Data: During the Term, Company may provide   NetAlly with Data. NetAlly may use such Data in 
connection with the performance   of its obligations under these General T&Cs. Company hereby agrees   to strictly comply with 
any and all applicable Data Protection Acts with   regards to the transfer, handling storage and processing of Personal Data.   
Company acknowledges and agrees that should Company transfer such Personal   Data to NetAlly, or other third parties, 
Company will serve as such Personal   Data’s “Controller”, as set forth in the applicable Data Protection Acts.   Further, in the 
event of a breach of Personal Data, attributed to Company’s   actions or inactions in furtherance of these General T&Cs, in 
violation   of the Data Protection Acts, Company shall promptly (i) take all necessary   steps to curtail such breach; (ii) undertake 
all necessary actions to   mitigate damages; (iii) provide the necessary notification and remediation,   as set forth in the 
applicable Data Protection Act; and (iv) aid and assist   in NetAlly’s efforts to do the same, at Company’s sole cost and expense.   
6. Term & Termination: These General T&Cs shall continue unless   terminated pursuant to this Section; provided, that the 
applicable subscription   term for any licenses purchased hereunder shall continue for the period   of time specified in the 
applicable Quotation. Either party may terminate   these General T&Cs immediately upon providing written notice of breach   to 
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the other party, if such other party materially breaches any of its   obligations hereunder but fails to cure such breach in a 
period of   thirty (30) days following receipt of such written notice. Upon any termination   of these General T&Cs (i) all licenses 
granted hereunder shall immediately   terminate, (ii) Company will either return the Software, Documentation,   and Copies or, 
with NetAlly's prior consent, destroy the Software, Documentation,   and Copies. 7. Confidentiality: “Confidential Information” 
shall mean   any and all non-public technical, financial, commercial or other confidential   or proprietary information, Services, 
Product roadmaps, pricing, software   code, Documentation, techniques and systems, and any and all results of   benchmark 
testing run on the Products. Neither party will disclose Confidential   Information to any third party except to the extent such 

============================================================

1. Definitions.  

“API(s)” means the software application interfaces and workflow methods   made generally available by NetAlly in certain 
Products to enable integration,   implementation, and interoperability with third party hardware and software.

“Company” means a valid legal entity, in good standing, which has entered   into a commercial agreement with NetAlly, 
allowing for the licensing or   re-licensing of Software or distribution, sale, or resale of Products   and Service.  

“Company Data” means information that Company uploads or uses in conjunction   with Company’s use of the Products.

“Data Protection Act” means the Health Information Portability and Accountability   Act (HIPAA) (29 U.S. Code § 1181, et seq.), 
Gramm Leach Bliley Act (GLBA)   (15 U.S Code § 1681), General Data Protection Regulation (GDPR) (EU 2016/679),   and other 
applicable regulations which seek to protect the processing   and storage of personal information.

“Documentation” means any installation guides, reference guides, operation   manuals and release notes provided with the 
Product in printed, electronic,   or online form.

“Evaluation Product” means software that contains a license key, which   disables the Software after 30 days, or other term as 
agreed to by the   parties, and which will render the Product unusable.

“Order" means the combination of Company’s P.O., a Quote issued   by NetAlly or a NetAlly Company, and these General T&Cs.

“Personal Data” means any information relating to an identified or identifiable   natural person (hereafter a “Data Subject”); an 
identifiable person is   one who can be identified, directly or indirectly, in particular by reference   to an identification number or 
to one or more factors specific to his   physical, physiological, mental, economic, cultural or social identity.

“P.O.” means a purchaser order or document, in tangible or intangible   form (e.g. .rtf, .pdf, formats, etc.), issued by Company 
indicating Company’s   acceptance of the Quote and these General T&Cs, without regards to   any conflicting terms and 
conditions presented therein, except with respect   to price, quantity, and location of Products or Services.

“Quote” means the document under which NetAlly offers for sale and licenses   its Products, Maintenance, and other services.

“Services” means Maintenance as well as any other services offered by   NetAlly to Company from time to time.   

2. Shipment & Delivery Terms. NetAlly ships all Products hereunder   FOB Origin. Unless otherwise agreed to by the parties, all 
shipments will   be made using the carrier designated by Company. If Company does not designate   a carrier, NetAlly reserves 
the right to choose a carrier at Company's   expense. For Software available for electronic download, delivery will   be deemed 
to have occurred once NetAlly has made the Software available   for download by Company or Company’s designate agent or 
representative.   Unless otherwise stated conspicuously on the face of the applicable Order,   NetAlly reserves the right to fulfill 
Orders via multiple shipments. For   all Products shipped internationally, Company will be the importer of   record. Company 
agrees that it will not remove any NetAlly General T&Cs   or other agreement from the NetAlly Product(s), and/or associated 
packaging.     

3. License Grant and Restrictions. Subject to payment of the applicable   license fee and the terms set forth in an applicable 
Order, NetAlly grants   Company a limited, non-exclusive, non-transferable, revocable license   to use the Software and the Docu-
mentation for Company’s own internal business   purposes.  

(a) Evaluation License: NetAlly hereby grants   Company a temporary, non-exclusive, non-transferable, revocable license   to use 
the Evaluation Product set forth in the applicable NetAlly Evaluation   Request Form solely for internal testing, evaluation, or 
demonstration   purposes. If Company chooses not to purchase a license for the Evaluation   Product, the Evaluation Product 
must be removed from Company’s system(s)   and all permitted copies of such Evaluation Product immediately destroyed.   A 
Return Materials Authorization number (“RMA #”) for any Hardware Evaluation   Product must be obtained before return of 
such Product.   

(b) Pre-Released Products. If the Product   Company has received with this license is not yet commercially available   ("Pre-
Released Product"), then NetAlly grants Company a temporary,   non-exclusive, non-transferable, revocable license to use the 
Pre-Released   Product and the associated Documentation, if any, as provided to Company   by NetAlly solely for internal 
evaluation purposes. NetAlly may terminate   Company’s right to use the Pre-Released Product at any time at NetAlly’s   
discretion. Company’s use of the Pre-Released Product is limited to thirty   (30) days unless otherwise agreed to in writing by 
NetAlly. Company acknowledges   and agrees that (i) NetAlly has not promised or guaranteed to Company   that the Pre-
Released Product will be announced or made available to anyone   in the future; (ii) NetAlly has no express or implied 
obligation to Company   to announce or introduce the Pre-Released Product; (iii) NetAlly may not   introduce a product similar 
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to or compatible with the Pre-Released Product;   and (iv) any use of the Pre-Released Product or any product associated   with 
the Pre-Released Product is entirely at Company’s own risk. During   the term of these General T&Cs, if requested by NetAlly, 
Company will   provide feedback to NetAlly regarding use of the Pre-Released Product.   Company will not disclose any features 
or functions of any Pre-Released   Product until NetAlly makes the Pre-Released Product publicly available.

(c) API License. NetAlly grants Company a   limited, non-exclusive, non-transferable revocable license to use the   API, together 
with applicable documentation, any sample code, and any   sample applications provided with the API, solely in connection 
with the   Products for Company’s internal business purposes; provided that Company   may not use the API in connection with 
developing a product or service   that competes with Products.  

(d) License Restrictions. Except as required   by law, Company will not, and will not cause or permit others to, derive   the 
source code of the Software, or reverse engineer, disassemble, or   decompile the Products. Company may not (i) create 
derivative works of   the Software, (ii) lend, rent, lease, assign, sublicense, and/or make   available through timesharing or 
service bureau the Software, or (iii)   transfer the Software or provide third party access to the Software.

(e) Third-party Technology. The Products   may contain embedded third-party technology (“Third-party Materials”).   Such 
Third-party Materials are licensed for use solely with the Product.   Third-party Materials are provided subject to the applicable 
third-party   terms of use (“TOU”). Company agrees to abide by the TOU and/or to obtain   any additional licenses that may be 
required to use the Third-party Materials.

(f) Ownership. NetAlly and its third-party   licensors retain all right, title, and interest in and to the Products,   Third party 
Technology and/or APIs. Company retain all right, title and   interest in and to the Company Data.

4. Acceptable Use. Company specifically agrees to limit the use of the   Products and/or Services to those specifically granted 
in these General   T&Cs. Without limiting the foregoing, Company specifically agrees   not to (i) attempt to reverse engineer, 
decompile, disassemble, or attempt   to derive the source code of the Software or any portion thereof; (ii)   modify, port, 
translate, localize or create derivative works of the Software;   (iii) remove any of NetAlly’s, or its vendors, copyright notices 
and proprietary   legends; (iv) use the Products to (a) infringe on the intellectual property   rights of any third party or any rights 
of publicity or privacy; (b) violate   any law, statute, ordinance, or regulation (including but not limited   to the laws and 
regulations governing export/import control, unfair competition,   anti-discrimination and/or false advertising); or (c) 
propagate any virus,   worms, Trojan horses or other programming routine intended to damage any   system or data; and/or (v) 
file copyright or patent applications that   include the Product or any portion thereof.

5. Company & Personal Data. During the Term, Company may provide   to NetAlly Company Data. NetAlly may use Company 
Data in connection with   the performance of its obligations under these General T&Cs. Company   hereby agrees to strictly 
comply with any and all applicable Data Protection   Acts with regards to the transfer, handling storage and processing of   
Personal Data. Company acknowledges and agrees that should Company transfer   such Personal Data to NetAlly, or other 
third-parties, Company will serve   as such Personal Data’s “Controller”, as set forth in the applicable Data   Protection Acts. 
Further, in the event of a breach of Personal Data, attributed   to Company’s actions or inactions in furtherance of these 
General T&Cs,   in violation of the Data Protection Acts, Company shall promptly (i) take   all necessary steps to curtail such 
breach; (ii) undertake all necessary   actions to mitigate damages; (iii) provide the necessary notification   and remediation, as 
set forth in the applicable Data Protection Act; and   (iv) aid and assist in NetAlly’s efforts to do the same, at Company’s   sole 
cost and expense.

6. Term and Termination. These General T&Cs shall continue unless   terminated pursuant to this Section; provided, that the 
applicable subscription   term for any licenses purchased hereunder shall continue for the period   of time specified in the 
applicable Quotation. Either party may terminate   these General T&Cs immediately upon providing written notice of breach   to 
the other party, if such other party materially breaches any of its   obligations hereunder but fails to cure such breach in a 
period of   thirty (30) days following receipt of such written notice. Upon any termination   of these General T&Cs (i) all licenses 
granted hereunder shall immediately   terminate, (ii) Company will either return the Software, Documentation,   and Copies or, 
with NetAlly's prior consent, destroy the Software, Documentation,   and Copies.

7. Confidentiality. “Confidential Information” shall mean any and all   non-public technical, financial, commercial or other con-
fidential or proprietary   information, Services, Product roadmaps, pricing, software code, Documentation,   techniques and 
systems, and any and all results of benchmark testing run   on the Products. Neither party will disclose Confidential 
Information   to any third party except to the extent such disclosure is necessary for   performance of these General T&Cs, or it 
can be documented that any   such Confidential Information is in the public domain and generally available   to the general 
public without any restriction. Each party will use the   same degree of care to protect Confidential Information as Company 
uses   to protect Company’s own confidential information but in no event less   than reasonable care.

8. Warranties. NetAlly warrants, for Company’s benefit alone, (i) that   the Hardware will be free from material defects for a 
period of twelve   (12) months following the date of shipment of the Hardware ("Hardware   Warranty Period"); and (ii) the 
Software, will conform materially   and substantially to the Documentation for a period of ninety (90) days

following the date when first made available to Company for download   (“Software Warranty Period”). The warranties set 
forth herein do not apply   to any failure of the Software or Hardware caused by (a) Company’s failure   to follow NetAlly's install-
ation, operation, or maintenance instructions,   procedures, or Documentation; (b) Company’s mishandling, misuse, 
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negligence,   or improper installation, de-installation, storage, servicing, or operation   of the Product; (c) modifications or 
repairs not authorized by NetAlly;   (d) use of the Products in combination with equipment or software not   supplied by NetAlly 
or authorized in the Documentation; and/or (e) power   failures or surges, fire, flood, accident, actions of third parties, or   other 
events outside NetAlly's reasonable control. NetAlly cannot and   does not warrant the performance or results that may be 
obtained by using   the Products, nor does NetAlly warrant that the Products are appropriate   for Company’s purposes or error-
free. If during the Software Warranty   Period or Hardware Warranty Period, a nonconformity is reported to NetAlly,   NetAlly, at 
its option, will use commercially reasonable efforts to repair   or replace the non-conforming Software or Hardware. THIS 
REMEDY IS CUSTOMER’S   SOLE AND EXCLUSIVE REMEDY, AND NETALLY’S SOLE LIABILITY FOR A BREACH OF   WARRANTY. 
EXCEPT FOR THE EXPRESS WARRANTIES STATED IN THIS SECTION 8,   “WARRANTIES” NETALLY DISCLAIMS ALL WARRANTIES 
ON MERCHANDISE SUPPLIED   UNDER THIS AGREEMENT, INCLUDING, WITHOUT LIMITATION, ALL IMPLIED WARRANTIES   OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  

9. LIMITATION OF LIABILITY. NETALLY SHALL NOT BE LIABLE FOR ANY LOSS   OR DAMAGE UNLESS SUCH LOSS OR DAMAGE IS 
DUE TO NETALLY’S GROSS NEGLIGENCE   AND/OR WILLFUL MISCONDUCT. IF NETALLY IS FOUND LIABLE, THE AMOUNT OF 
NETALLY’S   MAXIMUM LIABILITY FOR ANY AND ALL LOSSES AND/OR DAMAGES (IN CONTRACT,   TORT, OR OTHERWISE) SHALL 
NOT EXCEED THE TOTAL AMOUNT OF ALL LICENSE FEES   ACTUALLY PAID TO NETALLY FOR THE RELEVANT NETALLY PRODUCT
(S) OR SERVICE(S)   in THE PRIOR SIX (6) MONTHS FROM WHICH SUCH CLAIM ARISES.  

10. EXCLUSION OF CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL EITHER PARTY   BE LIABLE TO THE OTHER OR ANY THIRD 
PARTY FOR ANY CONSEQUENTIAL, INDIRECT,   SPECIAL, PUNITIVE, AND/OR INCIDENTAL DAMAGES, WHATSOEVER, INCLUDING 
BUT   NOT LIMITED TO LOST PROFITS OR LOSS OF DATA, EVEN IF SUCH PARTY HAS BEEN   ADVISED OF THE POSSIBILITY OF 
SUCH POTENTIAL LOSS OR DAMAGE.

11. ESSENTIAL PURPOSE. THE LIMITATION OF LIABILITY AND EXCLUSION OF   CERTAIN DAMAGES STATED HEREIN SHALL APPLY 
REGARDLESS OF THE FAILURE OF   ESSENTIAL PURPOSE OF ANY REMEDY. BOTH PARTIES HEREUNDER SPECIFICALLY 
ACKNOWLEDGE   THAT THESE LIMITATIONS OF LIABILITY ARE REFLECTED IN THE PRICING.

12. Indemnification. For any claims based on Company’s breach of Section   3, “License Grant and Restrictions”, 4. “Acceptable 
Use”, 5 “Company &   Personal Data”, 7 “Confidentiality”, 8 “Warranties”, 14.4 “Compliance   & Export Controls”, 14.6 “Anti-
Corruption and Anti-Bribery” and/or   Company use of Product(s), Company hereby agrees to indemnify, defend,   and hold 
NetAlly harmless against such claim(s) at Company’s expense and   pay all damages that a court of competent jurisdiction 
finally awards,   provided that NetAlly (i) promptly notifies Company in writing of the   claim(s); (ii) allows Company to control 
the defense or any related settlement   negotiations; and (iii) cooperates with Company in the defense of any   such claim(s); 
provided, that, Company will not affect any settlement   unless such settlement provides NetAlly with a full release.

13. Relationship with Third parties. The relationship between the parties   established by these General T&Cs is that of 
independent contractors,   and nothing contained in these General T&Cs shall be construed to:   (i) give either party the power 
to direct or control the day-to-day activities   of the other; (ii) constitute the parties as partners, joint ventures,   co-owners or 
otherwise as participants in a joint or common undertaking   or franchise; (iii) allow Company to create or assume any 
obligation on   behalf of NetAlly for any purpose whatsoever; or (iv) allow any customer,   End-User, or other person or entity 
not a party to these General T&Cs   to be considered a third-party beneficiary of these General T&Cs.

14. General Provisions.

 14.1 Entire Agreement T&Cs & Integration. These General   T&Cs and all Exhibits referencing these General T&Cs represent   the 
entire agreement between the parties on the subject matter hereof   and supersede all prior discussions, agreements and 
understandings of   every kind and nature between the parties. Neither party shall be deemed   the drafter of these General 
T&Cs. No modification of these General   T&Cs shall be effective unless in writing and signed by both parties.   All additional and 
conflicting terms and conditions presented with or   in any communication, including but not limited to Company’s P.O., 
except   with respect to price, quantity, and location specified in a P.O., are   hereby rejected, and shall be deemed null and 
void.

 14.2 Severability & Survival. The illegality or unenforceability   of any provision of these General T&Cs shall not affect the 
validity   and enforceability of any legal and enforceable provisions hereof. Should   any provision of these General T&Cs be 
deemed unenforceable by a court   of competent jurisdiction then such clause shall be re-construed to provide   the maximum 
protection afforded by law in accordance with the intent of   the applicable provision. Any provision contained herein, which 
by its   nature should survive the termination of these General T&Cs shall   survive, including, but not limited to, Section 7 “Con-
fidentiality”, 9   “Limitation of Liability & Exclusion of Consequential Damages”, 12   “Indemnification”, and 14 “General 
Provisions”.

 14.3 Assignment. Neither party may assign any rights or delegate   any obligations hereunder, whether by operation of law or 
otherwise, except   in the case of a sale of either party’s business whether by merger, sale   of assets, sale of stock or otherwise, 
or except with the prior written   consent of the other party, which consent will not be unreasonably withheld.   These General 
T&Cs binds the parties, their respective participating   subsidiaries, affiliates, successors, and permitted assigns.

 14.4 Compliance & Export Controls. Company shall comply fully   with all applicable laws, rules, and regulations including 
those of the   United States, and any and all other jurisdictions globally, which apply   to Company’s business activities in 
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connection with these General T&Cs.   Company acknowledges that the NetAlly Products and/or NetAlly Services   are subject to 
United States Government export control laws. Company shall   comply with all applicable export control laws, obtain all 
applicable   export licenses, and will not export or re-export any part of the Products   and/or Services to any country in 
violation of such restrictions or any   country that may be subject to an embargo by the United States Government   or to End-
Users owned by, or with affiliation to, such countries embargoed   by the United States Government.  

 14.5. U.S. Government Use Notice. The NetAlly Software is a “Commercial   Item”, as that term is defined at 48 C.F.R. § 2.101, 
consisting of “Commercial   Computer Software” and “Commercial Computer Software Documentation,” as   such terms are 
used in 48 C.F.R. § 12.212 and 48 C.F.R. § 227.7202, as   applicable. Consistent with 48 C.F.R. § 12.212 and 48 C.F.R. § 227.7202-1   
through 227.7202-4, the Commercial Computer Software and Commercial Computer   Software Documentation are being 
licensed to U.S. Government End-Users   (a) only as Commercial Items and (b) with only those rights as are granted   to all other 
End-Users pursuant to the terms and conditions herein. For   some components of the Software as specified in the Exhibit, 
Attachment,   and/or Schedule, this Software and Documentation are provided on a RESTRICTED   basis. Use, duplication, or 
disclosure by the United States Government   is subject to restrictions set forth in Subparagraphs (c) (1) and (2)   of the 
Commercial Computer Software Restricted Rights at 48 CFR 52.227-19,   as applicable.

 14.6 Anti-Corruption and Anti-Bribery. Company will not make or   permit to be made any improper payments and will comply 
with the U.S.   Foreign Corrupt Practices Act, the UK Bribery Act, the Organization for   Economic Co-operation and Development 
(“OECD”) Convention on Anti-Bribery,   and other applicable local anti-bribery laws and international anti- bribery   standards. 
Company represents and warrants that it will not pay any commission,   finder's fee, or referral fee, or make any political con-
tribution, to   any person in connection with activities on behalf of NetAlly.

 14.7 Applicable Law & Disputes. The parties specifically agree   that the U.N. Convention on the International Sale of Goods, 
the Uniform   Computer Information Transactions Act (“UCITA”), and the International   Commercial Terms issued by the Inter-
national Chamber of Commerce (“Incoterms”)   shall not apply to any and all actions performed by either party hereunder   in 
furtherance of these General T&Cs. These General T&Cs and all   resulting claims and/or counterclaims shall be governed, 
construed, enforced   and performed in accordance with the laws of the State of Colorado, United   States of America, without 
reference and/or regard to its conflicts of   laws principles. The parties hereto specifically agree that the exclusive   jurisdiction 
for any and all resulting claims and/or counterclaims arising   out of these General T&Cs shall be the federal and local courts of   
Denver, Colorado.

 14.8 Force Majeure. Neither party shall be liable for any failure   or delay in performing Services or any other obligation under 
these General   T&Cs, nor for any damages suffered by the other or an End-User by   reason of such failure or delay, which is, 
indirectly or directly, caused   by an event beyond such party’s foreseeable control including but not   limited to strikes, riots, 
natural catastrophes, terrorist acts, governmental   intervention, or other acts of God, or any other causes beyond such party’s   
reasonable control.

 14.9 Waiver. Each party agrees that the failure of the other party   at any time to require performance by such party of any of 
the provisions   herein shall not operate as a waiver of the rights of such party to request   strict performance of the same or like 
provisions, or any other provisions   hereof, at a later time.

 15. Notices. All notices under these General T&Cs shall be   in English and shall be in writing and given to the address 
indicated   upon the cover page and may be sent either by (i) registered airmail;   (ii) overnight delivery through a reputable 
third-party courier; or (iii)   via electronic mail (email) sent “read receipt” and “delivery receipt”.   With respect to NetAlly’s 
receipt of electronic notice set forth in (iii)   above such notice shall only been deemed received once Company receives   a con-
firmation of “read receipt” and “delivery receipt” and such notice   shall only be valid if sent to legal@netally.com.

 

See also https://www.netally.com/web-legal/.
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